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This document is a legal agreement between you, the end user and the authors. By using the
software, you are agreeing to be bound by the terms of this agreement.
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on that single computer. You may copy the software onto computers (office, home, laptop)
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copies of the Software equal to the number of users who will use the Software.

Y ou may not distribute copies of the Software or documentation to others. Y ou may not assign
sublicence, or transfer this Licence without the written permission of the authors. Y ou may not
rent or lease the Software without the prior permission of the authors. Y ou may not incorporate
all or part of the Software into another product for the use of other than yourself without the
written permission of the authors.

Term

This Licence is effective until terminated. Y ou may terminate it by destroying the Software and
documentation and all copies thereof. The Licence will also terminate if you fail to comply with
any term or condition of the Licence. Upon such termination you must destroy all copies of the
Software and documentation.

Disclaimer

The user of this software accepts and uses it at his’/her own risk.

The authors do not make any expressed of implied warranty of any kind with regard to this
software. Nor shall the authors be liable for incidental or consequential damages with or arising

out of the furnishing, use or performance of this software.

© Copyright 1991-1996 Wen-Hsing Chiang & Wolfgang Kinzelbach. All Rights Reserved.

Trademarks

Most computer and software brand names have trademarks or registered trademarks. The
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Preface

Processing Modflow was originally developed for a remediation project of adisposal sitein the
coastal region of Northern Germany several years ago. At the beginning of the work, the code
was designed as a pre- and postprocessor for MODFLOW. The size of the code grew up, aswe
began to add severa additional options and performances for supporting the particle tracking
code MODPATH and the solute transport program MT3D. In the mean time, various codes were
developed by numerous investigators for simulating specific features of the hydrologic system
with MODFLOW. In these days programs for the parameter estimation and model calibration,
such as PEST or MODFLOWI/P, are also available.

Two years ago, we began to prepare the Windows-version of Processing Modflow with the goal
of bringing various codes together in a complete ssimulation system. We have prepared the
Windows-based advective transport model PMPATH and added options for supporting the codes
including MODFLOW, MODPATH, MODPATH-PLOT, MT3D and PEST. We incorporated
MODFLOW, PMPATH and the educational version of PEST and MT3D in the ssmulation
system. We have made efforts to explain the theory and methods used in the code and included
numerous examples to facilitate the use of Processing Modflow.

Acknowledgments

We are very grateful to John Doherty who provided the educational release of PEST, explanations
of the program parameters and many valuable comments and criticisms. We are indebted to
Chunmiao Zheng of the Department of Geology at the University of Alabamawho provided the
educationd release of the solute trangport model MT3D and the corresponding input instructions.

Many thanks are due to many of our friends and colleagues for their contribution in developing,
checking and validating the various parts of this software.

Wen-Hsing Chiang Wolfgang Kinzelbach
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1. Introduction

What Is PMWIN

Processing Modflow for Windows (PMWIN) is a simulation system for modeling groundwater
flow and transport processes with the modular three-dimensional finite-difference groundwater
model MODFLOW of theU. S. Geologica Survey (McDonald et a., 1988), the particle tracking
mode PMPATH for Windows (Chiang, 1994) or MODPATH (Pollock, 1988, 1989, 1994), the
solute transport model MT3D (Zheng, 1990) and the parameter estimation program PEST
(Doherty et al., 1994). The codes supported by PMWIN are widely used and available at nominal
cost.

The applications of MODFLOW to the description and prediction of the behavior of groundwater
systems have increased significantly over the last few years. Since the publication of MODFLOW
various codes have been devel oped by numerous investigators for simulating specific features of
the hydrologic system. MODFLOW can simulate the effects of wells, rivers, drains, head-
dependent boundaries, recharge and evapotranspiration. PMWIN also supports the calculation
of elastic and inelastic compaction of an aquifer due to changes of hydraulic heads.

The particle tracking model PMPATH for Windows is included in PMWIN. PMPATH uses a
semi-analyticd particle tracking scheme (Pollock, 1988) to calculate the groundwater paths and
travel times. PMPATH allows a user to perform particle tracking with just a few clicks of the
mouse. Both forward and backward particle tracking schemes are allowed for steady-state and
trangent flow fields. PMPATH ca culates and shows pathlines or flowlines and travel time marks
simultaneoudly. It provides various on-screen graphical options including head contours,
drawdown contours and velocity vectors.

The development of the particle tracking model MODPATH can be roughly divided into two
stages. The earlier release of MODPATH was devel oped to compute flowlines based on output
from steady-state flow simulations by MODFLOW. The most recent release of MODPATH
permits forward and backward tracking in transient flow fields as well as steady-state flow fields.
Output from MODPATH can be displayed graphically by using the program MODPATH-PLOT.

The MT3D transport model uses a mixed Eulerian-Lagrangian approach to the solution of the
three-dimensional advective-dispersive-reactive transport equation. MT3D is based on the
assumption that changes in the concentration field will not affect the flow field significantly. This
alows the user to construct and calibrate a flow model independently. After aflow smulation is
complete, MT3D retrieves the calculated hydraulic heads and various flow terms saved by
MODFLOW. The MT3D transport model can be used to simulate changes in concentration of
single pecies miscible contaminants in groundwater considering advection, dispersion and some
smple chemical reactions. The chemical reactions included in the model are currently limited to
equilibrium-controlled linear or non-linear sorption and first-order irreversible decay or
biodegradation.

The purpose of PEST (which is an acronym for Parameter ESTimation) is to assist in data

I ntroduction


http://ourworld.compuserve.com/homepages/W_H_Chiang/
http://ourworld.compuserve.com/homepages/W_H_Chiang/pmwin.htm

1-2 Processing M odflow

interpretation and in model calibration. If there are field or laboratory measurements, PEST can
adjust model parameters and/or excitation data in order that the discrepancies between the
pertinent model-generated numbers and the corresponding measurements are reduced to a
minimum. It does this by taking control of the model (MODFLOW) and running it as many times
asis necessary in order to determine this optimal set of parameters and/or excitations. PMWIN
helps the user to inform PEST of assigning the adjustable parameters and excitations.

New Features in PMWIN

PMWIN is capable of using all available memory. Thereis almost no limit to the model size.
PMWIN can handel models with up to 80 layers and 1000 stress periods. Each model layer
can consist of 2000 x 2000 cells. Of course a sufficiently large harddisk must be avaiable to
store the forthcoming result files.

PMWIN provides comprehensive supports to the parameter estimation program, PEST. Users
just need to define zones of parameters and send them to a Parameter List. This is al
accomplished with aclick of the mouse.

PMWIN provides a Layer Options dialog box. Transmissivity, vertical leakance and storage
coefficient of each layer can be specified by the user directly or will be calculated by applying
aparticular rule, eg., Transmissvity = Hydraulic Conductivity x Layer Thickness. The choice
for each of these parameters is accomplished by choosing between "Calculated” or "User
Specified” in the Layer Options dialog box.

Three additiona packages of MODFLOW are supported by PMWIN. They are the Horizontal
Flow Barrier Package (HFB1) for easily smulating slurry walls, the Time Variant Specified
Head Package (CHD1), and the Interbed-Storage Package (IBS1) for ssmulating transient
storage and calculating compaction and subsidence of an aquifer due to changes of hydraulic
heads.

PMWIN provides a powerful Result Extractor. Normally, simulation results from Modflow
or MT3D are saved unformatted (binary) and cannot be viewed. The unformatted simulation
result filesinclude hydraulic head, drawdown, cell-by-cell flow terms, preconsolidation head,
compaction, subsidence and concentration. The Result Extractor allows the user to extract
smulation results from any stress period, time step and layer and put them into a spread sheet.
Users can then view the results or save them in ASCII or SURFER-compatible data files.

Using the Field Generator provided by PMWIN, fields with heterogeneously-distributed
transmissivity or hydraulic conductivity can be generated. This alows the user to statistically
amulate effects and influences of unknown small-scale heterogeneities. The Field Generator
(Frenzel, 1995) is based on Mgjias algorithm (1974).

PMWIN can display tempora development curves of simulation results including hydraulic
heads, drawdowns, concentrations, preconsolidation heads, compaction of amodel layer and
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subsidence of an entire aquifer.

® TheWater Budget Calculator for caculating water budgets has been improved. It cannot only
calculate the budget of user-specified zones but aso the exchange of flows between zones.
This facility is very useful in many practical cases. It allows the user to determine the flow
through a particular boundary exactly.

® PMWIN comes with the educationa version of MT3D and PEST and provides numerous
examples, including the test problems of the STR1, IBS1, BCF2 and MT3D packages.

® PMWIN can create contour maps or solid fill plots of input data or simulation results. Solid
Fill can utilize the full range of RGB colors to fill cells with different values. Contours can be
added to these plots. Report-quality graphics may be saved to a wide variety of file types,
including SURFER, DXF, HPGL and BMP (Windows Bitmap).

System Requirements

Hardware

Personal computer running Microsoft Windows 3.1 or later or Windows 95

8 MB of available memory (16MB or more recommended)

One 3.5" high-density disk drive and a hard disk (complete installation requires 27MB)
EGA or higher-resolution monitor

Microsoft Mouse or compatible pointing device

Software
The models MODFLOW, MODPATH and MT3D must be compiled by Lahey Fortran F77L-
EM/32.

Setting Up PMWIN
You instal PMWIN on your computer using the program SETUP.EXE contained in disk #1. The

Setup program ingtalls PMWIN itself and other program components from the distribution disks
to your hard disk.

Note that you cannot simply copy files from the distribution disks to your hard disk and run
PMWIN. You must use the Setup program, which decompresses and installs the files in the
appropriate directories.

After having ingtalled PMWIN, you should add the following entries to the file CONFIG.SY S and
AUTOEXEC.BAT and reboot your computer.

CONFIG.SYS:
FILES=80
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AUTOEXEC.BAT:
SET PESTDIR=path

where path isthe subdirectory of the PEST programs. If you do not have PEST, path should be
the subdirectory of PMWIN, e.g. C:\PMWIN.

Online Help

The online help system references nearly dl aspects of PMWIN. Y ou can access Help through the
Help menu Contents command, by searching for specific topics with the Help Search tool, or by
pressing F1 to get context sensitive Help on the PMWIN modeling environment.

Help Search

The fastest way to find a particular topic in Help isto use the Search dialog box. To display the
Search didog box, you can either choose Search from the Help menu or click the Search button
on any Help topic screen.

To search Help

1. From the Help menu, choose Search. (Y ou can aso choose the Search button from any Help
topic Window)

2. In the Search dialog box, type a word, or select one from the list by scrolling up or down.
Press ENTER or choose Show Topics to display a list of topics related to the word you
specified.

3. Select atopic name, and then press ENTER or choose Go To to view the topic.

Context-Sensitive Help

Many parts of PMWIN are context-sengtive. Context-sensitive means you can get Help on these
parts directly without having to go through the Help menu. For example, to get Help on any
dialog box of PMWIN, just click the Help button.

I ntroduction



Processing Modflow 2-1

2. Your First Groundwater Flow Model with PMWIN

It takes just afew minutesto build your first groundwater flow model with PMWIN. Y ou create
agroundwater model by choosing New Model from the File menu. Next, you determine the size
of themodd grid by choosing Mesh Size from the Grid menu. Then, you specify the geometrical
setup and assign the model parameters, such as hydraulic conductivity. Finally, you perform the
flow ssmulation by choosing Flow Computation (Modflow) from the Run menu. After the flow
smulation is completed, you can use the modeling tools provided by PMWIN to view the results,
to calculate water bugdets of particular zones, or graphically display the results, such as head
contours. Y ou can also use PMPATH to calculate and save pathlines.

This chapter provides an overview of the modeling process with PMWIN, describes the basic
skills you need to use PMWIN, and takes you step by step through the sample model. A complete
reference for al menus and dialog boxes in PMWIN is contained in Chapter 3. The modeling
tools are described in Chapter 4.

The Sample Problem

The configuration of the sample problem is shown in Fig. 2.1. The flow domain is bounded by
no-flow boundaries on the north and south sides. The west and east sides are constant-head
boundaries. The hydraulic heads on the west and east boundaries are 9 m and 8 m, respectively.

No-Flow Boundary

9 m)
8 m)

Pumping Well

Contaminated Area

y/ ramping vt

//

Contaminated Area

: Layer 1

Layer 2

600 m

Constant Head Boundary (h
Constant Head Boundary (h
5 13

No-Flow Boundary
| 580 m |

[ |
Fig. 2.1 Configuration of the sample problem

The aquifer conssts of two layers. Thefirst layer is unconfined and the second layer is confined.
Horizontal hydraulic conductivities of the first and second layers are 0.005 m/s and 0.001 nv/s,
respectively. Vertical hydraulic conductivity of both layersis about 10 percent of the horizontal
hydraulic conductivity. The effective porosity is approximately 25 percent. The elevation of the
top of thefirst layer is 10m. The thickness of the first layer and the second layer is 13 m and 5 m,

Y our First Groundwater Flow Model with PMWIN
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respectively. A contaminated arealiesin thefirst layer next to the west boundary. To clean up the
aquifer, afully penetrating pumping well is located next to the east boundary.

A numerical model has to be developed for this site to calculate the required pumping rate of a
well. The pumping rate must be large enough, so that the contaminated area lies within the
capture zone of the pumping well. We will use PMWIN to construct the numerical model and use
PMPATH to compute the capture zone.

Starting PMWIN

When you run the PMWIN Setup program, Setup automatically crestes anew program group and
new program items for Processing Modflow in Windows. Y ou are then ready to start PMWIN
from Windows.

» To start PMWIN from Windows
® Double-click the Processing Modflow icon.

When you start PMWIN, you see the interface of PMWIN with a Menu bar and atool bar. The
tool bar contains an Open Model icon, you can click thisicon to open a model.

Run a Steady-State Flow Simulation

There are four main steps to run a steady-state flow simulation:
1. Create aflow model

2. Assign model data

3. Perform the flow simulation

4. Check ssimulation results and produce output

Create a Flow Model
Thefirst step in running aflow simulation is to create a new model.

» To create a flow model
Choose New Model from the File menu. A New Model dialog box will appear. Select a
directory for saving the model data, such as C:\PMWIN\EXAMPLES\SAMPLE, and type
the file name SAMPLE for the sample model. A PMWIN model must always have the file
extension MDL. It is a good idea to save every model in a separate directory, where the
model and its output data will be kept. This will also alow you to run severa models
smultaneoudy (multitasking). If adesired directory for saving a new model is not available,
you have to use the File Manager of Windows or other utilities to create the directory.

2. Click OK.
PMWIN takes only afew secondsto creste the new model and show the model name on the
title bar.

Y our First Groundwater Flow Model with PMWIN
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Assign Model Data

The second step in running a flow smulation is to generate the model grid (mesh), specify
boundary conditions, and assign model parameters to the model grid. In MODFLOW, an aquifer
system is replaced by a discretized domain consisting of an array of nodes and associated finite
difference blocks (cdlls). Fig. 2.2 shows a spatial discretization of an aquifer system with amesh
of cellsand nodes at which hydraulic heads are calculated. The nodal grid forms the framework
of the numerica modd. Hydrostratigraphic units can be represented by one or more model layers.
The thicknesses of each model cell and the width of each column and row may be variable. The
locations of cells are described in terms of columns, rows, and layers. PMWIN uses an index
notation [J, I, K] for locating the cells. For example, the cell located in the 2nd column, 6th row,
and thefirst layer is denoted by [2, 6, 1].

Columns (J)
2 345678 9 10

Woi:ss: ok

4/ AT
S / .

Layers (K)

(V8]

Fig. 2.2 Spatia discretization of an aquifer system and the cell indices

» To generate the model grid
Choose Mesh Size from the Grid menu.
A Model Dimension dialog box will come up (Fig. 2.3)

2. Type2for the number of layers, 30 for the numbers of columns and rows, and 20 for the size
of columns and rows.

3. Click OK.
PMWIN changes the pull-down menus and shows the generated model grid (Fig. 2.4). Some
menus items are dimmed, as they will not be used here. PMWIN allows you to shift or rotate
the model grid, change the width of each model column or row, or add or delete model
columns or rows. For our sample problem, you do not need to modify the model grid. See
section 3.1 for more information about the Grid Editor.

4. Choose Leave Editor from the File menu or click the Leave Editor icon

Y our First Groundwater Flow Model with PMWIN
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B ModelDimension |
[Layers .
Cancel
[ Columns
Size: 20.000
"Rows
Size: 20.000

Fig. 2.3 The Model Dimension dialog box

= Processing Modflow - [SAMPLE.MDL] e
File Options Help

EERENEE

| 1171338 5388535 | 1.1 fime incependent Mesh Size [L]

— T —
Fig. 2.4 The generated moddl grid

The next step is to specify the type of layers.

» To assign the type of layers
Choose Layer Type from the Grid menu.
A Layer Options dialog box will appear.

2. Clicking acdl of the Type column, adrop-down button will appear in the current cell. If you
click on the button, alist will drop down which contains al the possible layer types, as shown

inFig. 2.5.
3. Sdecttype 1 for thefirst layer and type O for the second layer.
4. Click OK.

Y our First Groundwater Flow Model with PMWIN
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= Layer Options

Anisotropy |Interbed L
Layer pre Factor Storage Transmissivity

: Unconfined 1 No Calculated

0: Confined + jalculated

2: ConfinedfUnconfined (Transmissivity=const.)

3: Confined/Unconfined (Transmissivity varies)

4: Type 0 + semi-confining layer +

« ] -
‘ Help ” Cancel ” oK |

Fig. 2.5 The Layer Options dialog box and the layer type drop-down list

Now, you will specify boundary conditions of the flow model by using the IBOUND array. This
array contains a code for each model cell which indicates whether (1) the hydraulic head is
computed (active variable-head cell or active cell), (2) the hydraulic head is kept fixed at a given
value (constant-head cell or time-varying specified-head cell), or (3) no flow takes place within
the cell (inactive cell). It is suggested to use 1 for an active cell, -1 for a constant-head cell, and
0 for an inactive cell.

For the sample problem, we need to assign -1 to the cells on the west and east boundaries and 1
to all other cells.

N

To assign the boundary condition to the flow model

Choose Boundary Condition » IBOUND (Modflow) from the Grid Menu.

PMWIN shows the top view of the model grid (Fig. 2.6). The grid cursor is located in the
cdl [1, 1, 1], that isthe upper-left cdll of thefirst layer. The value of the current cell is shown
at the bottom of the status bar. The default value of the IBOUND array is 1. The grid cursor
can be moved horizontally by using the arrow keys or by clicking the mouse on the desired
position. To move to an other layer, you can use PgUp or PgDn keys or click the edit field
in the tool bar, type the new layer number, and then press enter.

Pressing the right mouse button, PMWIN shows a Cell Vaue dialog box.

Type -1 in the dialog box, then click OK.

The upper-l€eft cell of the model has been specified as a constant-head cell.

Now turn Duplication on by clicking the Duplication icon [l .

The small box on the lower-right corner of thisicon will be highlighted. The current cell
vaue will be duplicated to dl cells passed by the grid cursor, if it is moved while Duplication
ison. You can turn Duplication off by clicking the Duplication icon again.

Move the grid cursor from the upper-left cell [1, 1, 1] to the lower-left cell [1, 30, 1] of the
model grid.

The value of -1 isduplicated to all cells on the west side of the mode.

Move the grid cursor to the upper-right cell [30, 1, 1].

Y our First Groundwater Flow Model with PMWIN
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9.

Movethe grid cursor from the upper-right cell [30, 1, 1] to the lower-right cell [30, 30, 1].
The value of -1 isduplicated to all cells on the east side of the mode.

Turn Layer Copy on by clicking the Layer Copy icon =

The small box on the lower-right corner of thisicon will be highlighted. The cell values of
the current layer will be copied to other layers, if you move to the other model layer while
Layer Copy ison. You can turn Layer Copy off by clicking the Layer Copy icon.

Move to the second layer.

The cell values of the first layer are copied to the second layer.

10. Choose Leave Editor from the File menu or click the Leave Editor icon

File V¥alue Options Help

Processing Modflow - [SAMPLE.MDL] -

AR Bl @] === [ ]

-

5875

a1

96, 390.7643 | 111 rtme independent Boundary Condition (\BO@J) [] Active=1/Inactive=0/ Fixed Head=-1

Fig. 2.6 Top view of the model grid. Model data are assigned to each

cel in each layer.

The next step is to specify the geometrical setup of the model.

>

1.

2.

To specify the elevation of the top of model layers

Choose Top of Layers (TOP) from the Grid menu.

PMWIN shows the model grid.

Choose Matrix»Reset from the Value menu (or press Ctrl+R).
A Reset Matrix dialog box will come up.

Type 10 in the dialog box, then click OK.

The elevation of the top of the first layer is set to 10.

Move to the second layer by pressing PgDn.

Repeat steps 2 and 3 to set the top of the second layer to -3.

Choose Leave Editor from the File menu or click the Leave Editor icon

To specify the elevation of the bottom of model layers
Choose Bottom of Layers (BOT) from the Grid menu.

Y our First Groundwater Flow Model with PMWIN
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2.

3.

Repeat the same procedure as described above to set the bottom of the first layer to -3 and
the bottom of the second layer to -8.

Choose Leave Editor from the File menu or click the Leave Editor icon

Now, we are going to specify the temporal and spatial parameters of the model. For the sample
problem, spatial parameters include the starting hydraulic head, horizontal and vertical hydraulic
conductivities, and effective porosity.

>

1.

> w

To specify the temporal parameters

Choose Time from the Parameters menu.

A Time Parameters dialog box will come up. The temporal parameters include the time unit
and the numbers of stress periods, time steps and transport steps. In MODFLOW, the
simulation time is divided into stress periods - i.e., time intervals during which all external
excitations or stresses are congtant - which are, in turn, divided into time steps. In the MT3D
modedl, each time step is further divided into smaller time increments, called transport steps.
The length of stress periodsis not relevant to a steady state flow ssimulation. However, if you
want to perform contaminant transport simulation with MT3D at a later time, you must
specify the actual time length in the table.

Click OK to accept the default values.

To specify the initial hydraulic head

Choose Starting Values»Hydraulic Heads from the Parameters menu.

PMWIN shows the model grid. Now, you can specify the initial hydraulic heads for each
model cell. The initial hydraulic head at a constant-head boundary will be kept constant
during the flow ssimulation.

Choose Matrix»Reset from the Vaue menu (or press Ctrl+R) and type 8 in the dialog box,
then click OK.

Move the grid cursor to the upper-left model cell.

Press the right mouse button and type 9 in the Cell Vaue dialog box, then click OK.

Now turn Duplication on by clicking the Duplication icon [l .

The small box on the lower-right corner of thisicon will be highlighted. The current cell
vauewill be duplicated to al cells passed by the grid cursor, if it is moved while Duplication
ison.

Move the grid cursor from the upper-left cell to the lower-left cell of the model grid.

The value of 9 is duplicated to al cells on the west side of the model.

Turn Layer Copy on by clicking the Layer Copy icon =

The small box on the lower-right corner of thisicon will be highlighted. The cell values of
the current layer will be copied to another layer, if you move to the other model layer while
Layer Copy ison.

Move to the second layer by pressing PgDn.

The cell values of the first layer are copied to the second layer.

Choose Leave Editor from the File menu or click the Leave Editor icon

To specify the horizontal hydraulic conductivity
Choose Horizontal Hydraulic Conductivity from the Parameters menu.

Y our First Groundwater Flow Model with PMWIN
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2. Choose Matrix>Reset from the Value menu (or press Ctrl+R) and type 0.005 in the dialog
box, then click OK.

3. Moveto the second layer by pressing PgDn.

4. Choose Matrix>Reset from the Vaue menu (or press Ctrl+R) and type 0.001 in the dialog
box, then click OK.

5. Choose Leave Editor from the File menu or click the Leave Editor icon

» To specify the vertical hydraulic conductivity
. Choose Vertical Hydraulic Conductivity from the Parameters menu.
2. Choose Matrix>Reset from the Vaue menu (or press Ctrl+R) and type 0.0005 in the dialog
box, then click OK.
3. Moveto the second layer by pressing PgDn.
4. Choose Matrix>Reset from the Value menu (or press Ctrl+R) and type 0.0001 in the dialog
box, then click OK.

5. Choose Leave Editor from the File menu or click the Leave Editor icon

» To specify the effective porosity
. Choose Effective Porosity from the Parameters menu.
2. Choose Matrix»Reset from the Value menu (or press Ctrl+R) and type 0.25 in the dialog
box, then click OK.

3. Turn Layer Copy on by clicking the Layer Copy icon =
4. Move to the second layer by pressing PgDn.

5. Choose Leave Editor from the File menu or click the Leave Editor icon

Thelast step before performing the flow smulation of the sample model isto specify the location
of the pumping well and its pumping rate. In MODFLOW, an injection or pumping well is
represented by a node (or a cell). The user specifies an injection or pumping rate for each node.
It is implicitly assumed that the well penetrates the full thickness of the cell. MODFLOW can
simulate the effects of pumping from a well that penetrates more than one aquifer or layer
provided that the user supplies the pumping rate for each layer. The total pumping rate for the
multilayer well isequa to the sum of the pumping rates from the individual layers. The pumping
rate for each layer (Q, ) can be approximately calculated by dividing the total pumping rate
(Qyta) in proportion to the layer transmissivities (McDonald and Harbaugh, 1988).

Tk
Qk - Qtotal E (2-1)

where T, isthe transmissivity of layer k and 2T isthe sum of the transmissivities of al layers
penetrated by the multilayer well.

As we do not know the required pumping rate for capturing the contaminated area shown in
Fig. 2.1, we will try atotal pumping rate of 0.02 m%s. By applying equation 2.1, the pumping
rates are 0.0185 m*/s and 0:0015 m¥/s in the first and second layer, respectively.
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To specify the pumping well and the pumping rate

Choose Well (WEL 1) from the Packages menu.

Move the grid cursor to the cell [25, 15, 1]

Press the right mouse button and type -0.0185, then click OK. Negative value is used to
indicate a pumping well.

Move to the second layer by pressing PgDn.

Press the right mouse button and type -0.0015, then click OK.

6. Choose Leave Editor from the File menu or click the Leave Editor icon

WNPE Y

ok

Perform the Flow Simulation
Now everything is ready to run the flow simulation with MODFLOW.

» To perform the flow simulation
Select Run Menu and Choose Flow Computation (M odflow).
A Run Modflow dialog box will appear (Fig. 2.7).

2. Click OK to start the flow computation.
Prior to running MODFLOW, PMWIN will use user-specified data to generate input files of
MODFLOW and MODPATH asligted in the table of the Run Modflow dialog box. An input
file will be generated, only if the Generate flag is set to YES. You can click on arow to
toggle the Generate flag between YES and No. Generally, you do not need to change the
Generate flags, as PMWIN will care about the settings.

= Run Modflow

Depending on how the Modflow program is compiled and how much RAM is installed.,
the system may become unstable during the simulation. It is a good idea to save all

wour data before running Modflow.

Modflow Version:
|User's own |£|

Modflow Program:

|e:\p mwinimodflow\modflow exe

Generate |Description Destination

Yes Basic Package e’\pmwiniexamplesisampleibas.dat
Yes Block-Centered Flow (BCF1.2) |e:\pmwiniexamples\isampletbcf.dat

Yes Qutput Control e’pmwintexamples\sampleloc.dat

Yes Well e\pmwiniexamples\sampleiwel dat
Yes Solver - PCG2 e’\pmwiniexamples\samplelpcg2.dat
Yes Modpath (Vers. 1.x) e’\pmwiniexamplesisampleymain_dat
Yes Modpath (Vers. 3.x) e’ipmwiniexamplesisampleymain30.dat
[ -+

 Options
[~ Regenerate all input files for MODFLOW

[ Check the geometrical setting up of the model Cancel

[ Generate input files only, don't start MODFLOW Hel
elp

Fig. 2.7 The Run Modflow dialog box

Check Simulation Results and Produce Output

During a flow simulation, MODFLOW writes a detailed run record to the file
path\OUTPUT.DAT, where path is the directory in which your model data are saved. If aflow
smulation is successfully complete, MODFLOW saves the smulation results in various
unformatted (binary) files as listed in Table 2.1. Prior to running MODFLOW, the user may
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control the output of these unformatted (binary) files by choosing Output Control>Modflow from
the Packages menu. The output file path\INTERBED.DAT will only be generated, if the Interbed
Storage Package is activated (see Chapter 3 for details about the Interbed Storage Package).

For checking the simulation results, MODFLOW calculates a volumetric water budget for the
entire model at the end of each time step, and savesit in the record file (see Fig. 2.8). A water
budget provides an indication of the overall acceptability of the numerical solution. In numerical
solution techniques, the system of equations solved by a model actualy consists of a flow
continuity statement for each model cell. Continuity should aso exist for the total flows into and
out of the entire model or a sub-region. This means that the difference between total inflow and
total outflow should equal the total change in storage. It is recommended to read the record file
or at least glance at it. The record file contains other further essential information. In case of
difficulties, this supplementary information could be very helpful.

File Contents

path\OUTPUT.DAT Detailed run record and simulation report

path\HEADS.DAT Hydraulic heads

path\DDOWN.DAT Drawdowns, the difference between the starting heads and
the calculated hydraulic heads.

path\BUDGET.DAT Cell-by-Cdl flow terms

path\INTERBED.DAT Subsidence of the entire aquifer and compaction and
preconsolidation heads in individud layers.

Table 2.1 Output files from MODFLOW

VOLUMETRI C BUDGET FOR ENTI RE MODEL AT END OF TIME STEP 1 IN STRESS PEROD 1

CUMULATI VE VOLUVES  L**3/T RATES FOR THIS TIME STEP  L**3/T
I'N I'N
STORAGE = 0. 00000 STORAGE = 0. 00000
CONSTANT HEAD = 0. 68083E- 01 CONSTANT HEAD = 0. 68083E- 01
WELLS = 0. 00000 WELLS = 0. 00000
TOTAL IN = 0. 68083E-01 TOTAL IN = 0. 68083E-01
QuT: QUT:
STORAGE = 0. 00000 STORAGE = 0. 00000
CONSTANT HEAD = 0. 48096E- 01 CONSTANT HEAD = 0. 48096E- 01
WELLS = 0.2E-01 WELLS = 0. 20000E- 01
TOTAL QUT = 0. 68096E- 01 TOTAL QUT = 0. 68096E- 01
IN- QUT = -0.13150E-04 IN- QUT = -0.13150E-04
PERCENT DI SCREPANCY = -0.02 PERCENT DI SCREPANCY = -0.02

Fig. 2.8 Volumetric budget for the entire model written by MODFLOW

There are situations in which it is useful to calculate flow terms for various subregions of the
model. To facilitate such calculations, flow terms for individual cells are saved in the file
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path\BUDGET.DAT. These individual cell flows are referred to as cell-by-cell flow terms, and
are of four types: (1) cell-by-cell stress flows, or flows into or from an individua cell due to one
of the external stresses (excitations) represented in the model, e.g., pumping well or recharge;
(2) cdl-by-cdll storage terms, which give the rate of accumulation or depletion of storagein an
individual cell; (3) cell-by-cell constant-head flow terms, which give the net flow to or from
individual constant-head cells; and (4) internal cell-by-cell flows, which are the flows across
individud cell faces-that is, between adjacent model cells. The Water Budget Calculator uses the
cedll-by-cdll flow termsto compute water budgets for the entire model, user-specified subregions,
and flows between adjacent subregions. PMPATH uses the cell-by-cell flow terms and calculated
hydraulic heads for calculating and displaying pathlines.

In addition to the Water Budget Calculator and PMPATH, PMWIN provides various possibilities
for checking ssimulation results and creating graphical output. Using the Results Extractor,
gmulation results of any layer and time step can be read from the unformatted (binary) result files
and saved in ASCII Matrix files. An ASCII Matrix file contains a value for each model cell ina
layer. The format of the ASCII Matrix file is described in Appendix 2. PMWIN can generate
contour maps based on an ASCII Matrix file.

In the following, we will accomplish the steps:

1. Use the Water Budget Calculator to compute water budgets of each layer and the entire
model, and check if the percent discrepancies of in- and outflows are acceptable small.

2. Usethe Result Extractor to read and save the calculated hydraulic heads of each layer.

3. Generate contour maps based on the calculated hydraulic heads saved in step 2.

4. Create a solid fill plot based on the calculated hydraulic heads saved in step 2 and add
contours to the plot.

5. Use PMPATH to produce pathlines as well as the capture zone of the pumping well.

» To calculate subregional water budgets
Choose Water Budget from the Run menu.
A Water Budget dialog box will come up (Fig. 2.9). For a steady-state flow simulation, you
do not need to change the settings in the Time group.

2. Click Zones.
A zone is a subregion of a moddl for which a water budget will be calculated. A zone is
indicated by a zone number ranging from O to 50. A zone number must be assigned to each
mode cell. The zone number 0 shows that a cell is not associated with any zone. Follow the
steps 3 to 5 to assign zone numbers 1 to the first and 2 to the second layer.

3. Choose Matrix>Reset from the Vaue menu (or press Ctrl+R), type 1 in the dialog box, then
click OK.

4. Press PgDn to move to the second layer.

5. Choose Matrix>Reset from the Vaue menu (or press Ctrl+R), type 2 in the dialog box, then
click OK.

6. Choose Leave Editor from the File menu or click the Leave Editor icon

7. Click OK in the Water Budget dialog box.

PMWIN calculates and saves the flowsin the file path\ WATERBDG.DAT as shown in Fig. 2.10.
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The unit of the flows is [L¥T]. Flows are considered "IN", if they are entering a zone. Flows
between subregions are given in aflow matrix.

Water budgets are calculated for each zone in each layer and each time step. HORIZ.
EXCHANGE gives the flows which flow horizontally across a zone's boundary. EXCHANGE
(UPPER) or EXCHANGE (LOWER) give the flows which come from or go to the upper or
lower adjacent layers. Consider ZONE = 1 and LAYER = 1: the flow IN = 1.5266858 10* m¥/s
of EXCHANGE (LOWER) flows from the second layer into zone #1 and flow
OUT = 3.6502272 10* m?/s leaves zone #1 and flows to the second layer.

The percent discrepancy is calculated by

100 (IN - OUT)
(IN + OUT) / 2

2.2)

In this example, the percent discrepancies of in- and outflows for the model and each zone in each
layer are acceptably small. This means the model equations are correctly solved.

= Water Budget

Specify the stress period and time step for which the
water budget should be calculated. Click Zones to
specify subregions. When finished. click OK to start
the calculation.

Time

Stress Period: Zones

||1 oK

Time Step:

1 Cancel

Help

Flil]r

Fig. 2.9 The Water Budget dialog box

FLONS ARE CONSI DERED "I N' I F THEY ARE ENTERI NG A SUBREG ON
THE UNIT OF THE FLOANS | S [L"3/T]

TI ME STEP 1 OF STRESS PERI D 1
ZONE= 1 LAYER= 1

FLOW TERM I'N aut I N-QUT
STORAGE 0. 0000000E+00 0. 0000000E+00 0. 0000000E+00
CONSTANT HEAD 6.2836841E-02 4.4093262E-02 1.8743578E-02
HORI Z. EXCHANGE 0. 0000000E+00 0. 0000000E+00 0. 0000000E+00
EXCHANGE (UPPER) 0. 0000000E+00 0. 0000000E+00 0. 0000000E+00
EXCHANGE (LOWER) 1.5266858E-04 3.6502272E-04 -2.1235413E-04
VELLS 0. 0000000E+00 1.8500000E-02 -1.8500000E-02

Fig. 2.10 Output from the Water Budget Calculato
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DRAI NS

RECHARGE

ET

RI VER LEAKAGE
HEAD DEP BQUNDS
STREAM LEAKAGE

I NTERBED STORAGE
SUM OF THE LAYER

[oNeoNoNoNoNoNoNo]

ZONE= 1 LAYER= 2
FLOW TERM
(all flowternms are z

ZONE= 2 LAYER= 1
FLOW TERM

(all flowternms are z

ZONE= 2 LAYER= 2
FLOW TERM

STORAGE O

CONSTANT HEAD 5

HORI Z. EXCHANGE O

EXCHANGE (UPPER) 3

EXCHANGE (LOVER) O

VELLS O

DRAINS O

RECHARGE O

ET O

RI VER LEAKAGE O
HEAD DEP BCOUNDS O
STREAM LEAKAGE O.

| NTERBED STCRAGE O
SUM OF THE LAYER 5

. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 2989511E- 02

I'N

ero, because

I'N

ero, because

I'N

. 0000000E+00
. 2456958E- 03
. 0000000E+00
. 6502272E- 04
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00

. 0000000E+00
. 0000000E+00

0000000E+00

. 0000000E+00
.6107184E- 03

[oNeoNoNoNoNoNoNo]

. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 2958285E- 02

aut

[ eNoNoNoNoNoNo]

zone 1 lies only

zone 2 lies only

OO0OO0ORrROFrRLOMO

aut

. 0000000E+00
. 0024151E- 03
. 0000000E+00
. 5266858E- 04
. 0000000E+00
. 5000000E- 03
. 0000000E+00
. 0000000E+00
. 0000000E+00

. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 6550838E- 03

OO0OOFrRONORrO

. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 1225383E- 05

I N-QUT
in the first layer)

I N-QUT

in the second | ayer)

I N-QUT

. 0000000E+00
. 2432807E- 03
. 0000000E+00
. 1235413E- 04
. 0000000E+00
. 5000000E- 03
. 0000000E+00
. 0000000E+00
. 0000000E+00

. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 4365413E- 05

WATER BUDGET OF SELECTED ZONES:

ZONE( 1): 6.
ZONE( 2): 5.

I'N
2989511E- 02
6107184E- 03

. 2958285E- 02
. 6550838E- 03

I N-QUT

. 1225383E- 05
. 4365413E- 05

WATER BUDGET OF THE WHOLE MODEL DOVAI N

FLOW TERM
STORAGE
CONSTANT HEAD
VELLS

DRAI NS

RECHARGE

ET

Rl VER LEAKAGE
HEAD DEP BQUNDS
STREAM LEAKAGE
I NTERBED STORAGE

[eNoNoNoNoNoNoNoNe No]

I'N

. 0000000E+00
. 8082534E- 02
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00

[eNoNoNoNoNoNaN V¥ Yo

aut

. 0000000E+00
. B095688E- 02
. 0000000E- 02
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00

I N-QUT

. 0000000E+00
. 9986846E- 02
. 0000000E- 02
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00
. 0000000E+00

SUM 6.
DI SCREPANCY [% - 0.

The value of the element (i,j) of the following flow matrix gives the flow

8082534E- 02
02

. B095684E- 02

-1.

rate fromthe i-th zone into the j-th zone. Were

index and j is the ro

w i ndex.

3150275E- 05

is the colum
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FLOW MATRI X:
1 2

0 1 0.0000 1. 5267E- 04

0 2 3.6502E-04 0.0000

Fig.

N

2.10 (continued) Output from the Water Budget Calcul ator

To read and save the calculated hydraulic heads of each layer

Choose Result Extractor from the Run menu.

A Result Extractor dialog box appears (Fig. 2.11). Y ou can choose a result type from the
Result Type drop-down box. In the Time/Layer group, you can specify the number of the
layer, stress period and time step from which the result should be read. The spreadsheet
displays a series of columns and rows. The intersection of arow and columnisacell. Each
cdll of the spreadshest is corresponding to amodel cell in alayer. By setting the Save Format
option, the result can be optionally saved in an ASCII Matrix or a SURFER datafile format.
Follow steps 2 to 6 to save the hydraulic heads of the first and second layersin two ASCII
Matrix filesH1.DAT and H2.DAT.

Choose Hydraulic Head from the Result Type drop-down box.

In the Time/Layer group, type 1 in the Layer edit field.

For the sample problem, the stress period and time step number should be 1.

Click Read.

Hydraulic heads in the first layer at time step 1 and stress period 1 will be read and put into
the spreadsheet. Y ou can scroll the spreadsheet by clicking on the scrolling bars next to the
Spreadsheet.

Click Save.

A Save Matrix As dialog box will come up. Specify the file name H1.DAT and select a
directory in which HL.DAT should be saved. Click OK when ready.

Type 2 in the Layer edit field and repeat steps 4 and 5 to save the hydraulic heads of the
second layer inthe file H2.DAT.

Click Close to close the dialog box.
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— Results Extractor

Result Type: Column Width:
Hydraulic Head + 14 .
Hydraulic Head
Drawdown
Concentration
Compaction
Preconsolidation Head
Subsidence
Cell-By-Cell Flow Terms

3 1}

+

-
CIEEEEEGEEE
EICEGEEEEGEEE

BEEEEEEEEEEEEGEE M

BEEEEEEEEEEEEEENN

BCICIEEEEEEEEEEEE .

-

L+

Time [ Layer Save Format
Layer: Stress Period: Time Step: ® ASCII Matrix
|1 |1 |1 C Surfer Data File

‘ Save... H Help... || Read || Close |

Fig. 2.11 Result types and the Results Extractor dialog box.

» To generate contour maps of the calculated heads
Choose Recycle from the Parameters menu
Data specified in Recycle will not be used by any simulation programs. We can use Recycle
to save temporary data or to display simulation results graphically.
2. Choose Matrix»Browse from the Value menu (or Press Cirl+B).
A Browse Matrix dialog box appears (Fig. 2.12). Each cell of the spreadsheet is
corresponding to a model cell in the current layer. Y ou can load an ASCII Matrix file into
the spreadsheet or save the spreadsheet in an ASCII Matrix file by clicking Load or Save.
3. Click Load.
A Load Matrix dialog box will appear (Fig. 2.13).

4. Clickl&l] and select the file HL.DAT which will be loaded (H1.DAT is saved by using the
Results Extractor). Click OK when ready.

H1.DAT isloaded and put into the spreadsheet.

5. Inthe Browse Matrix dialog box, click OK.
The Browse Matrix dialog box will be closed.

6. Choose Environment from the Options menu (or Press Ctrl+E).

An Environment Options dialog box appears (Fig. 2.14). It alows the user to modify the
appearance and position of the model grid.

7. Inthe Environment Options dialog box, check the Visible check box of the Contours group,
click the color button next to the Visible check box to select an appearance color of the
contours. Note that PMWIN will uncheck the Visible check box, if you leave the Editor or
move to other layers.

8. Inthe Environment Options dialog box, Click OK.

PMWIN will redraw the model and display the contours (Fig. 2.15).

9. To savethe graphics, choose Save Plot As from the File menu and specify a plot format and
file name in the Save Plot As dialog box (Fig. 2.16).

10. Press PgDn to move to the second layer. Repesat steps 2 to 9 to load the file H2.DAT, display
and save the plot.
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Parameter:

Column Width

= Browse Matrix

|Re cycle

B

14

B

BIEEEEEEEEEEEEEEEEEEEms

B EIEEEE R EE EEEEEEEEGEEEM

CIEEEEEBEEEEEEECEEEEEEEEN

BIEEEEEEEEEEEEEEEEEEEr

]

MEEEEHEEEEHEEEEHEEEEEEEE N

3

| Load... ” Save... || Cancel ||

0K |

11.

. 2.12 The Browse Matrix dialog box with the cell values in the spreadsheet

Choose Leave Editor from the File menu or click the Leave Editor icon and click Yesto
save changes to Recycle.

Using the foregoing procedure, you can generate contour maps of your input data or any data
saved asan ASCII Matrix file. For example, you can create a contour map of the starting heads
or you can use the Result Extractor to read the concentration distribution and display the
contours. Y ou can aso generate contour maps of the fields created by the Field Interpolator or
Field Generator. See chapter 4 for details about the Field Interpolator and Field Generator.

Column= 30; Row= 30

O Divide

= Load Matrix
File:
Start Position = [ [ Options
Column {J): Row({l): ® Replace
O Add
| ! | | ! | I Substract
Maximum Numbers: O Multiply

Fig. 2.13 The Load Matrix dialog box
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= Environment Options

" Grid Appearance

Worksheet { Coordinate System

L1 X arid B well (discharge) oxev2)

& nactive Cells B well (recharge) -

™ Fixed Head D ] Drain v (Xo.¥a) = J

B GHE cells [ X River / Stream

@SIurryWall I Bores /‘{

" Grid Position | [ Worksheet Size | A
Xl={0

Xo= Iﬂi \I

Yo=| 600 Y1=| 0 ! b4
A=l 0 X2=| 1200 (A=Rotation angle in degree)
Y2=| 1200

1.v1
Vs (x1.Y1)

[" Display zones in the cell-by-cell mode

[ Ignore Inactive Cells

|Recyc|e El
Min.=| 7.971433 Interval= I 1028567
Max.=| 9 | Help | | Cancel | | OK I

Fig. 2.14 The Environment Options dialog box

Processing Modflow - [SAMPLE.MDL]

File Value Options Help

!E-ﬂ:l KUK Rol@f[e[ =] [ ]

1863503, GaB624z |

T s
Fig. 2.15 A contour map of the hydraulic headsin the first layer

111 [Steady state [Recycle [
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= Save Plot As

Format:

(DxF

3

File:

I edmyprogipmwinidemolex\sample.dxf

‘ Help_.. ” Cancel ” OK I

Fig. 2.16 The Save Plot As dialog box for saving graphicsin different formats

>

To create solid fill plots

Choose Recycle from the Parameters menu

Data specified in Recycle will not be used by any simulation programs. We can use Recycle
to save temporary data or to display ssimulation results graphically.

Repeat steps 2 to 5 of the foregoing procedure to load H1.DAT into the model grid. Skip
these steps, if the data were saved in the previous procedure.

Choose Search and Modify from the Vaue menu.

The Search and Modify diadog box appears (Fig. 2.17). If arow of the tableis active, model
cells with values located between the Minimum and Maximum will be filled with the user-
specified Color.

Set the first 10 rowsto active by clicking on cells of the Active-column.

A row isactive, if Activeisset to Yes.

To assign colors to the active rows, click Spectrum.

The Color Spectrum dialog box appears (Fig. 2.18).

In the Color Spectrum diaog box, click on the Minimum button and select a color. Click on
the Maximum button and select a color. Click OK, when finished.

To set the search ranges, click Level.

The Search Level dialog box appears (Fig. 2.19).

In the Search Level didog box, type 8 and 9 in the Minimum and Maximum edit fields. Click
OK when ready.

In the Search And Modify dialog box, click OK.

PMWIN redraws the model and fills colorsto cells.

Y ou can overlay contours to the solid fill plot by doing the following

1.
2.

Choose Environment from the Options menu, check the Visible check box, then click OK.
Choose Search and Modify from the Vaue menu, then Click OK.
Fig. 2.20 shows a solid fill plot with contour lines.
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= Search And Modify

Parameter:
|Recy|::le |£| X Ignore Inactive Cells
Active (Color Minimum Maximum Yalue |Options o
No 0 0 0 | Display Only =
No 0 0 0 |Display Only
No 0 0 0 | Display Only
No 0 0 0 | Display Only
No 0 0 0 |Display Only
No 0 0 0 |Display Only
No 0 0 0 | Display Only
No 0 0 0 |Display Only
No 0 0 0 |Display Only
No 0 0 0 | Display Only
No 0 0 0 |Display Only
No 0 0 0 |Display Only o
I
| Spectrum I| Level |
| Save... I| Load... | | Maps... I| Help I| Cancel || OK |

Fig. 2.17 The Search And Modify dialog box for creating solid fill plots

Color Spectrum

Maximum:

OK

Cancel

Fig. 2.18 The Color Spectrum dialog box for assigning colors

Maximum:

lo

E

= Search Level

Minimum:

OK

Cancel

Fig. 2.19 The Search Level dialog box
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Processing Modflow - [SAMPLE.MDL] e

5044586, 377.3865 111 Steacy state Fecycle []

Fig. 2.20 Solid fill plot and contour lines

» To calculate the capture zone of the pumping well
1. Choose Pathlines and Contours from the Run menu.
The Run PMPATH diaog box appears (Fig. 2.21). Y ou can specify the full path and filename

of the PMPATH program in the edit field, or dlick [, to select the PMPATH program from
adialog box. Normaly, you do not need to select the PMPATH program, as PMWIN will set
this automatically.

2. Inthe Run PMPATH dialog box, click OK.
PMWIN calls PMPATH by using the path and filename specified in the dialog box.

3. InPMPATH, dick [Z] and select the model file SAMPLE.MDL from the Open Model dialog
box.
PMPATH loads the SAMPLE model and shows the model grid (Fig. 2.22).

Note that if you have subsequently modified and calculated a model within PMWIN,
you must load the modified model into PMPATH again to ensure that the modifications
can be recognized by PMPATH.

4. To caculate the capture zone of the pumping well:

a. Click the Set Particle button
b. Move the mouse cursor to the model area. The mouse cursor becomes a cross hair.
c. Placethe cross hair at the upper-left corner of the pumping well, as shown in Fig. 2.22.
d. Dragthe cross hair until the window covers the pumping well. (Dragging means holding
the left mouse button down while you move an object with the mouse).
e. Release the mouse button.
The Particle Placement dialog box appears. Assign the numbers of particles to the edit
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fieldsin the dialog box as shown in Fig. 2.23. When finished, click OK.

f. To st particles around the pumping well in the second layer, press PgDn to move to the
second layer and repeat the steps ¢, d and e.

g. Click [=lto start the backward particle tracking.
PMPATH caculates and shows the projections of the pathlines aswell as the capture zone
of the pumping well (Fig. 2.24).

PMPATH allows you to create time-related capture zones of pumping wells. The 100-days-
capture zone shown in Fig. 2.26 is created by putting particles around the pumping well in the
second layer, using the settings in the Particle Tracking Options dialog box as shown in Fig. 2.25,

and clicking =],

= Run PMPATH

Specify the full path and filename of the PMPATH program. ¥When finished.
click OK to start PMPATH for Windows_

PMPATH program:

|E:\PMWIN\PM PATH.EXE

‘ Help || Cancel ||

Fig. 2.21 The Run PMPATH dialog box

PMPATH - [SAMPLE.MDL]
File  Run Options Help

R

r |l>|p [ os00]/§ 1

| [ 4738E+02,3,251E-02 2554E-00 | 24,141 | 8,1081E+0D | 49538E-05 ‘-T.EB[IEIE-EIE ]T]T_‘]T | 22:3312 |
Fig. 2.22 The sample model loaded in PMPATH
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— Particle Placement

Particles on cell faces | Particles within cells |
Face 1 (NI x NK) NI= | 0 @
Face 2 (NI x NK) NJ- |I| EI
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Fig. 2.23 The Particle Placement dialog box
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Fig. 2.24 The capture zone of the pumping well
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= Particle Tracking Options
[ Current Time Tracking Step = |[ Time Mark
Stress period: Unit: Interval:
b 8] IR ¢
Time step: Step length: Top view Cross-section
1 @ | 100.00 @ X Visible [ Visible
Maximum steps: Size: Size:
| 100 @ | 1[I| @ | 3| @

[ Simulation Mode
@® Flowlines. use the flow field from the current time step
O Pothlings, vee ranstant How deids

[ Stop Condition
[ Particles stop. when they enter cells with internal sinks
[ Particies ston when the simuiation tne Tl s reoched

[Fechuarge
C Assign recharge to the top face of cells

O Assign recharge to the bottom face of cells
® Assign recharge to top and botiom cell faces
C Treat recharge as a distributed source

[Evapoianspiration
O Assign evapotranspiration to the top face of cells

® Treat evapotranspiration as a distributed sink

OK I

Fig. 2.25 Particle tracking options
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Fig. 2.26 100-days-capture zone calculated by PMPATH
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3. The Modeling Environment

PMWIN assumes that you are using consistent units throughout the modeling process. For
example, if you are using length [L] units of feet and time [T] units of days, hydraulic conductivity
will be expressed in units of ft/d, pumping rates will be in units of ft¥d and dispersivity will bein
units of ft.

All model data are specified in the Data Editor (see below) or dialog boxes. PMWIN saves the
model datain binary files. A list of the binary datafilesis givenin Appendix 2. Prior to running
the supported models MODFLOW, MT3D or MODPATH or the parameter estimation program
PEST, PMWIN will generate the required ASCII input files. The file names of the ASCII input
filesare given in Appendix 7. The formats of the input files of MODFLOW and MT3D are given
in Appendices 3 and 4. The particle tracking model PMPATH retrieves the binary data files
directly, thus no ASCII input fileis required by PMPATH.

PMWIN uses pull-down menus. All modeling operations are controlled from the menu. A Toolbar
is displayed below the menu and contains icons that represent available PMWIN operations or
commands. Using the Toolbar is a shortcut to the menu system. To execute one of these
shortcuts, use the mouse to move the cursor over the toolbar icon and click on the Toolbar
button. In the following sections, the use of the Grid Editor, the Data Editor and each menu will
be described in detail. Some of this information has already been given in Chapter 2, however,
chapter 3 is a complete reference of al menus and dialogsin PMWIN.

3.1 The Grid Editor

To generate or modify amodel grid, choose Mesh Size from the Grid menu. If agrid does not
exist, aModd Dimension dialog box (Fig. 3.1) will ask you for the basic size of the model grid.
After having specified these data and clicked OK, the Grid Editor appears (Fig. 3.2). The Grid
Editor shows the plan view of the model grid. An index notation [J, 1] is used to describe the
location of the grid cursor in terms of columns [J] and rows[l].

At thefirst time you use the Grid Editor, you can insert or delete columns or rows (see below).
After having leaved the Grid Editor and saved the grid, you can subsequently refine the existing
model grid by calling the Grid Editor again. In each phase, you can change the size of each
column or row. If the grid isrefined, all model parameters are retained. For example, if the cell
of apumping well is divided into four cells, al four cellswill be treated as wells and the sum of
their pumping rates will be kept the same as that of the previous single well. This s true for
hydraulic conductance of the head-dependent boundaries, i.e., river, stream, drain and general-
head boundary. If the Stream-Routing Package is used, you must redefine the segment and reach
number of the stream, because these number cannot be retained automatically.

» To change the width of a column and/or a row
1. Click the Assign Vaueicon
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The grid cursor appears only if the Assign Value icon is pressed down. Y ou do not need to
click thisicon, if it isaready pressed down.

Movethe grid cursor by using the arrow keys or by clicking the mouse on the desired position.
The sizes of the current column and row are shown on the Statusbar.

Press the right mouse button once.

The Grid Editor shows a Size of Column and Row dialog box (Fig. 3.3).

In the dialog box, type new values, then click OK.

To insert or delete a column and/or a row

Click the Assign Vaueicon

Movethe grid cursor by using the arrow keys or by clicking the mouse on the desired position.
Hold down the Ctrl-key and pressthe up or right arrow key to insert arow or a column;. press
the down or left arrow key to delete the current row or column.

To refine a column and/or a row

Click the Assign Vaueicon

Movethe grid cursor by using the arrow keys or by clicking the mouse on the desired position.
Hold down the Cirl-key and pressthe up or right arrow key to refine arow or a column; press
the down or left arrow key to remove the refinement. The refinements of a column or arow
are shown on the status bar.

The following table summarizes the use of the Toolbar buttons of the Grid Editor.

Toolbar Button Action

NE Leave the Grid Editor

Assign Value; Allows you to move the grid cursor and assign values

Zoom In; Allows you to drag a zoom-window over a part of the model
domain.

Zoom Out; Forces the Grid Editor to display the entire worksheet.

Rotate Grid; To rotate the model grid, click the mouse on the worksheet
and hold down the left button while you move the mouse.

Shift Grid; To shift themode grid, click the mouse on the worksheet and

hold down the left button while you move the mouse.

Duplication On/Off; If Duplication is turned on, the size of the current row
or column will be copied to al rows or columns passed by the grid cursor.
Duplication is on, if the small box on the lower-left corner of thisicon is
highlighted.
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= Model Dimension

[Layers I
Number: 2
| Cancel I
" Columns
Number: ET) Help I
Size: 20.000
TRows |
Size: 20.000

Fig. 3.1 The Model Dimension dialog box

= Processing Modflow - [BCF2EX1.MDL] -
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Fig. 3.2 The Grid Editor
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Fig. 3.3 The Size of Column and Row dialog box
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3.2 The Data Editor

The Data Editor is used to assign parameters to the model cells. To load the Data Editor, select
acorresponding item from the Grid, Parameters, Packages or Source menu. For example, if you
want to assign effective porosity to model cells, you will choose Effective Porosity from the
Parameters menu.

The Worksheet shows the plan view of amodel layer (Fig. 3.4). Anindex notation [J, I, K] isused
to describe the location of cdlsin terms of columns [J], rows [1] and layers [K]. The origin of the
cell indexing system is located at the upper, top, left cell of the model. PMWIN numbers the
layers from the top down, an increment in the K index corresponds to adecrease in elevation. Y ou
can move to another layer by pressing PgDn or PgUp keys or click the Current Layer edit field
in the Toolbar, type the new layer number, and press Enter.

The Data Editor provides two display modes - Local and Global, and two input methods - Cell-
by-cell and Zone. It aso alows you to specify time-dependent model data.

Display Modes

In the Loca Display mode, the modd grid is displayed pardld to the Worksheet, as shown in Fig.
3.4. In the Global Display mode, the entire worksheet will be displayed (Fig. 3.5). Using the
Environment Options dialog box (see section 3.3.8), you can define the coordinates system and
the size of the worksheet. Y ou can aso place the model grid into a proper position. Using the
Maps Options dialog box (see section 3.3.8), you can import DXF site maps.

The Cell-by-Cell Input Method
To activate this method, choose Input Method»Cell-By-Cell from the Options menu. Y ou can

aternatively click the fifth button on the Toolbar until the button becomes [%el

» To assign new value(s) to a cell

1. Click the Assign Vaueicon
Y ou do not need to click the Assign Valueicon, if it is aready pressed down.

2. Movethegrid cursor to the desired cell by using the arrow keys or by clicking the mouse on
the cell. The value(s) of the current cell will be shown on the Statusbar.

3. Pressthe right mouse button once
The Data Editor shows a dialog box.

4. Inthe diaog box, type new value(s) then click OK.

If you double-click a cell, the Data Editor will highlight the cells that have the same value as the
cell. You can hold down the Ctrl key and press the left mouse button to open a Search and
Modify Cell Vaues dialog box (Fig. 3.6). It alows you to display al cells that have a value
located within the Search Range. According to the user-specified Value and the operation
Options, you can easily modify the cell values. For example, if Add is used, the user-specified
value will be added to the cell value. The Parameter drop-down box contains the available
parameter type(s). Y ou choose a parameter for which the Search and Modify operation will apply.
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current layer grid cursor

"rocessing Modflow - [EXAMPLE.MDI | ~

File ¥alue Options Help
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Fig. 3.4 The Data Editor (Local Display mode)

Processing Modflow - [EXAMPLE.MDL]

File Value Options Help
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Fig. 3.5 The Global Display mode of the Data Editor
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= Search and Modify Cell Values = Search and Modify Cell Values
Parameter: Parameter:
|Drain Hydraulic Conductance |é| Drain Hydraulic Conductance +
Drain Hydraulic Conductance
Value: | 00005 Drain E|E:¢'ﬂtl0n
Search Range Options Search Range Optians
Min: || oooos ® Replace Min: | 00005 giﬁﬂ'm
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L C Display Only Help | A S Help |

Fig. 3.6 Search and modify cell values

The Zone Input Method

The Zone Input Method allows you to assign parameters in the form of zones. The zonation
information will also be used by the parameter estimation program PEST. To activate this
method, choose Input Method>Zones from the Options menu. Alternatively, you can click the

fifth button on the Toolbar until the button becom&s

» Todraw a zone

1. Click the Assign Vaueicon
Y ou do not need to click the Assign Valueicon, if it is aready pressed down.
2. Click the mouse cursor on a desired position to anchor one end of aline.
3. Move the mouse to another position then press the left mouse button again.
4. Repesat steps 2 and 3 until the zone is closed or press the right mouse button to abort.

» To assign new value(s) to a zone

1. Click the Assign Vaueicon
Y ou do not need to click the Assign Valueicon, if it is aready pressed down.
2. Move the mouse cursor into a zone.
The boundary of the zone will be highlighted. The value(s) of the current zone will be shown
on the Statusbar.
3. Pressthe right mouse button once.
The Data Editor shows a dialog box.

4. Inthediaog box, type new vaue(s) then click [>> ] to transfer the new zone val ue(s) to cells.

PMWIN always usesthe cell data, and if zone data are not transferred, default values within the

cells are used by dl other parts of the program, except the parameter optimizing program PEST.
PEST uses the zonation information provided by the zones and the Parameter List. See Chapter 5

for how to use the Parameter List and how to perform model calibrations with PEST.

Y ou can shift avertex of azone by pointing the mouse cursor to the vertex node, holding down
the left mouse button while moving the mouse. If you have many zones, some zones can be
crossed or even covered by another. If you move the mouse cursor into a covered zone, the
boundary of the zone will not always be highlighted. In this case, you can move the mouse cursor
into the zone, hold down the Ctrl-key and press the left mouse button once. The Data Editor will
resort the order of the zones and the "lost" zone will be recovered.
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Specification of Temporal Data
If your model has more than one stress period, a Tempora Data dialog box appears after you

have dicked the Leave Editor button B This dialog box alows you to manage your temporal
model data. Y ou can edit model data for a particular stress period by selecting arow of the table
and clicking the Edit Data button. If the model data of a stress period are specified, the
corresponding row of the Data column is marked. The Use flag indicates whether the user-
gpecified data should be used for the flow simulation or not. PMWIN usesthe data of the previous
stress period, if the Use flag is not marked. You can click on an appropriate box to mark or
unmark the Useflag, if the model data have been specified. Use Copy Data, if you want to copy
model data from a stress period to another.

= Temporal Data

Period | Data Use Edit Data I

- EE
py Data

4 [ [

5 ] [ Cancel I

The following table summarizes the use of the Toolbar buttons of the Data Editor.
Toolbar Button Action

= L eave the Data Editor

Assign Vaue; Allows you to move the grid cursor and assign values

Zoom In; Allows you to drag a zoom-window over a part of the model
domain.

Zoom Out; Forces the Grid Editor to display the entire worksheet.

Cell-By-Cell Input Method is activated.

Zone Input Method is activated.

. Local Display Mode is activated.

Global Display Mode is activated.

Duplication On/Off; If Duplication is turned on, the cell value(s) of the
current cell will be copied to al cells passed by the grid cursor.
Duplication is on, if the small box on the lower-left corner of thisicon is
highlighted.

Layer Copy On/Off; If you turn Layer Copy on and then move to an other

layer, the zones and cell values of the current layer will be copied. Layer
Copy is on, if the small box on the lower-left corner of this icon is
highlighted.
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3.3 PMWIN Menus

PMWIN contains the menus File, Grid, Parameters, Packages, Source, Estimation, Run, Value,
Options and Help. The Vaue and Options menus gppear only in the Grid Editor and Data Editor.
The following table gives an overview of the menusin PMWIN.

Menu Usage
File Create new models; Open existing models; Save plots.
Grid Generate or modify amodel grid; Input of the geometry of the grid.

Parameters  Input of temporal and spatial model parameters, such as transmissivity.

Packages Add specific features of hydrologic system into the groundwater model, such as
wells, recharge or rivers. Define data of an iteration solver and output control.

Source Specify the source concentration which is associated with a specific features of
hydrologic system, e.g. concentration of water of an injection well.

Estimation  Specify datafor the parameter estimation program PEST.

Run Call smulation programs, modeling tools and postprocessing utilities.

Vaue Manipulate model data; Read or save model data in separate files.

Options Modify the appearance of the model grid on the screen; Load DXF site maps.
Help Call the online-Help

PMWIN uses an intelligent menu system to help you control the modeling process. If you have
specified amodd data st, the corresponding item of the Grid, Parameters, Packages and Source
menus will be checked. To deactivate a selected item in the Package and Source menu, just
seleted the item again. If you do not know which model data still have to be specified, you can
try to run your model by selecting the corresponding item from the Run menu. PMWIN will tell
you what you should do.

3.3.1 The File Menu

New Model

Select New Modd to create a new model. The New Model dialog is a standard Windows dialog
that allows you to choose any available directory or drive on your computer. All filenames valid
under MS-DOS can be used. A PMWIN model file uses the extension MDL. It isagood ideato
save every model in a separate directory, where you can keep the model and its output data. This
will dso allow you to run several models simultaneoudly (multitasking). If a desired directory is
not available, you need to use the File Manager of Windows or other utilities to create the
directory.

Open Model
Use Open Modd to load an existing PM modd. Models created by using PM3.0x are compatible
to PMWIN. Once amode is opened, PMWIN shows the file name of the model on the Title Bar.
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Model Information

Open the Mode Information dialog box as shown in Fig. 3.7. This dialog provides brief
information about your model. You can type a simulation title into the dialog. The maximum
length of the simulation title is 132 characters.

= Model Information
Simulation Title: |
Bample Problem of Modflow. This model is described in the | 1] 0K

manual of Modflow {Chapter Al. Book 6. USGS Open-File

Report 83-875). 1 cancer
ance

did

About This Model:

Model: e’\pmwin\examplesimflowexAmflowex mdl
Number of Rows: 15

Number of Columns: 15

Number of Layers: 3

Number of Stress Periods: 1

Simulation Flow Type: Steady State

Simulation Time Unit: seconds

Fig. 3.7 The Model Information dialog box

Save Plot As

Use Save Plot Asto save the contents of the worksheet in graphicsfiles (Fig. 3.8). Save Plot As
can only be used within the Local Display mode of the Data Editor. Three graphics formats are
available: Drawing Interchange File (DXF), Hewlett-Packard Graphics Language (HP-GL) and
Windows Bitmap (BMP). DXF isafairly sandard format developed by Autodesk for exchanging
data between CAD systems. HP-GL is a two-letter mnemonic graphics language developed by
Hewlett-Packard. These graphics formats can be understood by many graphics or word-
processing software, and graphics devices. Using the DXF format, you can save and overlay
graphics on the Worksheet, as you can import DXF files by using the Maps Options.

To select aformat, click the down-arrow on the Format drop-down box. Y ou can enter the file

name into the File edit field, or dlick |5 and sdect a file from the standard File Open dialog box.
Note that PMWIN uses the same resolution as Windows to save bitmap files. The 24 bits True
Color resolution is not supported by PMWIN. Do not try to save graphics in bitmap files, if you
areusing True Color.

Format:
IDxF K3
File:

| e’pmwiniexamplesimfloweximflowes dxf

| Help... I| Cancel I| OK |

Fig. 3.8 The Save Plot As dialog box
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3.3.2 The Grid Menu

Mesh Size
Allows you to generate or modify amodel grid. See Section 3.1 for how to use the Grid Editor.

Layer Type
Select Layer Typeto open aLayer Optionsdidog box (Fig. 3.9). The elements of this dialog box
are described below.

= Layer Options
Anisotropy | Interbed AP +
Layer |Type Factor Starage Transmissivity |11
1 1: Unconfined 1 No Calculated L—
2 3: Confined/Unconfined 1 No Calculated
(Transmissivily varies)
3 3: Confined/Unconfined 1 No Calculated
{Transmissivily varies)
4 3: Confined{/Unconfined 1 No Calculated
(Transmissivity varies)
5 0: Confined 1 No User specified
b 0: Confined 1 No User specified
7 0: Confined 1 No User specified
]
] 4]
| Help || Cancel || OK |

Fig. 3.9 The Layer Options dialog box

» Type

The numerical formulations, which are used by the Block-Centered-Flow (BCF) package to
describe groundwater flow, depend on the type of each model layer. The layer types are

TypeO

Type 1l

Type?2

Type3

Type 4
Type5

Thelayer isgrictly confined. For trangent smulations, the confined storage coefficient
(specific storage x layer thickness) is used to calculate the rate of change in storage.
Transmissivity of each cell is constant throughout the simulation.

The layer is strictly unconfined. The option is valid for the first layer only. Specific
yidd isused to calculate the rate of change in storage for this layer type. During a flow
gmulation, transmissvity of each cdl varieswith the saturated thickness of the aquifer.
A layer of thistypeis partialy convertible between confined and unconfined. Confined
storage coefficient (specific storage x layer thickness) is used to calculated the rate of
change in storage, if the layer isfully saturated, otherwise specific yield will be used.
Transmissvity of each cdll is constant throughout the smulation. Vertical |eakage from
aboveislimited if the layer desaturates.

A layer of this type is fully convertible between confined and unconfined. Confined
storage coefficient (specific storage x layer thickness) is used to calculate the rate of
change in storage, if the layer isfully saturated, otherwise specific yield will be used.
During aflow smulation, transmissivity of each cell varies with the saturated thickness
of the aquifer. Vertical leakage from above is limited if the layer desaturates.

Layer of type 0 + aquasi-3D confining layer.

Layer of type 1 + aquasi-3D confining layer
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Type6 Layer of type 2 + aquasi-3D confining layer
Type7 Layer of type 3 + aquasi-3D confining layer

The last four types are only used by MODPATH for quasi three-dimensional models in which
aquifer layers are separated by intervening semi-confining units. A confining unit does not need
to be smulated as active layersin finite-difference models. The effect of a confining unit can be
smulated by means of a transmission term named vertical leakance between two modd layers.
For transient smulations, release of water from storage within the unsmulated confining unit is
not considered. Use the Interbed Storage Package (IBS1; Leake and Prudic, 1988), if you need
to consider the changes in storage for transient smulations.

To cdculate pathlinesin MODPATH, each unsimulated confining unit is assumed to be a part of
the active modd layer directly aboveit. It is assumed that one-dimensional, steady-state vertical
flow exigts throughout the confining layer. This assumption implies that the average vertical linear
velocity is constant in the confining unit and that its magnitude equals the volumetric flow rate
between adjacent modd layers divided by the horizontal area of the cell and the effective porosity
of the confining unit. In PMWIN, the effective porosity of the confining unit is assumed to be the
same as that of the layer directly above the confining unit.

The use of thelast four layer typesis not recommended, not only because PMWIN does not allow
you to assign effective porosity to the confining units, but also they are not supported by
PMPATH and MT3D.

» Anisotropy factor

The anisotropy factor is the ratio of transmissivity or hydraulic conductivity (whichever is being
used) along the I-direction to transmissivity or hydraulic conductivity along the J-direction.
Although the principa axes of the conductivity tensor must be parallel to the | and J-axes of your
model grid, this has been often ignored.

» Interbed Storage

PMWIN supportes the Interbed-Storage Package (IBS1) for calculating storage changes from
both dastic and inelastic compaction of each modd layer. Click the flag of alayer and select YES,
if you want to use the IBS1 package to ca culate the compaction of the layer. See Packages Menu
for more information about the Interbed Storage Package.

» Transmissivity

MODFLOW requires transmissivity for layers of type O or 2. If the Transmissivity flag is set to
Calculated, PMWIN caculates transmissivity by using user-specified horizontal hydraulic
conductivity and the elevations of the top and bottom of each layer. Set the Transmissivity flag
to User Specified, if you want to specify transmissivity directly.

» Leakance

For flow ssmulations involving more than one layer, you must specify avertical transmission or
leakage term, know as vertical leakance or VCONT array, for each cell, except for cellsin the
bottom layer. If the Leakance flag is set to Calculated, PMWIN calculates VCONT by using
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user-specified vertical hydraulic conductivity and the elevations of the top and bottom of each
layer. Set the Leakance flag to User Specified, if you want to specify VCONT (vertical |eakance)
directly. See Parameters menu for more information about how to calculate VCONT.

» Storage Coefficient

For transient flow smulations, MODFLOW requires dimensionless storage terms specified for
each model layer. For a confined layer, these storage terms are given by the confined storage
coefficient (=specific storage [L™] x layer thickness [L]). If the Storage Coefficient flag is
Calculated, PMWIN uses user-specified specific storage and the elevations of the top and bottom
of each layer to calculate the confined storage coefficient. Set the Storage Coefficient flag to User
Specified, if you want to specify the confined storage coefficient directly. For an unconfined
layer, the storage values are equal to specific yield [-]. The setting of the Storage Coefficient flag
has no influence on the input of specific yield.

Boundary Condition

An IBOUND array is required by flow models. The IBOUND array contains a code for each
modd cdl which indicates whether (1) the hydraulic head is computed (active variable-head cell
or active cdll), (2) the hydraulic head is kept fixed at a given value (constant-head cell or time-
varying specified-head cell), or (3) no flow takes place within the cell (inactive cell). It is
suggested to use 1 for an active cell, -1 for a constant-head cell, and O for an inactive cell. For
constant-head cells, the initial hydraulic head remains the same throughout the simulation. The
initial hydraulic head is specified by choosing Starting Vaues-Hydraulic Heads from the
Parameters menu. A constant head boundary exists whenever the aquifer isin direct hydraulic
contact with ariver, alake or areservoir in which the water level is known. It isimportant to
know that a specified head boundary provides inexhaustible supply of water. The groundwater
system may get as much water as it needs from the constant head boundary. In some situations,
thismay be unredlistic. Y ou should thus be careful in setting constant head boundaries. Consider
to use the General-Head Boundary (GHB1) or the Time-Variant Specified-Head (CHD1)
packages, if the head at the prescribed head boundary varies with the time.

An ICBUND array isrequired by trangport models. The ICBUND array contains a code for each
model cell which indicates whether (1) the concentration varies with time (active concentration
cdl), (2) the concentration is constant (constant-concentration cell), or (3) the cell is an inactive
concentration cell. It is suggested to use 1 for an active concentration cell, -1 for a constant-
concentration cell, and O for an inactive concentration cell. In MT3D, no-flow or dry cells are
automatically converted into inactive concentration cells. Active variable-head cells can be treated
asinactive concentration cells to minimize the area needed for transport simulation, as long as the
solute transport is insignificant near those cells. For constant-concentration cells, the starting
concentration remains the same at the cell throughout the simulation. A constant-head cell may
or may not be a constant-concentration cell. The starting concentration is specified by choosing
Starting Vaues> Concentration from the Parameters menu.

Top of Layers (TOP)
MODFLOW reads the top elevation only for layers of type 2 or 3. Top of Layersisrequired, if
you want to use PMPATH, MT3D and MODPATH, or if you let PMWIN calculate
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transmissivity, vertical leakance or confined storage coefficient (see Layer Type above).

Bottom of Layers (BOT)

MODFLOW reads the bottom elevation only for layers of type 1 or 3. Bottom of Layersis
required, if you want to use PMPATH, MT3D and MODPATH, or if you let PMWIN calculate
transmissivity, vertical leakance or confined storage coefficient (see Layer Type above).

3.3.3 The Parameters Menu

Time

Y ou specify temporal parameters in the Time Parameters dialog box as shown in Fig. 3-10. To
activate astress period, click the Active flag and set it to YES. The temporal parameters include
the time unit, the length of stress periods and the numbers of stress periods, time steps and
trangport steps. In MODFLOW, the simulation time is divided into stress periods, which are, in
turn, divided into time steps. In the MT3D model, each time step is further divided into smaller
time increments, called transport steps.

Period [Active (Period Length |Time Steps |Multiplier ;rans_pl:m i
tepsize
1| Yes [1000 10 1.5 0 =
2| Yes [1000 10 1.5 0
3| Yes [1000 10 1.5 0
No |1 1 1 0
No |1 1 1 0
No |1 1 1 0
No |1 1 1 0
No |1 1 1 0
No |1 1 1 0 +
[ ] 2]
 Simulation Time Unit | [ Simulation Flow Type |
|days |£| ) Steady-State ‘
. Cancel
: @ Transient
[x Auto Update Period Length
Save... |
Total Period Number = 3
Total Time Steps = 30
Total Simulation Time = 3.E+3 days

Fig. 3.10 The Time Parameters dialog box

Each timeyou select atime unit from the Simulation Time Unit group, PMWIN will update the
Period Length in the table, if Auto Update Period Length is checked. PMWIN allows you to
perform steady state or transient flow simulations by selecting a corresponding option from the
Smulation Flow Type group. Y ou can run a steady state ssmulation over several stress periods.
In this case, a steady state solution is calculated for each stress period.

For each stress period, you have the option of changing parameters associated with head-dependent
boundary conditionsin the River, Stream, Drain, Evapotranspiration, General-Head Boundary and
Time-Variant Specified-Head Boundary Packages, as well as the recharge rates in the Recharge
Package and pumping rates in the Well Package. For transport simulations, you can change source
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concentration associated with Well, River, Stream, Recharge, Evapotranspiration and General-Heed
Boundary Packages as well as Constant-Head cells.

Using the buttons Save and Load, you can save or load the contents of the table in or from atime
parameter file. The format of the time parameter file is given in Appendix 2.

MODFLOW allows the time step to increase as the simulation progesses. It uses the following
formulae to increase the lengths of time steps as a geometric progression.

PERLEN - (1 - TSMULT)

Pelth) = 1 - TSMULT NSTP

(3.1)

Delt(m+1) = TSMULT - Delt(m) (3.2)

where PERLEN isthe length of agtress period, TSMULT isthe time step multiplier, NSTPis
the number of time steps and Delt(m)is the length of time step m in a stress period.

The length of stress periodsis not relevant to steedy state flow simulations. However, if you want
to perform contaminant transport smulation with MT3D at alater time, you must specify the actua
time length in the table. Because the explicit transport solution (MT3D, version 1.85) has certain
dability criteria associated with it, the length of atime step used for a head solution may be too
large for a transport solution. Each time step is, therefore, divided into smaller transport steps.
Y ou can specify the length of transport steps in the table of the Time Parameters dialog box. The
length of transport steps will be determined by an automatic stepsize control procedurein MT3D,
if the length of transport stepsis 0 (zero).

Recycle

Recycdleprovidesaway to create graphicsfrom simulation results. Y ou can freely modify the Recycle
data in the Data Editor, because neither simulation programs nor any parts of PMWIN will use
the Recycle data. See Chapter 2 for how to produce output graphics.

Starting Values

MODFLOW requiresinitid hydraulic heads at the beginning of aflow smulation. Initial hydraulic
heads a constant-head cellswill be kept constant during the flow simulation. The initial hydraulic
heads in constant-head cells must be higher than the elevation of the bottom of these cells, because
MODFLOW does not convert dry constant-head cells to inactive cells. If any constant-head cell
isdry, MODFLOW will stop the flow smulation and write amessage "CONSTANT-HEAD CELL
WENT DRY" into arun record file (see Table 2.1).

MODFLOW also requiresinitial headsin a steady state simulation. In that case theintial values
are starting values for the iterative equation solvers. Note that the heads at the prescribed head
cdlsmust be the actual model values while al other initial heads can be set arbitrarily, provided
they are higher than the bottom elevation of the cells.
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MT3D requiresinitial concentration at the beginning of atrangport smulation. Initial concentration
at constant-concentration cells will be kept constant during the smulation. Constant-concentration
cells can be used to simulate contaminated areas with constant concentration.

Horizontal Hydraulic Conductivity and Transmissivity

Horizontal hydraulic conductivity is the hydraulic conductivity along model rows. It is multiplied
by an anisotropy factor pecified in the Layer Options dialog to obtain the hydraulic conductivity
along model columns. Horizontal hydraulic conductivity is required for layers of type 1 or 3.
Transmissivity is required for layers of type 0 and 2.

PMWIN uses the horizontal hydraulic conductivity and layer thickness to calculate transmissivity,
if the corresponding Transmissivity flag in the Layer Options didog is Calculated. Y ou can specify
transmissvity of alayer directly by setting the corresponding Transmissvity flag to User-specified
and choosing Transmissivity from the Parameters menu. See section 3.2.2 for more information
about the Layer Options dialog.

Vertical Hydraulic Conductivity and Vertical Leakance

For flow simulations involving more than one model layer, MODFLOW requires the input of
the vertical transmission or leskage term, known as vertica leakance (VCONT), between two model
layers. PMWIN uses the vertical hydraulic conductivities and thicknesses of layers to calculate
VCONT, if the corresponding Leakance flag in the Layer Options dialog is Calculated.

2
AVk AV|<+1 (3.3)

+

Kijx  (Kijka

where (K,);; . and (K.);; ., arethevertical hydraulicconductivitiesof layersk andk+1, respectively.
Refer to Fig. 3.11afor definition of Av, and Av, ,. Equation 3.3 is used when each model layer
represents a different hydrostratigraphic unit or when two or more model layers represent asingle
hydrostratigraphic unit.

a b

VCONT =

| |
| Geohydrologic | Upper layer
I Unit A I
//h.l_k T //h.j_k T semiconfining unit
Avg 7 . Az, 7
s | Geohydrologic / |
// | Unit B // | Lower layer
1 1
i_l o Az, | N
AV e .
ket e Az 7 ik
4 s
s s

Fig. 3.11 Grid configurations used for the calculation of VCONT
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For quas three-dimensional models that contain unsimulated semiconfining units, VCONT must
bespecified by theuser directly. Inthiscase, VCONT can beca culated by using thefollowing equation.

2
Az, 27z, Az, (3.4)

), (K), (K

where (K,),,, (K,). and (K ), arethevertical hydraulic conditivitiesof theupper layer, semiconfining
unit and lower |ayer, respectively. Refer to Fig. 3.11b for definition of Az, Az, and Az . You
can pecify VCONT by setting the corresponding Leakance flag in the Layer Options dialog box
to User-specified and choosing Vertical Leakance from the Parameters menu. In the Data Editor,
VCONT between layer i and layer i+1isgiven asthedataof layeri. A VCONT array isnot required
for the bottom layer because MODFLOW assumes that the botton layer isunderlain by impermesble
material and VCONT is zero.

VCONT =

Specific Storage, Storage Coefficient and Specific Yield
For transient flow smulations, MODFLOW requires dimensionless storage terms specified for
each layer of the modd. For a steady state simulation, these menu items are not used and dimmed.

Inaconfined layer, the orageterm isgiven by storativity or confined storage coefficient (=gpecific
storage [L™] x layer thickness [L]). The specific storage or specific storativity is defined as the
volume of water that a unit column of aguifer releases from storage under aunit decline in hydraulic
head. The confined storage coefficient isrequired by layers of type 0, 2 and 3. PMWIN uses specific
storage and the layer thickness to cal cul ate the confined storage coefficient, if the corresponding
Storage Coefficient flag inthe Layer Optionsdialog is Calculated. By setting the Storage Coefficient
flagto User Specified and choosing Storage Coefficient from the Parameters menu, you can specify
the confined storage coefficient directly.

In an unconfined layer, the storage term is given by specific yield or unconfined storativity. Specific
yield is defined as the volume of water that an unconfined aquifer releases from storage per unit
surface area of aquifer per unit decline in the water table. Specific yield is required for layers of
type 1, 2 and 3.

Refer to Bear (1972) or Freeze and Cherry (1979) for more information about the storage terms
and their definitions.

Effective Porosity
Effective porosity is used by the programs PMPATH, MODPATH and MT3D to calculate the
average velocity of the flow through the porous medium.
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3.3.4 The Packages Menu

Well (WEL1)

In Modflow, an injection or apumping well is represented by amodd cdll. Theinjection or pumping
rates are specified by using the Data Editor. Negative cell vaues are used to indicate pumping wells,
while positive cell values indicate injection wells.

Theinjection or pumping rate of awell is constant during a given stress period and is independent
of both the cell area and the head in the cell. It isimplicitly assumed by MODFLOW that awell
penetrates the full thickness of the cell. MODFLOW can simulate wells that penetrates more than
one modd layer. In this case, the injection or pumping rate for each layer has to be specified. The
total injection or pumping rate for amultilayer well is equd to the sum of those from the individua
layers. Theinjection or pumping rate for each layer (Q, ) can be approximately cal culated by dividing
thetotal rate (Q,,,) in proportion to the layer transmissivities (McDonald and Harbaugh, 1988):

Tk
Qk - Qtotal ) E (3-5)

where T, isthe transmissivity of layer k and 2T isthe sum of the transmissivities of al layers
penetrated by the multilayer well.

An other possibility to smulate multi-layer wellsisto set avery large vertica hydraulic conductivity
or vertica leakance, eg., 1 [m/s] or 0.1 [1/9], to dl cells of thewell. The injection or pumping rate
for each penetrated layer can beequal tothetota rate(Q, ;) divided by thenumber of the penetrated
layers. In this case, the exact rates for each penetrated layer will be calculated by MODFLOW
implicitly. The exact flow rates can be obtained by using the Water Budget Calculator. See Chapter
2 for how to calculate subregional water budgets.

Drain (DRN1)

Drains are defined by using the Data Editor to assign two values to model cells (Fig. 3.12):
- Drain hydraulic conductance (C,) [L*T]

- Median elevation of the Drain (d) [L]

ThevduesC, and d are shown on the Statusbar. These values are constant during a given stress
period. For transent flow smulations involving severa stress periods, these values can be different
from period to period.

When the hydraulic head (h) in adrain-cell is greater than the drain elevation, water flows into
the drain and is removed from the groundwater model. Discharge to the drain is zero when the
hydraulic head is lower than or equal to the median drain elevation. Recharge from the drainis
aways zero, regardless of the hydraulic head in the aquifer. Discharge rate to the drain (Q,) is
calculated by

Q.=C_-(h-d (3.6)
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Thevalue C, of adrain-cell is often given by

C.=K-L (3.7)

where L isthe length of the drain within a cell. The value Kis a equivalent hydraulic conductivity
describing al of the head loss between the drain and the aquifer. It depends on the material and
characterigtics of the drain itself and the immediate environment. Thevalue C, is usually unknown
and must be adjusted during amodel calibration.

— Drain (DRNT)

Drain Hydraulic Conductance [L"2fT]:
.om

Elevation of the Drain [L]:

T

Current Column = 14
Current Row = 38

Fig. 3.12 The Drain (DRN1) dialog box

General-Head Boundary (GHB1)

The Genera-Head Boundary Package (GHBL) is used to smulate head-dependent flow boundaries
(Cauchy boundary conditions). Similar totheDrain Package, aGenera-Head Boundary cell (GHB-cdll)
is defined by two cell values:

- GHB hydraulic conductance C, [L?TY]

- Hydraulic head at the boundary h,, [L]

Thevaues C, and h, of a GHB-cell are shown on the Statusbar. Flow through the general-head
boundary Q, [L®T™] iscaculated by

Q. =C,(h, -h (3.8)

wherehis the hydraulic head in the aquifer. A GHB-cell is equivalent to a constant head cell, if
alargec,isusad. Thevaues C, and h, are constant during a given stress period. For transient flow
gmulationsinvolving several stress periods, these values can be different from period to period.
This allows you to change the head at "constant-head” boundaries as the transient simulation
progresses.

River (R1V1)

The River Package is used to smulate the flow between an aguifer and a surface-water feature,
such asrivers, lakesor reservoirs. Rivers are defined by using the Data Editor to assign the following
three values to the model cells:

- Hydraulic conductance of the riverbed (CRIV) [L*T™]

- Head in theriver (HRIV) [L], and

- Elevation of the bottom of the riverbed (RBOT) [L].
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The values CRIV, HRIV and RBOTof ariver-cell are shown from left to right on the Statusbar.
For trangent flow smulationsinvolving severa stress periods, these values can be different from
period to period. If the hydraulic head (h) in ariver-cell is greater than RBOT, the rate of leakage
(QRIV) from the river to the aquifer is calculated by:

QRIV = CRIV-(HRIV - h)  h>RBOT (3.9)

For the case that h is greater than HRIV, QRIV is negative. It means that water flows from the
aquifer into the river and is removed from the groundwater model. When h has fallen below the
bottom of the riverbed, the rate of leakage through the riverbed is given by:

QRIV = CRIV-(HRIV - RBOT) h<RBOT (3.10)
The value CRIV of ariver-cell is often given by

K-L-W
CRIV = N (3.11)

where the vaue K isthe hydraulic conductivity of the riverbed material, L is the length of the river
within acdl, W isthe width of the river and M is the thickness of the riverbed. If CRIV is unknown,
it must be adjusted during amodel calibration.

Streamflow-Routing (STR1)

The Streamflow-Routing Package STR1 (Prudic, 1989) is designed to account for the amount
of flow in streams and to Smulate the interaction between surface streams and groundwater. Streams
aredividedinto segmentsand reaches. Each reach correspondstoindividua cellsinthefinite-difference
grid. A segment consists of a group of reaches connected in downstream order. Streamflow is
accounted for by specifying flow for thefirst reach in each segment, and then computing streamflow
to adjacent downstream reaches in each segment as equal to inflow in the upstream reach plus or
minus leskage from or to the aquifer in the upstream reach. The accounting scheme used in STR1
assumes that streamflow entering the modeled layer is instantly available to downstream reaches.
Thisassumption is generdly reasonable because of the relatively slow rates of groundwater flow.

Streamflow into asegment that isformed from tributary streamsis computed by adding the outflows
from the last reach in each of the specified tributary segments. If a segment is a diversion, then
the specified flow into the first reach of the segment is subtracted from flow in the main stream.
However, if the specified flow of the diversion is greater than the flow out of the segment from
which flow isto be diverted, then no flow is diverted from that segment.

In the Data Editor, you can press the right mouse button and specify the following required cell

values in the Streamflow-Routine Package (STR1) dialog box. The specified cell values will be

shown on the Statusbar.

» Segment isanumber assgned to agroup of reaches. Segments must be numbered in downstream
order. The maximum number alowed in PMWIN is 25.
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>

Reach isasequentia number in a segment that begins with one for the farthest upstream reach
and continuesin downstream order to the last reach in the segment. In PMWIN, you can only
assign onereach to amodd cell, athough STR1 alows the user to assign more than one reach
in different segments to the same model cell. Refer to the documentation of the STR1 Package
for more information about the numbering scheme.

Streamflow [L®T?] is the streamflow entering a segment. This value is specified only for the
first reach in each segment. The value is either a zero or a blank when the reach number (Reach)
isnot 1. When inflow into a segment is the sum of outflow from a specified number of tributary
segments, the segment inflow values are specified as -1.

Stream Stage [L] isthe head in the stream.

Streambed Properties are used to cd cul ate leakageto or from the aquifer through the streambed.
The hydraulic conductance of the streambed CSTR is calculated in the same way as CRIV of
the River Package, see Equation 3.11.

Stream Channel Properties are used only when the option Calculate stream stages in reaches
ischosen. Stream width isthe width of the rectangular stream channel. Stream Slopeisthe dope
of thestream channel in each reach. Manning's roughness coeff./C istheresult of thedimensionless
Manning's roughness coefficient divided by a constant C. Some of the experimental values of
the dimensionless Manning's roughness coefficient can be found in the documentation of the
STR1 Package. The vaue of the constant C depends on the length and time units of your model.

n2 N2, n3, n,
m™ 1486 T _ 1710810 £ _ 1157410 T
S S

C=1

(3.12)

Stream Structure describes the configuration of the stream system. Each row in the table
represents a stream segment in the model. Each segment can have up to 10 tributary segments.
The number of the tributary segments are specified in the columns 1 to 10. The column lupseg
isthe number of the upstream segment from which water is diverted. For a segment that is not
adiversion, lupseg must be specified as zero. lupseg is used only when the option Simulate
diversions from segmentsis checked. The valuesin Fig. 3.13 indicate that segment 2 is diverted
from segment 1, segment 1 isatributary segment of segment 3, and segments 2 and 4 aretributary
segments of segment 5. The configuration of the stream system is shown in Fig. 3.14.
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= Streamflow-Routing Package (STR1)
Segment : Reach:
[ K
[Stream | [ Streambed Properties™ | [ Stream Channel Properties |
Streamflow [L"3/T]: Hydraulic Conductance [L"2/T]: Stream Width [L]:
|45 [12 10
Stream Stage [L]: Elevation of the Streambed Top: Stream Slope [-]:
[ 435 [ a3z 007
Elevation of the Streambed Bottom: | |Manning’s roughness coeff {C:
430 I 0202

[ Options Current Column = 3
P Simulate diversions from segments Current Row = 1

¥ Calculate stream stages in reaches

Stream Structure: | 0K |

Segment 1 2 3 4 5 3 7 8 9 10 |lupseg |4

1 0 [0 Jo Jo o Jo Jo o Jo fo o = |Cﬂncel |
2 0 0 0 0 0 0 0 0 0 0 1 =

3 1 0 0 0 0 0 0 0 0 0 0 Help |
] 0 0 0 0 0 0 0 0 0 0 0

5 ? 4 0 0 0 0 0 0 0 0 0 3

Fig. 3.13 The Streamflow-Routine Package (STR1) dialog box

segment 1

segment 4 segment 3

segment 5

Fig. 3.14 The configuration of the stream system specified in the table of figure 3.13

Similar to the River Package, leakage (Q,) to or from the aquifer through the streambed is computed
by Darcy's Law asfollows:

Q,
Q,

where CSTR isthe hydraulic conductance of the streambed, H, is the head in the stream, h isthe
head in the mode! cdll beneath the streambed and SBOT isthe éevation of the bottom of the stream.

CSTR(H, - h) h>SBOT
CSTR:(H_ - SBOT) h<SBOT (3.13)
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If the option Calculate stream stages in reachesis checked, the depth (d) in each reach is calcul ated
from Manning's equation under the assumption of arectangular stream channel:

Qn_ |-

C-w-S™

d = (3.14)

whereQ[L°T?] isthestream dischargecalculated by STR1, n [ -] isManning'sroughness coefficient,
w [L] isthewidth of the channel, S [LL™] isthe Sope of the stream channel and C is a constant
(see equation 3.12).

Recharge (RCH1)

The Recharge Packageisdesigned to smulate aredlly distributed rechargeto the groundwater system.
Recharge is defined by assigning the following datato model cells in the Recharge (RCH1) dialog
box (Fig. 3.15):

- Recharge Flux I [LT]

- Layer Indicator I, [-]

The specified values I, and I, ae shown on the Statusbar of the Data Editor. Note that although
I ad |, are specified for each vertical column of cdls, you are allowed to move to other layers
within the Data Editor and examine the grid configuration in each layer.

= Recharge (RCH1)

Recharge Flux [L/T]: |2 5F-09

Layer Indicator (IRCH):I 0 Canee]

"Recharge Options
® Recharge is only applied to the top grid layer
O Vertical distribution of recharge is specified in IRCH
' Recharge is applied to the highest active cell.

Current Column = 14

Current Row = 9

The recharge option is applied to the entire matrix. IRCH is only
required. if the second recharge option is selected.

Fig. 3.15 The Recharge (RCH1) dialog box

MODFLOW uses |, to calculate the recharge flow rate (Q, [L>T™]) applied to the model cell:
Q, = I, -DELR-DELC (3.15)

where DELR - DELCisthe map area of amodel cell. The recharge rate Q, is applied to asingle
cdl within avertical column of cells. Thereis no need to dlow for recharge to occur smultaneousy
at multiple depths in the same vertical column because natural recharge enters the groundwater
system at the water table. In the smplest situation, the water table is located in the top layer of
the model. The top layer is designated as unconfined and an array of Recharge Flux I is specified
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for that layer. Problems may arise, when the water table cuts across layers. To solve this kind of

problems, the RCH1 Package provides three options for specifying the cell in each vertical column

of cellsthat receives the recharge:

1. Rechargeisonly applied to the top grid layer

2. Vertica digribution of recharge is specified in the Layer Indicator Array. |, defines the layer
where recharge is applied.

3. Rechargeis applied to the highest active cell in each vertical column. The user does not have
to predetermine the layer to which recharge should be applied. The appropriate layer is
automatically selected by the RCH1 Package. If the highest active cell is a constant-head cell
recharge will be intercepted and cannot go deeper.

Evapotranspiration (EVT1)

The Evapotranspiration Package simulates the effects of plant transpiration and direct evaporation
in removing water from the saturated groundwater regime. The EVT1 Package requires the user
toassgnthefollowingdatafor each EVT-cdl inthe Evapotranspiration (EVT1) dialogbox (Fig. 3.16).

- Maximum ET Rate Rg,, [LT™],

- Elevation of the ET Surface hg [L],
- ET Extinction Depthd [L], and

- Layer Indicator I, [-]

The specified vaues will be shown on the Statusbar. Note that athough the values are specified
for each vertical column of cells, you are allowed to move to other layers within the Data Editor
and examine the grid configuration in each layer.

Maximum ET Rate [LfT]: |5E-10
Elevation of the ET Surface [L]: |12 Cancel
ET Extinction Depth [L]: |37 Help
Layer Indicator (IEVYT): I[[]i

" Evapotranspiration Options
@ ET is calculated on for cells in the top grid layer
(O Wertical distribution of evapotranspiration is specified in IEVT

Current Column = 16

Current Row = 11

The evapotranspiration option is applied to the entire matrix. IEVT is only
required. if the second evapotranspiration option is selected.

Fig. 3.16 The Evapotranspiration (EVT1) dialog box

The EVT1 Package is based on the following assumptions:

1. When water tableis at or above the elevation of the ET surface h, , evapotranspiration |oss
from the water tableis at the maximum ET Rate R.,,;

2. No evapotranspiration occurs when the depth of the water table below the elevation of the ET
surface exceeds the ET extinction depth d; and

3. In between these two extremes evapotranspiration varies linearly with the water table elevation.

The Modeling Environment



3-24 Processing Modflow

These assumptions can be expressed in equation form as:

Ros = Rosa h>he
R.. =0 h<h -d
N e
d - (h. - d) (3.16)
Rogy = Rogy — (h-d)<h<h_

where R, [L3LT7] isthe evapotranspiration rate per unit of surface area of water table. The
evapotranspiration flow rate (Q, [L*T™]) drawn from amodd cell is

Q.4 = Rog*DELR-DELC (3.17)

where DELR -DELC isthe map areaof amodd cdl. Q. isdrawn from only one cell in the vertical

columnbenesththemaparea DELR - DELC . TheEV T1 Package providestwo optionsfor specifying

the cell in each vertical column of cells where evapotranspiration is drawn from:

1. Evapotranspiration is always drawn from the top layer of the model.

2. Vetica digribution of evapotranspiration is specified in the Layer Indicator Array. I, defines
the layer where evapotranspiration is drawn from.

In either casethe Q; hasno influence on the simulation if the designated cell is either a no-flow
(inactive) cell or a constant head cell. Y ou can select an option in the Evapotranspiration (EVT1)
dialog box. The layer indicator array is needed only when the second option is used.

Horizontal-Flow Barrier (HFB1)

The Horizontal-Fow Barrier Package (Hseh and Freckleton, 1993) smulates thin low-permesbility
geologicfeatures, suchasvertica faultsor durry wals, that impedethe horizonta flow of groundwater.
These geol ogic features are gpproximated as a series of horizontal-flow barriers conceptually Stuated
on the boundaries between pairs of adjacent cellsin the finite-difference grid.

A horizonta-flow barrier isdefined by assigning thefollowing valuesto amodd cdll in the Horizonta -
Flow Barrier (HFB1) dialog box (Fig. 3.17):

- Barrier Direction [-]; and

- (Hydraulic Conductivity/Thickness) of the barrier TDW [T]

The barrier direction indicates the cell face where the barrier islocated. To erase an existing barrier,
use zero for the barrier direction. The second value TDW gives the hydraulic characteristic of the
barrier. In the HFB1 Package, barrier thicknessisincluded implicitly in TDW. If the layer typeis
1 or 3, TDW will beused by the HFB1 Package directly. If alayer is confined (type O or 2), however,
PMWIN assgns the product of TDW and the layer thickness to the HFB1 Package. In this case,
you have to specify the eevations of the top and bottom of these layers, although these elevations
are not aways required for simulating confined layers.

For thenumerical implementation of theHorizontal -FH ow Barrier Packagerefer toHs ehand Freckleton
(1993).
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= Horizontal-Flow Barrier (HFB1)

Barrier Direction (1-4):

2

(Hydraulic Conductivity / Thickness) of the

Barrier [1/T]:
1.0E-8

Current Column = 21 Directions
Current Row = 2b

1—:D—2

0 = MNo Barrier

Fig. 3.17 The Horizontal-Flow Barrier (HFB1) dialog box

Interbed Storage (IBS1)

For steady State flow smulations, the menu Interbed Storage (IBS1) is not used and dimmed. The
Interbed Storage Package (Leake and Prudic, 1991) smulates elastic and inelastic compaction of
compressible fine-grained beds due to groundwater extraction. The term "interbed” is used to denote
apoorly permeable bed within arelatively permeable aquifer.

To incorporate the calculation of interbed storage of alayer, set the Interbed Storage flag to YES
(seeLayer Optionsdidog in section 3.3.2). The data required by the IBS1 Package are specified
by using the Data Editor in the Interbed Storage dialog box (Fig. 3.18):
Preconsolidation Head or preconsolidation stress H, [L] in terms of head in the aquifer.
Preconsolidation head is the previous minimum head vaJ ue in the aquifer. For any model cells
in which the specified preconsolidation head is greater than the corresponding value of initial
head, the value of the preconsolidation head will be set to that of theinitial head;

- Elastic Storage Factor S,, [-] for interbeds present in the model layer;

- Indastic Storage Factor S;, [-] for interbeds present in the model layer;

- Starting Compaction [L]. Compactionva uescomputed by the IBS1 Packageare added to Starting
Compaction so that stored values of compaction and land subsidence may include previous
components. Starting Compaction does not affect calculations of storage changes or resulting
compaction.

= Interbed-Storage (IBS1)

Preconsolidation Head [L]:
||11

Elastic Storage Factor [-]:
o

Inelastic Storage Factor [-]:
.om

Starting Compaction [L]:

I 0

Current Column = 7
Current Row = 5

Fig. 3.18 The Interbed Storage (IBS1) dialog box
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For a confined aquifer, elastic compaction or expansion of sediments is proportional or nearly
proportiona to changein hydraulic headinthe aquifer. The IBS1 Package usesthefollowing equation
to calculate the change in thickness:

Ab = ‘Ah'S@b' b, = -Ah-S__ (3.18)
where Ab [L] ischangein thickness, positive for compaction and negative for expansion; A h[L]
ischangein hydraulic head, positivefor increase;S, . [L™] isthe skeletal component of elastic specific
storage; b, isthe thickness of the interbed; and S, isthe user-specified dadtic storage factor. When
compressi blefine-grai ned sedimentsare stressed beyond aprevious maximum stress (preconsolidation
stress), compaction is permanent (inelastic). In analogy to equation 3.18, the IBS1 package uses
the following equation to calculate the approximate inelastic compaction Ab* [L]:

Ab™ = —Ah-SGM- b. = -Ah-S_, (3.19)
where S, [L™] isthe skeletal component of inelastic specific storage and S, is the user-specified
inelastic storage factor.

For an unconfined aquifer, elastic compaction or expansion of sediments can be expressed as

Ab = -Ah-(1-n+n,)-S_-b. = -Ah-S__ (3.20)

wheren [-] isporosity and n,, [-] is moisture content above water table as a fraction of total volumn
of porous medium. Similarly, inelastic compaction or expansion of sediments can be expressed
as

Ab = -Ah-(1-n *”v)'S@M b, = -Ah-S_, (3.22)

For an aquifer with n interbeds with specific-storage values S, S,,..., S, and with thicknesses
b, b,, ..., b,, asingle equivalent storage factor S .., [-] is given by Jorgenson (1980):

SeTe@DJ: Sembm+SeHb|| +"'+Se<<b<< (3.22)

For the numerical implementation of the Interbed Storage Package refer to Leake and Prudic (1991).

Time-Variant Specified-Head (CHD1)

For transient smulations, the Time-Variant Specified-Head Package (L eake and Prudic, 1991)
alowsconstant-head cdlIsto take on different head val uesfor eachtimestep. Y ouusethe Time-Variant
Specified-Head (CHD1) diaog box to specify the data required by the CHD1 Package (Fig. 3.19):
- Hagl[-]. A non-zerovaueindicatesthat acell isspecified asatime-variant specified-head boundary.
- Start Head h, [L]. Thisvalueisthe head in the cell at the start of the stress period.

- EndHead h, [L]. Thisvalueisthe head that will be assigned to the cell for the last time step

in the stress period.
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The CHD1 Package does not alter the way constant-head boundaries are formulated in the finite-
difference equations of MODFLOW. CHD1 sets the element in the IBOUND array to a negative
vauefor dl celswhere atime-variant specified-head boundary is selected (Flag+0). The specified
heads are congtant during atime step. The CHD1 Package linearly interpolates boundary heads h
for each time-variant specified-head boundary cell by using the equation:

PERTIM

h=h+ (. = h) FerrEn

(3.23)

where PERTIM is the staring time of atime step in a stress period and PERLEN is the length of
the whole stress period.

= Time-Variant Specified Head (CHD1)

I
Start Head [L]:
I 10

End Head [L]:
9

Current Column = 1

Current Row = 1

If Flag <> 0. the current cell is a Time-Variant
Specified-Head cell

Fig. 3.19 The Time-Variant Specified-Head (CHD1) dialog box

Wetting Capability (BCF2)

Thewetting capability of the Block-Centered Flow 2 Package (BCF2; McDondld et d. 1991) dlows
the smulation of arising water table into unsaturated (dry) model layers. The BCF2 Package is
identical to the BCF1 Package of the "origina” MODFLOW (McDonald and Harbaugh, 1988)
except for thewetting and drying of cells. In BCFL, acdll falsdry when the head is below the bottom
elevation of the cdl. When acdl fdlsdry, IBOUND is st to O (which indicates no flow or inactive
cdl), al conductances to the dry cell are set to zero. The cell cannot be wetted again. In BCF2,
adry cdl or aninactive cell can become wet if the head from the previousiteration in aneighboring
cell is greater than or equal to the turn-on threshold. The turn-on threshold is

TURNON = BOT + [THRESH| (3.24)

where BOT isthe eevation of the bottom of the cell and THRESH is a user-specified constant called
the wetting threshold. A non-zero value THRESH is specified for each cell that can be wetted.
If THRESH<O, only the cell below a dry cell can cause the cell to become wet. If THRESH>O0,
the cell below adry cell and the four horizontally adjacent cells can cause the cell to become wet.
If THRESH is zero, the dry cell or the inactive cell cannot be wetted.
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Only varigble-head cdlls either immediately below or horizontally adjacent to adry cell can cause
the cdll to become wet. A neighboring cell cannot become wet as aresult of a cell that has become
wet in the same iteration. When acell iswetted, IBOUND for the cell is set to 1 (which indicates
avariable-head cdl), vertical conductances are set to their original values, and the hydraulic head
h at the cell is set equal to one of the following

h

BOT + WETFCT(hn - BOT) (3.25)

h

BOT + WETFCT-[THRESH] (3.26)

where hn isthe head at the neighboring cell that causesthe dry cell to wet, and WETFCT is a user-
specified constant caled the wetting factor. The user can select between equation 3.25 and 3.26
in the Wetting Capability (BCF2) didog box (Fig. 3.20). This dialog box appears when you select
Wetting Capability (BCF2) from the Packages menu. The dialog also allows you to specify the
iteration interval for attempting to wet cellSIWETIT. Wetting is attempted every IWETIT iterations.
If using the PCG2 solver (Hill, 1990), this appliesto outer iterations, not inner iterations. The reason
of adjusting IWETIT isthat the wetting of cells sometimes produces erroneous head changesin
neighboring cells during the succeeding iteration, which would cause erroneous conversions of
those cells. These erroneous conversions can be prevented by waiting afew iterations until heads
have had a chance to adjust before testing for additiona conversons. When setting IWETIT greater
than one, thereis somerisk that cells may be prevented from correctly converting from dry to wet.
If the solution for atime step is obtained in lessthan IWETIT iterations, then there will be no check
during that time step to seeif cells should be converted from dry to wet. The potentia for this problem
to occur is gregter in trandent smulations, which frequently require only afew iterations for atime

step.

The method of wetting and drying cells used in the BCF2 Package can cause problems with the
convergence of the iterative solvers used in MODFLOW. Convergence problems can occur in
MODFLOW even without the wetting capability but problems are more likely to occur when the
wetting capability is used. Symptoms of a problem are slow convergence or divergence combined
with the frequent wetting and drying of the same cells. It isnormal for the same cell to convert
between wet and dry severd times during the convergence process. but frequent conversions are
anindication of problems. The user can detect this situation by examining the model run record
file OUTPUT.DAT; amessage is printed each time a cell converts. Refer to the documentation
of the BCF2 Package for how to solve problems with convergence. As a matter of fact, situations
exist where the real solution is oscillating such as in the case of awell causing a drawdown which
makesthewell cdl fal dry. Thisin turn switches off the well and leads to arise of the water table
and wetting of the well cell etc.
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= Wetting Capability (BCF2)

Iteration Interval for Attemping to Wet Cells:

T

Wetting Factor (WETFCT):
A1

OK

Cancel

Initial Heads at Rewetted Cells :

® h = BOT + WETFCT (hn - BOT)
' h = BOT + WETFCT * [THRESH|

BOT = Bottom of cells
THRESH = Wetting threshold
hn = heads at the neighboring cells

Click OK to edit wetting threshold.

Fig. 3.20 The Wetting Capability (BCF2) dialog box

Advection (MTADV1)
The MT3D model provides four solution schemes for the advection term. The user can select a
solution scheme in the Advection Package (MTADV1) dialog box (Fig. 3.21).

The method of characteristics (MOC) scheme was implemented in the U.S. Geological Survey
two-dimensional transport model (Konikow and Bredehoeft, 1978), and has been widely used.
Using the MOC scheme, a set of moving particlesis distributed in the flow field at the beginning
of the smulation. A concentration and a position in the Cartesian coordinate system are associated
with each of these particles. Particles are tracked forward through the flow field using a small time
increment. At the end of each time increment, the average concentration at a cell due to advection
aoneisevaluated from the concentrations of particles which happen to be located within the cell.
One of the most desirable features of the MOC techniqueisthat it is virtually free of numerical
dispersion, which creates serious difficulty in many numerical schemes. The major drawback of
the MOC schemeisthat it can be slow and requires a large amount of computer memory when
alarge amount of particlesisrequired. In the MT3D model, instead of placing a uniform number
of particlesin every finite-difference cell, a dynamic approach is used to control the distribution
of moving particles. The number of particles placed at each cdll isnormaly set either at a high level
or at alow level, according to the so-called "relative cell concentration gradient”, or DCCELL,
defined as.

CMAX,;; - CMIN, .

CMAX - CMIN

(3.27)

where CMAX; ;. isthe maximum concentration in theimmediate vicinity of the cell (i, j, k); CMIN ;
is the minimum concentration in the immediate vicinity of the cdll (i, j, K); CMAX is the maximum
concentration in the entire grid; and CMIN  is the minimum concentration in the entire grid. With
the dynamic approach, the user defines a criterion DCEPS; the higher number of particles, NPH,
is placed in cellswhere the relative concentration gradient is greater than DCEPS, and the lower
number of particles, NPL, in cells where the relative concentration gradient is less than DCEPS.
Inmany practica problemsinvolving solute trangport modeling, the contaminant plumes may occupy
only asmadl fraction of the finite-difference grid and the concentrations may be changing rapidly
only at sharp fronts. In these cases, the number of total particles used is much smdler than required
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in the uniform particle distribution gpproach, thereby the efficiency of the method-of characteristics
model can be increased with little loss in accuracy.

= Advection Package (MTADV1)
" Solution Scheme
C Method of characteristics (MOC) OK I
O Modified method of characteristics (MMOC)
@ Hybrid MOC/MMOC (HMOC)
C Upstream finite difference method
Help I

[ Particle Tracking Algorithm

C First-order Euler algorithm

O Fourth-order Runge-Kutta algorithm

@® Use Runge-Kutta algorithm in sink{source cells and the cells
next to sinksfsources cells, otherwise use Euler alqorithm

Particle Flacement { Movement |
Max. number of total moving particles (MXPART) | 25000

T+

Courant number (PERCEL) 75 —

Concentration weighting factor (WD) 5

Negligible relative concentration gradient 0000
(DCEPS)
Pattern for initial placement of particles (NPLANE) | 2

+

Fig. 3.21 The Advection Package (MTADV 1) dialog box

The modified method of characteristics (MMOC) uses one particle for each finite-difference cell.
At each new time level, a particle is placed at the nodal point of each finite-difference cell. The
particleistracked backward to find its position at the old time level. The concentration associated
with that position is used to approximate the average concentration at the cell, where the particle
is placed. The MMOC techniquein the MT3D modd is intented for use in situations where sharp
fronts are not present, so that any numerical dispersion error resulting from the solution scheme
isinggnificant.

The hybrid method of characteristics (HMOC) attempts to combine the strengths of the MOC and
MM OC schemes by using an automatic adaptive scheme conceptually similar to the one proposed
by Neuman (1984). The fundamenta idea behind the scheme is automatic adaptation of the solution
process to the nature of the concentration field. When sharp concentration fronts are present, the
advection termis solved by MOC through the use of moving particles dynamically distributed around
eachfront. Away from such fronts, theadvection termissolved by MMOC. Thecriterion, DCHMOC,
for controlling the switch between the MOC and MMOC schemes is given by the user. If
DCCELL,;>DCHMOC, then the MOC scheme is used. Otherwise the MMOC scheme is used.

InMT3D, particles are introduced into the flow field and moved in a continuous spatial domain
according to avelocity field calculated from the hydraulic heads generated by MODFLOW. The
user can select aparticletrackinga gorithmbetweenthefirst-order Euler gorithmandthefourth-order
Runge-Kutta agorithm. Using the first-order Euler algorithm, the equation for calculating the final
coordinates (x,, y,, z,) of aparticle at the end of atracking step is

X, =X_+ (v) At/R
Y, = Yo + (V) At/R (3.28)
z, =7+ (v). At/R

/
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where (x,, Yo, %) istheinitid position of the particle; (v,),, (v ), and (v,), areinitial linear velocities
evauated at (X,, Yo, Z); ad R isthe retardation factor resulting from the incorporation of sorption
isotherms into the transport equation. Numerical errors tend to be large unless small transport
steps (At) are used. In MT3D, At is determined from

Ax Ay Az
(Vy)g (VT)g (V L)g
where Ax, Ay and Az arethe widths of the cdll inthe x, y and z-directions, v, is the Courant number.

IAt] < y_-R-MIN

(3.29)

The fourth-order Runge-Kutta method is preferred over the first-order Euler method because the

former ismore accurate and permitsthe use of larger tracking steps At. However, the computational

effort required by the fourth-order Runge-Kutta method is considerably larger than that required
by thefirgt-order Euler method. For thisreason amixed option combining both methodsisintroduced
inthe MT3D modd. The mixed option isimplemented by automatic selection of the fourth-order

Runge-Kuttaagorithm for particleslocated in cellswhich contain or are adjacent to sinks or sources,

and automatic selection of the first-order Euler agorithm for particles |ocated el sewhere. For more

information on the numerical implementation and the effective use of the MT3D model, refer to

Zheng (1990, 1993) or Zheng and Bennett (1995).

The Particle Placement/Movement parameters required by the Advection Package of MT3D

(MTADV1) areexplained below. TheparametersDCEPS, NPLANE, NPL, NPH, NPMIN, NPMAX

and SRMULT are only required by MOC or HMOC. The parameters NLSINK and NPSINK are

only required by MMOC or HMOC.

» MXPART isthe maximum number of total moving particles allowed, and is used only by the
MOC or HMOC solution schemes.

» PERCEL isthe Courant number, or number of cells any particle will be alowed to movein
any direction in one transport step. Generally, 0.5<PERCEL <1. Valuesin excess of 1 can be
used if the higher-order particle tracking method (fourth-order Runge-Kutta algorithm) is used
throughout the grid. Furthermore, because dl cellsin theentiregrid are checked when caculating
the maximum allowed tracking stepsize, there may be afew cells where a particle will move
more than one cell's length with PERCEL >1, while a particle will only move a fraction of a
cdl esawhere. If these cdlls are outside the area of interest, setting PERCEL >1 will not result
ininaccuracy. Note that if the upstream finite-difference method for solving advection is used,
PERCEL must not exceed 1.

» WD isaconcentration weighting factor between 0 and 1. The value of 0.5 is normally a good
choice. Thisnumber can be adjusted to achieve better mass balance. Generdly, it can beincreased
toward 1 as advection becomes more dominant.

» DCEPS isasmdl relative concentration gradient (DCCELL), such as 10°, which is considered
to be negligible.

» NPLANE isaflagindicating whether the random or fixed pattern is selected for initia placement
of moving particles.

If NPLANE>O, the fixed pattern is selected for initia placement. The value of NPLANE serves
asthe number of vertical "planes’ on which initia particles are placed within each cell block
(Fig. 3.224). Thisfixed pattern workswell in rdatively uniform flow Fields. For two-dimensiona
gmulationsin plan view, st NPLANE= 1. For cross sectiond or three-dimensiond smulations,
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NPLANE=2isnormally adequate. Increase NPLANE if more resolution in the vertical direction
is desired.

If NPLANE=0, the random pattern is selected for initial placement. particles are distributed
randomly by calling arandom number generator in both the horizontal and vertical directions
(Fig. 3.22b). This option generaly leads to smaller mass balance discrepancy in nonuniform
or diverging/converging flow fields.

» NPL isthe number of initia particles per cell to be placed in cells where DCCELL<DCEPS.
Generally, NPL can be set to O since advection is insignificant under the condition
DCCELL<DCEPS. Setting NPL equal to NPH causes auniform number of particlesto be placed
in every cell over the entire grid (i.e., the uniform approach).

» NPH isthe number of initial particles per cell to be placed at cells where DCCELL>DCEPS.
The selection of NPH depends on the nature of the flow field and a so the computer memory
limitation. Generaly, use asmaller number in rdatively uniform flow fields and alarger number
inrelatively nonuniformflow fields. However, vauesexceeding 16 in two-dimensional smulations
or 32 in three-dimensional ssimulations are rarely necessary. If the random pattern is chosen,
NPH particles are randomly distributed within the cell block. If the fixed pattern is chosen, NPH
isdivided by NPLANE to yield the number of particles to be placed per vertical plane, which
isrounded to one of the values shown in Fig. 3.23.

» NPMIN isthe minimum number of moving particles allowed per cell. If the number of particles
inacdl at the end of atransport step isfewer than NPMIN, new particles are inserted into that
cdl to maintain a sufficient number of particles. NPMIN can be set to O in relatively uniform
flow fields, and a number grester than zero in diverging/converging flow fields. Generaly,
0<NPMIN<4 is adequate.

» NPMAX isthe maximum number of particles allowed per cell. If the number of particlesin
acdl exceedsNPMAX, particles are removed from that cell until NPMAX is met. Generally,
NPMAX can be set to a value approximately twice the value of NPH.

» SRMULT isamultiplier for the particle number at source cells (SRMULT>1). In most cases,
SRMULT=1 is sufficient. However, better results may be obtained by increasing SRMULT.

» NLSINK isaflag indicating whether the random or fixed pattern is selected for initid placement
of particlesto gpproximate sink cellsin the MMOC scheme. The convention is the same as that
for NPLANE.

» NPSINK isthe number of particles used to approximate sink cellsin the MMOC scheme. The
convention is the same as that for NPH.

» DCHMOC isthe critical relative concentration gradient for controlling the selective use of
either MOC or MMOC in the HMOC solution scheme. The MOC solution is selected at cells
where DCCELL>DCHMOC. The MMOC solution is selected at cells where DCCELL <
DCHMOC. DCHMOC is only required when HMOC is used.
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a

Plane 1

Plane 2

Fig. 3.22 Initia placement of moving particles (after Zheng, 1990).

(a) Fixed pattern, 8 particles are placed on two planes within the cell block
(b) Random pattern, 8 particles are placed randomly within the cell block

Fixed pattern 1

Fixed pattern 4

Fixed pattern 2

Fixed pattern 3

Fixed pattern 5

Fixed pattern 6

Fig. 3.23 Distribution of initial particles using the fixed pattern (after Zheng, 1990)

If the fixed pattern is chosen, the number of particles placed per cell (NPL and NPH)
isdivided by the number of vertical planes NPLANE, to yield the number of particles
to be placed on each vertical plane, which is then rounded to one of the numbers of
particles shown here.
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Dispersion (MTDSP1)

In MT3D, the concentration change due to dispersion aone is solved with afully explicit central
finite-difference scheme. Thereisacertain stability criterion associated with MT3D. The transport
step size cannot exceed an upper limit. MT3D uses the following stepsize criterion:

0.5-R
DMM + DTT DLL (330)

+

AX [ Ay [ Az [

At <

where Ax, Ay and Az arethe widths of the cell inthe X, y and z-directions; R isthe retardation factor.

D,.. D,, and D,, are calculated as
V|| V|| V||
i T 1 *
D, =0, — + 0s "— + -— + D
ST M T M
[ [ [
Vv N Vv
D _=0g— + 0y "— + O — + D~ (3.31)
TN M
[ [ [
=« V_L + o ﬂ b e t— + *
UM M

wherea, [L] isthelongitudind dispersivity; o, [L] isthe horizontal transverse dispersivity; o, [L]
isthe verticd transverse dispersivity;D* [L*T™] is the effective molecular diffusion coefficient; v,
v,, v, [LT] are components of the flow velocity vector along the x, y, and z axes; and

M o= (v o+ vl e v (3.32)

T

Using the Data Editor, you specify the longitudinal dispersivity o, for each finite-difference cell.
The following vaues must be specified for each layer in the Disperson Package (MTDSPL) dialog
box (Fig. 3.24):

» TRPT istheratio of the horizontal transverse dispersivity to the longitudinal dispersivity.
» TRPV istheratio of the vertiocal transverse dispersivity to the longitudinal dispersivity.

» DMCOEEF isthe effective molecular diffusion coefficient.
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You need to specify the following values for each layer. When finished. click
OK to edit the longitudinal dispersivity [L].

Layer TRPT TRPY DMCOEF +
1 3 3 0 I
2 3 3 0 -
3 3 3 0

4 3 3 0

5 3 3 0

[ 3 3 0

7 3 3 0 3
TRPT: the ration of the horizontal transverse dispersivity to the longitudinal
dispersivity.

TRPY: the ration of the vertical transverse dispersivity to the longitudinal
dispersivity.

DMCOEF: the effective molecular diffusion coefficient [L"2/T]

| Help || Cancel || OK I

Fig. 3.24 The Dispersion Package (MTDSPL) dialog box

Chemical Reaction (MTRCT1)

Chemical reactions supported by the MT3D transport model include equilibrium-controlled sorption
reactions and first-order irreversible rate reactions, such as radioactive decay or biodegradation.
Y ou can select asorption type in the Chemical Reaction Package (MTRCT1) didog box (Fig. 3.25),

and specify the necessary datafor each layer in the table. Sorption isimplemented in MT3D through
use of the retardation factor R.

For thelinear isotherm, theretardation factor isindependent of the concentration field and isca culated
only once for each cell in the beginning of the simulation:

p/
Rapp =1+ ——Ke (3.33)
o)1

wheren,;, [-] isthe porosity of the porous medium in cell (i, j, k); K, [L*M™] isthe distribution
coefficient that depends on the solute species, nature of the porous medium, and other conditions
of the system; and p, [ML] isthe bulk density of the porous medium. The bulk density isthe
ratio of the mass of adried soil to the total volume of the soil.
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= Chemical Reaction Package (MTRCT1)
[ Type of Sorption
 Linear equilibrium isotherm
i Freundlich nonlinear equilibrium isotherm
@ Langmuir nonlinear equilibrium isotherm
O No sorption Help I
X Simulate the radioactive decay or biodegradation
Layer |RHOB SP1 SP2 RC1 1+
1 0 0 0 0 I
2 0 0 0 0 -
3 0 0 0 0
4 0 0 0 0
5 0 0 0 0
B 0 0 0 0 +
“ ] ]
RHOB is the bulk density of the porous medium in the aquifer [M/L"3]
SP1 is the Langmuir sorplion equilibrium constant K1 [L"3/M]
SP2 is the total concentration of sorption sites available [M/M]
RC1 is the first-order rate constant for the dissolved phase [1/T]
RC? is the first-order rate constant for the sorbed phase [1/T]

Fig. 3.25 The Chemical Reaction Package (MTRCT1) dialog box

For the Freundlich isotherm, the retardation factor at the beginning of each transport step is calculated
as:

p/.

Ry =1+
o]
Mom

~—N

where C, ; , is the solute concentration in the cell (i, J, k) at the beginning of each transport step;
a [-] is the Freundlich exponent; and K, [(L®*M™)q is the Freundlich constant.

For the Langmuir isotherm, theretardation factor at the beginning of each transport step is calculated
as:

P, Ky-S

R =1+ .
oD
Map1 (1 + KgCyp)

(3.35)

where K, [L*M] isthe Langmuir constant and S[MM] is the maximum amount of the solute
that can be adsorbed by the soil matrix.

To smulate the effect of the first-order irreversible rate reactions, check the box "Simulate the
radioactive decay or biodegradation” in the Chemical Reaction Package (MTRCT1) dialog. The
concentration change due to the chemical reaction from aold transport step to a new transport
step at cell (i, j, K) can be expressed as

At
R

Py =

AC S Ciix (3.36)

RCT i,j,k

)‘1'Ci,j,k + Ay N
i,j,k ij. k
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where A\, [T™] isthe first-order rate constant for the dissolved phase; A, [T™] isthe first-order rate
constant for the sorbed phase; At isthetransport time-step; and C; ik isthe mass of the solute species
adsorbed on the solids per unit bulk dry mass of the porous medium at the beginning of each transport
step. C,; . isin equilibrium with solute concentration C;;, in the same cell (i, j, k).

The rate constant is usually given in terms of the half-lifet,,:

In2
A= (3.37)

o

Generdly, if the reaction is radioactive decay, A\, should be set equal to A,. However, for certain
types of biodegradation, A, may be different from A,.

The linear sorption isotherm assumes that 6. ik isdirectly proportional to C; ; ,:

The Freundlich isotherm is a non-linear isotherm, expressed in the following form:

The Langmuir isotherm is expressed in the form:

Ciyq = —v @1 4
. K Cay (3.40)

For moreinformation on the mathematical description of adsorption and transport of reactive solutes
in soil, the user can refer to Travis (1978) or Bear and Verruijt (1987).

Modflow Solvers

To caculate headsin each cdl in thefinite-difference grid, MODFLOW prepares onefinite difference
equation for each cell, expressing the relationship among the head at a node and the heads at each
of the six adjacent nodes at the end of atime step. Because each equation may involve up to seven
unknown values of head, and because the set of unknown head values changes from one equation
to the next through the grid, the equations for the entire grid must be solved smultaneoudly at each
time step. The system of smultaneous finite difference linear equations can be expressed in matrix
notation as

Ax=b (3.41)
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where A isacoefficient matrix assembled by MODFLOW using user-specified model data; b is
avector of defined flows, terms associated with head-dependent boundary conditions and storage
termsat each cdll; x isavector of hydraulic heads at each cell. In MODFLOW, one value of head
for each cell is computed for the end of each time step. PMWIN supports three packages (solvers)
for solving systems of simultaneous linear equations by iteration. They are

- the Strongly Implicit Procedure (SIP);

- the Slice-Successive Overrelaxation approach (SSOR); and

- the Preconditioned Conjugate-Gradient 2 method (PCG2).

Input parameters of these solution methods are discussed below. See McDonad and Harbaugh
(1988) and Hill (1990a) for detailed mathematical background and numerical implementation of
these solvers. Various comparisons between the solution methods can be found in Trescott (1977),
Behie et a. (1983), Scandrett (1989) and Hill (1990b). Hill indicates that the greatest differences
in solver efficiency on scalar computers occurs for three-dimensional, non-linear problems. For
these types of problems, it may be well worth the time and effort to try more than one solver. SIP
generally isagood alternative to consider.

» SIP

Y ou specify the required parametersin the Strongly Implicit Procedure (SIP) dialog box (Fig. 3.26).

The parameters are described below:

* MXITER isthe maximum number of iterationsin onetime step in an attempt to solve the system
of finite-difference equations.

* |PRSIPistheprintout interva for SIP. A postiveinteger isrequired. The maximum head change
(positive or negative) is saved in the run record file OUTPUT.DAT for each iteration of atime
step whenever the time step is an even multiple of IPRSIP. This printout also occurs at the end
of each stress period regardless of the value of IPRSIP.

* NPARM isthenumber of iteration parametersto be used. Five parametersare generaly sufficient.

» ACCL isthe acceleration parameter. It must be greater than zero and is generally equal to one.

» Head Changeisthe head change criterion for convergence. When the maximum absolute value
of head change from al cells during an iteration isless than or equal to Head Change, iteration
stops.

= Strongly Implicit Procedure (SIP)
" Max. Allowed leration Number: |
MXITER: I 50

" Printout From the Solver
Interval (IPRSIP): I 1

No. of teration Parameters |
NPARM: 5

r Acceleration Parameter 1
ACCL: I 1

" Convergence Criterion 1
Head Change [L]: .00

Fig. 3.26 The Strongly Implicit Procedure (SIP) dialog box
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» SSOR

Y ou specify the required parameters in the Slice Successive Overrelaxation (SSOR) dialog box

(F|g 3.27). The parameters are described below:
MXITER isthe maximum number of iterationsin one time step in an attempt to solve the system
of finite-difference equations.

¢ IPRSORisthe printout interval for SSOR. A positive integer is required. The maximum head
change (positive or negative) is saved in the run record file OUTPUT.DAT for each iteration
of atime step whenever the time step is an even mulltiple of IPRSOR. This printout also occurs
at the end of each stress period regardless of the value of IPRSOR.

» ACCL isthe acceleration parameter, usually between 1.0 and 2.0.

» Head Change isthe head change criterion for convergence. When the maximum absolute value
of head change from al cells during an iteration isless than or equal to Head Change, iteration
stops.

= Slice-Successive Overrelaxation (SSOR)

" Allowed lteration Number:

MXITER: 50

|

Cancel |

" Printout From the Solver

Interval (IPRSOR): |1

|

rAcceleration Parameter

ACCL: | 1
" Conwvergence Criterion I
Head Change [L]: I oo

Fig. 3.27 The Slice Successive Overrelaxation (SSOR) dialog box

» PCG2

PCG2 provides two preconditioning options: the modified incomplete Cholesky preconditioner
MICCG (Axelsson and Lindskog, 1986) and the least-squares polynomial preconditioner POLCG
(Saad, 1985). Y ou can select a preconditioning method in the Preconditioned Conjugate Gradient
2 didog box, as shown in Fig. 3.28. The required parameters are described below.

= Preconditioned Conjugate Gradient 2 = Preconditioned Conjugate Gradient 2

" Preconditioning Method " Preconditioning Method
@ Modified Incomplete Cholesky ' Modified Incomplete Cholesky
O Neuman Series Polynomial @® Neuman Series Polynomial

Relaxation Parameter: | 1 I Calculate the upper bound on the maximum eigenvalue

" Allowed lteration Numbers:
Outer lteration (MXITER):

20

Inner lteration (ITER1):
20

" Printout From the Solver
@® All available information

O The number of iterations only
C None

Printout Interval: I 1

| [ Convergence Criteria

Head Change [L]:
.ooo1

Residual [L"3/T]:
.ooo1

OK

Cancel

Help

Outer lteration (MXITER):
20

Inner Iteration (ITER1):
20

" Allowed lteration Numbers:

| [ Convergence Criteria ™ |
Head Change [L]:

.ooo1
Residual [L"3/T]:
.0oo1

" Printout From the Solver

@ All available information
O The number of iterations
C None

0K

I
omy Cancel

Printout Interval: I 1

Fig. 3.28 The Preconditioned Conjugate Gradient 2 dialog box
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« MXITER isthe maximum number of outer iterations. For each outer iteration, A and b (equation
3.41) are updated by using the newly caculated hydraulic heads. For alinear problem, MXITER
should be 1, unless more that 50 inner iterations are required. A larger number (generally less
than 100) isrequired for anonlinear problem. Outer interations continue until thefinal convergence
criteria (see below) are met on the first inner iteration.

» |ITER1 isthe maximum number of inner iterations. Equation 3.41 with anew set of A and b
issolved in inner iterations. Theinner iterations continue until ITER1- iterations are executed
or the final convergence criteria (see below) are met.

» Head Change[L] isthe head change criterion for convergence. When the maximum absolute
vaue of the head change at al nodes during an iteration is less than or equal to Head Change,
and the criterion for Residual is satisfied (see below), iteration stops.

» Residual [L®T™] isthe residual criterion for convergence. Residual is calcuated asb - A - x
for each inner iteration. When the maximum absolute value of the residual at al cells during
an iteration isless than or equal to Residua, and the criterion for Head Change is satisfied (see
above), iteration stops.

» Relaxation Parameter is used with MICCG . Usudly, this parameter is equal to 1, but for some
problems a value of 0.99, 0.98 or 0.97 will reduce the number of iterations required for
convergence.

« Printout From the Solver: A positive integer isrequired by Printout Interval. If the option "All
available information” is selected, the maximum head change and resdud (positive or negative)
aresaved in the run record file OUTPUT.DAT for each iteration of atime step whenever the
time step isan even multiple of Printout Interva. If the option "The number of iterations only"
is checked, the printout of maximum head change and residual is suppressed. Select the option
"None", to suppress al printout from the solver.

» Thecheck box " Cd culatethe upper bound on the maximum eigenvaue" isonly used with POLCG.
The upper bound on the maximum eigenvaue of A isestimated asthe largest sum of the absolute
vauesof the componentsin any row of A. Check thisbox, if the upper bound should be calculated
by the solver. Otherwise, avaue of 2 will be used. Convergence is generaly insensitive to this
value. Estimation of the upper bound uses slightly more execution time per iteration.

Output Control
The Output Control menu is used to control the frequency and terms of simulation results of
MODFLOW and MT3D that will be printed or saved. The available options are described below.

» Modflow

Different smulation results can be saved in files by checking the corresponding output termsin
the Modflow Output Control dialog box (Fig. 3.29). The ssimulation results are saved whenever
the time step and stress period are an even multiple of output frequency specified in the dialog.
Note that the results for the first and last stress periods and time steps are always saved. Use 0
(zero) for the output frequency, if only the result of the last stress period or the last time step should
be saved. The predefined heads for no-flow cells (HNOFLO) and dry cells (NDRY) are givenin
the Predefined Head Vaues group.
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The output terms and the corresponding result files are described below. All result files are saved
in the directory in which your model data are saved.

Hydraulic Heads is the primary result of aMODFLOW simulation. Hydraulic heads in each
finite-difference cell are saved in the unformatted (binary) file HEADS.DAT.

Drawdowns is the differences between the initial hydraulic heads and the calculated hydraulic
heads. Drawdowns in each cell are saved in the unformatted (binary) file DDOWN.DAT.
Cdl-by-cdl FHow Termsare flow termsfor individua cells, including four types: (1) cell-by-cell
stressflows, or flowsinto or from anindividua cell dueto one of the external stresses (excitations)
represented in the model, e.g., pumping well or recharge; (2) cell-by-cell storage terms, which
givetherateof accummulation or depletion of orageinanindividua cel; (3) cell-by-cell constant-
head flow terms, which givethe net flow to or from individual constant-head cells; and (4) internal
cell-by-cdl flows, which are the flows acrossindividua cell faces-that is, between adjacent model
cdls. The Water Budget Caculator (see Chapter 4) usesthe cell-by-cell flow terms to compute
water budgets for the entire model, user-specified subregions, and flows between adjacent
subregions. PMPATH uses the cell-by-cell flow terms and the cal culated hydraulic heads for
caculating and displaying pathlines. The cell-by-cell flow terms are saved in the unformatted
(binary) file BUDGET.DAT.

Subsidence is the sum of the compaction of all model layers that have interbed storage.
Compection of individua layersisthe sum of the calculated compaction and the user-specified
starting compaction in each layer.

Preconsolidation head is the previous minimum head value in the aquifer. For any model cells
in which the specified preconsolidation head is grester than the corresponding value of starting
head, va ueof the preconsolidation head will beset to that of starting head. Subsidence, compaction
and preconsolidation head are saved in the unformatted (binary) file INTERBED.DAT.
Interface file to MT3D is an unformatted (binary) file containing the computed heads, fluxes
across cdll interfacesin dl directions and locations and flow rates of the various sinks/sources.
Theinterface fileis created by the package named LKMT. The LKMT package is incorporated
inthe verson of MODFLOW provided by the PMWIN or MT3D software. Y ou must use these
two versons of MODFLOW, if you intend to run MT3D subsequently. If it is preferred to use
a verson of MODFLOW other than these two, you should add the LKMT package into
MODFLOW. Refer to the manual of MT3D for how to do this.

= Modflow Output Control

" Output Terms
X Cell-by-cell Flow Terms
X Subsidence (from IBS1)

X Compaction of Individual Layers (from IBS1)
X Preconsolidation Heads (from IBS1)

™ Echo Print of Input Values

¥ Interface file to MT3D

| Output Frequency Predefined Head Values
Stress Period: For No-Flow Cells:

[1 [ 999 99

Time Step: For Dry Cells:

|1 |1E+3I]

Fig. 3.29 The Modflow Output Control dialog box
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For checking the smulation results, MODFLOW calculates a volumetric water budget for the entire
model at the end of each time step, and saves it in the smulation record file OUTPUT.DAT. A
water budget providesan indication of the overal acceptability of thenumerica solution. In numerica
solution techniques, the system of equations solved by amodd actudly consists of aflow continuity
statement for each model cell. Continuity should also exist for the total flows into and out of the
entire modd or a sub-region. This means that the difference between total inflow and total outflow
should equal the total change in storage. It is recommended to read the record file. The record
file also contains other essential information. In case of difficulties, this supplementary information
could be very helpful.

» MT3D

TheMT3D trangport model generatesan ASCI smulationrecord fileOUTPUT.M T3 and an optional
unformatted (binary) concentration file MT3D.UCN. Both files are saved in the same directory
asyour mode data. Optiondly, you can save someother resultsinthe OUTPUT.M T3 file by checking
the corresponding output termsin the MT3D Output Control dialog box (Fig. 3.30). In the dialog
box, CINACT isthe predefined concentration vaue for an inactive concentration cell (ICBUND=0)
and NPRS s aflag indicating the frequency of the output, and also indicating whether the output
frequency is specified in terms of total elapsed smulation time or the transport step number. If
NPRS=0, smulation results will be saved at the end of each time step. If NPRS<0, smulation results
will be saved whenever the number of transport steps is an even multiple of NPRS. If NPRS>0,
gmulation results will be saved at times as specified in the Output Time table as shown in Fig. 3.31.
The Output Time table appears when you have specified a positive NPRS (>0) and pressed the
Tab Key. The Output Time table disappears when you have specified NPRS = 0 and pressed the
Tab key.

= MT3D Output Control

[ Output Terms )
[~ Concentration (ASCII) s
[~ Number of Particles (ASCII)
[ Retardation Factor (ASCII)
[~ Dispersion Coefficient (ASCII) Help
[ Concentration {Unformatted)

" Options

CINACT = I 1E+30
NPRS= IU

Fig. 3.30 The MT3D Output Control dialog box
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— MT3D Qutput Control

" Output Terms
[ Concentration (ASCII)

" Number of Particles (ASCII)
™ Retardation Factor (ASCII)

™ Dispersion Coefficient (ASCII)
[® Concentration (Unformatted)

" Options

CINACT = 1E+30
NPRS- 12

Output Time

3.16E+07

6.3E+07

9.45E+07

1.26E+08

1.676E+08

1.89E+08

~|o|on| | po =

2.205E+08

+

K
Cancel

Help

gl

Fig. 3.31 The MT3D Output Control dialog box with the Output Time table
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3.3.5 The Source Menu

The source menu is used for specifying the concentration of point or areally-distributed sources
or sinks. You specify the concentration of a particular source or sink by using the Data Editor.
Point sources include wells, genera-head boundary cells, constant head cells and rivers or
streams. Recharge is the only areally-distributed source whereas evapotranspiration is the only
snk whaose concentration can be specified. The concentration of asink cannot be greater than that
of the aquifer at the Snk cdll. If the Sink concentration is specified greater than that of the aquifer,
it isautomaticaly set equal to the concentration of the aquifer by MT3D. Note that MT3D does
not alow the concurrent use of the River Package (RIV 1) and the Streamflow-Routing Package
(STR1). This does not cause problems in any case, because the STR1 Package has all
functionality of the RIV 1 Package.

Menu items of the Source menu are dimmed if the corresponding hydraulic features given in the
Packages menu are not used (checked). You may or may not specify the concentration for the
sources or sinks when they are used in the flow ssimulation. The specified concentration will be
used in the transport simulation if a corresponding item of the Source menu is checked. If a
checked item is no longer necessary for atransport smulation, select the item again and deactivate
it. If the concentration of a source or sink is not specified, the default value for the concentration
is zero.

3.3.6 The Estimation Menu

The Egtimation menu provides an interface between PMWIN, the flow model MODFLOW and
the parameter estimation program PEST. Using PMWIN and PEST, the following parameters
and/or excitations can be calibrated:

Horizontal hydraulic conductivity or transmissivity
Vertical hydraulic conductivity or vertical leakance
Specific storage, specific yield or storage coefficient
Inelastic storage factor

Pumping rate of wells

Conductance of adrain, GHB, river or stream-cell.
Recharge flux

Maximum ET rate

Using the Control Data menu, you specify the necessary control values for a PEST operation.The
Parameter List gives an overview of estimated parameters and/or excitations. An estimated
parameter (e.g., transmissvity or pumping rate) is defined by using the Zone Input Method of the
Data Editor (see Define an Estimated Parameter below). The bore coordinates and observation
values are given in the Bores and Observations. Using PEST, modd parameters and/or excitations
can be adjusted until model-generated numbers fit the observation values as closely as possible.
That is, PEST searches an optimal parameter set for which the sum of squared deviations between
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model-generated observations and experimental observations is reduced to a minimum. This sum
isreferred to as the objective function @.

Control Data

Y ou specify the control data and excution/output options in the PEST Control Data dialog box
(Fig. 3.32). The data are used to set internal array dimensions of PEST, tune the optimisation
algorithm to the problem at hand, and set some data output options. The user can refer to the
manual of PEST for detailed information about the PEST a gorithm.

The items of the control data are described in details below. When in doubt, you should use the
default values given by PMWIN.

» RLAMBDA1

Thisred varigbleistheinitidl Marquardt lambda (see section 2.1.7 of the manual of PEST). PEST
attempts parameter improvement using a number of different Marquardt lambdas during any one
optimisation iteration; however, in the course of the overall parameter estimation process, the
Marquardt lambda generally gets smaler. Aninitial value of 1.0 to 10.0 is appropriate for many
models, though if PEST complains that the normal matrix is not positive definite, you will need
to provide a higher initial Marquardt lambda. For high values of the Marquardt parameter (and
hence of the Marquardt lambda) the parameter estimation process approximates the gradient
method of optimisation. While the latter method isinefficient and slow if used for the entirety of
the optimisation process, it often helps in getting the process started, especidly if initial parameter
estimates are poor.

Control data Yalue + oK I
RLAMBDAI 5 1
RLAMFAC 2 Cancel I
PHIRATSUF 3

PHIREDLAM .03 Help I
NUMLAM 10

RELPARMAX 5

FACPARMAX 5

FACORIG ool

PHIREDSWH 1

NOPTMAX 30 T

" Execution / Output Options

[% Write covariance matrix

X Write correlation coefficient matrix

% Write normalised eigenvector matrix

[~ Save data for a possible restart

[™ Include decimal point even if redundant

Fig. 3.32 The PEST Control Data dialog box

» RLAMFAC

RLAMFAC, ared variable, isthe factor by which the Marquardt lambda is adjusted. RLAMFAC
must be greater than 1.0. When PEST reduces lambda it divides by RLAMFAC; when it increases
lambdait multiplies by RLAMFAC. PEST reduces lambdaif it can. However if the normal matrix
is not positive definite or if areduction in lambda does not lower the objective function, PEST
has no choice but to increase lambda.
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» PHIRATSUF

During any one optimisation iteration, PEST may calculate a parameter upgrade vector using a
number of different Marquardt lambdas. First it lowers lambda and, if this is unsuccessful in
lowering the objective function, it then raiseslambda. If, at any stage, it calculates an objective
function which is a fraction PHIRATSUF or less of the starting objective function for that
iteration, PEST considers that the goal of the current iteration has been achieved and moves on
to the next optimisation iteration. Thus PEST will commence iteration i+1 if, at any stage during
iteration i

o
. ° < PHIRATSUF (3.42)

o-N

where @, _, isthe lowest objective function calculated for optimisation iteration i-1 (and hence the
starting value for optimisation iteration i) and ®!is the objective function corresponding to a
parameter set calculated using the j-th Marquardt lambda tested during optimisation iteration i.

PHIRATSUF (which stands for "phi ratio sufficient") isareal variable for which avaue of 0.3
is often appropriate. If it is set too low, model runs may be wasted in search of an objective
function reduction which it is not possible to achieve. If it is set too high, PEST may not be given
the opportunity of refining lambdain order that its value continues to be optimal as the parameter
estimation process progresses.

» PHIREDLAM

If anew/old objective function ratio of PHIRATSUF or lessis not achieved as the effectiveness
of different Marquardt lambdas in lowering the objective function is tested, PEST must use some
other criterion in deciding when it should move on to the next optimisation iteration. This
criterion is partly provided by the real variable PHIREDLAM.

The first lambdathat PEST employsin calculating the parameter upgrade vector during any one
optimisation iteration is the lambda inherited from the previous iteration, possibly reduced by a
factor of RLAMFAC (unlessit is the first iteration, in which case RLAMBDAL is used). Unless,
through the use of thislambda, the objective function is reduced to less than PHIRATSUF of its
value at the beginning of the iteration, PEST then tries another lambda, less by a factor of
RLAMFAC than the first. If the objective function is lower than for the first lambda (and still
above PHIRATSUF of the starting objective function), PEST reduces lambda yet again; otherwise
it increases lambda to a value greater by a factor of RLAMFAC than the first lambda for the
iteration. If, in its attempts to find a more effective lambda by lowering and/or raising lambdain
this fashion, the objective function beginsto rise, PEST accepts the |lambda and the corresponding
parameter set giving rise to the lowest objective function for that iteration, and moves on to the
next iteration. Alternatively if the relative reduction in the objective function between the use of
two consecutive lambdas is less than PHIREDLAM, PEST takes this as an indication that it is
probably more efficient to begin the next optimisation iteration than to continue testing the effect
of new Marquardt lambdas. Thus if
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(9, - @)

< PHIREDLAM (3.43)
[-n

(I)®
where CD’, is the objective function value calculated during optimisation iteration i using the j-th
trial lambda, PEST moves on to iteration i+1.

A suitable value for PHIREDLAM s often around 0.01. If it is set too large, the criterion for
moving on to the next optimisation iteration is too easily met and PEST is not given the
opportunity of adjusting lambda to its optimal value for that particular stage of the parameter
estimation process. On the other hand if PHIREDLAM s set too low, PEST will test too many
Marquardt lambdas on each optimisation iteration when it would be better off starting on a new
iteration.

» NUMLAM

This integer variable places an upper limit on the number of lambdas that PEST can test during
any one optimisation iteration. It should normally be set between 5 and 10. For cases where
parameters are being adjusted near their upper or lower limits, and for which some parameters are
consequently being frozen (thus reducing the dimension of the problem in parameter space)
experience has shown that avalue closer to 10 may be more appropriate than one closer to 5; this
gives PEST a greater chance of adjusting to the reduced problem dimension as parameters are
frozen.

» RELPARMAX and FACPARMAX

There should be some limit placed on the amount by which parameter values are allowed to
change in any one optimisation iteration. If there is no limit, parameter adjustments could
regularly "overshoot” their optimal values, causing alengthening of the estimation process at best,
and ingtability with consequential estimation failure at worst; the dangers are greatest for highly
nonlinear problems.

PEST provides two real variables which can be used to limit parameter adjustments; these are
RELPARMAX and FACPARMAX. RELPARMAX is the maximum relative change that a
parameter is alowed to undergo between optimisation iterations, whereas FACPARMAX isthe
maximum factor change that a parameter is allowed to undergo. Any particular parameter can be
subject to only one of these condraints; i.e., a particular parameter must be either relative-limited
or factor-limited in its adjustments. Parameters are denoted as either relative-limited or
factor-limited through the variable PARCHGLIM supplied for each parameter in the Parameter
List, see below.

The relative change in parameter b between optimisation iterationsi-l and i is defined as

(0, - b)
b

N

(3.44)
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If parameter b is relative-limited, the absolute value of this relative change must be less than

RELPARMAX. If a parameter upgrade vector is calculated such that the relative adjustment
for one or more relative-limited parametersis greater than RELPARMAX, the magnitude of
the upgrade vector is reduced such that this no longer occurs.

The factor change for parameter b between optimisation iterations i-l and i is defined as

b,/ b, if |o,.d > lbj, or
by/b,.o if b) > |b,d (3.45)

If parameter b isfactor-limited, thisfactor change (which either equals or exceeds unity according
to equation 3.45) must be less than FACPARMAX. If a parameter upgrade vector is calculated
such that the factor adjustment for one or more factor-limited parameters is greater than
FACPARMAX, the magnitude of the upgrade vector is reduced such that this no longer occurs.

Whether a parameter should be relative-limited or factor-limited depends on the parameter.
However you should note that a parameter can be reduced from its current value right down to
zero for arelative change of only 1. If you wish to limit the extent of its downward movement
during any one iteration to less than this, you may wish to set RELPARMAX to, for example, 0.5;
however this may unduly redtrict its upward movement. It may be better to declare the parameter
asfactor-limited. If so, a FACPARMAX value of, say 5.0, would limit its downward movement
on any oneiteration to 0.2 of its value at the start of the iteration and its upward movement to 5
times its starting value. This may be a more sensible approach for many parameters.

It is important to note that a factor limit will not allow a parameter to change sign. Hence if a
parameter must be free to change sign in the course of the optimisation process, it must be
relative-limited; furthermore RELPARMAX must be set at greater than unity or the change of
sign will be impossible. Thus the utility program PESTCHEK (see section 3.3.9) will not allow
you to declare a parameter as factor-limited, or asrelative-limited with the relative limit of less
than 1, if its upper and lower bounds are of opposite sign. Similarly, if a parameter's upper or
lower bound is zero, it cannot be factor-limited and RELPARMAX must be at least unity.

Suitable valuesfor RELPARMAX and FACPARMAX can vary enormously between cases. For
highly non-linear problems, these values are best set low. If they are set too low, however, the
estimation process can be very dow. An ingpection of the PEST run record (by pressing the ESC
key) will often show whether you have set these values too low, for PEST records the maximum
parameter factor and relative changes on thisfile at the end of each optimisation iteration. If these
changes are aways at their upper limits and the estimation process is showing no signs of
instability, it is quite possible that RELPARMAX and/or FACPARMAX could be increased.

If RELPARMAX and FACPARMAX are set too high, the estimation process may fail. If PEST
seems to be making no progress in lowering the objective function and an inspection of the PEST
run record shows that some or al parameters are undergoing large changes at every optimisation
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iteration, then it would be agood idea to reduce RELPARMAX and/or FACPARMAX. Ancther
sign that these variables may need to be reduced is if PEST rapidly adjusts one or a number of
parametersto their upper or lower bounds, and the latter are set far higher or lower than what you
would expect the optimal parameter values to be; a further sign is if, rather than lowering the
objective function, PEST estimates parameter values for which the objective function isincredibly
high.

If you are unsure of how to set these parameters, a value of 5 for each of them is often suitable.
In cases of extreme nonlinearity, be prepared to set them much lower. Note, however, that
FACPARMAX can never be less than 1; RELPARMAX can be less than 1 as long as no
parameter's upper and lower bounds are of opposite sign. (If necessary, use the parameter
OFFSET variable to shift the parameter domain so that it does not include zero.)

» FACORIG

If, in the course of the estimation process, a parameter becomes very small, the relative or factor
limit to subsequent adjustment of this parameter may severely hamper its growth back to higher
values, resulting in very slow convergence to an objective function minimum. Furthermore, for
the case of relative-limited parameters which are permitted to change sign, it is possible that the
denominator of equation 3.44 could become zero.

To obviate these possibilities, choose a suitable value for the rea variable, FACORIG. If the
absolute value of a parameter falls below FACORIG times its original value, then FACORIG
times its origina value is substituted for the denominator of equation 3.44. For factor-limited
parameters, a similar modification to equation 3.45 applies. Thus the constraints that apply to a
growth in absolute value of a parameter are lifted when its absolute value has become less than
FACORIG times its original absolute value. However, where PEST wishes to reduce the
parameter's absolute value even further, factor-limitations are not lifted; nor are relative limitations
lifted if RELPARMAX islessthan 1. FACORIG is not used to adjust limits for log-transformed
parameters.

FACORIG must be greater than zero. A value of 0.001 is often suitable.

» PHIREDSWH

The derivatives of observations with respect to parameters can be calculated using either forward
differences (involving two parameter-observation pairs) or one of the variants of the central
method (involving three parameter-observation pairs) described in Section 2.3.1 of the manual
of PEST. As discussed below in Parameter List, you must inform PEST through the group
variables FORCEN and DERMTHD which method is to be used for the parameters belonging to
each parameter group.

Using the variable FORCEN, you may wish to decree that, for a particular parameter group,
derivatives will first be calculated using the forward difference method and later, when PEST is
faltering in its attempts to reduce the objective function, calculated using one of the central
methods. Alternatively, you may direct that no such switching take place, the forward or central
method being used at all times for the parameters belonging to a particular group. In the former
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case you must provide PEST with a means of judging when to make the switch; thisistherole
of the real variable PHIREDSWH.

If the relative reduction in the objective function between successive optimisation iterationsis less
than PHIREDSWH, PEST will make the switch to three-point derivatives calculation for those
parameter groups for which the character variable FORCEN has the value "switch"; thusif, for
thei'th iteration

(®,,-2)
®

o-N

< PHIREDSWH (3.46)

(where O, is the objective function calculated on the basis of the upgraded parameter set
determined in the i'th iteration), then PEST will use central derivativesin iterationi + 1 (and all
succeeding iterations) for al parameter groups for which FORCEN is "switch". A value of 0.1
is often suitable for PHIREDSWH. If it is set too high, PEST may make the switch to three-point
derivatives calculation too early. The result will be that more model runswill be required to fill
the Jacobian matrix than are really needed at that stage of the estimation process. If
PHIREDSWH is set too low, PEST may waste an optimisation iteration or two in lowering the
objective function to a smaller extent than would have been possible, if it had made an earlier
switch to central derivatives calculation. Note that PHIREDSWH should be set considerably
higher than the input variable PHIREDSTP which sets one of the termination criteria on the basis
of the relative objective function reduction between optimisation iterations.

» NOPTMAX

NOPTMAX sets the maximum number of optimisation iterations that PEST is permitted to
undertake on a particular parameter estimation run. If you want to ensure that PEST termination
istriggered by other criteria, more indicative of parameter convergence to an optimal set or of the
futility of further processing, you should set this variable very high. A value of 20 to 30 is often

appropriate.

» PHIREDSTP and NPHISTP
PHIREDSTP isareal variable whereas NPHISTP is an integer variable. If, in the course of the
parameter estimation process, there have been NPHISTP optimisation iterations for which

((I)e B (I)j®<<)
— % < PHIREDSTP (3.47)

@

(®, being the objective function value at the end of the i-th optimisation iteration and @, being
the lowest objective function achieved to date), PEST will consider that the optimisation process
isat an end.

For many cases 0.01 and 3 are suitable values for PHIREDSTP and NPHISTP respectively.
However you must be careful not to set NPHISTP too low if the optima values for some
parameters are near or at their upper or lower bounds (as defined by the parameter variables
PARLBND and PARUBND discussed in Parameter List). In this case it is possible that the
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magnitude of the parameter upgrade vector may be cut down over one or a number of
optimisation iterations to ensure that no parameter value overshoots its bound. The result may
be smaller reductionsin the objective function than would otherwise occur. It would be a shame
if these reduced reductions were mistaken for the onset of parameter convergence to the optimal
Set.

» NPHINORED
If PEST hasfailed to lower the objective function over NPHINORED successive iterations, it will
terminate execution. NPHINORED is an integer variable; avalue of 3 is often suitable.

» RELPARSTP and NRELPAR

If the magnitude of the maximum relative parameter change between optimisation iterationsis less
than RELPARSTP over NRELPAR successiveiterations, PEST will cease execution. The relative
parameter change between optimisation iterations for any parameter is calculated using equation
3.44. PEST evaluates this change for all adjustable parameters at the end of each optimisation
iteration, and determines the relative parameter change with the highest magnitude. If this
maximum relaive changeislessthan RELPARSTP, a counter is advanced by one; if it is greater
than RELPARSTP, the counter is zeroed.

All adjustable parameters, whether they are relative-limited or factor-limited, are involved in the
cdculaion of the maximum relative parameter change. RELPARSTP is areal variable for which
avalue of 0.01 is often suitable. NRELPAR is an integer variable; avalue of 2 or 3 isnormally
satisfactory.

The Excution/Output Options of the PEST Control Data dialog box are described below:
» Write covariance matrix, write correlation coefficient matrix and write normalised
eigenvector matrix

After the optimisation process is complete, one of the termination criteria having been met (or
perhaps another termination criterion such as zero objective function or zero objective function
gradient, for which no user-supplied settings are required) PEST writes some information
concerning the optimised parameter set to its run record file PESTCTL.REC. Thisfileis saved
in the data directory of your model. It tabulates the optimal values and the 95% confidence
intervals pertaining to al adjustable parameters. It aso tabul ates the model-cal culated observation
set based on these parameters, together with the residuals, i.e., the differences between measured
and model-calculated observations. Then, if you wish, PEST will write the parameter covariance
matrix, the parameter correlation coefficient matrix and the matrix of normalised eigenvectors of
the covariance matrix to the run record file.

» Save data for a possible restart

If thisoption is checked, PEST will dump the contents of many of its data arrays to a binary file
at the beginning of each optimisation iteration; this allows PEST to be restarted later if execution
is prematurely terminated. If subsequent PEST execution isinitiated using the "/r" command line
switch (see Section 5. 1.6 of the PEST manual), it will recommence execution at the beginning
of the iteration during which it was interrupted.
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If this option is not checked, PEST will not dump its array data at the beginning of each
optimisation iteration so that a later recommencement of execution after premature termination
isimpossible.

» Include decimal point even if redundant

If this option is not checked, PEST will omit the decimal point from representations of parameter
vaues on model input filesif the decima point is redundant, thus making room for the use of one
extrasgnificant figure. If this option is checked, PEST will ensure that the decimal point is aways
present.

Parameter List

The Parameter List gives an overview of estimated parameters and parameter groups. An
estimated parameter is defined by using the Zone Input Method of the Data Editor. Follow the
steps below to define an estimated parameter.

Define an Estimated Paramter

From the Parameters or Packages menu, select a menu item (e.g., Horizontal Hydraulic
Conductivity, Well or Drain, etc..).

The Data Editor appears.

Change to the Zone Input Method (see section 3.2).

3. Draw azonethat covers the area where the parameter value will be estimated. If you intend
to cdibrate the pumping rate of wells or the conductance of head-dependent cells (e.g., drain,
GHB, river or stream cells), you must first use the Cell-by-cell Input Method to define those
cells. Then, you just need to draw a zone that covers them. These cells will have the same
pumping rate or conductance during a calibration process. It is allowed that the zone covers
other cells, which are not defined as well or head-dependent cells.

Move the mouse cursor into the zone. The zone will be highlight (blue).

Click the right mouse button once.

The Data Editor shows adialog box for specifying value(s). Y ou can specify new value(s) in

the didog and dlick [22] to transfer the zone value(s) to the cells within the zone. The zone
value(s) has, however, nothing to do with the parameter estimation.

6. Click the button

The Parameter List dialog box appears (Fig. 3.33).
7. Sedlect aparameter (arow) from the Parameter Data table and change the appropriate settings
inthisrow. The zone is associated with this parameter (row). A parameter must be associated
with agroup defined in the Group Definition and Derivative Data table. More than one zones
can be associated with a parameter and more than one parameter can be associated with a
group. A parameter will only be estimated by PEST, if the Activeflagis set to YES. You can
switch the flag between YES and NO by clicking on the flag.
Click OK to accept the change.
In the dialog box, click OK to return to the Data Editor.

v

N

ok

©
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= Parameter List
Parameter Data: ‘
Name |Active |Description PARVAL1 |[PARLEBND PARUBND PART ¢
= 0o 0000 0Q
P2 Yes T2 300 1 10000 Log-t{
P3 Yes T3 300 1 10000 Log-t
P4 No 1] 1] 0 None|
4]
«[] -]
Group Definitions and Derivative Data
Name |Description INCTYP DERINC DERINCLEB FO| 4
Relative 0 0
G2 t2 Relative .01 0 Swi
G3 t3 Relative .m 0 Sw|
G4 Relative .m 0 Sw:l
3
“[] -]
Prior Information
No.  |Active |Prior Information +
1 No
2 No +
| Help I | Cancel I | 0K I

Fig. 3.33 The Parameter List dialog box

The items of the Parameter List dialog box are described in details below.

>

Parameter Data

Name is the parameter name given by PMWIN. The parameter name of the first parameter
isP1. The parameter name of the second parameter is P2 and so on. The maximum number
of paramtersis 150.

Active: A parameter will only be estimated by PEST, if the Active flag is set to YES. Y ou can
switch the flag between YES and NO by clicking on the flag.

Description is aplace for you to take notes. A Maximum of 120 charactersis allowed.

PARVALL1 isaparameter'sinitia value. For afixed parameter, this value remains invariant
during the optimisation process. For atied parameter, the ratio of PARVAL1 to the parent
parameter's PARVALL sets the ratio between these two parameters to be maintained
throughout the optimisation process. For an adjustable parameter PARVALL is the
parameter's starting value which, together with the starting values of all other adjustable
parameters, is successively improved during the optimisation process. To enhance
optimisation efficiency, you should choose an initial parameter value which is close to what
you think will be the parameter's optimised value. However you should note the following
repercussions of choosing an initial parameter value of zero.

1. A parameter cannot be subject to change limits (see the discussion on RELPARMAX and
FACPARMAX) during the first optimisation iteration if its value at the start of that
iteration is zero. Furthermore FACORIG cannot be used to modify the action of
RELPARMAX and FACPARMAX for aparticular parameter throughout the optimisation
process, if that parameter's original value is zero.

2. A relative increment for derivatives calculation cannot be evaluated during the first
iteration for a parameter whose initial value is zero. If the parameter belongs to a group
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for which derivatives are, in fact, calculated as Relative (see INCTYP and DERINC
below), a non-zero DERINCLB variable must be provided for that group.

3. If aparameter has aninitia value of zero, the parameter can be neither atied nor a parent
parameter as the tied/parent parameter ratio cannot be calculated.

 PARLBND and PARUBND represent a parameter's lower and upper bounds respectively. For
adjustable parameters the initial parameter value (PARVAL1) must lie between these two
bounds. However for fixed and tied parameters the values you provide for PARLBND and
PARUBND are ignored. (The upper and lower bounds for atied parameter are determined
by the upper and lower bounds of the parameter to which it istied and by the ratio between
the tied and parent parameters.)

* PARTRANS controls the parameter transformation. By clicking on the PARTRANS column,
thisflag can be set as None, Log-transformed, Tied or Fixed. Use Log-transformed, if you
wish that a parameter be log-transformed throughout the estimation process. Logarithmic
transformation of some parameters may have a profound affect on the success of the
parameter estimation process. If a parameter is log-transformed PEST optimises the log of
the parameter rather than the parameter itself. At the end of the parameter estimation process,
PEST provides the optimised parameter value itself rather than the log of its value.
Experience has shown repeatedly that log transformation of at |east some parameters can
make the difference between a successful parameter estimation run and an unsuccessful one.
Thisis because, in many cases, the linearity approximation on which each PEST optimisation
iteration is based holds better when certain parameters are log-transformed. However caution
must be exercised when designating parameters as log-transformed. A parameter which can
become zero or negative in the course of the parameter estimation process must not be
log-transformed; hence if a parameter's lower bound is zero or less, PEST will disallow
logarithmic transformation for that parameter. Note, however, that by using an appropriate
scale and offset, you can ensure that parameters never become negative. Thus if you are
estimating the value for a parameter whose domain, as far as the model is concerned, is the
interval [-9.99, 10], you can shift this domain to [0.01, 20] for PEST by designating a scale
of 1.0 and an offset of -10.0. Smilarly if aparameter's model domain is entirely negative, you
can make this domain entirely positive for PEST by supplying a scale of -1.0 and an offset of
0.0. See the discussion on the SCALE and OFFSET variables below.

If a parameter is fixed, taking no part in the optimisation process, PARTRANS must be
supplied as Fixed. If a parameter is linked to another parameter, this is signified by a
PARTRANS value of Tied. In the latter case the parameter takes only alimited rolein the
estimation process. However the parameter to which the tied parameter is linked (this
"parent” parameter must be neither fixed nor tied itself) takes an active part in the parameter
estimation process; the tied parameter ssimply "piggy-backs’ on the parent parameter, the
vaue of the tied parameter maintaining at al times the same ratio to the parent parameter as
the ratio of their initial values. If a parameter is neither fixed nor tied, and is not
log-transformed, the parameter transformation variable PARTRANS must be supplied as
None.
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PARCHGLIM is used to designate whether an adjustable parameter is relative-limited or
factor-limited. For tied or fixed parameters PARCHGLIM has no significance. See the
discussion on RELPARMAX and FACPARMAX.

PARGP is the number of the group to which a parameter belongs.

PARTIED isthe number of the "parent” parameter to which a parameter is linked. See also
PARTRANS.

SCALE and OFFSET: Just before a parameter value is written to an input file of
MODFLOW, it is multiplied by the real variable SCALE, after which the real variable
OFFSET is added. The use of these two variables allows you to redefine the domain of a
parameter. Because they operate on the parameter value "at the last moment” before it is sent,
they take no part in the estimation process; in fact they can "conceal" from PEST the true
value of aparameter as seen by the model, PEST optimising, instead, the parameter b, where

b = (b, - 0)/s (3.48)

Hereb, isthe parameter optimised by PEST, b, is the parameter seen by the model, while s
and o are the scale and offset for that parameter. If you wish to leave a parameter unaffected
by scale and offset, enter the SCALE as 1.0 and the OFFSET as 0.0.

Group Definitions and Derivative Data

Name is the group name given by PMWIN. The group name of the first parameter group is
G1. The group name of the second parameter group is G2 and so on. The maximum number
of paramter groupsis 150.

Description is a place for you to take notes. A maximum of 120 charactersis allowed.

INCTYP and DERINC: INCTYP can be Relative, Absolute or Rel_to_max. If it is
Relative, the increment used for forward-difference calculation of derivatives with respect
to any parameter belonging to the group is caculated as a fraction of the current value of that
parameter; that fraction is provided asthered variable DERINC. If INCTY P is Absolute the
parameter increment for parameters belonging to the group is fixed, being again provided as
the variable DERINC. Alternatively, if INCTYPisRel_to_max, the increment for any group
member is calculated as a fraction of the group member with highest absolute value, that
fraction again being DERINC. See Section 2.3 of the PEST manual for afull discussion of
the methods used by PEST to calculate parameter derivatives.

Thus if INCTYP is Relative and DERINC is 0.01 (a suitable value in many cases), the
increment for each group member for each optimisation iteration is calculated as 0.01 times
the current value of that member. However if INCTYP is Absolute and DERINC is 0.01, the
parameter increment isthe same for al members of the group over all optimisation iterations,
being equd t0 0.01. If INCTYPisRel_to_max and DERINC is again 0.01, the increment for
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al group members is the same for any one optimisation iteration, being equal to 0.01 times
the absolute value of the group member of highest current magnitude; however the increment
may vary from iteration to iteration.

If a group contains members which are fixed and/or tied you should note that the values of
these parameters are taken into account when calculating parameter increments using the
Rel_to_max option. For the Relative and Rel_to_max options, a DERINC value of 0.01 is
often appropriate. However no suggestion for an appropriate DERINC value can be provided
for the Absolute increment option; the most appropriate increment will depend on parameter
magnitudes.

« DERINCLB: If aparameter increment is calculated as Relative or Rel_to_mayx, it is possible
that it may become too low if the parameter becomes very small or, in the case of the
Rel_to_max option, if the magnitude of the largest parameter in the group becomes very
small. A parameter increment becomes "too low" if it does not alow reliable derivatives to
be calculated with respect to that parameter because of roundoff errors incurred in the
subtraction of nearly equal model-generated observation values. To bypass this possibility,
an absolute lower bound can be placed on parameter increments; this lower bound will be the
same for all group members, and is provided as the input variable DERINCLB. Thus if a
parameter vaue is currently 1000.0 and it belongs to a group for which INCTY P is Relative,
DERINC is 0.01, and DERINCLB is 15.0, the parameter increment will be 15.0 instead of
10.0 calculated on the basis of DERINC alone. If you do not wish to place alower bound on
parameter increments in this fashion, you should provide DERINCLB with a value of 0
(zero). Note that if INCTYP is Absolute, DERINCLB isignored.

+ FORCEN can be Always_2, Always_3 or Switch. It determines whether derivatives for
group members are calculated using forward differences, one of the variants of the central
difference method, of whether both aternatives are used in the course of an optimisation run.
If FORCEN for aparticular group is Always_2, derivatives for all parameters belonging to
that group will aways be calculated using the forward difference method; As described in the
section 2.3.1 of the PEST manud, filling of the columns of the Jacobian matrix corresponding
to members of the group will require as many model runs as there are adjustable parameters
in the group. If FORCEN is provided as Always_3, the filling of these same columns will
require twice as many model runs as there are parameters within the group; however the
derivatives will be calculated with greater accuracy and this will probably have a beneficia
effect on PEST's performance. If FORCEN is set to Switch, derivatives calculation for all
adjustable group members will begin using the forward difference method, switching to the
central method for the remainder of the estimation process on the iteration after the relative
objective function reduction between successive optimisation iterations is less than
PHIREDSWH defined in the Control Data.

Experience has shown that in most instances the most appropriate value for FORCEN is
Switch. This alows speed to take precedence over accuracy in the early stages of the
optimisation process when accuracy is not critical to objective function improvement, and
accuracy to take precedence over speed later in the process when realisation of a (normally
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smaller) objective function improvement requires that derivatives be calculated with as much
accuracy as possible, especidly if parameters are highly correlated and the normal matrix thus
approaches singularity.

« DERINCMUL: If derivatives are calculated using one of the three-point methods (see
DERMTHD), the parameter increment is first added to the current parameter value prior to
a modd run, and then subtracted prior to another model run. In some cases it may be
desirable to increase the value of the increment for this process over that used for forward
difference derivatives caculaion. Thered variable DERINCMUL allows you to achieve this.
If three-point derivatives calculation is employed, the value of DERINC is multiplied by
DERINCMUL,; this applies whether DERINC holds the increment factor, as it does for
Relative or Rel_to_max increment types, or holds the parameter increment itself, as it does
for Absolute increment types.

For many models the relationship between observations and parameters, while being in theory
continuoudly differentiable, is often "granular" when examined under the microscope, this
granularity being a by-product of the numerical solution scheme used by the model. In such
cases the use of parameter increments which are too small may lead to highly inaccurate
derivatives calculation, especidly if the two or three sets of parameter-observation pairs used
in a particular derivative calculation are on the same side of a "bump" in the
parameter-observation relationship. Parameter increments must be chosen large enough to
cope with mode output granularity of this type. But increasing parameter increments beyond
acertain amount diminishes the extent to which finite differences can approximate derivatives,
the definition of the derivative being the limit of the finite difference as the increment
approaches zero. However, the deterioration in the derivative approximation as increments
areincreased is normally much greater for the forward difference method than for any of the
central methods (particularly the Parabolic option, see below). Hence, the use of one of the
central methods with an enhanced derivative increment may allow you to calculate derivatives
in an otherwise hostile modeling environment.

Whenever the centra method is employed for derivatives calculation, DERINC is multiplied
by DERINCMUL, no matter whether INCTYPis Absolute, Relative or Rel_to_max, and
whether FORCEN is Always_2, Always_3 or Switch. If you do not wish the increment to
be increased, you must provide DERINCMUL with avalue of 1.0. Alternatively, if for some
reason you wish the increment to be reduced if three-point derivatives calculation is
employed, you should provide DERINCMUL with avaue of less than 1.0. Experience shows
that a value between 1.0 and 2.0 is usually satisfactory.

« DERMTHD: There are three variants of the central (ie. three-point) method of derivatives
calculation; each method is described in Section 2.3.1 of the manual of PEST. If FORCEN
for a particular parameter group is Always_3 or Switch, you must inform PEST which
three-point method to use. Thisis accomplished through the character variable DERMTHD
which must be supplied as Parabolic, Best_fit or Outside_pts. If FORCEN is Always_2,
the value of DERMTHD has no bearing on derivatives caculation for the member parameters.
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» Prior Information

It often happens that we have some information concerning the parameters that we wish to
optimise, and that we obtained this information independently of the current experiment. This
information may bein the form of other, unrelated, estimates of some or all of the parameters, or
of relationships between parameters. It is often useful to include this information in the parameter
estimation process both for the philosophical reason that it is a shame to withhold it, and secondly
because this information may lend stability to the process.

To activate aprior information line, set the Active flag to Y ES of the Prior Information table and
give the prior information equation in the Prior Information column. The syntax of a prior
information equation is

PIFAC * PARNME + PIFAC * log(PARNME) .... = PIVAL WEIGHT

To theleft of the "=" sign there are one or more combinations of afactor (PIFAC) plus parameter
name (PARNME), with a"log" prefix to the parameter name if appropriate. PIFAC and PARNME
are separated by a™*" character (which must be separated from PIFAC and PARNME by at |east
one space) signifying multiplication. All parameters referenced in a prior information equation
must be adjustable parameters; ie. you must not include any fixed or tied parametersin a prior
information equation. Furthermore, any particular parameter can be referenced only once in any
one prior information equation. If a parameter is log-transformed, you must provide prior
information pertinent to the log (to base 10) of that parameter. The parameter name must be
placed in brackets and preceded by "log" (note that there is no space between "log" and the
following opening bracket). Care must be used here, because PMWIN does not check the prior
information equation. However, you can use the program PESTCHEK (Doherty et al., 1994)
included in PMWIN to check the PEST data (see the Run Menu).

To theright of the"=" sign of each prior information equation are two real variablesviz. PIVAL
and WEIGHT. The former is the value of the right side of the prior information equation. The
latter is the weight pertaining to the article of prior information in the parameter estimation
process. The weight should be inversely proportional to the standard deviation of the prior
information value (PIVAL); it can be zero if you wish, but not be negative.

The following lines show some examples, refer to Doherty et a. (1994) for more details about
the prior information.

1.0 *log(P1) + 1.2 * log(P2) =-5.6 1.0
1.0*P1+1.455*P2-3.98*P3+2.123 * P4 =1.03E-3 2.00
212*P3+3.2*P6=1.3442.20

Bores and Observations

In the Bores and Observation dialog box (Fig. 3.34), you specify the eastings (x), northings (y)
and layer numbers of each bore in Table of Bores. A boreis activeif the Active flag in the table
is set to YES. When you edit model data, active bores and the corresponding bore number will
be shown on the screen by the Data Editor (Fig. 3.35). For transient smulations, PMWIN
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interpolates the simul ation results to the active bores, and you can use the Graphs (see Chapter
4) menu to see the time-related line graphs (e.g., Head-time curves).

In Table of Observations, you specify the bore number in the Bore column. The observation time
is given in the Time column. This is the time, measured from the start of the model simulation,
to which the measured head, drawdown, concentration, compaction, preconsolidation head and
subsidence value pertains. Using the Graph Viewer (see Chapter 4), you can create line graphs
based on the observation vaues. (Note that drawdown is defined by h, - h, where h,_is the starting

hydraulic head and h is the measured head at the observation time.)

Using the buttons Save and Load, you can save or load the contents of the tablesin or from a
Borefile or Observation file. The format of these filesis given in Appendix 2. You can insert or
delete arow of the tables by pressing the Ctrl+Ins or Ctrl+Del key. In PMWIN, the maximum
number of boresis 1000. The maximum number of observations is 6000.

For the model calibration, PEST uses the observed head or drawdown values only when the
observation times correspond to one of the smulation times at which MODFLOW writes the
gmulation resultsto its unformatted (binary) files, i.e, HEADS.DAT or DDOWN.DAT. If it does
not correspond to such atime, the observation value will beignored. It is PEST's role to minimise
the difference (residual) between the observation value and the corresponding model-cal culated
number by adjusting parameter values until the sum of squared weighted residuals (ie. the
objective function ® ) isa aminimum. The weight attached to each residual in the calculation of
the objective function is given in the Weight column of the observation table. An observation
weight can be zero if you wish (meaning that the observation takes no part in the calculation of
the objective function), but it must not be negative. Refer to the PEST manual for the
functionality of weightsin the parameter estimation process.

= Bores and Observations
| Table of Bores
,
Bore |Active |x ¥ layer =
1 Yes | 250 -350 1 —
2 Yes | 250 -450 1
3 Yes | 250 550 i
4 Yes | 350 -350 1
b Yes | 350 -550 1
[ Yes | 450 -350 1 +
| Save. .. | | Load... I | Clear |
 Table of Observations
Bore |Time Weight |Head Drawdown Il
1 30 1 2b.50655 0 —
1 60 1 27.00705 0
1 a0 1 27.04515 0
1 120 1 20.57287 0
1 150 1 20.07482 0 +
«[ T -+
| Save... | | Load... I | Clear |
" Options ;
® Use observed heads for the calibration:
O Use observed drawdowns for the calibration

Fig. 3.34 The Bores and Observations dialog box
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= Processing Modflow - [PESTEX.MDL] e
File Value Options Help
B ETR/IRBe]@=e= [ ]
4}9 -éﬂ
*bw {}4 *bs
4*3 4>5 $8
4}10 4}12
| 6763026 -4410828 | 111 [Time inclependent [Transmissivity [L"2/T]
300

Fig. 3.35 Active bores and the bore number
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3.3.7 The Value Menu

The Vaue menu appears only in the Data Editor. The menu items are described below.

Matrix
There are two items Reset and Browse in the submenu Matrix.

» Reset

Using Reset you can specify avauein the Reset Matrix dialog box (Fig. 3.36). The value will be
assigned to all finite-difference cells in the current layer. If you are editing a particular package,
in which acell has more than one value (e.g., River Package as shown in Fig. 3.37), al valuesin
the dialog will be assigned to all cellsin the current layer.

= Reset Matrix

Elevation of the Layer Bottom [L]: 0

|12 Cancel

Caution:
All cell values in the current layer will be
replaced by the value specified above.

Fig. 3.36 The Reset Matrix dialog box

Reset Matrix

‘

Hydraulic Conductance of the Riverbed [L"2/T]: K

.0m
Cancel
Head in the River [L]:

pesiinie e

Elevation of the Riverbed Bottom [L]:

10

specified above.

Caution:
Il cell values in the current layer will be replaced by the values

Fig. 3.37 The Reset Matrix dialog box for the River Package

» Browse

Using Browse you can examine cell values in the Browse Matrix dialog box (Fig 3.38). The
spreadsheet displays a series of columns and rows, which are corresponding to the columns and
rows of the finite-difference grid. The cell data are shown in the spreadshest. If you are editing
a particular package, in which a cell has more than one values (e.g., River Package), you can
select a parameter type from the Parameter drop-down box. The Column Width drop-down box
is used to change the appearance width of the columns of the spreadsheet.

Y ou can save the cdll datain an ASCI1 Matrix file by clicking the Save button and specifying the
file name in a standard file open dialog box. An ASCIl Maitrix file can be loaded into the
spreadshest at a later time. The format of the ASCII matrix fileis described in Appendix 2.
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Parameter: Column Width
|H0rizontal Hydraulic Conductivity |£| |14 gl

13 14 15 16 17 +
22 2.9221E-04 1.01632E-03 4.6885E-04 6.92151E-04 1.03861E-
23 3.38198E-04 4.39978E-04 5.73478E-04 9.11934E-04 1.19067E-
24 2.68443E-04 3.47362E-04 6.01774E-04 7.56159E-04 1.22076E-

25 4.68605E-04 4.68754E-04 1.58081E-03 1.23178E-03 4.53184E-
26 6.66174E-04 2.90403E-04 5.48027E-04 7.85387E-04 3.13501E-
27 3.01564E-04 2.44377E-04 2.15774E-04 1.33784E-04 4.10016E-
28 9.60952E-04 5.78082E-04 2.77989E-04 2.83251E-04 6.04779E-

29 0017704 9.28068E-04 9.45196E-04 8.25394E-04 2.05754E- :I
30 8.87563E-04 1.13588E-03 1.37807E-03 1.75707E-03 1.57262E-
] 001329 2.90043E-03 2.89293E-03 1.25639E-03 1.07987E-
32 2.62047E-03 1.62675E-03 0016789 1.57719E-03 1.08088E-
33 1.24068E-03 1.39345E-03 5.71724E-04 5.03016E-04 8.53189E-
34 7.53322E-04 4.25868E-04 5.156742E-04 3.5221E-04 4.55966E-

35 1.45341E-04 1.97768E-04 1.57381E-04 2.57363E-04 5.59864E-
36 1.10181E-03 3.76624E-04 3.99858E-04 6.97514E-04 3.81023E-

37 5.77998E-04 1.14111E-03 1.28299E-03 7.5161E-04 1.267169E-

36 1.35955E-03 8.29091E-04 6.90295E-04 8.03199E-04 9.06988E-

39 8.91863E-04 -oo10087 1.02246E-03 7.45047E-04 3.23402E-

40 1.36072E-03 8.09579E-04 3.5184E-04 5.2798E-04 4.80466E-

41 9.26306E-04 4.09068E-04 4.21967E-04 4.4923E-04 4. 47638E- EI
. L1 4]

| Load... || Save... || Cancel || OK |

Fig. 3.38 The Browse Matrix dialog box

» To load an ASCII Matrix file
1. Click the Load button.
A Load Matrix dialog box appears (Fig. 3.39)

Click =] and select an ASCII Matrix file from the standard open file dialog box.
3. Specify the starting position.
As shown in Fig. 3.40, the starting position gives the column and row at which an ASCII
Matrix will be loaded. The numbers of rows and columns of the ASCII matrix need not to be
identical asthose of the finite-difference grid. Thisalowsyou to replace only a part of the cell
data by the matrix. For example, you can use the Field Generator to generate a matrix with
heterogeneoudly distributed data from statistical parameters and load it into the grid.
4. Select an option from the Options group.
Just before aloaded matrix is sent to the spreadsheet, there are some possibilities to modifiy
its values.
Replace:  The cell datain the spreadsheet are replaced by those of the ASCII Matrix.
Add: The cell values of the ASCII Matrix are added to those of the spreadshest.
Subtract:  Thecdll datain the spreadsheet are subtracted from those of the loaded matrix.
Multiply:  The cell datain the spreadsheet are multiplied by those of the loaded matrix.
Divide: The cell datain the spreadsheet are divided by those of the loaded matrix. If a
cdll data of the loaded matrix is equal to zero, the corresponding cell datain the
spreadsheet remains unchanged.

N

The Browse and Load Matrix dialog boxes provide you possibilities of manipulating your model
data. For example, you can caculate the layer thickness by subtracting the bottom elevation from
the top elevation.
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= Load Matrix

File:

| dApmwiniexamples\pmexia_matrix.dat ‘ ‘

Start Positon [ [Options |
Column (J): Row(l): ® Replace

C Add
| 0y ] CSuben
Maximum Numbers: C Multiply
Column= 57; Row= 55 C Divide

Fig. 3.39 The Load Matrix dialog box

—Starting position

ASCII Matri

Finite-difference Grid
LT T T T T T 7

Fig. 3.40 The starting position of aloaded ASCII matrix.

Zones

The Zones menu allows you to save or load the zones of the current layer in or from a Zonefile.
Using Zonefiles, you can transfer zonation information between parameters or between models
with different grid configuration. The format of the Zone fileis given in Appendix 2.

Search and Modify

Use the Search and Modify dialog box (Fig. 3.41), if you want to automatically modify a part of
the cell data or if you want to create solid fill plots (for example Fig. 3.42) based on the cell data.
The items of the dialog box are described below:

» The Trace Table

Y ou define a search range and its attributesin arow of the table. A row is active when the Active
flag is YES. The search range is given by the minimum (lower limit) and the maximum (upper
limit). Thefill color of each search range is given in the Color column. The color is assigned to
the finite-difference cells that have a value located within the search range. The colors in the Color
column can be automatically assigned so you get a gradational change from one color to another
(see Spectrum below). To change the color individually, double-click on the colored cell of the
table, then select a new color from the Color dialog box. According to the user-specified value
(inthe Vaue column) and the operation option (in the Options column) in the active rows, you
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can easily modify the cell values. The available operation options are listed below:

Display Only: No operation takes place.

Replace: The cell values are replaced by the user-specified value.
Add: The user-specified value is added to the cell values.

Multiply: The cell values are multiplied by the user-specified value.

= Search And Modify

Parameter:
|Transmissivity Iil [ Ignore Inactive Cells
Active |Color Minimum Maximum Yalue |Options i
Yes 20 0 |Display Only —
Yes 30 0 [Display Only
Yes 40 0 |Display Only
Yes 50 0 [Display Only
Yes 60 0 |Display Only
No 1] 0 [Display Only
No 0 0 |Display Onhy
No 0 0 [Display Only
No 0 0 |Display Onby
No 0 0 [Display Only
No 1] 0 [Display Only
No 0 0 |Display Only =
|
Exoihcs
| Save... I| Load... | | Maps... I| Help I| Cancel ” OK
Fig. 3.41 The Search and Modify dialog box
= Processing Modflow - [MT3D1EX6.MDL] A

File ¥alue ©ptions Help
+ [EYR Rolde] o= [ 3]

| Erajmz, 9661119 | 493 [Steady state [Recycle [-]
Fig. 3.42 A solid fill plot shows the pumping wells and a concentration distribution of a
remediation case described in Zheng (1990)
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» Parameter drop-down box

For particular packages, in which acell has more than one value (e.g., River Package), this drop-
down box contains the available parameter type(s). Y ou choose a parameter type for which the
Search and Modify operation will apply.

» Ignore Inactive Cells
If "Ignore Inactive Cells' is checked, the Search and Modify operation will not apply to inactive
cdls.

» Spectrum
Using Spectrum, the colors in the Color column can be automatically assigned so you get a
gradational change from one color to another.

e To specify gradational fill colors:

1. Assign YESto the Active flag of desired search ranges (rows) in the Trace table.

2. Click Spectrum
A Color Spectrum dialog box appears (Fig. 3.43).

3. Inthe Color Spectrum dialog box, click the Minimum button to display a Color dialog box.
In the Color dialog box, sdlect acolor and click OK. Repeat this procedure for the Maximum
button.

4. Inthe Color Spectrum dialog box, click OK.

A gradation of colors from the minimum to the maximum is assigned to each active row of
the table.

= Color Spectrum

Minimum: Maximum:

_

Fig. 3.43 The Color Spectrum dialog box

» Level
Using Level you can automatically assign regularly-spaced search ranges to each active rowsin
the Trace table.

To specify regularly-spaced search ranges.
Assign YES to the Active flag of desired search ranges (rows) in the Trace table.
2. Click Leve

A Search Level dialog box appears (Fig. 3.44).
3. Inthe Search Leve dialog box, type the smallest value in the Mimimum edit field and type
largest value in the Maximum edit field. Click OK when finished.
The regularly-spaced search ranges are assigned to active rows. For example, the smallest
value could be defined as 10, the largest could be 60, and there are five active rows. The
search ranges would be the same as shown in Fig. 3.41.

=
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= Search Level
Minimum: Maximum:
| 10 | 60

Fig. 3.44 The Search Level diaog box

» Save and Load
The entries in the Trace table can be saved or loaded in Trace files. The format of the trace file
isgiven in Appendix 2.

» Maps
Y ou can display DXF background maps by using a Maps Options dialog box. See section 3.3.8
for details.

3.3.8 The Options menu

There are four menu itemsin the Options menu; viz. Environment, Maps, Display Mode and I nput
Method. The use of the menu items Environment and Maps is described below. Refer to section
3.2 for the description of the display modes and input methods.

» Environment

The Environment Options dialog box (Fig. 3.45) allows you to configure the coordinate system
and the appearance of the model grid. The available settings are summarized in four groups viz.
Grid Appearance, Grid Pogition, Worksheet Size and Contours. Check the "Display zonesin the
cell-by-cell mode" box, if you want to see the user-specified zones in the cell-by-cell mode.

= Environment Options

| Grid Appearance

Worksheet / Coordinate System

1 4 Grid <l well (discharge)
%2.Y2)
[ inactive Cells Bwell (recharge)
X Fixed Head D I Drain v J
(¥o.Yo) 7
E GHB Cells D & River / Stream
D wan (HFB) [ Bores /+(
[ Grid Position | [Worksheet Size | A
Xn=| 349.43 x1=|0 N
Yn=| 2963.18 Y1=|0 ! X
= %x2=| 4000 - i ;
A=|0 (A=Rotation angle in degree)
y2=| a000 — YD)
' Contours _ [ Display zones in the cell-by-cell mode
[Jvisible [¥ Ignore Inactive Cells:
|Horizonlal Hydraulic Conductivity |£|
Min,=| 7.55165E-05 Interval= I 4.032524E-04
Max.=| 4.10804E-03 | Help | | Cancel | | oK |

Fig. 3.45 The Environment Options dialog box
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Grid Appearance alowsyou to change the vighility and appearance color of each simulated
hydraulic elements. A ssimulated hydraulic element is visible if the corresponding check box
ischecked. To select anew color, click the colored button next to the check box and select
acolor from the Color dialog box.

Grid Position and Worksheet Size define the coordinates system of your model. The size
of the worksheet is defined by the lower-left and upper-right corners of the workshest, i.e.,
by the coordinates (X, Y ,) and (X,, Y,) as shown in Fig. 3.45. Using the rotation angle and
the coordinates (X,, Y ) of the left-upper corner of the model grid, you can rotate and place
the model grid at any position. The rotation angle is expressed in degrees and is measured
counterclockwise from the positive x-direction.

Contours: The Data Editor displays contours based on the cell data, if the Visible box is
checked. To select anew color, click the colored button next to the check box and select a
color from the Color dialog box. The contour interval isautomatically chosen such that 11
contours from the lower limit (Minimum) to the upper limit (Maximum) of the cell data are
displayed. Each time you activate the Environment Options dialog box, Minimum and
Maximum are set to the lower and upper limits of the cell data. Different contour levels can
be obtained by changing the values of Maximum, Minimum and Interval. The data of inactive
cellswill not be used, if "Ignore Inactive Cdlls' is checked. For particular packages, in which
acdl has more than one value (e.g. River Package), the Parameter drop-down box contains
the available parameter type(s). The Data Editor creates contours based on the cell data of
the selected parameter type.

» Maps

The Maps Options dialog box (Fig. 3.46) alows you to display up to 5 background DXF-maps.
A DXF file contains detailed data describing numerous CAD entities. An entities is a line or
symbol placed on adrawing by the CAD system. PMWIN supports the following entities: LINE,
POLYLINE, POINT, ARC, SOLID, CIRCLE and TEXT. The other entities will be ignored.
Thereisno size limit to the number of the acceptable entities.

DXF File: X ¥ Factor:
[X] [H:\pmwin\examples\pmexymap./| 2000.00|| 2000.00)| 13.100
|:| |E Id:\,pmwin\examples\pmm(\exarr | I]_I]I]| I I].I]I]| | 1.I]I]I]|
1] [ 0.00| | 0.00/[  1.000
| [ 0.00| | 0.00/|  1.000]
L0 [ 0.00] | 0.00/|  1.000

= Maps Options

Click the right mouse button on the
DXF file fields to select files

| Help || Cancel || OK |

Fig. 3.46 The Maps Options dialog box
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To import a DXF-map:

1. Click the right mouse button on any of the five DXF file edit fields and select a DXF-file from
the standard File Open diaog box.

2. If necessary, use a scale factor to enlarge or reduce the appearance size of the DXF-map. Use
the valuesin X and Y to shift the scaled DXF-map to the desired position. For details, see
Scaling a DXF map below.

3. Click the color button in the front of the DXF-file edit field and select a standard color for
the DXF-map from the Color diaog box. A DXF-graphics entity will have the standard color,
if the entity's color is not defined in the DXF file.

4. Check the check box next to the DXF-file edit field. The map will be displayed only when the

box is checked.

e Scaling aDXF map

Normally, X and Y should be 0 and Scale should be 1, if aDXF fileis generated by PMWIN or
PMPATH. However, some drawing or CAD software will store the coordinates in the DXF file
in other units. If the scale factor or the X, Y values are incorrect, a DXF-map will be displayed
too small, too large or outside of the worksheet. If this happens, use the Environment options to
define a very large worksheet ensuring that the map can be displayed within the worksheet. Then,
you can check the units on the imported map by moving the mouse around the map and looking
at the X and Y coordinates displayed in the status bar. Choose two points that are a known
distance apart and check the distance with the status bar. If the distance is incorrect, compute a
scale factor and import the map again. Once you have a correct scale factor, you can shift the
scaled DXF-map to adesired position by using X and Y. Fig. 3.47 uses atriangle as an example
to show the use of X, Y and the scale factor.

N,
>

(8% + X, s:¥ +Y)

(X3,%)

(s + X, 5 +Y) (sX% +X,5¥ +Y)

(X1, ¥ ) (X2,% )

> X > X

A DXF map with a triangle before scaling and shifting The DXF map after scaling and shifting
A scale factor s and displacement X, Y are used

Fig. 3.47 Theuse of X, Y and the scale factor
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3.3.9 The Run Menu

Y ou start the parameter estimation or simulation programs or the modeling tools from the Run
menu. The moddling tools are described in chapter 4. Prior to running a parameter estimation or

smulation program, PMWIN shows adialog box and asks for the path of the program and other
settings as described below.

Parameter Estimation (PEST)

= Run PEST
Depending on how PEST and Modflow programs are compiled and how much RAM is
installed, the system may become unstable during the simulation. It is a good idea to save
all your data before running PEST.
Modflow Yersion:
|User's own |£|
Modflow Program: PEST Program:
e’\pmwinimodflowimodflow. exe l% | EAPMWINAPESTLITE.EXE
Generate |Description Destination
Yes Basic Package e’\pmwiniexamples\pestiex]ibas_dat
Yes Block-Centered Flow (BCF1.2) |e’\pmwin\examples\pestiex1\bci dat; bcftpl dai
Yes Output Control e’\pmwiniexamples\pestiex]ioc dat
Yes River e’pmwiniexamples\pestiexliriv.dat rivipl.dat
Yes Recharge e’dpmwin\examplesipestiexlirch.dat; rchipl.dal
Yes Solver - PCG2 e’\pmwiniexamples\pestiex]ipcg?2.dat
«[ -+
[ Options
™ Regenerate all input files for MODFLOW and PEST
[™ Generate input files only. don't start PEST
[~ Perform PESTCHEK prior to running PEST
[ Check the geometrical setting up of the model

Fig. 3.48 The Run PEST dialog box

» Modflow Version, Modflow Program and PEST Program

Y ou must specify the verson of MODFLOW and the full path and file names of MODFLOW and
PEST in the Run PEST dialog box (Fig. 3.48). PMWIN supports four versions of MODFLOW
viz. User's own and the versions distributed by the Scientific Software Group, the International
Ground Water Modeling Center and S. S. Papadopulos & Associates. The User's own version
must be used, if you are using the MODFLOW provided by PMWIN. PMWIN automatically
installs MODFLOW in the directory pm_home\MODFLOW; where pm_home is the home

directory of PMWIN. Refer to Appendix 5, if you want to use a version of MODFLOW other
than the four versions supported by PMWIN.

There are four variants of PEST. They are named PESTLITE, PESTLM, PESTSW and
PESTEM. PESTLITE (included in PMWIN) is an educationa version of PESTLM and is
restricted to 4 parameters and 80 observations. Use of the other three variants is identical;
however they each use your machine's memory in a different way. PESTLM is the most basic of
the three. It uses conventional DOS memory (limited to 640k), staying resident in this memory
when it runs MODFLOW. PESTSW isidentical to PESTLM except it vacates the conventional
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memory asit calls MODFLOW. PESTEM uses your machine's extended memory and executes
faster, as it was compiled with a 32-bit compiler. However, an unsolved memory problem will
occur, if you run PESTEM within Windows. The problem is probably caused by the operating
system or the 32-bit compiler. Fortunately, PESTLM is sufficient for most groundwater problems.
You should use PESTLM unless you have other problems with the conventional memory.

» The File Table

PMWIN uses the user-specified data to generate input files of MODFLOW and PEST. The
Description column gives the name of the packages used in the flow model. The path and name
of the input file are shown in the Destination column. PMWIN generates an input file, only if the
Generate flag isset to YES. Y ou can click on arow to toggle the Generate flag between Y ES and
NO. Generdly, you do not need to worry about these flags, as PMWIN will care about the
settings. See Appendix 7 for the names of the generated input files of MODFLOW and PEST.

» Options

* Regenerate all input filesfor MODFLOW and PEST: Y ou should check this option, if the
input files have been deleted or overwritten by other programs, or you want to run another
model saved in the same subdirectory as the current model.

» Generate input files only, don't start PEST: Check this option, if you want to run PEST
outside of Windows (for example you want to use PESTEM). See OK (below) for how to
run PEST outside of Windows.

o Perform PESTCHEK prior to running PEST: PESTCHEK reads the PEST input files
generated by PMWIN, making sure that every item is consistent with every other item and
writing errors to the file PEST.CHK. It isrecommended to use PESTCHEK, as PMWIN and
PEST do not carry out consistency checks of all user-specified control data and parameters.

»  Check the geometrica setup of the model: PMWIN finds errors in the geometrical setting up
and writes them to the file CHECK.LST, if (1) thelayer thicknessis zero or negative; (2) the
elevations of the layer top and bottom are not consistent; and (3) the starting hydraulic head
at acongtant head cell islower than the cdll bottom. In the last case, instead of converting the
constant head cell to an inactive dry cell, MODFLOW writes an error message to the run
record file OUTPUT.DAT and stops the simulation.

» OK

Click OK to start the generation of input files of MODFLOW and PEST. In addition, PMWIN
generates two batch files in your model directory: PEST.BAT and MODELRUN.BAT. After
having generated all necessary files;, PMWIN automatically opens a DOS-box and runs
PEST.BAT in the box. The batch file MODELRUN.BAT isused by PEST.BAT.

Follow the steps below if you want to run PEST outside of Windows

1. IntheRun PEST dialog box, check the option Generate input files only, don't start PEST then
click OK.

2. Leave Windows

3. Change the default path to your model directory.

4. Type PEST.BAT at the DOS-prompt then press enter.
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After completing the parameter estimation process, PEST prints the optimised parameter values
to the run record file PESTCTL.REC saved in your model directory. PEST automatically writes
the optimised parameter valuesto the input files of MODFLOW (BCF.DAT, WEL.DAT,... , etc.).
The smulation results of MODFLOW are updated by using these parameter values. Y ou can use
the modeling tools to examine the results.

Note that you should assign the optimised parameter values to your model by using the
Data Editor, because PMWIN does not retrieve these values automatically.

Flow Computation (MODFLOW)

» Modflow Version and Modflow Program

Y ou must specify the version of MODFLOW and the full path and file name of MODFLOW in
the Run Modflow dialog box (Fig. 3.49). PMWIN supports four versions of MODFLOW viz.
User's own and the versions distributed by the Scientific Software Group, the International
Ground Water Modeling Center and S. S. Papadopulos & Associates. The User's own version
must be used, if you are using the MODFLOW provided by PMWIN. PMWIN automatically
installs MODFLOW in the directory pm_home\MODFLOW; where pm_home is the home
directory of PMWIN. Refer to Appendix 5, if you want to use a version of MODFLOW other
than the four versions supported by PMWIN.

= Run Modflow

Depending on how the Modflow program is compiled and how much RAM is installed,
the system may become unstable during the simulation. It is a good idea to save all
wyour data before running Modflow.

Modflow Version:

|User's own Iél
Modflow Program:

e’\pmwinimodflow\modflow.exe

Generate |[Description Destination

Yes Basic Package e\pmwin\examples\sample\bas.dat
Yes Block-Centered Flow (BCF1.2) |e’\pmwin\examplesisampleibci.dat
Yes Output Control e’ipmwiniexamples\sampleloc.dat

Yes Well e’\pmwiniexamples\sample\wel dat
Yes Solver - PCG2 e\pmwin\examples\sample\pcg?2.dat
Yes Modpath (Vers. 1.x) e’pmwiniexamplesisampleimain.dat
Yes Modpath (Vers. 3.x) e’\pmwiniexamples\sample\main30.dat
«[ ] +
| Options

[ Regenerate all input files for MODFLOW e

[ Check the geometrical setting up of the model Cancel

[ Generate input files only. don't start MODFLOW Help

Fig. 3.49 The Run Modflow dialog box

» The File Table

PMWIN uses the user-specified data to generate input files of MODFLOW and MODPATH. The
Description column gives the name of the packages used in the flow model. The path and name
of the input file are shown in the Destination column. PMWIN generates an input file, only if the
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Generate flag isset to YES. You can click on arow to toggle the Generate flag between Y ES and
NO. Generdly, you do not need to worry about these flags, as PMWIN will care about the
settings. See Appendix 3 for details about the input files of MODFLOW. Note that you cannot
run MODPATH and/or MODPATH-PLOT from PMWIN directly. See Appendix 6 for how to
run these programs.

» Options

* Regenerate al input files for MODFLOW: Y ou should check this option, if the input files
have been deleted or overwritten by other programs, or you want run an other model saved
in the same subdirectory as the current model.

¢ Check the geometrica setup of the model: PMWIN finds errors in the geometrical setup and
writes them to the file CHECK.LST, if (1) the layer thickness is zero or negative; (2) the
elevations of the layer top and bottom are not consistent; and (3) the starting hydraulic head
at acongtant head cdll islower than the cell bottom. In the last case, instead of converting the
constant head cell to an inactive dry cell, MODFLOW writes an error message to the run
record file OUTPUT.DAT and stops the simulation.

e Generate input files only, don't start MODFLOW: Check this option, if you want to run
MODFLOW outside of Windows. See OK (below) for details.

» OK

Click OK to start the generation of input files of MODFLOW. In addition, PMWIN generates a

batch file MODFLOW.BAT saved in your model directory. After having generated all necessary

files, PMWIN automatically opens a DOS-box and runs MODFLOW.BAT in the box.

Follow the steps below if you want to run MODFLOW outside of Windows

1. Inthe Run MODFLOW dialog box, check the option Generate input files only, don't start
MODFL OW then click OK.

2. Leave Windows

3. Change the default path to your model directory.

4. Type MODFLOW.BAT at the DOS-prompt then press enter.

During aflow simulation, MODFLOW writes a detailed run record to the file OUTPUT.DAT
saved in your model directory. If aflow simulation is successfully complete, MODFLOW saves
the smulation resultsin various unformatted (binary) files aslisted in Table 2.1. Prior to running
MODFLOW, the user may control the output of these unformatted (binary) files by choosing
Output Control>Modflow from the Packages menu.

Pathline and Contours (PMPATH)

To run PMPATH, specify the path and file name in to the Run PMPATH dialog box (Fig. 3.50)
and click OK. Normally, you do not need to change the default path and file name displayed in
thisdialog, as PMWIN will ingall PMPATH in its home-directory. However, if you have changed
the configuration of your computer (for example added a new hard drive), you may need to
change the path.
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PMPATH runs independently from PMWIN. If you have subsequently modified model data and
performed the flow computation, you must load the modified model into PMPATH again to
ensure that PMPATH can recognize the modifications.

= Run PMPATH

Specify the full path and filename of the PMPATH program. When finished,
click OK to start PMPATH for Windows.

PMPATH program:

| Help || Cancel || OK |

Fig. 3.50 The Run PMPATH dialog box

|d:\pmwin\pmpﬂth.exe| ‘ ‘

Solute Transport (MT3D)

» MT3D Program
PMWIN needs to know the full path and file name of MT3D. Y ou can type the full path and file

name of MT3D in the Run MT3D dialog box (Fig. 3.51) or click & and select the MT3D
program from the standard Open file dialog box.

= Run MT3D

Depending on how the MT3D program is compiled and how much RAM is installed.
the system may become unstable during the simulation. Itis a good idea to save all
your data before running MT3D.

MT3D Program:

EAPMWINVMT 3DLITE.EXE I% |
Generate |Description Destination

Yes Basic Transport Package e’\pmwiniexamplesipmeximtbtnl_dat
Yes Advection Package e’\pmwiniexamplesipmeximtadv].dat
Yes Dispersion Package e’\pmwiniexamplesipmeximidsp1.dat
Yes Chemical Reaction Package e’\pmwiniexamplesipmeximtrct] dat
Yes Sink and Source Mixing e’jpmwiniexamplesipmeximtssml.dat
«[ ] +
| Options

[ Regenerate all input files for MT3D

[ Generate input files only. don't start MT3D

Help |

Fig. 3.51 The Run MT3D dialog box

» The File Table

PMWIN uses the user-specified data to generate input files of MT3D. The Description column
gives the name of the packages used in the transport model. The path and name of the input file
are shown in the Destination column. PMWIN generates an input file, only if the Generate flag
is set to YES. You can click on a row to toggle the Generate flag between YES and NO.
Generaly, you do not need to worry about these flags, as PMWIN will care about the settings.
See Appendix 4 for details about the generated input files of MT3D.
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» Options

Regenerate dl input filesfor MT3D: Y ou should check this option, if the input files have been
deleted or overwritten by other programs, or you want to run an other model saved in the
same subdirectory as the current model.

Generate input files only, don't start MT3D: Check this option, if you want to run MT3D
outside of Windows. See OK below.

» OK

Click OK to start the generation of the input files of MT3D. In addition, PMWIN generates a
batch file MT3D.BAT saved in your model directory. After having generated all necessary files,
PMWIN automatically opens a DOS-box and runs MT3D.BAT in the box.

Follow the steps below if you want to run MT3D outside of Windows

1.

2.
3.
4. Type MT3D.BAT at the DOS-prompt then press enter.

Inthe Run MT3D dialog box, check the option Generate input files only, don't start MT3D
then click OK.

Leave Windows

Change the default path to your model directory.

During a transport smulation, MT3D writes a detailed run record to the file OUTPUT.MT3
saved in your model directory. The calculated concentrations are saved in the unformatted
(binary) file MT3D.UCN. See Output Control for details.

The Modeling Environment



Processing M odflow 4-1

4. Modeling Tools

4.1 The Advective Transport Model PMPATH

PMPATH is an advective transport model running independently from PMWIN. PMPATH
retrieves the groundwater models created in PMWIN and simulation result files from the flow
model MODFLOW. A semi-analytical particle tracking scheme (Pollock, 1988, 1989) is used to
calculate the groundwater paths and travel times. Through the interactive graphical modeling
environment of PMPATH, the user can place particles and perform particle tracking with just a
few mouse clicks. While most available particle tracking models need postprocessors for
visualization of computed paths and times data, PMPATH cal culates and shows the pathlines and
travel time marks simultaneously (Fig. 4.1). Moreover, PMPATH provides various on-screen
graphical options including head contours, drawdown contours and velocity vectors for any
selected model layer and time step.

PMPATH - [EXAMPLE.MDL] -

File  Run  Options Info

mwmﬁﬁw
Fig. 4.1 PMPATH in operation

09:25:24

Both forward and backward particle tracking are allowed for steady-state and transient flow
simulations. For transient flow simulations, particles can start from any time step. During the
simulation, the particle tracking algorithm will check the current time of every particle. If a
particle reaches the end (forward tracking) or the beginning (backward tracking) of atime step,
PMPATH forcesthe particle to wait, until the flow field of the next time step has been read. The
particle tracking simulation goes further until all particles leave the model or until the user-
specified time limit is reached.

The time length of asingle particle tracking step and the alowed number of tracking steps can be
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specified. Furthermore, each particle can have its own color and retardation factor. With these
features, PMPATH can be used to smulate advective transport in groundwater, to delineate
contaminant capture zones, injection zones and wellhead protection areas or to find the point of
origin of water in specified zones. PMPATH creates severd output files including hydraulic heads
distribution, velocity field, the x,y,z coordinates and travel times of particles. Graphics output
includes DXF, HPGL and BMP (Windows bitmap) formats. Due to PMPATH's intensive
graphica capability, there is no need for additional packages for graphical representations of the
simulation results.

4.1.1 The Semi-analytical Particle Tracking Method

» Theory

Pollock's semi-analytica particle tracking scheme is based on the assumption that each directional
velocity component varies linearly within amodel cell in its own coordinate direction. Additional
codes are added to PMPATH to enable the computation of groundwater paths under transient
flow conditions. The following briefly describes Pollock’s algorithm and the modified algorithm
used in PMPATH.

Assume that the dengity of groundwater is constant. Consider a unit volume of a porous medium
as shown in Fig. 4.2 and apply Darcy's law and the law of conservation of mass. The three
dimensonal form of the partial differential equation for transient groundwater flow in saturated
porous media can be expressed as

ov ov ov oh

X sy SZ _w = Ss_ (4.1)
ox ay 0z ot
where

Voo Ve, AN\, [L/T] are values of the specific discharge (or Darcy velocity) through the unit
volume aong the x, y, and z coordinate axes;

w [L/T] isavolumetric flux per unit volume and represents internal sources and/or sinks of
water;

S, [V/L] isthe specific storage of saturated porous media;

h [L] isthe hydraulic head; and

t[T] istime.

For athree-dimensional finite-difference cell as shown in Fig. 4.3, the finite-difference form of
equation (1) can be written as

(sz - Qxl) N (Qy2 - le) N (sz - Qzl) _ W LS i
(Ay-Az)-Ax (Ax-Az)-Ay (Ax-Ay)-Az Ax-Ay-Az * At

(4.2)

where
Qu Qe Q1 Q2 Q, and Q,, [L3T™] are volume flow rates across the six cell faces.
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Ax, Ay and Az [L] are the dimensions of the cell in the respective coordinate directions,
W [L3T ] isflow to internal sources or sinks within the cell; and
Ah [L] isthe change in hydraulic head over atime interva of length At [T].

QZZ Qy2

5l
Vo, +—=—V, 0
szt gz %% Vsy"'WVsy /
) (x2,y2, 22)

Ay
Qu

[ X 4( —>Qp

Az

d
*Hvsx'i'aixvsx

/ 7 (x1, y1, z1)

y Vsy y le
. Qzl
X sz X

Fig. 4.2: Flow through unit porous medium Fig. 4.3: Finite-difference approach

The left Side of equation 4.2 represents the net mass rate of outflow per unit volume of the porous
medium, and the right hand side is the mass rate production per unit volume due to internal
sources/sinks and mass storage. Equation 4.2 is the mass balance equation for a finite-difference
cell. Substitution of Darcy's law for each flow term in equation 4.2, i.e. Q=Ah-K-A, yields an
equation expressed in terms of (unknown) heads at the center of the cell itself and adjacent cells.
An equation of thisform iswritten for every cell in the mesh in which head is free to vary with
time. Once the system of equationsis solved and the heads are obtained, the volume flow rates
across the cdll faces can be computed from Darcy's law. The average velocity components across
each cell face are

Vi = Qu/(n-Ay-Az) (4.33)
Vi = szl(n-Ay-AZ) (4.3b)
Vyp = Qp/(n"Ax-Az) (4.3c)
Vi, = Q/ (NAx-AZ) (4.3d)
V= Qu/(nAx-Ay) (4.3€)
V,, = Q,,/(n"Ax-Ay) (4.3f)
where

n [-] is the effective porosity, and
Vs Vies g, Mo Vg, 8N v, [LT] are the average velocity components across each cell face.

The semi-analytical particle tracking algorithm uses simple linear interpolation to compute the
principle velocity components at points within a cell. Given the starting location (x, y, z) of the
particle and the starting time t,, the velocity components are expressed in the form
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Vx(tl) - AX(X - Xl) * Va (4.4a)
Vy(tl) = Ay(y - yl) + Vy1 (4.4b)
v,(t) =A(z -z) +Vv, (4.4¢)

where A,, A, and A, [T*] are the components of the velocity gradient within the cell,

Ax = (Vx2 h Vxl)/AX (458.)
A, = (v, = Vv,) /Ay (4.5b)
A, = (v, ~Vv,)IAz (4.5¢)

Using adirect integration method described in Pollock (1988) and considering the movement of
the particle within a cell, the particle location at timet, is

X(t) = x, + (v, (t)-e™%T —v ) /A (4.63)
y(t) =y, + (v t)e™ T - v )T A (4.6b)
2(t) =z, + (v,(t)-e™"" —v,) /A, (4.6¢)

where AT =t, - t;

For steady-state flow fields, the location of the particle at time t, must be still within the cell.
Given any particle's starting location within a cell at time t,, Pollock’s agorithm alows to
determine the particles exit timet, and exit point from the cell directly, without having to known
the actua path of the particle within the cell. The particle leaves the cell and enters a neighbouring
cdl. This sequenceis repeated until the particle reaches a discharge point or until a user-specified
timelimit isreached. The particle tracking is backward if al velocity termsin equation 4.3a - 4.3f
aremultiplied by -1.

For trangent flow fields, the smulation time is divided into stress periods - time intervals during
which all external stresses are constant - which are, in turn, divided into time steps. In addition
to the condition for steady-state flow fields, t, and t, must lie within the same time step. In
PMPATH, each particle is associated with a set of attributes, i.e., the retardation factor, the
gtarting, forward and backward travel times and positions. If a particle is travelling across the end
(forward tracking) or the beginning (backward tracking) of atime step of aflow simulation, the
modified agorithm setst, to thistime and forces the particle to wait until the flow field of the next
time step (forward tracking) or the previous time step (backward tracking) is read. If the end or
beginning time of a flow simulation is reached, the modified algorithm can treat the latest flow
field as steady-state and the movement of particles can go on.

» Consideration of the spatial discretization and water table layers

The method described above is based on the assumption that the model domain was discretized
into an orthogona finite-difference mesh (Fig. 4.4), i.e.,, dl modd cellsin the same layer have the
same thickness. In practice, many modelers use variable layer thickness to simulate the varying
thickness of stratigraphic geohydrologic units (Fig. 4.5). In order to calculate approximate
groundwater paths for the last discretization type, PMPATH (as well as MODPATH) uses a
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vertica local coordinate instead of the z-coordinate. The vertical local coordinate is defined for
each cell as

2z =(z-2)1(z, - 2) (4.7)

where z, and z, are the elevations of the bottom and top of the cell, respectively. According to
this equation, the vertical loca coordinate z, equals O at the bottom of the cell and 1 at the top of
the cell. When a particle is moved laterally from one cell to another, its vertical local coordinate
remains unchanged, regardless of how the elevations of the bottom and top vary from one cell to
another.

In MODFLOW, moded layers of type 1 (unconfined) are always water table layers, model layers
of type 2 or 3 (confined/unconfined) are water table layers when the head in the cell is beneath
the elevation of the cell top. For the water table layers, z, is set equal to the head in the cell. For
the particle tracking, water table layers are treated in the same way as variabl e thickness model

layers.
model grid—>(
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Fig. 4.4: Discretization with an orthogonal grid
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Fig. 4.5: Discretization with a deformed grid
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4.1.2 PMPATH Modeling Environment

The PMPATH modeling environment (Fig. 4.6) consists of the Toolbar, the Top view window
of the modd, Cross-section windows of the model, and the Status bar. They are described
below.

»Top view window, Cross-section windows and the Status bar

The Top view window shows the plan view of the groundwater model you built in PMWIN.
PMPATH use the same spatial discretization convention as used by MODFLOW. An aquifer
system isdiscretized into mesh blocks, or cells. An |, J, K indexing system is used to describe the
locations of cellsin terms of rows, columns and layers. The |-, J-, and K- axes are oriented along
the row, column and layer direction, respectively. The origin of the cell indexing system is located
at the upper, top, left cell of the model. MODFLOW numbers the layers from the top down, an
increment in the K index corresponds to a decrease in elevation z.

PMWIN allows a user to shift and rotate a model grid by giving the rotation angle A and the
coordinates (x, ,Y,) of the upper-left corner of the grid. PMPATH always displays the model grid
parallel to the Top view window. The relation between the model grid and the x, y, z Cartesian
coordinate system isillustrated in Fig. 4.6. The Top view window displays the construction of the
current model layer and the projection of pathlines on the 1 J-plane. The Cross-section windows
display the projection of pathlines on the IK- and JK-planes. An Environment Options dialog box
of PMPATH (see below) alows a user to change the appearances of these windows. The
projection of pathlines on the cross-sections is useful when running PMPATH with a three-
dimensiond (multi-layer) flow field. One should aways keep in mind that only the projections of
pathlines are displayed. The projection of a pathline may be intersected by another or even itself,
particularly if athree-dimensiona flow field or atransient flow field is used.

Because of the capability of calculating particle's exit point from a cell directly, pathlines displayed
by PMPATH may sometimes intersect each other. Consider the case shown in Fig. 4.7, two
particles start from the same two-dimensional cell at the same time The dashed curves represent
the actua paths of these two particles. The solid lines are the pathlines displayed by PMPATH.
The pathlines intersect each other, although the particles exit points are exactly equal to that of
the actud paths. This effect can be prevented by using a smaller particle tracking step length such
that intermediate particle positions between starting point and exit point can be calculated. See
Particle Tracking Options for how to change the particle tracking step length.

The Statusbar displays the following messages:

the current position of the mouse cursor (in both [X, y, z] coordinates and [J, I, K] indices);
the hydraulic head at the cell [J, I, K];

the horizontal flow velocity at the center of the cdll [J, I, K];

the vertical flow velocity at the center of the cell [J, I, K];

the current stress period of the flow simulation;

the current time step of the flow ssimulation; and

the number of particles.

Noo,rwbdE
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See Particle Tracking Options for how to change the current stress period and time step. The
hydraulic heads at the current stress period and time step are calculated by MODFLOW. The
horizontal flow velocity at the center of a cell isthe average of the velocities v, vy, V4, V,, (see
equation 4.3a-4.3d). The vertical flow velocity at the center of a cell is the average of the
velocitiesv,,, V,, (see equation 4.3e and 4.3f). The vertical flow velocity is defined as positive
when it points in the k-direction.

vertical local coordinate for setting particles
current layer

top view

I-K cross-section
PMPAT'1- [EXAMPI.E.MDL]

File Run Options Info

mouse cursor

2293403, LA0GEF03, LAQOEDT | #4531 |1,3283E-01 | 28980E-05 [ 53360509 [ [ | @4

[ 085508
——— J-K cross-section

number of particles

current time step

current stress period

vertical velocity at the cell [J,1,K]

horizontal velocity at the cell [J,1,K]

head at the cell [J,1,K]

current cursor position (in cell indices [J,1,K])

current cursor position (in [x,y,z] coordinates)

Fig. 4.6: The PMPATH modeling environment
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Fig. 4.7: Schematic illugtration of the spuriousintersection of two pathlines in a two-dimensional

cel.

» Toolbar

The Toolbar provides quick access to commonly used commands in the PMPATH modeling
environment. You click an icon on the toolbar once to carry out the action represented by that
icon. To change the current layer or the vertical local coordinate, click the corresponding edit field
in the Toolbar and type the new value then press ENTER. See section 4.1.1 for the definition of
the vertical local coordinate. The following table summarizes the use of the Toolbar buttons of

PMPATH

—

oolbar Button

Action

~u

H 2 = X [ [E

[4]

Open Model; Allows a user to open amodel created by PMWIN.

Set Particle; Allows a user to place particles in the model domain.

Erase Particle; Provides away to delete particles

Zoom In; Allows you to drag a zoom-window over a part of the model.
Zoom Out; Forces PMPATH to display the entire model grid.

Particle color; Allows a user to select a color for new particles from the
standard color dialog box.

Run particles backward; Executes backward particle tracking for atime
lenght. Thetime length is defined by the product of the number of particle
tracking steps by the particle tracking step length.
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Run particles backward step by step; Executes backward particle tracking
for a user-specified particle tracking step length.

Stop; Stops the particle tracking or stops drawing particles.

IE| Run particles forward step by step; Executes backward particle tracking
for a user-specified particle tracking step length.

= Run particles forward; Executes forward particle tracking for a time

length. Thetime length is defined by the product of the number of particle
tracking steps and the particle tracking step length.

Open model

Opens an existing model created by PMWIN. A PMWIN-model file aways has the extension
MDL. The flow smulation with MODFL OW must be complete, before you can open a model.
By default, PMPATH reads the unformatted (binary) files (HEADS.DAT and BUDGET.DAT)
from the same directory as the loaded model.

Set particle

Use the following two methods to place particlesin the current layer. The current layer is shown
in the Toolbar (Fig. 4.6). Change it first, if you need to place particles into another layer. Note
that particles cannot be placed in inactive cells or specified head cells (constant head cells).

» To place a group of particles

1. Click the Set particleicon

2 Movethe mouse cursor to your active mode areain the top view window. The mouse cursor
becomes a cross hair.

3. Place the cross hair where you want a corner of the "Set Particle” window.

4. Dragthecross hair until the window covers the subregion over which particles will be placed,
then release the mouse button.
A Particle Placement dialog box will appear (Fig. 4.8). Where NI, NJand NK are the number
of particlesin |, Jand K directions, respectively. These numbers can range from 0 to 999.
Using NI, NJand NK, particles can be placed either on cell faces or within cellswhich liein
the " Set Particle” window. In the case shown in Fig. 4.8, one particle will be placed within
each cell and 4 (=2x2) particles will be placed on the cell face 3. New particles will get the
color and the retardation factor given in the dialog box.

» To place a single particle

1. Click the Set particle icon

2. Change the vertical local coordinate and the particle color (for the definition of the vertical
local coordinate, see equation 4.7 and Fig. 4.6)

3. Move the mouse cursor to the desired position in the top view window and click the right
mouse button. A particle will be placed. Note that New particles will have the retardation
factor pecified in the Particle Placement diaog box. Once particles are placed, their color and
retardation factor cannot be changed any more.
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Particles on cell faces | Particles within cells |
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Fig. 4.8: The Particle Placement dialog box

The retardation factor R is defined by

R=1+ _-Kd (4.8)

where p, is the bulk mass density of the porous medium, n is the porosity, and K, is the
digtribution coefficient. A detailed description of these parameters can be found in the literature,
e.g., Freeze and Cherry (1979). The retardation factor was first applied to groundwater problems
by Higgins (1959) and Baetsle (1967). Baetsle indicated that it can be used to determine the
retardation of the center of mass of a contaminant moving from a point source while undergoing
adsorption. PMPATH uses the retardation factor to modify the particle velocity. The velocity
vectorsin equation (3a)-(3f) become

V., = Q. /(n"Ay-Az)/R

v,, = Q,/(n"By-Az)/R Ej:gg‘g
vy = Qp/(nAx-Az)/R (4.9¢)
Vyp = QyZ/(n-Ax-Az)/R (4.9d)
v,, = Q,,/(n"Ax-Ay)/R (4.9e)
V,, = Q/(n-Ax-Ay)/R (4.90)

[%] Erase particle

Y ou can only erase particles located in the current layer. The current layer is shown in the toolbar
of the PMPATH modeling environment (Fig. 4.6). Change it first, if you need to erase particles
in another layer.
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» To delete particles

1. Click the Erase particle icon[X]

2. Move the mouse cursor to where you want a corner of the "Erase”" window.

3 Drag the mouse cursor until the window covers the particles which will be deleted.
4. Release the mouse button.

Zoom In

By default, PMPATH displays the entire modd grid. "Zoom in" isuseful, if you want to see a part
of the model domain in greater detail or if you want to save plots of a certain part of the model
area (see Save Graphics for how to save plots).

» To zoom in on a part of the model

1. Click the Zoom Inicon

2. Move the mouse cursor to where you want a corner of the "Zoom" window.

3 Drag the mouse cursor until the window covers the model areawhich is to be displayed.
4. Release the mouse button.

Zoom Out
Clicking on the "Zoom out" button forces PMPATH to display the entire model grid.

Particle color

Clicking on the "Particle color" button allows a user to select a color for new particles from a
standard color dialog box. Particles with different colors are useful when, for example, you want
to determine the capture zones of several pumping wells. In this case, particles with a certain
color are placed within or on the cell-faces of each pumping well. Through backward tracking,
capture zones of each pumping well can be recognized by their different colors.

Run particles backward

Click the "Run particles backward" icon to execute backward particle tracking for atime length.
Thetimelength is defined by the product of the number of particle tracking steps by the particle
tracking step length given in the Particle Tracking Options dialog box. See the section Particle
Tracking Options for details.

Run particles backward step by step

Click the "Run particles backward step by step™ icon to move particles backward a single particle
tracking step. The particle tracking step length is defined in the Particle Tracking Options dialog
box.

Stop

Y ou can click the "Stop" button to stop particle tracking or stop redrawing particles when the
"Stop" button is highlighted (the rectangle on the button is colored in red).

PMPATH redraws the particles whenever the PMPATH window has been covered by other
windows and is activated again. For example, if you change to another application and then return
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to PMPATH, PMPATH will redraw al particles. If too many particles are placed, you will need
to stop PMPATH redrawing al particles. Under some circumstances, PMPATH will take along
time for calculating the coordinates of flow paths and travel times. Thisis especially true, if the
flow velocities and the user-specified time step length of particle tracking are very small. Click
the "Stop" button, if the particle tracking simulation appears too slow.

|E| Run particles forward step by step
Click the "Run particles step forward step by step” button to move particles forward a single

particle tracking step. The particle tracking step length is defined in the Particle Tracking Options
dialog box.

[»] Run particles forward

Click the "Run particles forward" button to execute forward particle tracking for a specified time
length. Thetime length is defined by the product of the number of particle tracking steps and the
particle tracking step length given in the Particle Tracking Options dialog box.

4.1.3 PMPATH Options

There are three menu items in the Options menu of PMPATH; viz. Environment, Particle
Tracking and Maps. The use of the Environment and Particle Tracking options is described below.
Refer to section 3.3.8 for the description of the Maps options.

» Environment Options

From the Options menu, choose Environment to modify any of the settings in the Environment
Options dialog box (Fig. 4.9). The available settings are summarized in the Top View and the
Cross Sections groups. The Top View group contains the Grid Appearance, Contours and
Velocity Vectors groups. The settings are described below.

= Environment Options
Top View | Cross Sections |
" Grid Appearance .
Wisibl

O K arid EHwen (discharge) B visible
B Inactive Cells Blwen ( recharge ) L show grid
B constantHead ] B Drain Scaling factor for the height:
|Z| Ghb Cells D @ River/Stream %

B Sturry wall —

[ Contours -
[Jvisible ® Head () Drawdown
Minimum: Maximum:
| 13,14D|E| | 13_545|%

Interval:
0.04050 @

"Velocity Vectors
[visible Vector size:@

Fig. 4.9 The Environment Options dialog box
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» Grid Appearance dlowsyou to change the vighility and appearance color of each simulated
hydraulic elements. A ssimulated hydraulic element is visible if the corresponding check box
ischecked. To select anew color, click the colored button next to the check box and select
acolor from the Color dialog box.

e Contours: PMPATH displays contours based on the s mulated heads or drawdowns, if the
Visble box is checked. To select anew color, click the colored button next to the check box
and select a color from the Color dialog box. The contour interval is automatically chosen
such that 11 contours from the lower limit (Minimum) to the upper limit (Maximum) of the
cdl dataare displayed. Each time you activate the Environment Options dialog box, Minimum
and Maximum are set to the lower and upper limits of the heads or drawdowns found in the
current layer and time step. Different contour levels can be obtained by changing Maximum,
Minimum and Interval.

e Velocity Vectors describe the directions of water movement at any instant of a given time
step of the smulation (defined in Current Time). Check the Visible check box, the projection
of velocity vectors of each active model cell can be shown on the Top view window. Click
the color button to change the appearance color of the velocity vectors. The appearance size
of the largest velocity vector is defined by the Vector size (in pixels). Vector size defaultsto
25 and can range from 1 to 2,147,483,647.

e Cross Sections are visible, if the Visible box is checked. To display the model grid on the
cross section, check the Show Grid check box. Because of the possible usage of deformed
grid (Fig. 4.5), only the vertical model grid will be displayed on the cross-section windows.
Use Scaling factor for the height (exaggeration) to change the appearing height of the model.
Using a larger scaling factor let you see the projection of the pathlines on the cross-section
windows in greater details. The scaling factor can range from 0.01 to 1000. Note that
PMPATH cannot display the cross sections, if the model thickness or the exaggeration factor
istoo small. In this case, the Visible check box will unchecked automatically.

» Particle Tracking Options

From the Options menu, choose Particle Tracking to modify any of the settings in the Particle
Tracking Options dialog box, shown in Fig. 4.10. The available settings are summarized in
Current Time, Tracking Step, Time Mark, Smulation Mode, Stop Condition, Recharge and
Evapotranspiration.

o Current Time

Y ou can move to any stress period and time step as long as the resulting heads and cell-by-cell
flow terms are saved for that stress period/time step. The starting time of each particle is aways
the beginning of the time step defined in Current Time,

e Tracking Step
To select atime unit for Step length, click the down arrow on the Unit drop-down box. The

particle tracking step length is the time length that particles may move when the buttons E or
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] are pressed. Maximum steps is the allowed number of particle tracking steps. Each time you
press the buttons (=] or E| particles may move backward or forward for atime length defined

by the product of Step length and Maximum steps.

—

" Current Time
Stress period:

[ Tracking Step

Particle Tracking Options

Unit:

rTime Mark
Interval:

| |[#]

Time step:

|seconds

Step length:

2]

Top view

(¢

Cross-section

[~ visible

[~ Visible
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Size:
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| 100@ |

3|E|

" Simulation Mode
O Flowlines, use the flow field from the current time step
@ Pathlines. use transient flow fields

OK I

C 1
| Stop Condition
[¥ Particles stop. when they enter cells with internal sinks

[" Particles stop. when the simulation time limit is reached

" Recharge
O Assign recharge to the top face of cells

O Assign recharge to the bottom face of cells
@® Assign recharge to top and bottom cell faces
O Treat recharge as a distributed source

| Ewapohanspivatinn
O Assign evapotranspiration to the top face of cells
@ Treat evapotranspiration as a distributed sink

Fig. 4.10: The Particle Tracking Options dialog box

o Time Mark

PMPATH placestime marks on pathlines for each n-th tracking step, where n is the appearance
frequence of the time marks given in Interval. Check the corresponding Visible check boxes, if
you want to see time marks on the top view or the cross-section windows. The appearance size
of the time marks is defined by Size (in pixels). The default value of Sizeis 10 for the top view
window and 3 for the cross-section windows. The size can range from 1 to 2,147,483,647.

e Simulation Mode

PMPATH can be used to calculate flowlines or pathlines. Flowlines indicate the instantaneous
direction of flow throughout a system (at all times of a steady-state flow simulation or at agiven
time step of atransient flow simulation). Pathlines map the route that an individual particle of
water follows through aregion of flow during a steady-state or transient condition. In a steady-
date flow system pathlines will coincide with flowlines. In this case, only the option Flowline, use
the flow field from the current time step is available. In the case that flowlines change in each time
step of atransient flow simulation, the flowlines and pathlines do not coincide. Use the option
Pathlines, use transient flow fields, to calculate transient pathlines.

» Stop Condition

In general, particles will stop when the alowed travel time defined in Tracking Step is reached
or when the particles reach specified head cells. In addition to these conditions, two stop
conditions are available:
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1. Particles stop, when they enter cells with internal sinks:

The flow model MODFLOW includes the options to simulate wells, drains, rivers, general-
head boundaries, streams, evapotranspiration and recharge. Except the last two options, they
aretreated as internal distributed sources or sinks by PMPATH. If the internal sink of a cell
isaufficiently strong, flow will be into the cell from &l cell faces. In that case, every particle
that entersthe cell will be discharged. If the sink is weak, flow will be into the cell from some
cell faces and a part of flow will leave the cell through other faces. A particle entering such
a cell may be discharged or may leave the cell again. In the finite-difference approach,
however, it is not possible to determine whether that particle should be discharged or pass
through the cell. If this option is selected, particles will be discharged when they enter cells
with internal sinks, regardless of the flow condition.

2. Particles stop, when the simulation time limit is reached.

This option is only available, if the smulation mode Pathlines, use transient flow fields is
selected. In PMPATH, the starting time of each particle is always the beginning of the time
step defined in Current Time. For the forward particle tracking scheme, the simulation time
limit isthe end of atransient flow simulation. For the backward particle tracking scheme, on
the other hand, the smulation time limit is the beginning of the smulation. Backward particle
tracking will not work, if this stop option is checked and particles are started from the
beginning of atransient flow simulation. In this case, particles will be stopped immediately
after the gtart. If the smulation time limit is reached and this option is not checked, PMPATH
caculaesflowlines by usng the flow field of the first or last time step. Note that you cannot
start backward particle tracking from the end of a transient flow simulation. Y ou can only
start particles from the beginning of the last smulation time step.

* Recharge

MODFLOW treats recharge as an internal distributed source of a cell and does not assign it to
any of the six cdl faces. The distributed source gpproximation is usually only appropriate for two-
dimensiona areal flow models. The flow velocity across the top face of a cell in the top model
layer would be zero, if the existing recharge is not assigned to the top face. Consequently,
particles would never reach the top face, if the backward tracking scheme is applied.

In PMPATH, recharge may be treated as a distributed source, or assigned to the top face or
bottom face of a cell by selecting a corresponding option from the Particle Tracking Options
dialog box (Fig. 4.10). Recharge will be assigned to the top face and "negative" recharge will be
assigned to the bottom face, if the option Assign recharge to top and bottom cell faces is chosen.

» Evapotranspiration
Similarly to Recharge, evapotranspiration can be assigned to the top face of a cell or treated as
adistributed sink.
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4.1.4 PMPATH Output Files

» Plots

To save the contents of the Top view window in plot files, choose Save Plot As from the File
menu and specify the format and the file name in the dialog box (Fig. 4.11). Four formats are
available: Drawing Interchange Format (DXF), Hewlett-Packard Graphics Language (HP-GL),
Windows Bitmap (BMP) and the PATHLINE file of MODPATH. To select aformat, click the
down-arrow on the Format drop-down box. You can type in the file name in the file edit field
directly or click the right mouse button on the edit field and select afile from the standard File
Open didog box. Note that PMPATH uses the same color resolution as the video screen to save
Windows Bitmap files. The True Color resolution is not supported by PMPATH. Do not save
plotsin the Windows Bitmap format, if you are using the True Color resolution.

= Save Plot As
Format:
|DxF |2 —
File:

Ic:\pm3\e)(\example.d)d

Click the right mouse button on the file fields to
select a file.

Fig. 4.11: The Save Plot As dialog box

If the MODPATH format is chosen, coordinates along the path of each particle are recorded in
the file specified in the Save Plot As diaog box. The file contains the starting coordinates of a
particle, and the coordinates at every point where a particle enters a new cell. In addition,
coordinates of intermediate points are saved whenever a particle tracking step length is reached.
The pathline file contains a sequence of one-line records, each line containing coordinate and
location information for one point on a pathline. Each record contains nine variables, and is
written in the format

15,1X,5(E20.12,1X),2(13,1X),13

The variables, in the order of appearance on the line, are defined as:

1. Paticleindex number: The index number is positive, if the forward particle tracking scheme
isused. A negative index number indicates that the backward particle tracking scheme is used.
Global coordinate in the x-direction.

Global coordinate in the y-direction.

Verticle local coordinate within the cell

Global coordinate in the z-direction

Cumulative travel time.

Jindex of cell containing the point.

| index of cell containing the point.

K index of cell containing the point.

CoNOrWN
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Except the particle index number, this format is identical to the PATHLINE FILE format
described in the program documentation of MODPATH.

» Hydraulic heads

To save the hydraulic heads in the current layer at the current stress period and time step, select
Save Heads As from the File menu. PMPATH saves the hydraulic headsin ASCIl Matrix format
(see Appendix 2).

» Drawdowns

To save drawdowns in the current layer, choose Save Drawdowns As from the File menu and
specify afile name in the standard File Save As dialog box. This menu item is disabled, if the
drawdown file DDOWN.DAT is not available. PMPATH saves the drawdowns in the ASCI|
Matrix format (see Appendix 2).

» Flow velocities

To save flow velocities in the current layer, choose Save Velocity As from the File menu and
specify afile name in the standard File Save As dialog box. Flow velocities at the center of each
cdl are saved in the ASCII Matrix format (see Appendix 2). In addition, the velocity components
aongthel-, J and K-axes are added to the end of the file. The flow velocity at the cell center is
the average of the velocities across the six cell faces. The default velocity at inactive cells is
1.0x10%.

» Particles

To save the starting position and the attributes of each particle, choose Save Particles As from
the File menu and specify afile name in the sandard dialog box. Thefollowing data format is used
to save the particles:

1. Data: version label
2. Data: NP
3.Data LI, LJ, LK, I,J K,Z, C, R

Thefirgt line of this particle file contains the version label PMPATH_V100 PARTICLES. The
second line contains the number of particles NP. The third record contains one line of data for
each particle. The particle locations within the cell [J, I, K] are specified using local coordinates
[LJ, LI, LK]. Local coordinates vary within a cell from zero to one as shown in Fig. 4.12. In
addition, the global vertica coordinate Z, the color C and the retardation factor R of the particle
are saved in the same line.

The particles file can be loaded by choosing Load Particles from the File menu. When you load
a particle file, PMPATH just adds particles to the model. Already existing particles will not be
removed.
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Fig. 4.12: Local coordinates within acell
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4.2 The Field Interpolator PMDIS

Numerica groundwater models require aredlly distributed parameters (e.g. hydraulic conductivity,
hydraulic heads, €levations of geologica layers etc.) assigned to each cell or element in the model
domain. Usudly, the modeler obtains a parameter distribution in the form of scattered (irregular)
datapoints (x;, y;, f;), i=1, ..., N. Where N is the number of measurement points, x, and y, are the
coordinates and f, isthe parameter value at point i. One of the basic problemsis how to estimate
the parameter values for each model cell from these data

A number of interpolation (or extrapolation) methods for solving thiskind of data-fitting problems
have been proposed. Some of the methods are used by commercia contouring software, e.g.
GEOKRIG, GRIDZO, SURFER or TECKON®. Many modelers and geologists use this software
for preparing contour maps. The gridded information or the digitized maps will be overlaid on the
model grid for assigning parameter values to model cells. The process isindirect and somewhat
cumbersome.

PMDIS provides a more direct way for assigning cell vaues by using the Kriging method and
methods devel oped by Shepard (1968), Akima (1978a, 1978b) and Renka (1984a, 1984b). The
interpolation program takes measurement data and interpol ates the data to each model cell. The
mode grid can beirregularly spaced. Interpolation results are saved in the ASCII Matrix format
(See Appendix 2), which can be accepted by the Data Editor. Depending on the interpolation
method and the interpolation parameters the results may be dightly different. Using the Data
Editor, you can create contour maps of the interpolation results and visually choose a "best"
result. See section 6.11 for an example.

Theory is not emphasized in this description, because it is introduced in an extensive literature.
For example, Franke (1982) provides a brief review and classification of 32 algorithms. Hoschek
and Lasser (1992) give acomprehensgve discussion of theories in geometrical data processing and
extensve references in the area of datainterpolation and computer graphics techniques. Akin and
Siemes (1988) and Davis (1973) provide necessary mathematical background skills on the
statistics and data analysis in geology.

PMDIS runs independently from PMWIN. To start PMDIS, select Field Interpolator (PMDIS)

from the Run menu of PMWIN or double-click the icon Ei= from the Program Manager. A dialog
box appears (Fig. 4.13). The available settings are summarized in Files, Gridding Method, Search
Method and Grid Position.

Files

» PMWIN Model
If you have dready opened amode within PMWIN, thisfield gives the model file name. If "Open

A Modd Firgt" is shown, you must click =1 and select a PMWIN-model from a standard Open
File dialog box. A PMWIN-mode file always has the extension MDL .
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» Input File
An input file contains the measurement data and must be prepared with other software or text

editors. Click [l to select an existing input file. An input file must have the following format:
N first line of the data file

X1, Y1, ©r second line of the data file

Xz, Y, Ty third line of the data file

Xi, Yir i (i+1)-th line of the data file

Xns Yoo Ty last line of the data file

Where N is the number of data points, x, and y, are the x- and y-coordinates of data point i and
f. isthe measurement value at the data point i. The maximum number of data points is 2000.

» Output file
An output file contains the interpolated data for each model cell and is saved in the ASCIl Matrix
format. See Appendix 2 for the format of the ASCII matrix file.

= Field Interpolator v
Files:
PMWIN Model: |e:\pmwin\examples\pmdis\expmdis.mdl
Input File: |e:\pmwin\examples\pmdis\measum.dat
Output File: [e‘\pmwiniexamplesipmdis\gridded.dat
rGridding Method ™ | [ Search Method
Shepard's Inverse Distance Iél |0c:lant Iél
Weighting Exponent: | 2 Data Per Sector: I 3
rCoordinates System | 1 Grid Position
Y [Xo.Yo) A Xo= Ih‘ﬁ4l]l,19
/‘( Yo= |51352_55
A A- I—z?_z
\II
(A=Rotation angle in degree) ‘ Help | ‘ Close | Go I

Fig. 4.13 The Field Interpolator dialog box

Gridding Method

PMDIS provides four gridding methods, viz. the Shepard's inverse distance method, Akima's
bivariate interpolation method, Renka's triangulation method and the Kriging method. Y ou can
select a method from the drop-down box. For each gridding method, there is a corresponding
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interpolation program. The interpolation programs are written in FORTRAN and compiled with
a 32-bit compiler.

» Shepard's inverse distance
The Shepard's inverse distance method uses Equation 4.10 for interpolating data to finite-
difference cdlls.

o mz

1[fi/(df>]
f:l

N (4.10)
E[1/d]
i=1

Whered, isthe distance between data point i and the center of amodel cedll, f; isthe value at the
i-th data point, F is the weighting exponent and f is the estimated value at the model cell.

The weighting exponent must be greater than zero and less than or equal to 10. Fig. 4.14 shows
the effects of different weighting exponents. Five data points are regularly distributed along the
x-axis. Using higher exponents (e.g., F = 4) the interpolated cell values will approach the value
of the nearest data point. The surface is therefore relatively flat near all data points. Lower
exponents (e.g. F=1) produce a surface with peaks to attain the proper values at the data points.
An exponent of F=2 is suggested by Shepard (1968).

Interpolated data value

I I I I I
10 20 30 40 50

F=1 ——- F=2 ——— - F=4 O data point

Fig. 4.14 Effects of different weighting exponents
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» Akima's bivariate interpolation

This method creates a triangulation of the measurement data points and performs interpolation
by usng abivariate quintic polynomia of Hermite type for the interpolation within atriangle. It
uses a user-specified number of data points closest to amodel cell for estimating the value at the
cell.

» Renka’s triangulation

This method crestes a triangulation of the measurement data points and uses a global derivative-
estimation procedure to compute estimated partial derivatives at each point. The program
determines a piecewise cubic function F(x,y). F has continuous first derivates over the created
mesh and extends beyond the mesh boundary allowing extrapolation.

» Kriging
The Kriging method is popularized by Mathéron (1963) in honor of D. G. Krige, a noted South
African mining geologist and statistician. PMDIS assumes that the measurement data are
stationary and isotropic. The Kriging method estimates the value at a model cell from a user-
specified number of adjacent data values while considering the interdependence expressed in the
variogram.

A variogram is a plot of semivariance vy, versus vector distance h. The variogram is used to
define the relationship of the measurement values or to estimate the distance over which
messurement values are interdependent. Click the "Variogram™ button to display the Variogram
dialog box (Fig. 4.15). You need to select a variogram model from the drop-down box and
gpecify the parameters for the selected variogram model. PMDI'S does not provide a procedure
for fitting the selected variogram curve to the measurement data. Thisis atask for geostatistical
software and beyond the objective of this software. If you do not know the variogram type, use
the linear variogram. Kriging with alinear variogram is usually quite effective.

= Variogram

"¥ariogram Model

[Power or Linear | i'

[ Parameters
Wariance C: | 6.843471

Nugget Variance: | 0

Power Factor: | 1

Slope: |1

11

‘ Help ” Cancel ” OK |

Fig. 4.15 The Variogram dialog box

The meaning of necessary parameters and the equations used by the program are listed below:

Modeling Tools



Processing M odflow 4-23

e Power law and linear model;

((h) = "™|h|®+c, ">0, 0<T<2 (4.11)
e Logarithmic model
(( hy ~ 3" Og|h|+co >0 (4.12)
e Spherical model
3./hl_|hP®

-C- (220 + C h<a
((h) ( 2 a 2a3) 0 (4.13)
((h) =C + ¢ h>a

e Gaussian modd
((h) = C - (1-EXP _hZ/aZ]) + Cy (4.14)

e Exponentia model
((h) =C - (1-EXP[ -|h|/a]) + Co (4.15)

Where C isthe variance of measurement data and will automatically be calculated by PMDIS, a
the correlation length, ¢, the nugget variance, o the slope and w the power factor of the power
modd. w=1 yieldsthe linear model (Fig. 4.16). The variance C will be calculated by the program.

Y(h) M)
°°8: linear 0'8:
0.6 0.6
0n4: o 0.4: 3a
0.2: power 0.2:
INE ]
| 1 2 3 4 h 2’510 2030 h

Fig. 4.16 Linear, power and logarithmic model

Search Method

The interpolation algorithms use three search methods to find a certain number of the
measurement data points for interpolating a cell value. The search methods are SIMPLE,
QUADRANT and OCTANT. PMDIS assumes that the search radiusisinfinitely large.
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The SIMPLE search method finds the data points nearest to the model cell. The QUADRANT
or OCTANT search methods find closest data points from each quadrant or octant around a
model cell (Fig. 4.17aand 4.17b). The number of data points used in a search is defined by the
Data Per Sector value. If fewer than Data Per Sector points are found in a sector, the program
uses the other nearest points found in the entire model. The valid range of Data Per Sector is
SIMPLE 3<Data Per Sector<30

QUADRANT 1<Data Per Sector<7

OCTANT 1<Data Per Sector<3

The search method defaults to OCTANT search. Octant or quadrant searches are usually used
when the measurement points are grouped in clusters. These search methods force the
interpolation programs to use measurement data points radially distributed around the mode! cell.
They usually introduce more smoothing than a SIMPLE search.

Note that the entries in Search Method are ignored when Renka's triangulation algorithm is used.

a

Fig. 4.17 Search pattern used by (a) Quadrant Search (Data Per Sector=2) and (b) Octant
Search (Data Per Sector=1)

Grid Position

Using the rotation angle and the coordinates (X, Y,,) of the left corner of the model grid, you can
rotate and place the grid at any position. The rotation angle is expressed in degrees and is
mesasured counterclockwise from the positive x-direction. See section 3.3.8 for details about the
coordinate system of PMWIN.
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GO

Click GO to start the interpolation. PMDIS creates and writes the settings and the coordinates
to a batch file PMDIS.BAT and two ASCII files PMDIS IN{1} and PMDIS IN.{2}. After
having created these files, PM DI S automatically opens a DOS-box and runs PMDIS.BAT in the
box. The ASCII files are used by the interpolation program.
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4.3 The Field Generator PMFGN

Using the Field Generator (Frenzel, 1995), fields with heterogeneoudly-distributed transmissivity
or hydraulic conductivity can be generated. This allows the user to do stochastic modeling with
PMWIN. In stochastic modeling, uncertainty due to unknown small-scale distribution of the
model parameters is addressed directly by assuming that the parameters are random variables.
Hydraulic conductivity or transmisstivity is commonly assumed to be lognormally distributed. We
denote the hydraulic conductivity by X and avariable Y=log(X). When Y is normally distributed
with mean value p and standard deviation o, then X has the lognormal distribution.

PMFGN runsindependently from PMWIN. To start PMFGN, select Field Generator (PMFGN)
from the Run menu of PMWIN. A didog box appears (Fig. 4.18). PMFGN uses the mean value ,
standard deviation o and correlation scales in both | and J-directions to generate a quantitative
description (aredization) of the hydraulic conductivity or transmissivity field. The size of the field
(number of cdls) and the number of desired redlizations is specified in the dialog box. Realizations
are saved in the ASCII Matrix format (see Appendix 2) using the file names filename.xxx, where
filename is the output file name specified in the dialog and xxx is the realization number. The
generated field islognormally (to base 10) distributed. Using the Data Editor (see section 3.3.7),
you can load the generated field into an area of the model grid where the columns and rows are
regularly spaced.

= Field Generator -

Output Filename (Without Extension):

|e:\p mwintexamplesipmexifield

[ Parameter Characteristics

Number of Realizations [1 to 999]: I 2
Mean Value (log10 ) [-30 to +30]: I‘:2
Standard Deviation (log10) [-30 to +30]: I -5

(Correlation Length/Field Width) in the I-direction [0 to 1]: | A
(Correlation Length{Field Width) in the J-direction [0 to 1]: I A
Number of Cells in the I-direction [2 to 400]: | 30

Number of Cells in the J-direction [2 to 400]: | 30

‘ Help |‘ Close

Fig. 4.18 The Field Generator dialog box

The smulation of the hydraulic conductivity distribution produced in this way is unconditional
because the hydraulic conductivity values are not constrained to match point measurementsin the
real field. In the conditional simulation existing measurements are used which reduce the space
of possbleredizations. The conditional generation of a single realization procedes in five steps:

Lo |

1. The parameter value for each model cell are interpolated from the measurements using the
Kriging method. The correlation length is determined from the measurements.
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2. Anunconditional generation is performed using the Field Generator with the same correlation
length (correlation scale).

3. The unconditionally generated values at the measurement locations are used to interpolate
values for each model cell by using the Kriging method again.

4. Thedigribution from step 3 is subtracted from the distribution from step 2 yielding kriging-
residuals.

5. Thekriging-resduas are added to the distribution from step 1 yielding a redization which has
the same correlation length and passes through the measured values at the measurement
points.

Modeling Tools



4-28 Processing M odflow

4.4 The Results Extractor

Normally, smulation results from MODFLOW or MT3D are saved unformatted (binary) and
cannot be viewed by using usud text editors. Using the Results Extractor (Fig. 4.19) you can read
the unformatted (binary) result files and save them in ASCII Matrix or Surfer Data files (see
Appendix 2).

Result Type: Column ¥Width:

|Hydraulic Head |£|
3 4 5 b 7 8 +

1 8.9306 5.695605 5.860457 8.82521 §.769894 8.754512 [

2 §.930452 5.695454 5.660298 5.625026 8.769684 8.754284 |—

3 8.930328 5.895316 5.860154 5.624866 8.769497 §.754069

4 8.930222 6.695185 6.660009 8.624706 8.789311 8.753851

5 8.930126 8.895058 8.859861 8.824537 8.789117 8.75362

b 8.930039 8.894938 8.859712 8.824363 8.788911 8.753375

7 8.92996 8.894823 8.859567 8.824185 8.788698 8.763119

8 8.929888 8.894716 8.859426 8.824012 8.788487 8.752863

9 $.929823 5.694619 5.859297 5.623849 8.768285 8.752614

10 $.929765 5.694531 5.65918 8.8237 §.768099 §.752384

11 8.929716 8.694456 6.659078 8.82357 8.787937 8.752183
12 8.929677 8.894394 8.858995 8.823463 8.787805 8.752019
13 8.929648 8.894348 8.858932 8.823384 8.787707 8.751898
14 8.929632 8.89432 8.858894 8.823336 8.787647 8.751826
15 8929628 8.894311 8.858881 8.823319 8.787629 8.751807 3

o 11 4]
Time { Layer Save Format |
Layer: Stress Period: Time Step: @® ASCII Matrix
1 [1 h © Surfer Data File

| Save... || Help... || Read || Close |

Fig. 4.19 The Results Extractor dialog box

The reault filesinclude hydraulic head, drawdown, cell-by-cell flow terms, preconsolidation head,
compaction, subsidence and concentraion (see Output Control of section 3.3.4 for the definition
of each term). You can choose a result type from the Result Type drop-down dox. The
gpreadsheet displays a series of columns and rows, which are corresponding to the columns and
rows of the finite-difference grid. By clicking the Read button, a result will be read and put into
the spreadsheet. In the Time/Layer group, you specify the layer number, stress period and time
step from which the result is read. If the result type is Cell-By-Cell Flow Terms, you can select
a flow term the Flow Term drop down dialog box (Fig. 4.20). Refer to section 4.5 for the
definition of the flow terms. If the result type is concentration, you can choose atotal elapsed time
at which caculated concentration is saved (Fig. 4.21). By setting a Save Format and clicking the
Save button, the result can be saved.

Modeling Tools



Processing M odflow 4-29

= Results Extractor

Result Type: Flow Term: Column Width:
|CeII—BrCeII Flow Terms Iél Flow Front Face + |1 4 gl
Storage

1 2 f‘onst?ant Head i 5 %]
1 0 0 Flow Right Face = 0
2 0 0 L
3 0 0 Flow Lower Face 0
4 0 0 wells [1]
5 0 0 Drains 237
I [ 0 Recharge AS09E-05_ |2.67
7 0 0 0 5.921766E-05 3.76
8 0 0 1.940654E-05 5.110249E-05 3176
9 a 0 3.669192E-05 4.678602E-05 374
10 a 1.767147E-05 3.706648E-05 4.384415E-05 371
11 0 3.428539E-05 3.834661E-05 4.18024E-05 3.67
12 0 5.037387E-05 3.971086E-05 4.033763E-05 3.63
13 0 5.106714E-05 4.045864E-05 3.92024E-05 3.59
14 0 5.582141E-05 4.075965E-05 3.821158E-05 3.56
15 0 6.510006E-05 4.06365E-05 3.723218E-05 3.533

[ ] [+]
Time { Layer Save Format— |
Layer: Stress Period: Time Step: ® ASCIl Matrix
|1 |1 Il C Surfer Data File

| Save... I | Help... I | Read | | Close I

Fig. 4.20 Reading the cell-by-cell flow terms with the Result Extractor

= Results Extractor

Result Type: Column Width:
|C|:|n|:entrati|:|n |£| 14
9 10 11 12 13 |+

28 4.809007E-02 5.780726E-02 6.792369E-02 7.827192E-02 8.85
29 4.628633E-02 5.63674bE-02 6.696413E-02 7.785328E-02 8.88
30 4.388367E-02 5.456321E-02 6.553254E-02 7.686552E-02 8.83
£l 4.129644E-02 5.224279E-02 6.357138E-02 7.516653E-02 8.69
32 3.864779E-02 4.997296E-02 6.118661E-02 7.273538E-02 8.43
33 3.627735E-02 4.733118E-02 5.862047E-02 6_965069E-02 8.06
34 3.438641E-02 4.499775E-02 5.564398E-02 6.672165E-02 7.56
36 3.301356E-02 4.286475E-02 5.278913E-02 6.267062E-02 7.18
36 3.189698E-02 4.096115E-02 4.994368E-02 5.894772E-02 6.75
37 3.089813E-02 3.895164E-02 0471467 5.548922E-02 6.33
38 2.977026E-02 3.700705E-02 4.448099E-02 5.151314E-02 5.89
39 2.061979E-02 3.506532E-02 4.168234E-02 4.752367E-02 5.40
40 2.751162E-02 3.3166561E-02 3.859163E-02 4.313505E-02 4.70

11 2 628482E-02 3.137115E-02 0363545 3.983655E-02 4.25

42 2.513766E-02 0298026 3.407381E-02 3.724185E-02 3.853
* |1 [+]

Time { Layer Save Format I

Layer: Total Elapsed Time: ® ASCIl Matrix

|1 O Surfer Data File

| Read || Close I

Fig. 4.21 Reading the calculated concentration with the Results Extractor
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4.5 The Water Budget Calculator

There are situations in which it is useful to calculate flow terms for various subregions of the
model. To facilitate such calculations, the computed flow termsfor individual cells are saved in
the file BUDGET.DAT. Theseindividud cell flows are referred to as cell-by-cell flow terms, and
are of four types: (1) cell-by-cell stress flows, or flows into or from an individua cell due to one
of the external stresses (excitations) represented in the model, e.g., pumping well or recharge;
(2) cdl-by-cell storage terms, which give the rate of accumulation or depletion of storagein an
individual cell; (3) cell-by-cell constant-head flow terms, which give the net flow to or from
individual constant-head cells; and (4) internal cell-by-cell flows, which are the flows across
individual cell faces. In the file BUDGET.DAT, the flow between the cells[J, |, K] and [}1, I,
K] is denoted by FLOW RIGHT FACE, the flow between the cells[J, I, K] and [J, 1+1, K] is
denoted by FLOW FRONT FACE, and the flow between the cells [J, I, K] and [J, |, K+1] is
FLOW LOWER FACE. The Water Budget Caculator usesthe cell-by-cell flow terms to compute
water budgets for the entire model, user-specified subregions, and in- and outflows between
adjacent subregions. Refer to Check simulation results and produce output of chapter 2 for
details.
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4.6 The Graph Viewer

To activate the graph viewer, select an appropriate menu item from the Run»Graphs menu. The
graph viewer (Fig. 4.22) dlowsyou to examine tempora development curves of the observations
and the smulation results, including hydraulic heads, drawdowns, concentration, preconsolidation
heads, compaction of each mode layer and subsidence of an entire aquifer. (Note that drawdown
isdefined by h, - h, where h, isthe starting hydraulic head and h is the calculated head at time't.)
The coordinates of bores and the corresponding observed data are specified in the Bores and
Observations dialog box (see section 3.3.6).

PMWIN employs a bilinear interpolation scheme to calculate values pertaining to user-specified
bores from those saved in unformatted (binary) simulation result files. For each user-specified
bore, the four model cells surrounding that bore are first determined. The simulation results at
those cells are then interpolated to the bore by using the following equation:

s(h; A,
h = % i=1to4; A =0ifh =HDRY, HNOFLOor CINACT (4.16)

where A, isthe area and h, is the computed value at the center of a cell as shown in Fig. 4.23;
HNOFLO and HDRY are predefined heads for no-flow cells and dry cells, and CINACT is the

predefined concentration value for inactive concentration cells. If aboreliesin an inactive cell,
h=HDRY.

Head Bore |Plot |Color |4

h 1 No

2. BEE+14 2 No

3 No

1 No

5 Yes

b No

7 No

8 No

9 No

10 No

11 Yes

12 No
13 No | 3
" Graph Style 1

2E+ +—t — @ Linear

3E+1 1.8E+2 C Semi-Log
[ X-Axis (Time) || Y-Axis [Data Types | | Data >> I
Min_Time: Min. Value: ® Calculated
|30 | 20.00919 X Observation | seveplotas. |
Max. Time: Max. Yalue:
(Options | Close I
I 18) I 26.73034 [ Draw Horizotal Grid
Ticks: Ticks: X Draw Yertical Grid | Help I
| 10 | 10 % Auto Adjust MinfMax

Fig. 4.22 The Graph Viewer showing head-time curves
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The available settings of the graph viewer are summarized below.

>

The Bore Table

The bore numbers and the plot colors are given in the table of the graph viewer. The curve
of a bore will be displayed only when the corresponding Plot flag is set to YES. The plot
color of each curveis given in the Color column. To change the color, double-click on the
colored cell of the table. Note that if you have deactivated a bore in the Bores and
Observations dialog box, the corresponding row of the table in the graph viewer will be
dimmed, and you cannot change its settings.

X-Axis (Time)

Min. Time and Max. Time define arange of smulation time for which the curves should be
displayed. The number of desired ticksis given in the edit field of Ticks.

Y-AXis

Min. Vaue and Max. Vaue specify the minimum Y -axis value and maximum Y -axis value on

the graph. The number of desired ticksis given in the edit field of Ticks.

Data Types

Check the Calculated or Observation boxes to display the curves based on the computed or
observed data. The graph viewer uses solid linesfor displaying calculated curves. Observation
curves are dashed.

Options

Fig. 4.23 Interpolation of simulation results to a user-specified bore

Check the Draw Horizontal Grid or Draw Vertical Grid box to display the reference grids on
the graph. If Auto Adjust Min/Max is checked, the graph viewer searches the minimum and
maximum smulation times and values from the smulation result and put them into the X-Axis
(Time) and Y -Axis groups

Graph Style

Y ou can display the time axis (X-axis) either on alinear or logarithmic scale.

Save Plot As

Modeling Tools



Processing M odflow

4-33

Use this button to save the graph in Windows bitmap format. Note that PMWIN uses the
same resolution as Windows to save hitmap files. The 24 bits True Color resolution is not
supported by PMWIN. Do not try to save graphs, if you are using True Color.

» Data »

Click this button to display aVdue Table didog box (Fig. 4.24) showing the observation and
calculated values. Clicking the Save As button, you can save the calculated values in a
Observation file (see Appendix 2 for the format).

Observations: Calculated Values:
Bore [Time Yalue 4| [Bore [Time Yalue +
1 30 26.50655 =11 30 25.84934 I
1 60 27.00705 = (1 60 26.25483 -
1 90 27.04515 1 90 26.28266
1 120 20.57287 1 120 20.4635
1 150 20.07482 1 150 20.05996
1 180 20.03691 1 180 20.03227
2 30 26.4474 2 30 25.82236
2 60 26.94232 2 60 26.22545
2 90 26.97998 2 90 26.2531
2 120 20.56834 2 120 20.46234
2 150 20.07584 2 150 20.06118
2 180 20.03836 2 180 20.03366
+ +
| Help I | Save As._.. I | Close

Fig. 4.24 The Vaue Tables dialog box
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5. Applications and Sample Problems

The sample problems contained in this chapter are intended to illustrate the use of PMWIN and
the supported programs. Some of the sample problems are documented in the description of the
corresponding software. There is a model for each sample problem. In order to give the user a
complete reference, these sample problems are described in this chapter again. In the following
sections, the path to each model is given by Location. An example, which shows the input and
output from MODFLOW (see McDonad et al., 1988; Appendix D), is located in
PMWIN\EXAMPLES\MFLOWEX.

5.1 The Theis Solution
Location: PMWIN\EXAMPLES\THEIS

Problem Description and Modeling Approach

Given the aquifer properties, transmissivity and confined storage coefficient, the Theis solution
predicts drawdown in aconfined aquifer at any distance from awell at any time since the start of
pumping. This example gives an approximation of the Theis solution with a numerical model.

The assumptions inherent in the Theis solution include:

(1) The aquifer is homogeneous, isotropic and of uniform thickness,

(2) The aguifer is confined between impermeable formation on top and bottom, and of infinite
areal extent.

(3) Theinitial potentiometric surface is horizontal and uniform.

(4) The pumping rate of the well is constant with time.

(5) The well penetrates the entire aquifer and the well diameter is small.

(6) Water isremoved from storage instantaneously with decline in head.

All of these assumptions, with the exception of infinite areal extent, can be represented with the
numerica model. The modeled domain presented in this model is therefore fairly large and a
limited time frame is modeled. An increasing grid spacing expansion is used to extend the model
boundaries (Fig. 5.1). A single modd layer is used to model the confined aquifer. A fully
penetrating well located at the center of the model domain pumps a a constant rate. The
drawdown of the head is monitored with time at an observation bore 55m from the pumping well.
The model parameters are listed below:

Starting hydraulic head = 0.0 m

Transmissivity = 0.0023 m?/s

Storage coefficient = 0.00075

Pumping rate = 4 x 10° m®/s

Total simulation time = 86400 s

Number of time steps = 20

Time step multiplier = 1.3

Number of SIP iteration paramters =5
Convergence criterion of head change = 0.0001

Applications and Sample Problems
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Maximum number of iterations = 50

Constant head boundary

pumping

observation poi

=
©
©
c
E]
°
a
)
©
o
<
<
o
@
c
&
O

Constant head boundary

Constant head boundary

Fig. 5.1 Configuration of the groundwater model

Simulation Results

Both the analytical and calculated drawdown versus time curves are shown in Fig. 5.2. The
analytical values are specified in the Bores and Observations dialog box (see section 3.3.6). An
exact comparison is not attained because of the approximations made in the numerical model.
These include: (1) use of a discrete rather than continuous spatial domain, (2) use of a discrete
rather than continuous time domain, (3) use of an iterative solution with a convergence tolerance,
and (4) artificial placement of boundaries.

In practice, you can specify the real observation time and datain that dialog box and use PEST
to estimate the aquifer transmissivity. In this sample model, the aquifer transmissivity is already
defined as an estimated parameter (see Parameter List of section 3.3.6 for details). Click
RUN»>Parameter Estimation (PEST) to see how PEST works. Refer to Freeze and Cherry (1979)
for more information on the Theis solution and the pumping test.

Drawdown
h

0 1 .
1 1 1 1 1 1 1 1 1 1

fm-nen analytical
' calculated !

0.E+D ——t—t+—t+—+—+—+—t+—1 Time
0.E+0 A.64E+4

Fig. 5.2 Drawdown versus time curves
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5.2 Model Calibration with PEST

Location: PMWIN\EXAMPLES\PEST\EX 1

Problem Description and Modeling Approach

Groundwater models are usualy applied to conceptualize and understand a hydrologic system or
to predict the outcome of a future change to the system. In order to provide some assurance that
the model reflects the behavior or appearance of the flow system, it must be calibrated prior to
use as a predictive tool. Calibration is accomplished by finding a set of parameters, boundary
conditions, and excitations or stresses that produce simulated heads (or drawdowns) and fluxes
that match measurement values within an acceptable range of error. Model calibration can be
performed by the hand-operated trid-and-error adjustment of aquifer parameters or by automated
calibration programs, such as PEST (supported by PMWIN), MODINV (Doherty, 1990) or
MODFLOWI/P (Hill, 1992). This example provides an exercise in model calibration with PEST.
Specific details of this example are from Andersen (1993).

Fig. 5.3 shows the idealized flow system and locations of observation bores. The flow system is
asmal, confined aquifer which is strongly controlled by the river which across it. The aquifer is
approximately 100 ft thick and is composed primarily of silty sand. The river is not in direct
hydraulic connection with the aguifer, but acts as aleaky boundary condition which can gain or
lose water to the aquifer. Stage data for the river and riverbed elevation are listed in Table 5.1.
Other boundary conditions are no-flow, which surround the square and define the areal extent of
the aguifer. Given congraints of uniform transmissivity and recharge, and additional data below,
obtain a steady state calibration based on the measurements listed in Table 5.2.

Initial hydraulic head = 100.0 ft

grid size= 15x 15

Ax = Ay =500 ft

river base flow at western model boundary = 10 cfs
river base flow at eatern model boundary = 11.125 cfs
riverbed conductance = 0.01 ft¥/s

$

1

Fig. 5.3 Configuration of the aquifer system
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Row Column Stage (ft) Riverbed Elevation (ft)
4 1 100.0 90.0
4 2 100.0 90.0
4 3 100.0 90.0
4 4 99.0 89.0
4 5 99.0 89.0
5 6 98.0 88.0
6 7 97.0 86.0
7 8 96.0 86.0
8 9 95.0 85.0
9 10 94.0 84.0
9 11 94.0 84.0
9 12 94.0 84.0
9 13 94.0 84.0
9 14 93.0 83.0
9 15 93.0 83.0

Table 5.1 River data

Bore Row Column Head (ft)
1 14 1 124.0
2 11 4 119.9
3 13 13 113.9
4 8 1 116.1
5 4 12 113.0
6 9 6 114.0
7 2 3 108.5
8 11 10 111.7
9 7 14 107.6
10 3 18 111.3
11 2 15 115.6

Table 5.2 Measurement data

Simulation Results

Transmissvity and recharge are defined as parameters pl and p2 and estimated by PEST. The
estimation program records the optimised parameter values and the correlation coefficient matrix
to the run record file as shown below:

Par amet er Esti mat ed 95% percent confidence limts
val ue lower limt upper limt

pl 1. 000282E- 02 9. 724991E- 03 1. 028859E- 02

p2 1. 996080E- 08 1. 985581E- 08 2. 006578E- 08

Note: confidence linits provide only an indication of paraneter uncertainty.
They rely on a linearity assunption which nay not extend as far in
paraneter space as the confidence limts thenselves - see PEST manual

Correl ation Coefficient Matrix ----- >
1. 000 0. 9572
0. 9572 1. 000
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The diagona elements of the correlation coefficient matrix are aways unity. The off-diagonal
elements are dways between 1 and -1. The closer an off-diagonal element isto 1 or -1, the more
highly correlated are the parameters corresponding to the row and column numbers of that
element. For thisexample, transmissivity (parameter pl) and recharge (parameter p2) are highly
correlated, asisindicated by the value 0.9572 of the correlation coefficient matrix. This means
that these paramters are determined with ahigh degree of uncertainty in the parameter estimation
process. A senditivity analysis could be used to quantify the uncertainty in the calibrated model
caused by uncertainty in the estimates of the aquifer parameters. Refer to Anderson and Woessner
(1992) for more about the sengitivity analysis.

For our example, the only dischargeisto theriver and the only source is recharge. To be in steady
state, these two must balance. Recharge must therefore equal to 1.125 cfs (the river gain equals
11.125 cfs - 10 cfs) Spreading over the modeled area:

1.125ft 3/s

recharge=
(15 x 15)-(500ft x 500ft)

= 2x10°® ft/s (5.1)

The estimated parameter values are acceptable.
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5.3 Estimation of Pumping Rates with PEST

Location: PMWIN\EXAMPLES\PEST\EX2

Problem Description and Modeling Approach

This example involves the encagpsulation of ahighly contaminated area. The parameter estimation
program PEST is used to calculate the necessary pumping rate. The aguifer in which the
contaminated areais buried consists of one unconfined layer and is of infinite area extent. The
extent of contamination area is about 65 m x 65 m. The head in the center of this areais about
9.45 m. The elevation of the aguifer top is 10 m and the aquifer bottom is O m. The hydraulic
conductivity isisotropic and uniformly 3x10* m/s. The unconfined storage coefficient (specific
yidd) isabout 0.2. Recharge is assumed to be zero. The groundwater flow is directed from west
to east with a hydraulic gradient of 0.5%o.

The objective of the remediation measure is to prevent contaminated water flow out of the area.
Different types and combinations of measures can be introduced for this purpose including a surry
wall around the area, drainages and pumping wells. An impervious cover could be considered, if
the recharge were not zero. All measures are directed to the same goal - a reduction of the
piezometric head in the area itself such that the groundwater flow is directed towards the
contaminated area. To achieve this objective, a slurry wall around this area and four pumping
wells have been chosen. Fig. 5.4 shows the configuration of the remediation measures. The slurry
wall is 0.5 m thick and the hydraulic conductivity of the materia is 5x10® m/s. The configuration
of the model is shown in Fig. 5.5. To obtain the hydraulic gradient of 0.5%o, the west and east
sdes of the model are assumed to be constant-head boundaries with hydraulic heads of 9.8925
and 9 m, respectively.

The pumping rate of the wells should be estimated such that the hydraulic head in the center of
the contaminated area in the steady state is reduced to 8 m. Furthermore, the duration until the
steady state is reached should be calculated.

‘ W pumping weII#

ATT \ slurry waIL

Fig. 5.4 Configuration of the remediation measures
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No-flow boundary

Jslurry wall

£
S
o

Constant-head boundary, h
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1785 m

Fig. 5.5 Configuration of the groundwater model

Simulation Results

The pumping rates of the wells are defined as an estimated parameter by using a zone that covers
al four wells. An "observation” boreis set at the center of the contaminated area as shown in Fig.
5.4. The"observed" head at time 1 is set at 8 m (the remediation objective). The simulation time
for the steady State cdibration (parameter estimation) isalso set to 1. The pumping rate of each
well (estimated by PEST) is about 7.9x10° m?/s.

To calculate the duration until the steady state is reached, the estimated pumping rate of 7.9x10°
m*/s is specified to each well. A transient simulation with one stress period (subdivided into 25
equal time steps) is carried out. The total simulation time is 1x10® seconds. The cal culated head-
time curve (Fig. 5.6) shows that the steady state is reached at t~4x10" s.

G.E+D
0.E+0 1.E+8

Fig. 5.6 Head versus time at the center of the contaminant area
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5.4 Using the Field Interpolator

Location: PMWIN\EXAMPLES\PMDIS

Problem Description
This example illustrates the use of the Field Interpolator. Fig. 5.7 shows the plan view of the

modd area, the model grid and the locations of measurement points. The model grid consists of
70 rows and 60 columns and one layer. The measured hydraulic heads and the coordinates of the
messurement points are saved in the file MEASURE.DAT. To obtain the starting head of aflow
simulation, the measured hydraulic heads should be interpolated to each model cell.
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Fig. 5.7 Plan view of the model area

Interpolation Results
Theinterpolation results are shown in the form of contoursin Fig. 5.8 - 5.11. The octant search

method with Data Per Sector = 1 isused by all gridding methods. A weighting exponent of F = 2
is used by Shepard's inverse distance method. The Kriging method uses the linear variogram
moded with ¢, = 0 and o = 1. For comparison, the contours produced by SURFER are shown in
Fig. 5.12, where the inverse distance method and the octant search method with Data Per
Sector = 1 and weighting exponent F = 2 were used. The grid size used in SURFER is 80x80
points. The dight difference between Fig. 5.8 and Fig. 5.12 is caused by different numbers of
columns and rows of the grid. There is no significant difference observed in these figures when
sufficient data points are available. The major difference is observed in the southern part of the
mode area, where only one measurement point is found and the system is not well conditioned.
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655 660 66.5 67.0 67.5 68,0
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Fig. 5.8 Contours produced by Shepard's inverse distance method
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Fig. 5.9 Contours produced by the Kriging method
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Fig. 5.10 Contours produced by Akimas bivariate interpolation
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Fig. 5.11 Contours produced by Renka's triangulation algorithm
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Fig. 5.12 Contours produced by SURFER. The inverse distance method is used.
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5.5 An Example of Stochastic Modeling
Location: PMWIN\EXAMPLES\SAMPLE

Problem Description and Modeling Approach

Aquifer remediation measures are often designed by means of groundwater models. Model results
are usualy uncertain due to the imperfect knowledge of aquifer parameters. We are uncertain
about whether the calibrated values of parameters indeed represent the real aquifer system. We
never know the actud small-scale distribution of some parameters, e.g. hydraulic conductivity or
recharge. Thus, all groundwater models involve uncertainty. Stochastic models are often
employed to consider the uncertainty. In the stochastic modeling, the model parameters appear
in the form of probability distributions of values, rather than as deterministic sets. This example
illustrates a conception of stochastic modeling.

We use the same model as described in chapter 2 and utilize the Field Generator to create a
lognormal correlated distribution of the horizontal hydraulic conductivity. The mean value of the
horizonta hydraulic conductivity is assumed to be p = log K = -2.3 and the standard deviation o
= 0.5. The correlation length is 60m. In chapter 2, the pumping rate of the well was determined
such that the contaminated arealies within the capture zone of the well. When redlisations of the
heterogeneous distribution of hydraulic conductivity are introduced, it is obvious that the capture
zone not aways covers the entire contaminated area. Define the safety criterion as the percentage
of the covered areain relation to the entire contaminated area. To estimate this safety criterion,
a stochastic smulation should be performed.

Simulation Results

Using the Field Generator with the settings shown in Fig 5.12, lognormal distributions of the
horizontal hydraulic conductivity are generated and saved in ASCII Matrix files. First, each
generated realization is imported into the horizontal hydraulic conductivity matrix, then aflow
samulation is performed. The capture zone of the pumping well, as well as pathlines, are generated
by using PMPATH. The safety criterion can be quantified by using Monte Carlo simulations
whereby many such realizations of the parameter field are produced and used in the flow
simulation.

— Field Generator A

Qutput Filename (¥ithout Extension):

A |

|e:\pmwin\examples\sample\field

" Parameter Characteristics
Number of Realizations [1 to 999]: | 10

Mean Value (log10 ) [-30 to +30]: -2.3|
Standard Deviation (log10) [-30 to +30]: I -5

(Correlation Length{/Field Width) in the X-direction [0 to 1]: I 1
(Correlation Length/Field Width) in the Y-direction [0 to 1]: I 1
Number of Cells in the X-direction [2 to 400]: | 30
Number of Cells in the Y-direction [2 to 400]: | 30

[ e |
Fig. 5.13 Use of the Field Generator to create lognormal correlated distributions of model
parameters

| Help

| Close
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Fig. 5.14 shows results of five reaizations and the calculated mean safety criteria. Mean safety
criterion is the sum of safety criteria divided by the number of realizations. A large number of
realizations may be needed until the mean safety criterion converges.

Contaminated area
pumping well

Realization 1
Safety Criterion = 87.5%
Mean Safety Criterion = 87.5%

Realization 2
Safety Criterion = 91.5%
Mean Safety Criterion = 89.5%

Realization 3
Safety Criterion = 100%
Mean Safety Criterion = 93%

Realization 4
Safety Criterion = 83%
Mean Safety Criterion = 90.5%

Realization 5
Safety Criterion = 100%
Mean Safety Criterion = 92.4%

Fig. 5.14 Calculation of the mean safety criterion by using the Monte Carlo method
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5.6 Simulation of a Two-Layer Aquifer System in which the Top Layer
Converts Between Wet and Dry

Location: PMWIN\EXAMPLES\BCF2\EX1

Problem Description and Modeling Approach

Thisexample isfrom thefirg test problem of the BCF2 Package (McDonald et a., 1991). Inan
aquifer system where two aquifers are separated by a confining bed, large pumpage withdrawals
from the bottom aquifer can desaturate parts of the upper aquifer. If pumpage is discontinued,
resaturation of the upper aquifer can occur. This problem demonstrates the capability of the BCF2
Package to successfully smulate this common hydrologic situation which is difficult or impossible
to simulate with the original BCF1 Package.

The mode consists of two layers - one for each aguifer - separated by a confining unit (Fig. 5.15).
No-flow boundaries surround the system on all sides, except that the lower aquifer discharges to
agtream aong the right side of the area. Recharge from precipitation is applied evenly over the
entire area. The stream penetrates the lower aquifer; in the region above the stream, the upper
aquifer and confining unit are missing. Under natural conditions, recharge flows through the
system to the stream. Under stressed conditions, two wells withdraw water from the lower
aquifer. If enough water is pumped, cells in the upper aquifer will desaturate. Removal of the
stresses will then cause the desaturated areas to resaturate.

Because horizontal flow in the confining bed is small compared to horizontal flow in the aquifers
and storage is not a factor in steady-state smulations, the confining bed is not treated as a
separate model layer. The effect of the confining bed is incorporated in the value for vertical
leakance (see section 3.3.3). Note that if storage in the confining bed were significant, transient
simulations would require that the confining layer be ssimulated using one or more layers. The
confining layer must also be smulated, if you intend to calculate pathlines with PMPATH or to
smulate solute transport with MT3D. A uniform horizontal grid of 10 rows and 15 columnsis
used. Aquifer parameters are specified as shown in Fig. 5.15.

Simulation Results

Two steady-state solutions were obtained to smulate natural conditions and pumping conditions.
The two solutions are designed to demondtrate the ability of the BCF2 Package to handle a broad
range of possihilities for cells converting between wet and dry in the top aquifer. When solving
for natural conditions, the top aquifer initialy is specified as being entirely dry and many cells
must convert to wet. When solving for pumping conditions, the top aquifer isinitialy specified
to be under natural conditions and many cells must convert to dry. The steady-state solutions
were obtained through a single smulation consisting of two stress periods. The first stress period
smulates naturd conditions and the second period simulates the addition of pumping wells with
extraction rates of 30000 ft*/d. The simulation is declared to be steady state, so no storage values
are specified and each stress period requires only a single time step to produce a steady-state
result. The PCG2 Package is used to solve the flow equations for the simulations.
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Fig. 5.15 Configuration of the hypothetical model (after McDonald et a., 1991).

Determination of the wetting threshold THRESH (see equation 3.24) often requires considerable
effort. The user may have to make multiple test runs trying different values in different areas of
the model. On the right Side of the model, THRESH is negative in order to cause a cell to become
wet only when the head in the layer below exceeds the wetting threshold. This was done to avoid
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incorrectly converting dry cells to wet because of the large head differences between adjacent
horizontal cells. For example, the smulation of natural conditions (Stress Period 1) shows cells
in column 14 of layer 1 being dry, which is reasonable based on the head below these cells. That
is, the head in column 14 of layer 2 is over 20 feet below the bottom of layer 1. However, the
head in column 13 of layer 1 is 21 feet above the bottom of the aquifer, which means that, if the
head in adjacent horizontal cellsis allowed to wet cells, column 14 would convert to wet. Thus,
it isnot readily apparent whether column 14 should be wet or dry. The trial simulations showed
that, when horizontal wetting is allowed, column 14 repeatedly oscillates between wet and dry,
indicating that column 14 should be dry. If horizontal wetting is used, oscillation between wet and
dry can be prevented by raising the wetting threshold, but this also can prevent some cells that
should be partly saturated from converting to wet.

On theleft Sde of the mode, horizontal head changes between adjacent cells generally are small,
50 head in the neighboring horizonta cellsis agood indicator of whether or not adry cell should
become wet. Therefore, positive values of the wetting threshold THRESH are used in most of this
areato alow wetting to occur either from the cell below or from horizontally adjacent cells. Near
the well, the horizontal head gradients under pumping conditions also are relatively large;
consequently, a negative THRESH was used at the cells above the well. This prevents these cells
from incorrectly becoming wet. It is aso possible to use a larger positive wetting threshold to
prevent these cells from incorrectly becoming wet.
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5.7 Simulation of a Water-Table Mound Resulting from Local Recharge
Location: PMWIN\EXAMPLES\BCF2\EX2

Problem Description and Modeling Approach

Localized recharge to a water-table aquifer results in formation of a ground-water mound. For
example, a ground-water mound may form in response to recharge from infiltration ponds
commonly used to artificialy replenish aquifers or to remove contamination by filtration through
asoil column. If the aquifer haslow vertical hydraulic conductivity or contains interspersed zones
of low hydraulic conductivity, it may be necessary to ssimulate the aquifer using multiple model
layersin which the mound crosses more than one layer. This example is posed to demonstrate the
capability of the BCF2 Package to simulate mounding of the water table through multiple model
layers. The hypothetical model is from the second test problem of the BCF2 Package.

The conceptual modd consists of arectangular, unconfined aquifer overlain by athick unsaturated
zone (Fig. 5.16). The horizontal hydraulic conductivity is 5 feet per day and vertical hydraulic
conductivity is 0.25 feet per day (=0.0762 m/d). A leaking pond recharges the aquifer, resulting
in the formation of a ground-water mound. The pond covers approximately 6 acres (=23225 m?)
and pond leakage is 12,500 cubic feet per day (=354 m*/d). The specific yield is 20 percent. The
water table isflat prior to the creation of the recharge pond. The flat water table is the result of
auniform constant-head boundary that surrounds the aquifer.

Because of the symmetry, heads are identica in each quadrant of the aquifer, and there is no flow
between quadrants; therefore, only one quarter of the system needs to be simulated. The problem
issmulated using agrid of 40 rows, 40 columns, and 14 layers (Fig. 5.16). A uniform horizontal
grid spacing of 125 feet (=38.1 m) is used, and each layer is 5 feet (=1.52 m) thick. The pond is
in the upper left corner of the grid. The boundaries along row 1 and column 1 are no-flow asa
result of the symmetry. A constant-head boundary of 25 feet (=7.62 m) is specified along row 40
and column 40 for layers 10-14; ano-flow boundary is assigned along row 40 and column 40 for
layers 1-9. Without the recharge from the pond, layers 1-9 are dry, and the head in al the cells
of layers 10-14 is 25 feet. Recharge from the pond is applied to the horizontal area encompassed
by rows 1 through 2 and columns 1 through 2. Recharge option 3 (see section 3.3.4) is used so
that recharge will penetrate through inactive cells down to the water table. The recharge rate of
0.05 foot per day (=0.0152 m/d) simulates leakage of 3,125 cubic feet per day (=~88.5md)
through one quarter of the pond bottom, a simulated area of 62,500 square feet (=5806 m?).
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Fig. 5.16 Hydrogeology and model grid configuration

Simulation Results

Reasonable solutions to the ground-water mounding problem can be obtained in two steady-state
smulations by using the PCG2 solver. In the first smulation, dry cells are converted to wet by
comparison of the wetting threshold THRESH (see equation 3.24) to head only in underlying
cdls whichisindicated by a negative value of THRESH. The wetting-iteration interval is 1 and
THRESH is-0.5 foot, which means that the wetting threshold is 10 percent of the thickness of
a cell. In the second simulation, wetting of cells is based on comparison to heads both in
horizontally adjacent and underlying cells (THRESH is positive). A wetting-iteration interval of
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2and aTHRESH of 1.5 feet are used in order to prevent continued oscillation between wet and
dry for some cells. Due to the stegpness of the head gradient and the grid discretization, the head
difference between adjacent horizontal cells is generally much larger than the head difference
between adjacent vertical cells aong the mound. For example, the cell at layer 4, row 3, column
4 is supposed to be dry even though the head in the horizontally adjacent cell in column 3is 1.4
feet above the bottom of the layer. The vertical head difference between cellsin this part of the
mode is much less; the difference between the head at the cell in layer 4, row 3, column 3 and the
cdl below isonly 0.05 foot. Thus, the neighboring cell to the right is repeatedly and incorrectly
converted to wet during the solution processif horizonta wetting is used with a wetting threshold
of 0.5 foot. The larger wetting threshold and wetting-iteration interval used in the second
smulation alow convergence to occur, but only after many iterations. In this simulation, head in
adjacent vertical cellsisthe best indicator of when a dry cell should become wet.

The formation of the groundwater mound over time can be obtained with a transient smulation.
The transient simulation is run for one stress period with a length of 500,000 days. The stress
period is divided into 50 time steps with atime-step multiplier of 1.3. The first time stepis 0.3
days, and the last time step is 115,385 days. The specific yield is 20 percent and the confined
storage coefficient is0.001. The PCG2 solver isused and cells are activated by comparison of the
wetting threshold to headsin underlying cells. The head change criterion for closure is 0.001 foot
and the residual-change criterion is 10,000 cubic feet, the wetting threshold is 0.5 foot, the
wetting factor is 0.5, and the wetting-iteration interval is 1. Fig. 5.17 shows simulated water-table
heads along row 1 at several times during the transient simulation. Steady-state conditions were
reached at the 44th time step of the transient simulation as indicated by storage flow terms being
zero (see the smulation record file OUTPUT.DAT).

Simulated Water Table
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Fig. 5.17 Simulated water-table heads dong row 1 beneath aleaking pond after 190 days, 708
days, 2630 days and steady state conditions (after McDonald et al., 1991)
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5.8 Simulation of a Perched Water Table
Location: PMWIN\EXAMPLES\BCF2\EX 3

Problem Description and Modeling Approach

Contrastsin vertica hydraulic conductivity within the unsaturated zone can provide a mechanism
for the formation of perched ground-water tables. This example is from the third test problem of
the BCF2 Package. It simulates formation of a perched water table and has practical application
in the simulation of recharge going to a deeper aquifer system.

The conceptual model is rectangular and consists of three geohydrologic units. The upper and
lower units have higher hydraulic conductivities than the middle unit (Fig. 5.18). There is a
regional water table in which the head is below the bottom of the middle unit. Natural recharge
occurs over the entire area at arate of 0.001 foot per day. This recharge can percolate through
the two upper units without the formation of a water table above the middle because the vertical
hydraulic conductivity of this unit is 0.002 foot per day.

Recharge at a rate of 0.01 foot per day from a pond covering 6 acres (~23225 m?) causes a
perched ground-water body to form in the top two units. The total pond leakage is about 2,360
cubic feet per day (=66.8 m*/d). The perched water table spreads out over an area much larger
than the area covered by the pond. This has an impact on the distribution of recharge to the lower
unit.

Because of the rectangular symmetry of the system, there is no flow between quadrants.
Therefore, only one quarter of the system must be simulated. The problem is smulated using a
grid of 50 rows, 50 columns, and 2 mode! layers. A uniform grid spacing of 16 feet is used. The
recharge pond is in the upper left corner of the grid; the quarter of the pond that is simulated
occupies a square area that is 16 rows long and 16 columns wide. The boundaries along row 1
and along column 1 are no-flow boundaries as a result of the symmetry.

Modd layer 1 smulates the upper geohydrologic unit and is assigned a hydraulic conductivity of
5 feet per day. The bottom of layer 1 isat an elevation of 20 feet. The lower geohydrologic unit
issmulated asmodd layer 2. Thislayer issmulated as a confined/unconfined layer with constant
transmissivity (layer type 2; see section 3.3.2). The top and bottom of layer 2 are set at 10 and
O feet, respectively. Because the head in this layer is always below the layer top, the flow from
aboveislimited as described by McDonald and Harbaugh (1988, p. 5-19). Thus, there is no direct
hydraulic connection between the perched layer and the lower layer, but the perched heads have
adirect impact on the recharge into the lower layer. The purpose of the smulation isto show that
the distribution of recharge from the perched system can be estimated by using the BCF2 Package
to simulate the perched water table. All cellsin layer 2 are assigned a constant head of 1 foot
because there is no need to smulate heads in this layer for the purpose of estimating recharge. The
middle geohydrologic unit is not simulated as a separate model layer because it is assumed that
horizonta flow and storage affects are negligible. This unit is represented by the value for vertical
leakance (see section 3.3.3) between model layers 1 and 2. The vertical leakance is assumed to
be 0.0002 per day. In areas not covered by the pond, recharge is applied aredlly at arate of 0.001

Applications and Sample Problems



Processing Modflow 5-21

foot per day to simulate natural recharge. Recharge option 3 (see section 3.3.3) is used so that
recharge will penetrate through inactive cells to the water table. A recharge rate of 0.01 foot per
day is applied to the area covered by the pond.

Cross-Section Model Grid Configuration
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Fig. 5.18 Hydrogeology and model grid configuration
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Simulation Results

A steady-state simulation is performed to simulate the formation of a perched water table.
Solution of the flow equation is obtained using the SIP solver. The steady-state simulation
produced the long-term head distribution resulting from the pond recharge.

Starting hydraulic head in layer 1 under the pond is set at 21 feet. All other cellsin layer 1 initialy
are specified as no-flow cells. Wetting and SIP solver parameters are adjusted to obtain a solution.
The wetting-iteration interval, THRESH (see equation 3.24), and wetting factor are set at 2
iterations, 1.0 foot, and 0.5, respectively. A positive value of THRESH indicates that horizontally
adjacent cells can cause dry cells to become wet. This is the only way for cells in layer 1 to
become wet because heads in layer 2 are always below the bottom of layer 1.

Steady-dtate heads dong row 1in layer 1 range from 29.92 feet in cell [J, I, K]=[1, 1, 1] to 20.75
feet in cell [40, 1, 1]. Fig. 5.19 shows the contours of steady-state headsin layer 1.

[ 1h=21.0-22.8ft
B h=22.8 - 24.6 ft

[ h=24.6 - 26.4 ft
Plan View [ ] h=26.4-282ft
I h-28.2-30.0 ft

Fig. 5.19 Contours of the smulated steady-state heads
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5.9 Simulation of an Aquifer System with Irregular Recharge and a Stream
Location: PMWIN\EXAMPLES\STRI\EX 1

Problem Description and Modeling Approach

Thisexample isfrom thefirst test problem of the Streamflow-Routing (STR1) Package. For this
example, results from the STR1 Package were compared to results from an analytical solution
developed by Oakes and Wilkinson (1972). An idealized aquifer with ariver flowing through the
middle was chosen and isshown in Fig. 5.20. The width of the aquifer perpendicular to the river
was 4,000 ft on each side, while the length paralldl to the river was 13,000 ft. Assumptions used
in both the analytical solution and the model simulation include:

The lateral boundaries of the aquifer are impermeable (no flow is alowed).

The rocks beneath the aquifer are impermeable.

The river penetrates the entire depth of the aguifer and has vertical banks.

Theriver is not separated from the aquifer by any confining material.

The transmissivity and storage coefficient are constant throughout the aquifer and remain
constant in time.

The aquifer is confined and Darcy's Law isvalid.

The flow of groundwater is horizontal.

The water level in theriver is constant along its length and with time.

The infiltration of recharge to the aguifer is instantaneous (no delay between the time
precipitation infiltrates the surface until it reaches the water table).

10. The discharge from the aquifer isonly to theriver.
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Fig. 5.20 Configuration of the model and the location of the observation well
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Transmissvity of the aquifer used for both the andytical solution and in the model simulation was
3,200 ft¥d (3.45x10° m?/s). The storage coefficient is 0.20. Because the river is assumed fully
penetrating and the aquifer is not separated from the river by any confining material, the
streambed conductance value was assumed equal to the transmissivity of the aquifer (in this
example, the width of the river is assumed equal to the depth of the aquifer) times the length of
theriver in each cell (1,000 ft) divided by an assumed I-foot thickness of the riverbed. Actualy,
any large streambed conductance value can be used as long as the head value in the model cell
that corresponds to the river remains constant during the smulation. Results of varying the
streambed conductance value indicates that for this problem, streambed conductances greater than
10 ft?/d produce nearly the same results. The Streamflow-Routing Package is not really needed
to Smulate this condition, as the river could have been represented using constant-head cells. The
smulation was done to determine if the package correctly accumulates flow from the aguifer into
the stream.

Annual recharge to the aquifer was 1.5 ft and it was applied evenly over the aquifer. However,
the daily recharge rate varied according to a sinusoidal distribution for the first 180 days, while
no recharge was allowed for the following 180 days (Fig. 5.21).

Simulation Results

The aquifer is simulated using one model layer. Specification of the elevations of layer top and
bottom are not necessary, because the layer is confined and transmissivity and confined storage
coefficient are specified directly (as defined in the Layer Options dialog box). The sinusoidal
distribution of the recharge rate was divided into 15-day intervals for the model simulation and
the rate for the middle of each interval was used as a constant. The distribution used in the
smulation is also shown in Fig. 5.21. A total of six 360-day infiltration periods (144 stress
periods, each with a length of 15 days) were used in the smulation. The first five 360-day
infiltration periods were computed to allow the model to reach a stable yearly cycle because the
darting water level for each modd cell was not known. Results of the model simulation from the
gxth infiltration period are compared to the results from the analytical solution for an observation
well 2,000 ft from theriver (Fig. 5.22). The location of the well is shown in Fig. 5.20. The same
results were obtained using the River Package.
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5.10 Simulation of a Flood in a River
Location: PMWIN\EXAMPLES\STR1\EX 2

Problem Description and Modeling Approach

This example is from the second test problem of ths STR1 Package. The function of the STR1
Package that computes the head in the stream as well as changes in flows to and from the aquifer
was compared to an analytica solution developed by Cooper and Rorabaugh (1963). The model
grid used in the previous example (Fig. 5.20) was also used in this model. The aquifer properties
and assumptions are the same as those used in the previous example, except for assumptions 8 -
10, which are replaced with the following assumptions: (1) The recharge to the aquifer is only
from the river asriver stage increases with time and (2) The discharge from the aquifer is aso
only to the river asriver stage decreases with time.

The andytical solution from Cooper and Rorabaugh (1963, p. 355-358) is applicable for the case
where the lateral boundary is at infinity (referred to by Cooper and Rorabaugh as semi-infinite).
The impermeable boundary assigned at 4,000 ft for this model is of sufficient distance from the
river as not to interfere with the results. A flood in the river was simulated for a 30-day period.
The procedure used to calculate the distribution of streamflow for the 30-day period and for 60
days following the flood was first to calculate a distribution of river stage using equation 71 in
Cooper and Rorabaugh (1963, p. 355), assuming a maximum flood stage of 4 ft above the initial
river stage. The streamflow distribution shown in Fig. 5.23 then was calculated by rearranging
equation 5 and solving for streamflow. The streamflow distribution was calculated from the river
stage ditribution, ariver width of 100 ft, aroughness coefficient of 0.02377, a slope of 0.0001,
and a constant C (see equation 3.12) of 1.486.

4.2

40
3.8 Solution from equation 5

3.6
Flow assigned to stream

3.4 for each stress period

3.2
3.0
2.8
2.6
2.4
2.2
2.0

1.8 T I

o 10 20 30 40 50 60 70 80 90

Streamflow, in thousands of cubic feet per secol

Times, in days since start of flood
Fig. 5.23 Distribution of streamflow for a 30-day flood event used for the smulation (after
Prudic, 1988)

Applications and Sample Problems



Processing Modflow 5-27

Simulation Results

Streamflow for the first 30 days was divided into I-day periods for simulation. Fig. 5.24 shows
the computed river stage. The simulation results are the same as the manually calculated river
stage values using equation 71 of Cooper and Rorabaugh (1963, p. 355). Detailed discussion on
the analytical and numerical results can be found in Prudic (1988). Results of varying both the
number of columns and the length of stress periods used to simulate the flood wave indicate that
both the number of columns and the length of the time step are important in exactly duplicating
the analytical solution.

Stream stage, in feet above sea le

0 10 20 30 40 50 60 70 80 90
Times, in days since start of flood

Fig. 5.24 Model calculated river stage

The ground-water flow model with the Streamflow-Routing Package has an advantage over
andytical solutions because it can be used to simulate complex systems. The example (Location:
PMWIN\EXAMPLES\STR1\EX3) of a stream system shown in Fig. 5.25 is used to illustrate
most of the features of the STR1 package. The example assumes an aquifer 6,000 ft wide by
6,000 ft long divided into six equally spaced rows and columns. The transmissivity of the aquifer
is0.08 ft¥s. Recharge to the aquifer occurs only from stream |leakage as does discharge from the
aquifer. The example includes 7 stream segmentswith atotal of 16 reaches. There is one diversion
(segment 2) and two places where streams join (segments 2 and 4 join to make segment 5 and
segments 3, 5, and 6 join to make segment 7). Stream stages are also computed for each reach.
The streams range in width from 5 to 10 ft. Streambed conductance values also vary depending
on the length and width of each stream reach. The hydraulic conductivity of the streambed
depositsis 4 x 10 ft/s.
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Fig. 5.25 Example numbering system of streams and diversions (after Prudic, 1988)
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5.11 Simulation of the Storage-Depletion
Location: PMWIN\EXAMPLES\IBS1\EX 1

Problem Description and Modeling Approach

This exampleis from the first test problem of the Interbed Storage (IBS1) Package (L eake and
Prudic, 1991). The finite-difference grid consists of two layers with 10 rows and 12 columns of
cells. Thefirst and last column of cells in both layers are constant-head boundaries, so that the
other 10 active columns of cells are aflow region subject to head and storage changes. The grid
dimensionsfor each cdll are 1,000 m aong both rows and columns. Each layer has a transmissivity
of 1,000 m%d and a storage coefficient of 0.0001. The configuration of the model is shown in Fig.
5.26.

The starting head in the active area specifies a uniform gradient of 0.001 along the rows. The
starting head vaues in the constant-head columns also specify a gradient of 0.001 along the rows
over the entire grid but at alevel exactly 10 m lower than the starting heads in the active area of
the model. Thus, if the transient solution is allowed to run until steady-state conditions are
reached, the head at each interior cdll will be exactly 10 m below the corresponding starting head.

For this example, compressible interbeds are assumed to occur in the aquifer represented by the
upper layer. The preconsolidation head is assumed to be 5 m below the starting head at each cell.
The elastic storage factor (the sum of the products of thickness and elastic skeletal specific
storage for interbeds) in the upper layer is assumed to be 0.0001 at each cell. Similarly, the
inelastic storage factor is assumed to be 0.001 at each cell.
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Fig. 5.26 Configuration of the model and the location of the observation point

Simulation Results

Within 1,000 days of smulation time, head values at all cells will be within about 0.001 m of the
final steady-state value. The volumetric budget for the simulation is shown in table 5.1. The
correct volume of water released by the interbeds can be computed as the product of total area
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excluding boundary cdlls (1x10° m?), storage factors (0.0001 for elastic and 0.001 for inelastic),
and head decline (5 m under elastic conditions and 5 m under inelastic conditions). The correct
amount of water released from interbed storage therefore is 5x10* m?® for declinesin the eastic
range and 5x10° m? for declines in the inelastic range. The sum of the two values is consistent
with the 5.5x10° m?® release of water from interbed storage calculated by the model. For this
example, the model computes 5.5x10° m of compaction at the observation point (Fig. 5.27). That
vaueis congstent with the sum of elastic and indlastic compaction computed from equations 3.18
and 3.19.

VOLUMETRI C BUDGET FOR ENTI RE MODEL AT END OF TI ME STEP 10 IN STRESS PERIOD 3

CUMULATI VE VOLUMES L**3 RATES FOR TH S TI ME STEP L**3/T

I'N: I'N:

STORAGE = 0. 20000E+06 STORAGE = 0.00000

CONSTANT HEAD = 0. 59683E+08 CONSTANT HEAD = 20000.

| NTERBED STORAGE = 0. 55000E+06 | NTERBED STORAGE = 0. 00000

TOTAL IN = 0. 60433E+08 TOTAL IN = 20000.
ouT: ouT:

STORAGE = 0. 00000 STORAGE = 0.00000

CONSTANT HEAD = 0. 60433E+08 CONSTANT HEAD = 20000.

| NTERBED STORAGE = 0. 00000 | NTERBED STORAGE = 0. 00000

TOTAL OUT = 0. 60433E+08 TOTAL QUT = 20000.

IN - OUT = 4.0000 IN - OQUT = 0.00000

PERCENT DI SCREPANCY = 0. 00 PERCENT DI SCREPANCY = 0.00

Table 5.1 Volumetric budget at the end of time step 10 in stress period 3

5.5E-3

________________________________________

————————————————————————————————————————

Compaction, in meter

————————————————————————————————————————

________________________________________

1.52E-3 .’ i .’ —>
1 10 100 1000 10000
Elapsed Simulation Time (days)

Fig. 5.27 Calculated compaction at the observation point 1
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5.12 Simulation of a Non-declining Cyclical Ramp Load Problem
Location: PMWIN\EXAMPLES\IBS1\EX2

Problem Description and Modeling Approach

This example is from the second test problem of the Interbed-Storage (IBS1) Package (Leake and
Prudic, 1991). The ramp-load problem presented here is similar to the non-declining ramp-load
problem given by Helm (1975, p. 470-473). Helm computes compaction of compressible beds
given effective stress changes at the boundary by solving a one-dimensional partial-differential
equation by finite differences.

This example involves the simulation of the cumulative compaction of 100 identical interbeds
with the following properties:

Thickness =10 [m]

Hydraulic conductivity = 2.78x10° [m/d]
Elastic specific storage = 1x10° [1/m]
Inelastic specific storage = 1x10* [1/m]

The head a the boundaries of the interbeds is set to successively decline linearly for 180 days to
10 m below the starting value. Following the declines, the head recovers linearly for 180 days to
the origina value. Successive cycles of declines and recoveries are approximated with 180 1-day
steps in each ramp (Fig. 5.28). The preconsolidation head throughout the interbeds is assumed
to be equal to the starting head so that compaction isinitialy in the inelastic range.

Change in effective stress (m)
hydraulic head (m)

0 360 720 1080 1440 1800
Simulation Time (days)

Fig. 5.28 Change in effective stress caused by a non-declining cyclical ramp load

Simulation Results

The problem can be solved by simulating compaction in one-half of a single doubly draining bed
and multiplying those results by 200 to obtain the total compaction for all 100 interbeds. To apply
the IBS1 Package to this problem, one approach would be to discretize the compressible bed into
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anumber of model layers. The problem could aso be solved with a single row of finite-difference
cdlsin one model layer, because flow in the low-permeable compressible beds is assumed to be
one-dimensiona. The single-row approach is less difficult than the multiple-layer approach
because input to and output from the flow model generally are carried out layer by layer. A
disadvantage of orienting the grid along arow is that the IBS1 Package sums compaction in al
layers to compute total compaction. The package is incapable of summing compaction along a
row to calculate total compaction; however, the total compaction can be obtained by dividing the
net cumulative volume of water released from interbed storage by the cross-sectional area of the
grid. As shown in Fig. 5.29, a cross-sectional area of 1 m by 1 m was chosen so that the net
volume of water from interbed storage in the volumetric budget of the model would directly relate
to total compaction for half of the doubly draining bed. A cell width of 0.25 m was selected
thereby requiring 20 finite-difference cells to represent onehalf of the doubly draining bed. An
additional cell was required to impose the specified-head boundary condition of cyclical ramp
loading.

Fig. 5.29 Configuration of the finite-difference grid (after Leake and Prudic, 1991)

In the "origina" MODFLOW by McDonald and Harbaugh (1988), the only provision for
changing specified head at boundary cells is by use of the River Package, Drain Package, or
General-Head Boundary Package. Those packages allow specification of a different boundary
head at each stress period. If associated river-bed conductances are large enough, the head in the
aquifer will almost equal the boundary head. For the ramp-load problem, difficulties may arise
from using these packages to approximate a specified aquifer head. First, the flow from the
boundary to the aquifer is computed as the product of conductance and head difference between
the boundary and the aguifer. If the intent is to make that difference small, mass-balance errors
result because of imprecision in computing the head difference across the boundary. Precisionis
lost when two nearly equal numbers are subtracted. Second, alarge amount of input to and output
from the model are associated with each stress period. Simulation of one complete cycle of the
loading to the precision shown in Fig. 5.28 would require 360 stress periods. As an alternative
way of smulating a specified boundary head, the Time-Variant Specified-Head Package was used.
For each time step within a stress period, the value of each specified head is linearly interpolated
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from the user-specified starting and ending heads of the period and the proportion of elapsed time
within the stress period to length of the stress period.

Fig. 5.30 shows the smulated total compaction. A comparison of the results of the IBS1 Package
with those of one-dimensional compaction model COMPAC1 (Helm 1975) can be found in Leake
and Prudic (1991).
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Fig. 5.30 The computed total compaction

Applications and Sample Problems



5-34 Processing M odflow

5.13 Two-Dimensional Transport in a Uniform Flow Field
Location: PMWIN\EXAMPLES\MT3D1\EX 1

Problem Description and Modeling Approach
In this example, transport of solute injected continuously from a point source in a steady-state
uniform flow field should be simulated. The available parameters are listed below:

Layer thickness =10 m

Groundwater seepage velocity = |1/3 m/day
Effective porosity = 0.3

Longitudinal dispersivity =10 m

Ratio of transverse to longitudinal dispersivity = 0.3
Volumetric injection rate = 1 m¥/day

Concentration of the injected water = 1000 ppm
Total smulation time = 365 days

A numerical model consisting of 46 columns, 31 rows and 1 layer was constructed to simulate
the problem. The configuration of the model is shown in Fig. 5.31. The mode! layer is simulated
as a confined layer. The top and buttom of the model layer is a an elevaiton of 10 m and O m,
respectively. To smulate the groundwater seepage velocity of 1/3 m/day, constant-head
boundaries (with h = 11 m and h = 10m) are assigned to the west and east side of the model. The
horizontal hydraulic conductivity is 45 m/day.

14m
[a]
Vi

10m

I Injection Well
Q=1 n? /day

300m
constant-head boundary, h

| N
onstant-head boundary, h

c
¢

Y

< 450 m >
< >

Fig. 5.31 Configuration of the model and the location of the injection well

Simulation Results
Theflow fidd wasfirst caculcated by MODFLOW. The hybrid MOC/MMOC, or HMOC option
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was used in the smulation for the advection term, with DCHMOC set to 10 and the rest of the
parameters as follows:

DCEPS = 10°, NPLANE =1, NPL = 0, NPH = 9, NPMIN=0, NPMAX = 16

INTERP =1, NLSINK =1, NPSINK =9

Thus, in the solution process, the MOC scheme was automatically selected in cells where
DCCELL > 10% and the MMOC scheme was automatically selected in cells where
DCCELL < 10°. When the MOC scheme was used, 9 particles were placed in cells with afixed
pattern on one vertica plane (NPLANE=1) where DCCELL is greater than the specified
negligible limit. When the MM OC scheme was used, 1 fictitious particle was placed at the nodal
point for backward tracking except at asink cell where 9 particles were placed (i.e., NPSINK=9)
on one (1) vertical plane within the sink cell block (i.e., NLSINK=1). For particle tracking, the
fourth-order Runge-Kutta method is used in the vicinity of the point source whereas the first
Euler method is used elsawhere.

The contour map of the concentration field at the end of the 365-day simulation period obtained
for thisexampleisshown in Fig. 5.32. An analytical solution for this problem is given by Wilson
and Miller (1978). The analytical solution is applicable only under the assumption that 1) the
aquifer isrelatively thin, so that instantaneous vertical mixing can be assumed; 2) the injection rate
isinsignificant compared with the ambient uniform flow.

Comparison of the numerical solutions of MT3D and analytical solutions for two- or three-
dimensiona transport can be found in Zheng (1990). This example is the same as that desribed
in section 7.2 of the MT3D manual. Further examples of MT3D are reconstructed by using
PMWIN and arelisted in Table 5.2.

Fig. 5.32 Concentration plume calculated by MT3D
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Location

Description

PMWIN\EXAMPLE\WMT3D1\EX2

PMWIN\EXAMPLE\WMT3D1\EX3

PMWIN\EXAMPLE\WMT3D1\EX4

PMWIN\EXAMPLE\WMT3D1\EX5

PMWIN\EXAMPLE\WMT3D1\EX6

A numerica mode congisting of 31 columns, 31 rows and
1 layer is used to simulate the two-dimensiona transport
in a radial flow field; numerical results were compared
with the analytical solution of Moench and Ogata (1981).
(See section 7.3 of the manual of MT3D for details)

A numerica mode consisting of 31 columns, 31 rows and
1 layer is used to simulate the concentration change at the
injection/extration well; numerical results were compared
with the approximate anaytical solution of Gelhar and
Collins (1971). (See section 7.4 of the manua of MT3D
for details)

A numerica mode congisting of 21 columns, 15 rows and
8 layersis usad to solve the three-dimensional transport in
a uniform flow field. The point source was ssimulated at
column 3, row 8 and layer 7. Numerica results were
compared with the anaytical solution of Hunt (1978). (See
section 7.5 of the manual of MT3D for details)

This example illustrates the application of MODFLOW
and MT3D to a problem involving transport of
contaminants in atwo-dimensional heterogeneous aquifer.
(See section 7.6 of the manual of MT3D for details)
This example illustrates the application of MT3D to an
actua field problem involving evaluation of the
effectiveness of proposed groundwater remediation
schemes. (See section 7.7 of the manua of MT3D for
details)

Table 5.2 Reconstructed MT3D examples
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5.14 A Field Application

Location: PMWIN\EXAMPLES\PMEX\EXAMPLE

Problem Description and Modeling Approach

This example shows a smplified model for the landfill shown on the cover page. The plan view
of the model areaisillustrated in Fig. 5.33. Benzene is dissolved in the groundwater and enters
the aguifer system with a concentration equal to 100x10° kg/m? (=100 pg/l). A numerical model
was developed for this site to calculate the steady-state groundwater flow. Under steady-state
flow conditions, the concentration distribution of benzene twenty years after the beginning of
benzene migration in the aquifer should be calcul ated.
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Fig. 5.33 Plan view of the model area

The parameters used in the model are listed in the following table:

Horizontal hydraulic conductivity in the second layer = 8.0x10* m/s

Horizontal hydraulic conductivity in the first layer ranges from 0.0003 m/s to 0.0006 my/s.
Vertical hydraulic conductivity = 4.0x10° m/s

Recharge = 2.5x10° m/s (= 80mm/yr)

Effective porosity = 0.2

Longitudinal dispersivity =5m

Distribution coefficient of benzene = 2x10* m¥/kg

Bulk density of the porous medium of the aquifer = 1700 kg/m?

Starting concentration = 0 kg/m?

Theratio of horizontal and vertical transverse to longitudinal dispersivity in both layersis 0.1.
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Simulation Results

The problemissmulated using agrid of 55 rows and 57 columns. The aquifer is discretized into
two layers. Both layers are confined. The thickness of the first layer is 8 m and the other 7 m. The
configuration of the finite-difference grid is shown in Fig. 5.34. The boundaries of the model area
are defined by the Mueggenburger Cand and the rivers Norderelbe and Dove Elbe. The rivers and
the cand are assumed to bein full hydraulic contact with the aquifer and are treated as constant-
head boundaries of the model. The other boundaries are defined by stream lines and are therefore
impervious (no-flow boundaries). The calculated concentration plume is shown in Fig. 5.35.

Fig. 5.34 Configuration of the model grid and location of observation wells

Fig. 5.35 Calculate concentration pme
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Appendix 1: Limitation of PMWIN

This section gives the size limtation of PMWIN Refer to the docunentation of individua

packages for their assunptions, applicability and limtations

Data Editor

Maxi mum nunber of |ayers = 80

Maxi mum nunber of stress periods = 1000

Maxi mum nunber of cells along rows or colums = 2000
Maxi mum nunber of cells in a layer = 2000 x 2000 = 4 000 000
Maxi mum nunber of zones in a layer = 40

Maxi mum nunber of vertex nodes of a zone = 40

Maxi mum nunber of stream segnents = 25

Maxi mum nunber of tributary segments of each stream segnment = 10

There is no limt to the nunmber of wells, general-head boundary cells,
horizontal -fl owbarrier cells

Bores and Observations
Maxi mum nunber of bores = 1000
Maxi mum nunber of observati ons = 6000

Field Interpolator

Maxi mum nunber of cells in a layer = 250 000
Maxi mum nunber of cells along rows or colums = 2000
Maxi mum nunber of input data points = 2000

Field Generator
Maxi mum nunber of cells in a layer = 250 000

Maxi mum nunber of cells along rows or col ums 500

Water Budget Calculator

Maxi mum nunber of subregi ons = 50

rivers, drains and
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Appendix 2: Files and Formats

ASCII Matrix File

An ASCII Matrix file can be saved or | oaded by the Browse Matrix dial og box (see section 3.3.7)
The Result Extractor, Field Interpolator and Field Generator use this file format to save the
gener ated data

File Format
1. Dat a: NCOL NROW
2. Data: MATRI X (NCOL, NROW

Explanation of Fields Used in Input Instructions
ALL DATA IN THE SAME RECORD ARE SEPARATED BY A COMVA OR BLANK.

NCOL is the number of nodel col ums
NROW is the number of nodel rows.
MATRI X is a two dinensional data matrix saved row by row. Matrix can be saved in free
format.
Example
If NCOL=6 and NROM5, an ASCI| Matrix file would be
6 5

121 152 133 144 315 516
221 252 233 244 215 216
321 352 333 344 315 316
421 452 433 444 415 416
521 552 533 544 515 516

O

6 5

121 152 133 144 315 516 221 252 233 244 215 216
321 352 333 344 315 316 421 452 433 444 415 416
521 552 533 544 515 516
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Bore file
A bore file can be saved or | oaded by the Bores and Cbservations dial og box (see section 3.3.6).
File Format

1. Dat a: LABEL

2. Dat a: NB XXX XXX XXX XXX

(The follow ng data repeats NB tinmes)
3. Data: Active X Y Layer Draw  Col or

Explanation of Fields Used in Input Instructions
ALL DATA IN THE SAME RECORD ARE SEPARATED BY A COMVA OR BLANK.

LABEL is the file label. It must be PMA NAOOO_BOR FI LE

NB is the number of bores. Maxi mum nunber of NB is 1000

XXX reserved

Active A bore is active, if Active =1

X is the x-coordinate of the bore

Y is the y-coordinate of the bore

Layer is the |layer nunber of the bore

Dr aw If Draw = -1, the obervation vs. time curve of a bore will be shown when the G aphs
Viewer is activated

Col or is the color used to draw the obervation vs. tinme curve of a bore. The color is

defined by a long integer using the equation: color = red + green x 256 + blue x
65536, where red, green and blue are the color conponents ranging fromO0O to 255
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Observation File

An observation file can be created by the Bores and Cbservations dial og box (see section 3.3.6)
or the Graphs Viewer (see section 4.6). An existing observation file can be inported into the
Bores and Cbservations dial og box.

File Format
1. Data: LABEL
2. Data: NOBS FLAG XXX XXX XXX

(The following data repeats NOBS tines)
3. Dat a: BORENO TIME WEIGHT HEAD DDOAMN CONC COWAC PREHEAD SUBSDNS

Explanation of Fields Used in Input Instructions
ALL DATA IN THE SAME RECORD ARE SEPARATED BY A COMVA OR BLANK.

LABEL is the file label. It nust be PMA N4000_OBS FI LE

NOBS is the number of observations. Maxi mum nunber of NOBS is 6000

FLAG if FLAG = 1, the observed heads will be used for the paraneter estimation
if FLAG = 2, the observed drawdowns will be used for the paraneter estinmation

XXX reserved

BORENO is the bore nunber where the observation is nade

TI ME is the observation tinme, neasured fromthe start of the sinulation

VEI GHT is the weight attached to each observation

HEAD is the observed head at tinme TIME

DDOWN is the observed drawdown at tine TIME

CONC is the observed concentration at time TIME

COWPAC is the conmpaction at time TIME

PREHEAD is the preconsolidation head at tinme TIME

SUBSDNS is the subsidence at tine TIME
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Time Parameter File

A Tine Paranmeter file can be saved or |oaded by the Tine Paraneter dialog box (see section

3.3.3)

File Format
1. Dat a
2. Dat a

LABEL
NPER | TMUN

(The follow ng data repeats NPER tinmes)

3. Dat a

ACTI VE PERLEN NSTP TSMULT DTO MXSTRN

Explanation of Fields Used in Input Instructions
ALL DATA IN THE SAME RECORD ARE SEPARATED BY A COMVA OR BLANK.

LABEL

ACTI VE
PERLEN
NSTP
TSMULT
DTO

MXSTRN

is the file label. It nust be PMA NAOOO_TI ME_FI LE

is the nunber of stress periods in the sinulation

indicates the tinme unit of npdel data. (It is used only for printout of elapsed
simulation time. It does not affect nodel calculations.)

0 - undefined 1 - seconds 2 - minutes

3 - hours 4 - days 5 - years

The unit of time nust be consistent for all data values that involve tinme. For
exanmple, if years is the chosen time unit, stress-period length, timestep length

transm ssivity, etc., nust all be expressed using years for their tine units

Li kewi se, the length unit nust also be consistent.

A stress period is active, if ACTIVE = -1. Set ACTIVE=0, if a stress period is
i nactive

is the length of a stress period. It is specified for each stress period

is the number of tinme steps in a stress period

is the nultiplier for the length of successive tine steps. The length of the first
time step DELT(1l) is related to PERLEN, NSTP and TSMULT by the relation

DELT(1) = PERLEN(1- TSMULT)/ (1- TSMULT**NSTP).

is the length of transport steps. |If DI0=0, the length of transport steps will be
determ ned by an automatic stepsize control procedure in MI3D.

i s the maxi mum nunber of transport steps
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Trace File

A Trace file can be saved or |oaded by the Search and Mddify dial og box (see section 3.3.7)

File Format
1. Dat a:

LABEL

(The following data repeats 50 tinmes, one record for each search range)

3. Dat a

ACTIVE COLOR MN MAX VALUE OPTION

Explanation of Fields Used in Input Instructions
ALL DATA IN THE SAME RECORD ARE SEPARATED BY A COMVA OR BLANK.

LABEL
ACTI VE
COLOR

M N MAX
VALUE

OPTI ON

is the file label. It nust be PMA NAOOO_TRACEFI LE

a search range (see MN/ MAX below) is active, if ACTIVE = -1

is the fill color. The color is defined by a long integer using the equation: color
= red + green x 256 + blue x 65536, where red, green and blue are the color
conponents rangeing fromO to 255. COLOR is assigned to the finite-difference cells
that have a value located within the search range (see M N/ MAX bel ow).

define the lower limt and upper limt of the search range

According to OPTION (see bel ow), you can easily nodify the cell values (see section
3.3.7 for details.)

OPTION = 0, Display only.

OPTION = 1, Replace: The cell values are replaced by VALUE
OPTION = 2, Add: VALUE is added to the cell values

OPTIOn = 3, Multiply: The cell values are nultiplied by VALUE
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Zone file

A zone file can be saved or |oaded by the Data Editor by using the item Zones from the Val ue

nmenu.

File Format
1. Dat a:
2. Dat a:

LABEL
NZONES, XXX, XXX, XXX, XXX

(The following data (data 3-6) repeat NZONES tines)

3. Dat a:
4. Dat a:
5. Dat a:

NP
PARNO
Val ue(1) Value(2) Value(3) ... Value(l) ... Value(16)

(The follow ng data repeats NP tines)

6. Dat a:

X(J3), Y(J)

Explanation of Fields Used in Input Instructions

LABEL
NZONES
XXX

NP
PARNO

Val ue(1)

X(3),Y(J)

is the file label. It nust be PMA NAOOO_ASCI | _ZONEFI LE

is the nunber of zones. Maxi mumis 20.

reserved.

is the nunber of nodes of each zone. The first and the |ast node nust overl ap.
The maxi mum nunber of NP is 41.

is the assigned paraneter nunber (see section 3.3.6 for how to define an
estimated paranter)

I = 1 to 16; Value(l) are the zone values. For aquifer paraneters, such as
transmssivity or porosity, only the first value is used. For MODFLOW packages,
such as Drain Package, as many val ues as required by the package are used. For
exanple, two values (Hydraulic conductance and the elevation of the drain)
required for defining a drain will be saved in Value(l) and Value(2). Oher
values that are not used nust be specified as zero. The follow ng table gives
the assignment of the paraneters in the Value(l) vector. Refer to section 3.3.4
for the definitions of the paraneters.

Package Val ue( 1) Val ue(2) Val ue(3) Val ue(4)

WEL1 Recharge rate XXX XXX XXX

DRNL Hydr. conductance El evati on XXX XXX

R V1 Hydr. conductance Head in river El evati on XXX

EVT1 Max. ET rate ET Surface Extinction Depth Layer | ndicator
GHB1 Hydr. conductance Head at boundary XXX XXX

RCH1L Rechar ge Fl ux Layer | ndicator XXX XXX

HFB1 Barrier Direction K/ Thi ckness XXX XXX

| BS1 Preconlidation head El astic storage Inelastic storage Starting conpaction
CHD1 Fl ag Start head End head XXX

The val ues used by the STRL package are

Val ue(1) = Segnent; Value(2) = Reach; Value(3) = Streanflow, Value(4) = Stream stage;
Val ue(5) = Hydr. conductance; Value(6) = El avation of the streanbed top;

Val ue(7) = Elavation of the streanbed bottom Value(8) = Stream width;

Val ue(9) = Stream sl ope; Value(10) = Manning's roughness coefficient divided by C

are the (x,y) coordinates of the J-th nodes of the zone. The first and the |ast
node nust overl ap.

Appendix



A-8 Processing M odflow

Internal data files of PMWIN

PMN' N saves nost of the user-specified data in binary files by using the nodel name as the file
name and the extensions given in the following lists. Cell-by-cell data are saved in files
indicated by (CBC). Zone data are saved in files indicated by (ZONE). The data files with the
sane file type (e.g., CBC or ZONE) are saved in the sane fornat.

Geometrical Setting Up and Boundary Conditions

Ext ensi on Descri pti on

BOT (CBO) El evation of the bottom of Iayers.
DWA (CBO) Wetting threshold (BCF2 Package).
HEA (CBO) Initial hydraulic heads.

| BD (CBO) | BOUND natri x.

TOP (CBO) El evation of the top of layers.
BOz (ZONE) Elevation of the bottomof |ayers.
DWz (ZONE) Wetting threshold (BCF2 Package).
HEZ (ZONE) Initial hydraulic heads.

| BZ (ZONE) 1 BOUND matri x.

TOZ (ZONE) Elevation of the top of |ayers.

X Cell sizes in x-direction.

Y Cell sizes in y-direction.

(ONLY Mr3D)

TIC (CBO) | CBUND matri x.

TSC (CBO) Initial concentration.

MrO (ZONE) | CBUND natri x.

Mr1 (ZONE) Initial concentration.

Aquifer Properties

Ext ensi on Descri pti on

CON (CBO) hori zontal hydraulic conductivity.

HTC (CBO) Transm ssivity.

LEA (CBO) Vertical hydraulic conductivity.

LKN (CBO) Vertical |eakance.

POR (CBO) Ef fective porosity.

SCC (CBO) Storage coefficient.

STO (CBO) Speci fic storage.

TAL (CBO) Longi tudi nal dispersivity.

YLD (CBO) Specific yield.

COZ (ZONE) horizontal hydraulic conductivity.

HTZ (ZONE) Transmissivity.

LEZ (ZONE) Vertical hydraulic conductivity.

LKz (ZONE) Vertical |eakance.

(2074 (ZONE) Effective porosity.

SCz (ZONE) Storage coefficient.

STZ (ZONE) Specific storage.

T11 (ZONE)  Longi tudi nal dispersivity.

YLZ (ZONE) Specific yield.

Packages

Ext ensi on Descri pti on

(CHD1 Package)

CH1 (CBO) A non-zero value indicates a CHD cel|.

CH2 (CBO) Head at the beginning of a stress period (Start head).

CH3 (CBO) Head at the end of a stress period (End head).

Clz (ZONE) A non-zero value indicates a CHD cell.

c2z (ZONE) Head at the beginning of a stress period (Start head).

C3z (ZONE) Head at the end of a stress period (End head).

(DRN1 Package)

DRC (CBO) Hydraul i ¢ conductance of the interface between an aquifer and a drain.

DRE (CBO) El evation of drain.

DCz (ZONE) Hydraulic conductance of the interface between an aquifer and a drain.

DEZ (ZONE) El evation of drain.

(EVT1 Package)

EET (CBO) Maxi mum evapotranspiration rate [L/T].

ElE (CBO) Layer indicator array. For each horizontal location, it indicates the |layer from
whi ch evapotranspiration is renpved.

ESU (CBO) El evation of the evapotranspiration surface.
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Packages (continued)

Ext ensi on Descri ption

EXD (CBC) Evapotranspiration extinction depth

EDZ (ZONE) Evapotranspiration extinction depth

EEZ (ZONE) Layer indicator array. For each horizontal location, it indicates the layer from
whi ch evapotranspiration is renoved

ETZ (ZONE) Maxi mum evapotranspiration rate [L/T].

EUZ (ZONE) Elevation of the evapotranspiration surface

(GHB1 Package)

GHB (CBO) Head on the general - head- boundary.

GHC (CBO) Hydraul i ¢ conductance of the interface between the aquifer cell and the general -
head boundary.

GBZ (ZONE) Head at the general - head-boundary.

GCz (ZONE) Hydraulic conductance of the interface between the aquifer cell and the general -
head boundary.

(HFB1 Package)

WAL (CBO) Direction of a horizontal-flow barrier

WAC (CBO) Hydraulic conductivity divided by the thickness of a horizontal-flow barrier

(1 BS1 Package)

| B1 (CBO) Preconsol i dati on Head.

| B2 (CBO) El astic Storage Factor.

| B3 (CBO) I nel astic Storage Factor.

| B4 (CBO) Starting Conpacti on.

11z (ZONE) Preconsolidati on Head

122 (ZONE) Elastic Storage Factor.

132 (ZONE) Inelastic Storage Factor

142 (ZONE) Starting Compaction.

(RCHL Package)

RCH (CBO) Recharge flux [L/T].

RCI (CBO) Layer indicator array that defines the layer in each vertical colum where
recharge is applied

RHZ (ZONE) Recharge flux [L/T]

R Z (ZONE) Layer indicator array that defines the layer in each vertical colum where
recharge is applied

(RI'V1 Package)

RI C (CBO) Hydraul i ¢ conductance of riverbed

R R (CBO) El evation of the bottom of riverbed.

RIS (CBO) Water surface el evation of river

RCZ (ZONE) Hydraulic conductance of riverbed

RRZ (ZONE) Elevation of the bottom of riverbed

RSZ (ZONE) Water surface elevation of river

(STR1L Package)

SBO (CBO) El evation of the bottom of the streanbed

SEG (CBO) Segrment nunber - sequential nunber assigned to a group of reaches

SFL (CBO) Streanflow in |l ength cubed per tine.

SRE (CBO) Sequenti al nunber of reaches

SRO (CBO) Manni ng' s roughness coefficient/C for each streamreach

SSL (CBO) Sl ope of the stream channel in each reach

SST (CBO) Stream st age.

STC (CBO) Streanbed hydraul i ¢ conduct ance

STT (CBO) El evation of the top of the streanbed

sw (CBO) Wdth of the stream channel in each reach

S1z (ZONE) Segnent nunber - sequential number assigned to a group of reaches

S27 (ZONE) Sequential nunber of reaches within a segment

S3Z (ZONE) Streanflow in |length cubed per tine

S4z (ZONE) Stream stage.

S57 (ZONE) Streanbed hydraul i c conductance

S6Z (ZONE) Elevation of the top of the streanbed

S7Z (ZONE) El evation of the bottom of the streanbed

S8z (ZONE) Wdth of the stream channel in each reach

S97Z (ZONE) Sl ope of the stream channel in each reach

S0z (ZONE)  Manning's roughness coefficient/C for each streamreach

(WEL1 Package)

W\EL (CBO) Vol unetric recharge rate of wells.

WEZ (ZONE) Volumetric recharge rate of wells
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Packages (continued)
Descri ption

Ext ensi on

(Mr3D Sink & Source Package)

TCH (CBO) Speci fi ed concentration at constant head cells.

TE (CBO) Speci fied concentration of evapotranspiration fl ux.

TG (CBO) Speci fi ed concentration at general -head boundary cells.
TR (CBO) Speci fied concentration of river.

TRC (CBO) Speci fi ed concentration of recharge fl ux.

TST (CBO) Speci fi ed concentration of stream

T™W (CBO) Speci fied concentration of injection wells.

MT3 (ZONE) Specified concentration of injection wells.

MT5 (ZONE) Specified concentration of river.

M6 (ZONE) Specified concentration of evapotranspiration flux.

Mr7 (ZONE) Specified concentration at general -head boundary cells.
M8 (ZONE) Specified concentration of recharge fl ux.

MT9 (ZONE) Specified concentration of stream

MLO (ZONE) Specified concentration at constant head cells.

(Mr3D Di spersion Package)

DPS User-specified settings for the Dispersion Package.

TAL (CBO) Longi tudi nal dispersivity.

ML1 (ZONE)  Longi tudi nal dispersivity.

(Mr3D Chemi cal Reaction Package)

CHE User-specified settings for the Chenmical Reaction Package.
(Mr3D Advection Package)

ADV User-specified settings for the Advection Package.

Other Reserved File Extensions

Ext ensi on Descri pti on

GRD Gid Specification file (see Appendix 7)

I'NI Mbost options and setting of a nodel is saved in this file.

L Settings of the Layer options.

MDL Mbdel information file.

POL is a binary file for saving the user-specified bores and observations.
PPL is a binary file for saving the settings of the paranmeter I|ist.
RCD Information for the allocation of data arrays.

TRN Extented time paraneter file.

TRS is a Trace file (see above) saved automatically by PMA N

WBL (CBO) Subregi ons for cal cul ating of water bal ance.

_83 (CBO) Recycl e.

WBZ (ZONE)  Subregions for cal cul ati ng of water bal ance.

783 (ZONE) Recycle.

(The following file extensions are used by PMB.0 only)

LMK position of nodel grid and | andmarks.

TRA Tinme paraneter file.

VET Settings of the BCF2 Package.

XFD Settings of inport of DXF-maps.

MAP Reserved for the DXF file created by PMCAD.
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Appendix 3: Input Instructions of Modflow

These input instructions are intended as a reference for the experienced user. PMAN N transl ates
the user-specified data to the input files of MODFLOW by using the rules given in these input
instructions. Mst explanations of the input variables are al so contained in Chapter 3. |nput for
the Basi c Package (BAS1l) except for output control is read fromunit 1 as specified in the main
pr ogram

Input Instructions For Array Reading Utility Modules

There are three array reading utilities nodules in MODFLOW - ULDREL, U2DI NT and W2DREL. The real
two-di nensional array reader (U2DREL), the integer two-dinensional array reader (U2DI NT), and the
real one-dinmensional array reader (ULDREL) read one array-control record and, optionally, a data
array in a format specified on the array-control record. The control record is read fromthe
input unit nunber specified for the major option (of the Basic Package input file) that is
requesting the array. For exanple, the Recharge Package uses U2DREL to read the RECH array. The
input unit for the recharge option is contained in IUNIT (8), and accordingly, the RECH array
control record is read on this input unit.

FOR REAL ARRAY READER (U2DREL or U1DREL)

Dat a: LOCAT CNSTNT FMTI N | PRN
For mat : 110 F10.0 5A4 110
FOR INTEGER ARRAY READER (U2DINT)
Dat a: LOCAT | CONST FMTI N | PRN
For mat : 110 110 5A4 110
Explanation of Fields Used in Input Instructions
LOCAT indicates the location of the data which will be put into the array.
If LOCAT < 0, the sign is reversed to give the unit nunber from which an
unformatted record will be read.
If LOCAT = 0, every elenent in the array will be set equal to the value

CNSTNT/ | CONST
If LOCAT > 0, it is the unit nunmber from which data values will be read in the
format specified in the third field of the array-control record (FMIIN).
CNSTNT/ | CONST
is a constant. Its use depends on the value of LOCAT.
If LOCAT = 0, every elenent in the array is set equal to CNSTNT/ I CONST.
If LOCAT = O and if CNSTNT/ICONST = O every element in the array is nmultiplied
by CNSTNT/ | CONST
FMTI N is the format of records containing the array values. It is used only if the first
field in the array-control record (LOCAT) contains a positive nunber. The format
must be encl osed i n parentheses; for exanple, (15F5.0) for real data and (1515) for
i nteger data.
| PRN is a flag indicating that the array being read should be printed and a code for
indicating the format that should be used. It is used only if LOCAT is not equal
to zero. The format codes are different for each of the three npdules. IPRN is set
to zero when the specified val ue exceeds those defined in the chart below. If |PRN
is less than zero, the array will not be printed.
I PRN  U2DREL U2DI NT U1DREL

0 10G11.4 10111 10Gl2. 5
1 11G10.3 6011
2 9G13.6 4012
3 15F7.1 3013
4 15F7. 2 251 4
5 15F7. 3 2015
6 15F7. 4

7 20F5.0

8 20F5.1

9 20F5. 2

10 20F5. 3

11 20F5. 4

12 10Gl11. 4

Appendix



A-12

Processing M odflow

Basic Package

FOR EACH SIMULATION

1. Dat a:
For mat :
2. Dat a:
For mat :
3. Dat a:
For mat :
4. Dat a:
For mat :
5. Dat a:
For mat :
6 Dat a
7. Dat a:
For mat :
8 Dat a

HEADNG( 32)

2004

HEADNG (conti nued)

12A4

NLAY NROW NCOL NPER | TMUNI

1170 110 110 110 110

I UNI T( 24)

241 3

(BCF2 VWEL1 DRN1 RIV1 EVT1 XXXX GHB1 RCHL SIP1 XXXX SOR1 OC

PC& STR1 GFDL HFB1 XXXX XXXX | BS1 CHD1 XXXX LKMI BCF3 BCF1)

Note: XXXX is reserved; underlined packages are not supported by PMA'N
| APART | STRT

110 110

| BOUND( NCOL, NROW | nput Mbodul e: U2DI NT

(one array for each layer in the grid)

HNOFLO

F10.0

Shead( NCOL, NROW | nput Mbdul e: U2DREL

(One array for each layer in the grid)

NOTE: |1 BOUND and Shead are treated as three-dinensional arrays in the program
However, the input to each of these arrays is handled as a series of
two-di mensi onal arrays, one for each layer in the grid.

FOR EACH STRESS PERIOD

9. Dat a:
For mat :

PERLEN NSTP TSMULT
F10.0 110 F10.0

Explanation of Fields Used in Input Instructions
HEADNG is the sinulation title that is printed on the sinulation record file. It nay be
up to 132 characters long; 80 in the first record and 52 in the second. Both
records nust be included even if they are bl ank

NLAY is the nunber of nodel |ayers.

NROW is the number of nodel rows.

NCOL is the number of nodel col umms.

NPER is the number of stress periods in the simulation.

I TMUNI indicates the tinme unit of nodel data. (It is used only for printout of elapsed
simulation time. It does not affect nodel calcul ations.)
0 - undefined 1 - seconds 2 - minutes
3 - hours 4 - days 5 - years

The unit of time nust be consistent for all data values that involve tinme. For
exanmple, if years is the chosen time unit, stress-period length, timestep |ength,
transm ssivity, etc., nust all be expressed using years for their tinme units.
Li kewi se, the length unit nust al so be consistent.

IUNI'T is a 24-elenent table of input units for use by all major options.

| f
| f

IUNIT(n) < O, the correspondi ng maj or option is not being used.
IUNIT(n) > 0, the corresponding nmajor option is being used and data for that

option will be read fromthe unit nunber contained in [UNIT(n). The unit nunbers
in ITUNT should be integers from1l to 99. Al though the same nunber may be used for

al |

or sone of the najor options, it is recoomended that a different number be used

for each major option. Printer output is assigned to unit 6 (unless it is changed
to nmeet conputer requirenents). That unit nunber should not be used for any other
input or output. The user is also permitted to assign unit nunbers for output.
Those nunmbers shoul d be different fromthose assigned to i nput. The Basic Package
reads fromunit 1 (unless it is changed to neet conputer requirenents). It is
permi ssi ble but unwise to use that unit for other major options.

IUNI T LOCATI ON Maj or Opti on/ Package

©CO~NOODWNE

Bl ock- Centered Fl ow Package 2 (BCF2)

Wel | Package (WEL1)

Drai n Package ( DRN1)

Ri ver Package (RIV1)

Evapotranspirati on Package (EVT1)

Reser ved

Gener al - Head Boundary Package (GHB1)
Rechar ge Package (RCH1)

Strongly Inplicit Procedure Package (SIP1)
Reser ved

Slice-Successive Overrel axati on Package (SOR1)
Qut put Control Options (OC)

Precondi ti oned Conjugate G adi ent Package 2
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| APART

| STRT

| BOUND

HNOFLO

Shead

PERLEN
NSTP
TSMULT

14 Streanf |l ow Routi ng Package (STR1)

15 General Finite-Difference Flow Package (GFDl) Not Supported by
PMAY N

16 Hori zont al - Fl ow Barri er Package (HFB1)

17 Reserved

18 Reserved

19 I nt er bed- St or age Package (1 BS1)

20 Ti me- Vari ant Specifi ed- Head Package (CHD1)

21 Reserved

22 LKMI Package (this package creates interface files to MI3D)

23 Bl ock- Centered Fl ow Package 3 (BCF3) Not Supported by PMA'N

24 Bl ock- Centered Flow Package 1 (BCFl1) Not Supported by PMAYN, as

BCF2 has all options of BCF1

i ndi cates whether array BUFF is separate fromarray RHS.

If | APART = O(Default by PMAN), the arrays BUFF and RHS occupy the sanme space.
This option conserves space. This option should be used unless sone other package
explicitly says otherwi se.

If IAPART = 0, the arrays BUFF and RHS occupy different space.

indicates whether initial heads are to be saved. |If they are saved, they will be
stored in array STRT. They nust be saved if drawdown is cal cul ated.

If ISTRT = 0, initial heads are not saved.

If ISTRT # O(Default by PMAN), initial heads are saved.

is the boundary array.

If I1BOUND(I,J,K) < 0, cell 1,J,K has a constant head.

If IBOUND(I,J,K) =0, cell I,J,Kis inactive (no-flow).

If IBOUND(I,J,K) >0, cell 1,J,Kis variable-head.

is the value of head to be assigned to all inactive cells (I BOUND = 0) throughout

the simulation. Since heads at inactive cells are unused, this does not affect
nodel results but serves to identify inactive cells when head is printed. This
value is also used as drawdown at inactive cells if the drawdown option is used.
Even if the user does not anticipate having inactive cells, a value for HNOFLO nust
be submitted.

is head at the start of the sinulation. Regardless of whether initial head is
saved, these values nmust be input to initialize the solution.

is the length of a stress period. It is specified for each stress period.

is the number of tine steps in a stress period.

is the nultiplier for the length of successive tine steps. The length of the first
time step DELT(1) is related to PERLEN, NSTP and TSMULT by the relation

DELT(1) = PERLEN(1- TSMULT)/ (1- TSMULT**NSTP).
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Output Control Options

Qut put Control is a nmjor option separate fromthe rest of the Basic Package. |nput to Qutput
Control is read fromthe unit specified in IUNIT(12). If ITUNIT(12) is zero, no output control
data are read, and default output control is used. Under the default, head and total budget are
printed at the end of every stress period. Additionally, if initial heads are saved (I STRT is not
0), drawdown is printed at the end of every stress period. The default printout format for head
and drawdown is 10Gl1.4. Al printer output goes to unit 6 as specified in the main program |f
necessary, the unit nunber for printer output can be changed to neet the requirenents of a
particul ar conputer.

FOR EACH SIMULATION

1. Dat a: | HEDFM | DDNFM | HEDUN | DDNUN
For mat : 110 110 110 110

FOR EACH TIME STEP

2. Dat a: | NCODE | HDDFL | BUDFL | CBCFL
For mat : 110 110 110 110

3. Data: Hdpr Ddpr Hdsv Ddsv
For mat : 110 110 110 110

(Record 3 is read 0, 1, or NLAY tinmes, depending on the value of | NCODE. )

Explanation of Fields Used in Input Instructions

| HEDFM is a code for the format in which heads will be printed.

| DDNFM is a code for the format in which drawdowns will be printed. Format codes have the
sane neaning for both head and drawdown. A positive format code indicates that each
row of data is printed conpletely before starting the next row This neans that
when there are nore columms in a row than will fit on one line, additional |ines
are used as required to conplete the row This format is called the wap fornmat.
A negative format code indicates that the printout is broken into strips where only
that nunmber of colums that will fit across one line are printed in a strip. As
many strips are used as are required to print the entire nodel width. This format
is called the strip format. The absolute value of the format code specifies the
printout format as follows (The default code of PMAN is 0).

0 - (10G11.4) 1 - (11GlL0.3) 2 - (9G13.6) 3 - (15F7.1) 4 - (15F7.2)
5 - (15F7.3) 6 - (15F7.4) 7 - (20F5.0) 8 - (20F5.1) 9 - (20F5.2)
10 - (20F5. 3) 11 - (20F5. 4) 12 -(10Gl1. 4)
| HEDUN is the unit nunber to which heads will be witten if they are saved on disk.
| DDNUN is the unit nunber to which drawdowns will be witten if they are saved on di sk.
| NCODE is the head/drawdown ouput code. It determ nes the number of records in the 3.
dat a.

I'f INCODE < 0, l|ayer-by-layer specifications fromthe last tine steps are used. The
3. data is not read.

If INCODE = 0, all layers are treated the same way. The 3. data will consist of one
record.
If INCODE > 0, The 3. data will consist of one record for each |ayer.
| HDDFL is a head and drawdown out put fl ag.
If IHDDFL = 0, neither heads nor drawdowns will be printed or saved on disk.
If IHDDFL # 0, heads and drawdowns will be printed or saved according to the flags
for each layer specified in the 3. data.
| BUDFL is a budget print flag.
If IBUDFL = 0, overall volunetric budget will not be printed.
If IBUDFL # O, overall volunetric budget will be printed.
(Note that the overall volunetric budget will always be printed at the end of a
stress period, even if the value of IBUDFL is zero.)
| CBCFL is acell-by-cell flowtermflag.

If ICBCFL = 0, cell-by-cell flowterns are not saved or printed.
If ICBCFL = 0, cell-by-cell flow terns are printed or recorded on disk depending

on flags set in the conmponent of flow packages, i.e., |WELCB, | RCHCB, etc.
Hdpr is the output flag for head printout.
If Hdpr = 0, head is not printed for the corresponding |ayer.
If Hdpr # 0, head is printed for the corresponding | ayer.
Ddpr is the output flag for drawdown printout.
If Ddpr = 0, drawdown is not printed for the corresponding |ayer.
If Ddpr # 0, drawdown is printed for the corresponding |ayer.
Hdsv is the output flag for head save.
If Hdsv = 0, head is not saved for the corresponding |ayer.
If Hdsv # 0, head is saved for the corresponding |ayer.
Ddsv is the output flag for drawdown save.
If Ddsv = 0, drawdown is not saved for the corresponding |ayer.
If Ddsv # 0, drawdown is saved for the corresponding |ayer.
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Block-Centered Flow 2 Package

Mbst of the data required by the BCF2 Package are the same as for the BCFl Package. These data
consist primarily of arrays that are used to cal cul ate conductance and storage terns for each
layer. The required arrays can include transm ssivity, hydraulic conductivity, specific yield,
confined storage coefficient, vertical |eakance, aquifer bottom elevation, and aquifer top
el evation. The specific arrays required depend on the options that are used as indicated by the
| ayer-type code, LAYCON. The reader is referred to section 3.3.2 for a detailed description of
these data. Because BCF2 is designed as a replacenent for BCF1l, input unit nunmber is specified
in TUNIT(1). The data are read once at the start of the sinulation.

FOR EACH SIMULATION

1. Dat a: ISS | BCFCB HDRY I WOFLG WETFCT | WETIT | HDWET
For mat : 110 110 F10.0 110 F10.0 110 110
2. Data: LAYCON( NLAY) ( Maxi mum of 80 | ayers)

For mat : 401 2
(If there are 40 or fewer |layers, use one record; otherw se, use two records.)

3. Data: TRPY(NLAY) | nput Modul e: ULDREL
4, Data: DELR(NCOL) | nput Mbdul e: ULDREL
5 Dat a: DELC( NROW | nput Mbdul e: ULDREL

A subset of the followi ng two-di mensional arrays is used to describe each |ayer. The arrays
needed for each layer depend on the |layer-type code (LAYCON), whether the simulation is
transient (ISS = 0) or steady state (1SS = 0), and if the wetting capability is active
(IVWDFLG # 0). If an array is not needed, it nust be omitted. In no situation will all arrays
be required. The required arrays (Data 6-13) for layer 1 are read first; then the arrays for
| ayer 2, etc.

IF THE SIMULATION IS TRANSIENT (ISS = 0)

6. Data: sf 1( NCOL, NROW | nput Modul e: U2DREL

IF THE LAYER-TYPE CODE (LAYCON) is O or 2

7. Data: Tran(NCOL, NROWN | nput Modul e: U2DREL

IF THE LAYER-TYPE CODE (LAYCON) IS 1 or 3

8. Data: HY( NCOL, NROW | nput Mbdul e: U2DREL

9. Data: BOT( NCOL, NROW | nput Mbdul e: U2DREL

IF NOT THE BOTTOM LAYER

10. Data: Vcont (NCOL, NROW | nput Mbdul e: U2DREL

IF THE SIMULATION IS TRANSIENT (ISS = 0) AND THE LAYER-TYPE CODE (LAYCON) IS 2 OR 3
11. Data: sf2(NCOL, NROWN | nput Modul e: U2DREL

IF THE LAYER-TYPE CODE (LAYCON) IS 2 OR 3

12. Data: TOP(NCOL, NROWN | nput Modul e: U2DREL

IF THE LAYER-TYPE CODE (LAYCON) IS 1 OR 3 AND THE WETTING CAPABILITY IS ACTIVE (IWDFLG 1S NOT
0)

13. Data: WETDRY( NCOL, NROW | nput Mbdul e: U2DREL

Explanation of Parameters Used in Input Instructions
| SS is the steady-state flag
If 1SS = 0, the sinulation is steady state.
If 1SS =0, the simulation is transient.
| BCFCB is aflag and a unit nunber.
If IBCFCB > 0, it is the unit nunmber on which cell-by-cell flow terms will be
recorded whenever | CBCFL (see Qutput Control Options) is set; the terns which are

saved will include cell-by-cell storage terns, cell-by-cell constant head fl ows,
and cell-by-cell flow between adjacent cells.
If IBCFCB = 0, cell-by-cell flowterns will not be printed or recorded.
If IBCFCB < 0, flow for each constant-head cell will be printed in the listing file
whenever |CBCFL is set; cell-by-cell storage terns and cell-by-cell flow between
adj acent cells will not be recorded or printed.

HDRY is the head that is assigned to cells that are converted to dry during a

simul ati on. Although this value plays no role in the nodel calculations, it is
useful as an indicator when | ooking at the resulting heads that are output fromthe
model . HDRY is thus similar to HNOFLO in the Basic Package, which is the value
assigned to cells that are no-flow cells at the start of a nodel sinulation.

| WDFLG is aflag that determnes if the wetting capability is active.
If IWDFLG = 0, the wetting capability is inactive.
If IWDFLG # 0, the wetting capability is active.
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VETFCT

I VETI T

| HDWET

LAYCON

TRPY

DELR
DELC

sf1l

Tran

BOT

Vcont

sf2

TOP
WETDRY

is a factor that is included in the calculation of the head that is initially
established at a cell when it is converted fromdry to wet. (See | HDVET.)
is the iteration interval for attenpting to wet cells. Wtting is attenpted every
IVETIT iterations. If using the PC& solver (Hll, 1990), this applies to outer
iterations, not inner iterations. If IVETIT is 0, it is changed to 1.
is aflag that determi nes which equation is used to calculate the initial head at
cells that become wet:
If IHDWET = 0, h = BOT + WETFCT (hn - BQT),
If IHDWET # 0, h = BOT + WETFCT ( THRESH).
is the layer-type table. Each elenent holds the code for the respective |ayer. Read
one value for each layer. There is a limt of 80 layers. |f there are 40 or fewer
| ayers, use one record; otherwi se, use two records. Leave unused elenments in a
record bl ank.
LAYCON = 0 (confined |ayer):
Transmi ssivity and storage coefficient of the layer are constant for the
entire simulation.
LAYCON = 1 (unconfined |ayer):
Transmissivity of the layer varies. It is calculated from the saturated
thi ckness and hydraulic conductivity. The storage coefficient is constant.
This type code is valid only for |ayer 1.
LAYCON = 2 (confined/unconfined |ayer):
Transmi ssivity of the layer is constant. The storage coefficient my
al ternate between confined and unconfined values. Vertical flow from above
islimted if the | ayer desaturates.
LAYCON = 3 (confined/unconfined |ayer):
Transmissivity of the layer varies. It is calculated from the saturated
thi ckness and hydraul i c conductivity. The storage coefficient may alternate
bet ween confined and unconfined val ues. Vertical flow fromabove is linmted
if the aquifer desaturates.
is a one-dinensional array containing an anisotropy factor for each layer. It is
the ratio of transmissivity or hydraulic conductivity (whichever is being used)
along a colum to transmissivity or hydraulic conductivity along a row. Set to 1.0
for isotropic conditions.
is the cell width along rows. Read one value for each of the NCOL columms. This is
a single array with one value for each col um.
is the cell width along colums. Read one value for each of the NRONrows. This is
a single array with one value for each row
is the prinmary storage coefficient. Read only for a transient sinulation (1SS = 0).
For LAYCON equal to 1, sfl will always be specific yield, while for LAYCON equal
to 0, 2 or 3, sfl will be confined storage coefficient.
is the transmissivity along rows. Tran is mnultiplied by TRPY to obtain
transm ssivity along colums. Read only for |ayers where LAYCON is 0O or 2.
is the hydraulic conductivity along rows. HY is multiplied by TRPY to obtain
hydrauli ¢ conductivity along colums. Read only for |ayers where LAYCON is 1 or 3
is the el evation of the aquifer bottom Read only for |ayers where LAYCON is 1 or
3.
is the vertical hydraulic conductivity divided by the thickness froma |ayer to the
|l ayer below. The value for a cell is the hydraulic conductivity divided by
thickness for the material between the node in that cell and the node in the cell
bel ow. Because there is not a l|layer beneath the bottom |ayer, Vcont cannot be
specified for the bottom | ayer.
is the secondary storage coefficient. Read only for |ayers where LAYCON is 2 or 3
and only if the sinulation is transient (ISS = 0). The secondary storage
coefficient is always specific yield.
is the el evation of the aquifer top. Read only for |ayers where LAYCON is 2 or 3.
is a conbination of the wetting threshold and a flag to indicate which nei ghboring
cells can cause a cell to become wet. |f WETDRY < 0, only the cell below a dry cell
can cause the cell to becomre wet. |f WETDRY > 0, the cell below a dry cell and the
four horizontally adjacent cells can cause a cell to become wet. |If WETDRY is O,
the cell cannot be wetted. The absolute value of WETDRY is the wetting threshol d.
When the sum of BOT and the absolute value of WETDRY at a dry cell is equaled or
exceeded by the head at an adjacent cell, the cell is wetted. Read only if LAYCON
is 1 or 3 and IWDFLG is not O.
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Well Package

I nput for the Well Package (WEL1) is read fromthe unit specified in | UN T(2)

FOR EACH SIMULATION

1. Data: MXWELL | VELCB
For mat : 110 110
FOR EACH STRESS PERIOD
2. Data: I TMP
For mat : 110
3. Data: Layer Row  Col um Q
For mat : 110 110 110 F10.0
(The 3. data nornally consists of one record for each well. If ITMP is negative or zero, The

3. data is not read.)

Explanation of Fields Used In Input Instructions

MXVEL L
| \ELCB

I TMP

Layer
Row
Col um

i s the maxi mum nunber of wells used at any tine.

is aflag and a unit nunber

If IVWELCB > 0, it is the unit nunber on which cell-by-cell flow ternms will be
recorded whenever | CBCFL (see Qutput Control Options) is set.

If IVWELCB = 0, cell-by-cell flowterns will not be printed or recorded

If IVELCB < 0, well recharge will be printed whenever |ICBCFL is set

is aflag and a counter
|

f ITMP < 0, well data fromthe |last stress period will be reused
If ITMP > 0, ITMP will be the number of wells active during the current stress
peri od.

is the layer number of the nodel cell that contains the well.

is the row nunmber of the npdel cell that contains the well.

is the colum nunber of the nodel cell that contains the well.

is the volumetric recharge rate. A positive value indicates recharge and a negative
val ue indi cates di scharge
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Drain Package

Input to the Drain Package (DRN1)

is read fromthe unit specified in | UNIT(3).

FOR EACH SIMULATION

1. Dat a:

For mat :

MXDRN
110

| DRNCB
110

FOR EACH STRESS PERIOD

2. Data: I TMP
For mat : 110
3. Data: Layer Row Col El evation Cond
For mat : 110 110 110 F10.0 F10.0
(The 3. data nornally consists of one record for each drain. If ITMP is negative or zero, the
3. data will not be read.)
Explanation of Fields Used in Input Instructions

MXDRN is the maxi mum nunber of drain cells active at one tine.

| DRNCB is aflag and a unit nunber.
If IDRNCB > 0, it is the unit nunmber on which cell-by-cell flow ternms will be
recorded whenever | CBCFL (see Qutput Control Options) is set.
If IDRNCB = 0, cell-by-cell flowterns will not be printed or recorded.
If IDRNCB < 0, drain | eakage for each cell will be printed whenever |ICBCFL is set.

| TMP is a flag and a counter.
If ITMP <0, drain data fromthe | ast stress period will be reused.
If ITMP > 0, ITMP will be the number of drains active during the current stress
peri od.

Layer is the layer nunber of the cell containing the drain.

Row is the row nunber of the cell containing the drain.

Col umm is the colum nunber of the cell containing the drain.

El evation
is the elevation of the drain.

Cond is the hydraulic conductance of the interface between the aquifer and the drain.
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River Package

Input to the River Package (RIV1) is read fromthe unit specified in IUNT(4).

FOR EACH SIMULATION

1. Dat a: MXRI VR | RI VCB
For mat : 110 110

FOR EACH STRESS PERIOD

2. Data: I TMP
For mat : 110

3. Data: Layer Row Columm Stage Cond Rbot
For mat : 110 110 110 F10.0 F10.0 F10.0

(The 3. data nornally consists of one record for each river

or zero, the 3. data is not read.)

Explanation of Fields Used in Input Instructions

MXRI VR is the maxi mum nunber of river reaches active at one tine

| R VCB is aflag and a unit nunber

If IRIVCB > 0, it is the unit nunber on which cell-by-cel

recorded whenever | CBCFL (see CQutput Contro
If IRRVCB = 0, cell-by-cell flowterms wll

not be printed or

I TMP is negative

flow terms will be

If IRVCB < 0, river |eakage for each reach will be printed whenever |CBCFL is set.
| TMP is aflag and a counter
If ITMP < 0, river data fromthe last stress period will
If ITMW > 0, ITMP will be the nunber of reaches active during the current stress
peri od.
Layer is the layer nunber of the cell containing the river
Row is the row nunber of the cell containing the river
Col umm is the colum nunber of the cell containing the river
St age is the head in the river
Cond is the riverbed hydraulic conductance
Rbot is the elevation of the bottomof the riverbed
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Evapotranspiration Package

Input to the Evapotranspirati on Package (EVT1l) is read fromthe unit specified in [UNIT(5).

FOR EACH SIMULATION

1. Dat a: NEVTOP | EVTCB
For mat : 110 110
FOR EACH STRESS PERIOD
2. Dat a: | NSURF I NEVTR | NEXDP I NI EVT
For mat : 110 110 110 110
3. Data: SURF( NCOL, NROW | nput Modul e: U2DREL
4, Data: EVTR(NCOL, NROW | nput Mbdul e: U2DREL
5 Dat a: EXDP( NCOL, NROW | nput Mbdul e: U2DREL
IF NEVTOP 1S EQUAL TO TWO
6. Data: I EVT(NCOL, NROW | nput Mbdul e: U2DI NT
Explanation of Fields Used in Input Instructions
NEVTOP is the Evapotranspiration (ET) option code. ET paraneters (ET surface, nmaxi num ET
rate, and extinction depth) are specified in two-di mensional arrays, SURF, EVTR,
and EXDP, with one value for each vertical colum. Accordingly, ET is calculated
for one cell in each vertical colum. The option codes determine for which cell in
the colum ET will be calcul ated.
If NEVTOP = 1, ET is calculated only for cells in the top grid |ayer.
If NEVTOP = 2, the cell for each vertical colum is specified by the user in array
| EVT.
| EVTCB is aflag and a unit nunber.
If IEVICB > 0, it is the unit nunber on which cell-by-cell flow terms will be
recorded whenever | CBCFL (see Qutput Control Options) is set.
If TEVICB < 0, cell-by-cell flowterns will not be printed or recorded.
| NSURF is the ET surface (SURF) read fl ag.
If INSURF > 0, an array containing the ET surface elevation will be read.
If INSURF < 0, the ET surface fromthe preceding stress period will be reused.
I NEVTR is the maxi um ET rate (EVIR} read fl ag.
If INEVIR > 0, an array containing the nmaxi numET rate will be read.
If INEVIR < 0, the nmaxi mumET rate fromthe precedi ng stress period will be reused.
| NEXDP is the extinction depth (EXDP) read fl ag.
If INEXDP > 0, an array containing the extinction depth (EXDP) will be read.
If INEXDP < 0, the extinction depth from the preceding stress period wll be
reused.
I NI EVT is the layer indicator (IEVT) read flag. It is used only if the ET option (NEVTOP)
is equal to two.
If INNEVT > 0, an array containing the layer indicators (IEVT) will be read.
If INEVT < 0, layer indicators used during the preceding stress period will be
reused.
SURF is the elevation of the ET surface.
EVTR is the maxi mum ET rate (volume of water per unit area [L/T]).
EXDP is the ET extinction depth.
| EVT is the layer indicator array. For each horizontal location, it indicates the |ayer

fromwhich ET is removed. It is needed only if the ET option (NEVIOP) is equal to
t wo.
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General-Head Boundary Package

Input for the

Gener al - Head Boundary Package (GHBl) is read fromthe unit specified in [ UNIT(7)

FOR EACH SIMULATION

1. Dat a: MXBND | GHBCB
For mat : 110 110

FOR EACH STRESS PERIOD

2. Dat a: I TMP
For mat : 110

3. Data: Layer Row Colum Head Cond
For mat : 110 110 110 F10.0 F10.0

(The 3. data nornally consists of one record for each GHB. If ITMP is negative or zero, the
3. data is not read.)

Explanation of Fields Used in Input Instructions

MXBND
| GHBCB

I TMP

Layer
Row
Col um
Head
Cond

i s the maxi num nunber of general -head boundary cells at one tine

is aflag and a unit nunber

If IGHBCB > 0, it is the unit nunmber on which cell-by-cell flow ternms will be
recorded whenever | CBCFL (see Qutput Control Options) is set.

If 1GHBCB = 0, cell-by-cell flowterns will not be printed or recorded

If IGHBCB < 0, boundary |eakage for each cell will be printed whenever ICBCFL is
set.

is aflag and a counter

If ITMP <0, GHB data fromthe preceding stress period will be reused

If ITMP >0, ITMP is the nunber of general -head boundaries during the current stress
peri od.

is the |layer nunber of the cell affected by the head-dependent boundary.

is the row nunber of the cell affected by the head-dependent boundary.

is the colum nunber of the cell affected by the head-dependent boundary.

is the head on the boundary.

is the hydraulic conductance of the interface between the aquifer cell and the
boundary.
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Recharge Package
Input to the Recharge Package (RCH1) is read fromthe unit specified in I UNIT(8).

FOR EACH SIMULATION

1. Dat a: NRCHOP | RCHCB
For mat : 110 110
FOR EACH STRESS PERIOD
2. Dat a: I NRECH | NI RCH
For mat : 110 110
3 Dat a: RECH( NCOL, NROW | nput Mbdul e: U2DREL

IF NRCHOP = 2
4, Data: | RCH(NCOL, NROW | nput Modul e: U2DI NT

Explanation of Fields Used in Input Instructions

NRCHOP is the recharge option code. Recharge fluxes are defined in a two dinensional
array, RECH, with one value for each vertical colum. Accordingly, recharge is
applied to one cell in each vertical colum, and the option code deternines which
cell in the colum is selected for recharge.

NRCHOP = 1 - Recharge is only to the top grid |ayer.

NRCHOP = 2 - Vertical distribution of recharge is specified in array |RCH.

NRCHOP = 3 - Recharge is applied to the highest active cell in each vertical

colum. A constant-head node intercepts recharge and prevents deeper infiltration.
| RCHCB is aflag and a unit nunber.

If IRCHCB > 0, it is the unit nunmber on which cell-by-cell flow ternms will be

recorded whenever | CBCFL (see Qutput Control Options) is set.

If IRCHCB < 0, cell-by-cell flowterns will not be printed or recorded.

| NRECH is the RECH read fl ag.
If INRECH > 0, an array of recharge fluxes, RECH, is read.
If INRECH < 0, recharge rates fromthe preceding stress period are used.
I NI RCH is the IRCH read flag. Wen NRCHOP is two,
If INNRCH > 0, an array of layer nunbers (IRCH) is read.
If INNRCH < 0, the array (IRCH) used in the preceding stress period is reused.
Not e: When NRCHOP is one or three, INIRCH is ignored.
RECH is the recharge flux [L/T]. Read only if INRECH is greater than or equal to zero.
I RCH is the layer nunber array that defines the layer in each vertical colum where

recharge is applied. Read only if NRCHOP is two and if INIRCH is greater than or
equal to zero.
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Strongly Implicit Procedure Package

Input to the Strongly Inplicit Procedure Package (SIP) is read from the unit specified in
I UNI T(9).

FOR EACH SIMULATION

1. Dat a: MXI TER NPARM
For mat : 110 110

2. Dat a: ACCL HCLOSE | PCALC WSBEED |PRSIP
For mat : F10.0 F10.0 110 F10.0 110

Explanation of Fields Used in Input Instructions
MXI TER is the maxi mum nunber of tines through the iteration loop in one time step in an
attenpt to solve the systemof finite-difference equations. Fifty Iterations are
general ly sufficient.

NPARM is the nunber of iteration paraneters to be used. Five paraneters are generally
sufficient.

ACCL is the acceleration paraneter. It nust be greater than zero and is generally equa
to one. If a zero is entered, it is changed to one.

HCLGSE is the head change criterion for convergence. Wen the maxi mrum absol ute val ue of

head change from all nodes during an iteration is less than or equal to HCLOSE
iteration stops

| PCALC is aflag indicating where the iteration paraneter seed will cone from
0 - the seed will be entered by the user
1 - the seed will be calculated at the start of the sinmulation from problem
parameters

WSEED is the seed for calculating iteration paranmeters. It is only specified if |PCALC
is equal to zero

| PRSI P is the printout interval for SIP. If IPRSIPis equal to zero, it is changed to 999

The maxi mum head change (positive or negative) is printed for each iteration of a
tinme step whenever the tinme step is an even nmultiple of IPRSIP. This printout also
occurs at the end of each stress period regardl ess of the value of |IPRSIP
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Slice-Successive Overrelaxation Package

Input to the Slice-Successive Overrel axati on Package (SSOR) Is read fromthe unit specified in

IUNIT(11).
FOR EACH SIMULATION
1. Dat a: MXI TER
For mat : 110
2. Dat a: ACCL HCLOSE | PRSOR

For mat : F10.0 F10.0 110

Explanation of Fields Used in Input Instructions

MXI TER
ACCL
HCLOSE

| PRSOR

i s the maxi mum nunber of iterations allowed in a time step

is the acceleration paraneter, usually between 1.0 and 2.0

is the head change criterion for convergence. Wen the nmaxi num absol ute val ue of
head change from all nodes during an iteration is less than or equal to HCLOSE
iteration stops

is the printout interval for SSOR |F IPRSOR is equal to zero, it is changed to
999. The maxi num head change (positive or negative) is printed for each iteration
of a time step whenever the time step is an even nmultiple of | PRSOR This printout
al so occurs at the end of each stress period regardl ess of the value of |PRSOR
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Preconditioned Conjugate Gradient 2 Package

Input for the Preconditioned Conjugate G adi ent 2 Package (PC&) is read fromthe unit specified

in [UNIT(13).

FOR EACH SIMULATION

1. Dat a:

MXI TER | TERL NPCOND

For mat : 110 110 110

2. Dat a:

HCLOSE RCLOSE RELAX NBPOL | PRPCG MJUTPCG | PCGCD

For mat : F10.0 F10.0 F10.0 110 110 110 110

Explanation of Fields Used in Input Instructions

MXI TER

| TER1

NPCOND

HCLOSE

RCLOSE

RELAX

NBPOL

| PRPCG

MJTPCG

| PCGCD

is the maxi mum nunber of outer iterations -- that is, calls to the solution
routine. For a linear problem MXITER should be 1, unless nore than 50 inner
iterations are required, when EXITER could be as large as 10. A |larger nunber
(generally less than 100) is required for a nonlinear problem

i's the maxi mum nunber of inner iterations. For nonlinear problens, |TERL usually
ranges from3 to 10; a value of 30 will be sufficient for nost |inear problens.
is the flag used to select the matrix preconditioning nethod. The follow ng options
are avail abl e

NPCOND PRECONDI TI ONI NG METHCD

1 Modi fi ed | nconpl ete Chol esky (for use on scal ar conputers)

2 Pol ynomi al (for use on vector conputers or to conserve conputer storage)
is the head change criterion for convergence, in units of length

Wien the naxi num absol ute val ue of the head change at all nodes during an iteration
is less than or equal to HCLOSE, and the criterion for RCLOSE is satisfied (see
bel ow), iteration stops. Commonly HCLOSE equal s 0.01

is the residual criterion for convergence, in units of cubic length per tine.
When the maxi mum absol ute value of the residual at all nodes during an iteration
is less than or equal to RCLOCSE, and the criterion for HCLOSE is satisfied (see
above), iteration stops. Commonly, RCLOSE equals HCLOSE. For nonlinear problens,
convergence i s achi eved when the convergence criteria are satisfied on the first
inner iteration.

is the relaxation parameter used with NPCOND=1 (M CCG). Usual ly, RELAX=1.0, but for
sone problens value of 0.99 0.98, or 0.97 will reduce the number of iterations
requi red for convergence. RELAX is not used if NPCOND # 1

is used when NPCOND=2 to indicate whether the estimte of the upper bound on the
maxi mum ei genvalue is 2.0, or whether the estimate will be cal cul ated NBPOL=2 is
used to specify the value as 2.0; for any other value of NBPOL the estimate is
cal cul ated. Convergence is generally insensitive to this paraneter. NBPOL is not
used if NPCOND does not equal 2

is the printout interval for PCG |If IPRPCGis equal to zero it is changed to 999
The extreme head change and residual (positive or negative) are printed for each
iteration of a time step whenever the tine step is an even nultiple of |IPRPCG The
printout also occurs at the end of each stress period regardl ess of the val ue of
| PRPCG

is aflag which controls printing fromthe solver. If MJTPCG = 0, printing fromthe
sol ver is suppressed. If MJTPCG=1l, the nunber of iterations is printed, but the
lists of extreme head changes and residuals is suppressed. |If MJTPCG=2, al
printing i s suppressed

is a flag which is used when NPCOND=1 to control whether the sanme Chol esky
deconposi tion may be used for nultiple calls to PCGAP. | PCGCD should be zero for
nmost applications. However, future packages m ght benefit from nonzero val ues of
| PCGCD.
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Streamflow-Routing Package
Input for the Streanfl ow Routing Package (STR1l) is read fromthe unit specified in | UNIT(14).

FOR EACH SIMULATION

1. Dat a: MXSTRM NSS NTRIB NDIV | CALC CONST |STCBI |STCB2
For mat : 110 110 110 110 110 F10.0 110 110

FOR EACH STRESS PERIOD

2. Dat a: | TMP | RDFLG | PTFLG
For mat : 110 110 110

3. Data: Layer Row Col Seg Reach Flow Stage Cond Shot St op
For mat : 15 15 15 15 15 F15.0 F10.0 F10.0 F10.0 F10.0

(The 3. data nornmally consists of one record for each reach. Records are read in sequenti al
order fromupstreamto downstream first by segments, and then by reaches. The downstream
ordering and reading of segnents and reaches are inportant as the order determines the
connection of inflows and outflows. If ITMP is negative or zero, data 3-6 are not read.)

If stream stages for each reach are to be calculated (I CALC>0), then the follow ng data set
is read in sequential order of segment and reach.

4. Data: Wdth Slope Rough
For mat : F10.0 F10.0 F10.0

If the maxi mum nunber of tributaries (NTRIB) that can join a segnent is greater than zero,
then the following data set is read. One record for each segnent is read in sequential order.
A record is necessary even for segnments that do not have tributaries. In this case a bl ank
record or a record with all zeros is read.

5. Data: ltrib(1) Itrib(2) ... Itri b(NTRIB)
For mat : 15 15 ... |5

If diversions are specified (NDIV>0O, then the following data set is read. One record is read
for each segnent in sequential order. For segnments that are not diversions, zeros or blanks
are specified for each input item

6. Data: | upseg
For mat : 110
Explanation of Fields Used in Input Instructions

MXSTRM i s the maxi mum nunber of streamreaches that can be active during the sinmulation.

NSS is the maxi mum nunber of segnents that can be used during the sinulation.

NTRI B is the maxi mum nunber of tributary segnments that can join during a sinmulation. This
is the axi mum nunber allowed as currently specified in the program

NDI V is aflag, which when positive, specifies that diversions fromsegnents are to be
si mul at ed.

| CALC is aflag, which when positive, specifies that stream stages in reaches are to be
cal cul at ed.

CONST is a constant value used in calculating stream stage in reaches. It is specified
whenever |ICALC is greater than zero. Refer to equation 3.12 for the values of this
const ant .

| STCB1 is aflag and a unit nunber.
If ISTCBL >0, it is the unit nunber to which | eakage between each streamreach and
the corresponding nodel cell will be saved on di sk whenever the variable ICBCFL is
specified (See Qutput Control Options).
If ISTCBL = 0, | eakage between each reach and correspondi ng nodel cell will not be

printed nor filed on disk.
If ISTCB1 < 0, streanflows into and out of each reach and | eakage between each

reach and correspondi ng nodel cell will be printed whenever the variable | CBCFL is
speci fi ed.

| STCB2 is a flag and unit nunber for an option of storing streanflow out of each reach
instead of having the results printed.
If ISTCB2 > 0, it is the unit nunber where streanflow out of each reach will be
saved on di sk whenever the variable ICBCFL is specified.
If ISTCB2 < 0, streanflows out of each reach will not be saved on disk.

| TMP is a flag and a counter.
If ITMP < 0, streamdata fromthe |last stress period will be reused.
If ITMP > 0, ITMP will be the nunber of reaches active during the current stress
peri od.

| RDFLG is a flag, which when positive, suppresses printing of the input data set specified
for a stress period. The input data set is printed for a stress period if the val ue
is zero or bl ank.
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| PTFLG

Layer
Row
Col
Seg

Reach

Fl ow

St age
Cond
Shot
St op
wi dt h
Sl ope
Rough

ltrib(1)

ltrib(2)

| upseg

is a flag, which when positive, suppresses printing of results for a stress period.
The results are printed for a stress period if the value is zero or blank and
whenever the variable | CBCFL is specified.

is the layer nunber of the cell containing the streamreach.

is the row nunber of the cell containing the streamreach.

is the colum nunber of the cell containing the streamreach.

is a nunber assigned to a group of reaches. Segnents nust be nunbered in downstream
order and are read into the programin sequential order.

is a sequential nunber in a segnment that begins with one for the farthest upstream
reach and continues in downstreamorder to the last reach in the segment. Reaches
nmust be read in sequentially as the order reaches are read into the program
determ nes the order of connection of inflows and outfl ows.

is the streanflow, in length cubed per tine, entering a segment. This value is
specified only for the first reach in each segnent. The value is either a zero or
a bl ank when the reach nunber (Reach) is not 1. Wen inflowinto a segnment is the
sum of outflow from a specified nunber of tributary segments, the segnent inflow
val ues are specified as a -1. (Note: if the specified inflow to a diversion is
greater than the flowin the reach fromwhich flowis to be diverted, then no flow
is diverted fromthe stream)

the stream stage, in units of |ength.

the streanbed hydraulic conductance, in units of length squared per tine.

the el evation of the bottomof the streanbed, in units of Iength.

the elevation of the top of the streanbed, in units of Iength.

s the width of the streamchannel, in units of length. It is used only when stream
stage in each reach is cal cul at ed.

is the slope of the stream channel in each reach, in units of length pre |ength.
It is used only when stream stage in each reach is cal cul at ed.

is Manning's roughness coefficient for each stream reach. It is used only when
stream stage in each reach is cal cul at ed.

for a segnent that has tributary segnents, Itrib(1l) is the nunber of the first
tributary segment. For a segnent with no tributary, Itrib(1l) nust be specified as
zero.

for a segment that has tributary segnments, Itrib(2) is the number of the second
tributary segment. For a segnent with no tributary, Itrib(2) nust be specified as
zero.

for a diversion segnent, lupseg is the nunber of the upstream segnent from which
water is diverted. For a segment that is not a diversion, lupseg nust be specified
as zero.

i
is
is
is
is
i
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Horizontal-Flow-Barrier Package

Input for the Horizontal-FlowBarrier Package (HFBl) is read from the unit specified in
| UNI T(16).

FOR EACH SIMULATION
1. Dat a: NHFB
For mat : 110

The following input data are read one layer at a tine; that is, all the data for layer 1 are
read first, then all the data for layer 2, and so forth.

FOR EACH LAYER

2. Dat a: NBRLAY
For mat : 110

3. Dat a: IROM 1COL1 RO [COL2 HYDCHR
For mat : 110 110 110 110 F10.0

(The 3. data consists of one record for each horizontal-flow barrier. If NBRLAY is zero, the
3. data will not be read.)

Explanation of Fields Used in Input Instructions
NHFB is the total nunmber of horizontal-flow barriers in the finite-difference grid.
NBRLAY is the number of horizontal-flow barriers in a |ayer.

NOTE: Wthin a layer, the location of a horizontal-flow barrier is identified by the two
cells on either side of the barrier. The row and col um nunbers of these two cells are | ROA,
I COL1, and |ROA2, | COL2, respectively. There is no requirement regarding the order in which
the cells are identified.

| RO is the row nunber of the cell on one side of the horizontal-flow barrier.

| CcaLl is the colum nunber of the cell on one side of the horizontal-flow barrier.

| RON2 is the row nunber of the cell on the other side of the horizontal-flow barrier.

| COL2 is the colum nunber of the cell on the other side of the horizontal-flow barrier.
HYDCHR is a hydraulic characteristic of the horizontal-flow barrier. If the |layer type is

O or 2, it is the barrier transmssivity divided by the width (thickness) of the
horizontal -flow barrier. If the layer type is 1 or 3, it is the barrier hydraulic
conductivity divided by the width (thickness) of the horizontal -flow barrier.
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Interbed-Storage Package

I nput for the

I nt er bed- St orage Package (1BS1) is read fromthe unit specified in I UNIT(19).

FOR EACH SIMULATION

1. Dat a: 11 BSCB 11 BSOC
For mat : 110 110
2. Data: | BQ(NLAY) (Maxi num of 80 | ayers)

For mat : 401 2
(If there are 40 or fewer |layers, use one record; otherw se, use two records)

The foll ow ng
of nodel |ayer

four arrays are needed to specify the material properties and initial conpaction
s having interbed storage as indicated in the IBQ array. The four arrays are first

read for the uppernost |ayer with interbed storage, and then continuing downward to | ower |ayers

wi th interbed

st or age.

FOR EACH LAYER WITH 1BQ CODE GREATER THAN ZERO

3. Data: HC( NCOL, NROW | nput Mbdul e: U2DREL

4, Data: Sf e( NCOL, NROW | nput Modul e: U2DREL

5. Data: Sfv(NCOL, NROW | nput Mddul e: U2DREL

6. Data: COM NCOL, NROW | nput Modul e: U2DREL

IF 1IBSOC IS GREATER THAN ZERO

7. Dat a: | SUBFM | COWM | HCFM | SUBUN | COMUN | HCUN
For mat : 110 110 110 110 110 110

FOR EACH TIME STEP

IF 11BSOC 1S GREATER THAN ZERO
8. Data: | SUBPR | COWPR | HCPR |SUBSV |COMBY | HCSV
For mat : 110 110 110 110 110 110

Explanation of Fields Used in Input Instructions

| 1 BSCB

|1 BSCC

I BQ

HC

sfv

| SUBFM
| COVFM
| HCFM

is a flag and unit nunber.
If IIBSCB > 0, it is the unit nunmber on which cell-by-cell flow ternms will be
recorded whenever | CBCFL (see Qutput Control Options) is set.

If 11BSCB < 0, cell-by-cell flowterns will not be recorded.

is a flag for selecting output control for each tine step.

If 11BSOC > 0, output control wll be read each time step for printing and
recordi ng subsidence (total conpaction of all layers with interbed storage), and
conpaction and preconsolidation head for all layers with interbed storage.

If I1BSOC < 0, subsidence will be printed at the end of each stress period using
format (10Gl1l.4). Conpaction and preconsolidation head will not be printed and
subsi dence, conpaction, and preconsolidation head will not be recorded.

is an indicator to specify which nodel |ayers have interbed storage.

If IBQ(K) > 0, nodel layer K has interbed storage.

If I1BQ(K) < 0, nodel layer K does not have interbed storage.

is an array specifying the preconsolidation head or preconsolidation stress in
terms of head in the aquifer. Preconsolidation head is the previous mni mum head
value in the aquifer. For any nodel cells in which specified HC is greater than the
corresponding value of initial head (see the input instruction of the Basic
Package), value of HC will be set to that of initial head.

is an array specifying the dinmensionless elastic storage factor for interbeds
present in nodel layer. The storage factor may be estimated as the sum of the
products of el astic skeletal specific storage and thickness of all interbeds in a
nodel | ayer.

is an array specifying the dinmensionless inelastic storage factor for interbeds
present in nodel layer. The storage factor may be estimated as the sum of the
products of inelastic skeletal specific storage and thickness of all interbeds in
a nodel |ayer.

is an array specifying the starting conpaction in each |layer with interbed storage.
Conpaction val ues conputed by the package are added to values in this array so that
printed or stored values of conpaction and |and subsidence may include previous
conponents. Values in this array do not affect calculations of storage changes or
resulting conpaction. For sinulations in which output values are to reflect
conpaction and subsi dence since the start of the sinulation, enter zero values for
all elements of this array.

is a code for the format in which subsidence will be printed.
is a code for the format in which conpaction will be printed.
is a code for the format in which preconsolidation head will be printed. Fornat

codes have the sane neani ng for subsidence, conpaction, and preconsolidation head
and are the same as codes for printing head and drawdown (see Qutput Control

Options).
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| SUBUN is the unit nunber to which subsidence arrays will be witten if they are saved on
di sk.

| COMUN is the unit nunber to which conpaction arrays will be witten if they are saved on
di sk.

| HCUN is the unit nunber to which preconsolidation head arrays will be witten if they
are saved on disk.

| SUBPR is the output flag for subsidence printout.
If | SUBPR > 0, subsidence is printed.
If I SUBPR < 0, subsidence is not printed.

| COWPR is the output flag for conpaction printout.
If 1COMWPR > 0, conpaction is printed for each layer with interbed storage.
If 1COWR < 0, conpaction is not printed.

| HCPR is the output flag for preconsolidation head printout.
If IHCPR > 0, preconsolidation head is printed for each layer with interbed
st or age.
If ITHCPR < 0, preconsolidation head is not printed.

| SUBSV is the output flag for saving subsidence in an unformatted disk file.
If 1SUBSV > 0, subsidence is saved.
If ISUBSV < 0, subsidence is not saved.

| COMBV is the output flag for saving conpaction in an unformatted disk file.
If ICOMBV > 0, conpaction is saved for each layer with interbed storage.
If 1COMBV < 0, conpaction is not saved.

| HCSV is the output flag for saving preconsolidation head in an unformatted disk file.
| f
| f

IHCSV < 0, preconsolidation head is not saved.
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Time-Variant Specified-Head Package

I nput for the Time-Variant Specified-Head Package (CHDl) is read from the unit specified in

I UNI T( 20) .
FOR EACH SIMULATION
1. Data: MXCHD
For mat : 110
FOR EACH STRESS PERIOD
2. Data: I TMP
For mat : 110
3. Data: Layer Row Columm StartHead EndHead
For mat 110 110 110 F10.0 F10.0
(The 3. data normally consists of one record for each specified-head boundary cell. If ITWP

is zero, the 3. data is not read)

Explanation of Fields Used in Input Instructions

MXCHD i's the maxi mum nunber of specified-head cells to be specified each stress period.

| TMP is a flag.
If ITMP < 0, specified-head boundary data fromthe previous stress period will be
reused and the 3. data will not be read. Reusing data froma previous stress period
neans that the head values at the start and end of the current stress period wll
be the same as they were at the start and end of the previous stress period.
If ITMP > 0, it is the nunber of records of specified-head boundary data that will
be read for the current stress period.

Layer is the layer nunber of the cell affected by the specified-head boundary.

Row is the row number of the cell affected by the specified-head boundary.

Col um is the colum nunber of the cell affected by the specified-head boundary.

St art Head

is the head value at the cell at the start of the stress period. Because the
package assigns head values on the basis of linear interpolation to the end of a
time step, the assigned specified-head value will never equal StartHead unless
Start Head and EndHead are equal .

EndHead is the head value at the cell at the end of the stress period. It is the value that

will be assigned to the cell for the last time step in the stress period.
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Appendix 4: Input Instructions of MT3D

These input instructions are intended as a reference for the experienced user. PMAN N transl ates
the user-specified data to the input files of MI3D by using the rules given in these input
instructions. Mst explanations of the input variables are contained in Chapter 3 of this nmanual
or in Chapter 6 of the manual of MI3D (Zheng, 1990).

Basic Transport Package

Input to the Basic Transport Package (BTN) is read on unit 1, which is preset in the main program
of MI3D. Since the BTN Package is needed for every sinmulation, this input file is always
required.

FOR EACH SIMULATION

l. Dat a: HEADNGL
Famat : A80
2. Dat a: HEADNG2
For mat : A80
3. Dat a: NLAY NROW  NCOL NPER
For mat : 110 110 110 110
4. Dat a: TUNNT LUNIT MINT
For mat : Ad Ad Ad
5. Data: TRNOP( 10)

For mat : 10L2
(ADV DSP SSM RCT XXX XXX XXX XXX XXX XXX)

6. Data: LAYCON( NLAY)
For mat : 401 2
7. Data: DELR(NCOL) | nput Mbdul e: ULDREL
8. Data: DELC(NROW | nput Mbdul e: ULDREL
9. Data: HTOP( NCOL, NROW | nput Mbdul e: U2DREL
10. Data: DZ(NCOL, NROW | nput Mddul e: U2DREL (one array for each |ayer)
11. Data: PRSI TY( NCOL, NROW | nput Modul e: U2DREL (one array for each |ayer)
12. Data: | CBUND( NCOL, NROW | nput Mbodul e: ULDREL (one array for each |ayer)
13. Data: SCONC( NCOL, NROW | nput Mbdul e: U2DREL (one array for each |ayer)
14. Data: Cl NACT
For mat : F10.0
15. Data: IFMICN | FMINP | FMTRF | FMTDP  SAVUCN
For mat : 110 110 110 110 L10
16. Data NPRS
For mat : 110
(Entar the 17. Data only if NPRS > 0)
17. Data: TI MPRS( NPRS)
For mat : 8F10.0
18. Data: NOBS
For mat : 110
(Enter the 19. Data NOBS times if NOBS > 0)
19. Data: KOBS 10BS JOBS
For mat : 110 110 110
20. Data: CHKMVAS

For mat : L10

FOR EACH STRESS PERIOD

21. Data: PERLEN NSTP TSMULT
For mat : F10.0 110 F10.0

(Enter the 22. Data if TSMULT < 0)

22. Data: TSLNGH( NSTP)
For mat : 8F10.0
23 Data: DTO MXSTRN

For mat : F10.0 110

Explanation of Fields Used in Input Instructions
HEADNGL is the first line of any title or heading for the sinmulation run. The |ine should
not be longer than 80 characters.
HEADNG2 is the second line of any title or heading for the sinmulation run. The |ine shoul d
not be longer than 80 characters.

NLAY is the total nunber of |ayers.

NROW is the total number of rows.

NCOL is the total number of col ums.

NPER is the total nunber of stress periods.

TUNIT is the name of unit for time, such as DAY or HOUR;

LUNI' T is the name of unit for length, such as FT or CM

MUNI T is the name of wunit for mass, such as LB or KG These nanes are used for
identification purposes only, and do not affect the nodel outcone.
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TRNOP

LAYCON

DELR
DELC
HTOP

Dz

PRSI TY
| CBUND

SCONC
Cl NACT

| FMICN

| FMTNP

| FMTRF

| FMTDP

SAVUCN

NPRS

TI MPRS

is a array that contains logical flags for major transport options. TRNOP(1l) to (4)
corresponds to Advection, Dispersion, Sink & Source M xing, and Chem cal Reaction
Options, respectively. If any of these options is used, enter its correspondi ng
TRNOP el ement as T, otherwise as F. TRNOP(5) to (10) are not used in the current
version (version 1.x) of MI3D.

is the nodel |ayer-type code. Enter one value for each layer. Enter LAYCON in as
many |ines as necessary if NLAY > 40. |If LAYCON = 0, the nodel layer is confined.
If LAYCON # 0, the nodel l|ayer is either unconfined or convertible between confined
and unconfined. (Note that this corresponds to the LAYCON values of 1, 2, and 3 in
MODFLOW however, there is no need to distinguish between these |layer types in the
transport sinulation.)

is the cell width along rows. Enter one value for each columm in the grid.

is the cell width along colums. Enter one value for each row in the grid.

is the top elevation of cells in the first layer relative to the sane datum as the
heads. |f the first layer is unconfined, HTOP can be set npbst conveniently to a
uni form el evati on above the water table. Note that the concentration for cells in
the first layer is calculated at nodes assuned to be m dway between HTOP and the
bottomof the first layer. HTOP should not be set nmuch higher than the water table.
If the first layer is confined, then, HTOP is equal to the bottom el evation of the
confining unit overlying the first |ayer.

is the cell thickness in each layer. DZ is a three-dinensional array. The input to
three-dinmensional arrays is handled as a series of two-dinmensional arrays with one
array for each layer, entered in the sequence of layer 1, 2, ..., NLAY. The
thickness of the first layer should be entered as the difference between HTOP and
its bottom el evation.

is the effective porosity of the porous nmediumfor each cell of the grid.

is the boundary indicator array for the concentration field.

If ICBUND = 0, the cell is an inactive concentration cell. Note that noflow or dry
cells are automatically converted into inactive concentration cells. Furthernore,
active head cells can be treated as inactive concentration cells to mninmze the
area needed for transport sinulation, as long as the solute transport is
insignificant near those cells.

If ICBUND < 0, the cell is a constant-concentration cell. The initial concentration
renains the same at the cell throughout the simulation. Note that a constant-head
cell May or may not be a constant-concentration cell.

If ICBUND > 0, the cell is a variable (active) concentration cell.

is the starang concentration at the begi nning of the simulation.

is the value for indicating an inactive concentration cell (ICBUND = 0). Even if
it is not anticipated to have inactive cells in the nodel, a value for CINACT still
nmust be submitted.

is a flag indicating whether the cal cul ated concentration should be printed and
al so serves as a printing-format code if it is printed. The codes for print-formats
are the sane as those for the input nbdul e (see Appendi x A3).

If IFMICN > 0, concentration is printed in the wap form

If IFMICN < 0, concentration is printed in the strip form

If IFMICN = 0, concentration is not printed.

is aflag indicating whether the nunber of particles in each cell should be printed
and al so serves as a printing-format code if they are printed. The convention is
the sane as that used for | FMICN.

is a flag indicating whether the nodel-calculated retardation factor should be
printed and al so serves as a printing-format code if it is printed. The convention
is the sane as that used for | FMICN.

is a flag indicating whether the nodel-cal cul ated distance weighted dispersion
coefficient should be printed and al so serves as a printing-format code if it is
printed. The convention is the same as that usedfor | FMICN.

is alogical flag indicating whether the concentration should be saved in a default
unformatted file (MI3D.UCN) for a continuation run or for post-processing purposes.
If SAVILN = T, the concentration will be saved in file MI3D.UCN. In addition, the
nmodel spatial discretization infornmation will al so be saved in another default file
naned MI3D.CNF, to be used in conjunction with MI3D. UCN for post-processing.

If SAVUCN = F, neither MI3D. UCN nor MI3D.CNF is created.

is aflag indicating the frequency of the output, and al so indicating whether the
out put frequency is specified in terns of total elapsed sinmulation tine or the
transport step nunber. Note that what are actually printed or saved is controlled
by the input values entered in the 15. data.

If NPRS > 0, sinulation results will be printed or saved at tinmes as specified in
the 17. data TI MPRS(NPRS).

If NPRS = 0, simulation results will not be printed nor saved except at the end of
each stress period.

If NPRS < 0, sinmulation results will be printed or saved whenever the nunber of

transport steps is an even nultiple of NPRS.

is the total elapsed tine at which sinulation results are printed to the standard
output file or saved in the default unformatted concentration file MI3D. UCN.

If NPRS > 8, enter TIMPRS in as nany |lines as necessary.
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NOBS

KOBS,

CHKMAS

PERLEN
NSTP
TSMULT

TSLNGH

DTO

MXSTRN

is the nunber of observation points at which the concentration will be printed or
saved at every transport step in the default observation point file MI3D. OBS.

| OBS and JOBS

are the cell indices (layer, row, colum) in which the observation point or
nmonitoring well is located and for which the concentration is to be printed or
saved at every transport step in file MI3D. OBS. Enter one set of KOBS, |OBS, JOBS
for each observation point.

is alogical flag indicating whether a one-line summary of mass bal ance i nformation
for each transport step should be saved in the default file named MI3D. MAS for
checki ng purposes.

If CHKMAS = T, the mass bal ance information for each transport step will be saved
in file MI3D. MAS.

If CHKMAS = F, file MI3D. MAS is not created.

is the length of the current stress period.

is the number of time steps in the current stress period.

is the multiplier for the length of successive tinme steps.

If TSMULT > 0, the length of each time step within the current stress period is
cal cul ated using the geonetric progression as in MODFLON Note that PERLEN, NSTP
and TSMULT nust be the sanme as those used in the flow nodel except in steady state
si mul ati ons.

If TSMULT < O, the length of tine steps within the current stress period is read
fromthe 22. Data. This option is needed in case the length of tine steps in the
head solution is not based on a geonetric progression in a flow nodel other than
MODFL OW

provides the length of time steps in the current stress period. This record is
needed only if the length of tine steps for the head solution is not based on a
geonetric progression. Enter TSLNGH in as many |ines as necessary if NSTP>8.

is the user-specified transport stepsize. The program will always calculate a
nmaxi mum transport stepsize which neets the various stability criteria. Setting DTO
to zero or a negative value causes the nodel-cal cul ated transport stepsize to be
used in the simulation. However, the nodel-calculated DTO may not always be
optimal. In this situation, DIO should be adjusted to find a DTO which |leads to the
best results. If DIO is given a value greater than the nodel -cal cul ated stepsi ze,
the nodel -cal cul ated stepsize, instead of DTO, will be used in the sinulation.

is the maxi mum nunber of transport steps allowed for one tine step (of the head
solution). If the nunber of transport steps within one time step exceeds MXSTRN,
the sinulation is term nated.

Appendix



Processing M odflow A-35

Advection Package

I nput to the Advection Package (MIADV1) is read on unit 2, which is preset in the nain program
of MI3D. The input file is needed only if the Advecti on Package is used; however, this package
i s needed under alnopst all circunstances.

FOR EACH SIMULATION

1. Dat a: M XELM PERCEL MXPART
For mat : 110 F10.0 110

2. Dat a: | TRACK WD
For mat : 110 F10.0

(Enter the 3. Data, if MXELM = 1 or 3)

3. Dat a:

DCEPS NPLANE NPL NPH NPM N NPMAX  SRMULT

For mat : F10.0 110 110 110 110 110 F10.0

(Enter the 4. Data, if MXELM = 2 or 3)

4. Dat a:

I NTERP  NLSI NK NPSI NK

For mat : 110 110 110

(Enter the 5. Data, if M XELM = 3)

5. Dat a:

DCHVOC

For mat : F10.0

Explanation of Fields Used in Input Instructions

M XELM

PERCEL

MXPART

| TRACK

WD

DCEPS

NPLANE

NPL

is a flag indicating the advection solution schene.

If MXELM = 1, the Method OF Characteristics (MOXC) is used.

If MXELM = 2, the Mddified Method O Characteristics (MMOC) is used.
If MXELM = 3, the Hybrid MOC MMOC (HMOC) is used.

If MXELM = 0, the upstreamfinite difference nethod is used.

is the Courant nunber, or nunber of cells any particle will be allowed to nove in
any direction in one transport step. PERCEL is used to calculate the nmaxi num
al l oned stepsize for particle tracking. This stepsize is then conpared with other
stability criteria, if any, to determi ne an appropriate stepsize to be used in the
sinul ation. Cenerally, 0.5<PERCEL<1. However, values in excess of 1 can be used if
the higher-order particle tracking nmethod is used throughout the grid. Furthernore,
because all cells in the entire grid are checked when cal cul ating the maxi num
al l oned stepsize for particle tracking, there may be a few cells where a particle
will nove nore than one cell's length with PERCEL > 1, while a particle will only
nove a fraction of a cell elsewhere. |If these cells are outside the area of
interest, setting PERCEL>1 will not result in inaccuracy. (Note that if M XELM =
0, i.e., using upstreamfinite difference nethod for solving advection, PERCEL nust
not exceed 1.)

is the maxi mum nunber of total noving particles allowed, and is used only when
M XELM = 1 or 3.

is a flag indicating which particle tracking algorithmis selected.

If ITRACK = 1, the first-order Euler algorithmis used;

If ITRACK = 2, the fourth-order Runge-Kutta algorithmis used;

If ITRACK = 3, the Runge-Kutta algorithmis used in sink/source cells and the cells
next to sinks/sources while the Euler algorithmis used el sewhere.

is a concentration weighting factor between 0 and 1. The value of 0.5 is nornmally
a good choice. This nunmber can be adjusted to achieve better mass bal ance.
Generally, it can be increased toward 1 as advecti on beconmes nore doni nant.

is a small relative concentration gradient (DCCELL), which is considered to be
negligible (see equation 3.27).

is a flag indicating whether the randomor fixed pattern is selected for initial
pl acenent of noving particles.

If NPLANE = 0, the the random pattern is selected for initial placenent. Particles
are distributed randomy by calling a random nunber generator in both the honzontal
and vertical directions (refer to Fig. 3.22b). This option generally leads to
snal | er nass bal ance di screpancy in nonuniformor diverging/converging flow fields.
If NPLANE > 0, the fixed pattern is selected for initial placenent. The val ue of
NPLANE serves as the number of vertical "planes" on which initial particles are
placed within each cell block (refer to Fig.3.22a). This fixed pattern works well
in relatively uniformflow fields. For two-dinensional sinmulations in plan view,
set NPLANE = 1. For cross sectional or three-dinensional sinulations, NPLANE = 2
is normal |y adequate. Increase NPLANE if nore resolution in the vertical direction
i s desired.

is nunmber of initial particles per cell to be placed at cells where DCCELL < DCEPS.
Generally, NPL can be set to O since advection is insignificant under the condition
DCCELL < DCEPS. Setting NPL equal to NPH causes a uniform nunber of particles to
be placed in every cell over the entire grid (i.e., the uniform approach).
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NPH

NPM N

NPNMAX

SRMULT

| NTERP

NLSI NK

NPSI NK

DCHVOC

is nunmber of initial particles per cell to be placed at cells where DCCELL > DCEPS.
The sel ection of NPH depends on the nature of the flow field and al so the conputer
menory limtation. Generally, use a smaller nunber in relatively uniform flow
fields and a larger number in relatively nonuniformflow fields. However, val ues
exceeding 16 in two dinensional simulation or 32 in three-dimensional sinmulation
are rarely necessary. If the random pattern is chosen, NPH particles are randomy
distributed within the cell block. If the fixed pattern is chosen, NPH is divided
by NPLANE to yield the nunber of particles to be placed per vertical plane, which
is rounded to one of the values shown in Fig. 3.23.

is the mninum nunber of noving particles allowed per cell. If the nunber of
particles in a cell at the end of a transport step is fewer than NPM N, new
particles are inserted into that cell to naintain a sufficient nunber of particles.
NPM N can be set to O inrelatively uniformflow fields, and a nunber greater than
zero in diverging/converging flow fields. Generally, 0 < N°PMNE < 4 is adequate.

is the maxi mum nunber of particles allowed per cell. |If the nunber of particles in
a cell exceeds NPMAX, particles are renpved from that cell until NPMAX is net.
General ly. NPMAX can be set to a value approxi mately twi ce the value of NPH.

is a nultiplier for the particle nunber at source cells (SRMUT > 1). In nost
cases, SRMULT = 1 is sufficient. However, better results may be obtained by
i ncreasi ng SRMULT.

is a flag indicating the concentration interpolation nethod for use in the MMOC
solution scheme. Currently, only linear interpolation is inplenmented. Enter | NTERP
= 1.

is a flag indicating whether the randomor fixed pattern is selected for initial
pl acement of particles to approximate sink cells in the MMOC schene. The convention
is the sanme as that for NPLANE

is the nunber of particles used to approximate sink cells in the MMOC schenme. The
convention for is the same as that for NPH.

is the critical relative concentration gradient for controlling the selective use
of either MOC or MMOC in the HMOC sol ution scheme. The MOC solution is selected at
cells where DCCELL > DCHMOC. The MMOC solution is selected at cells where
DCCELL < DCHMCC.
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Chemical Reaction Package

Input to the Chemi cal Reaction Package (MIRCT1l) is read on unit 5, which is preset in the min
program of MI3D. The input file is needed only if a sorption isothermor a first-order rate
reaction (decay or biodegradation) is sinulated.

FOR EACH SIMULATION

1. Data: | SOTHM | REACT

For mat : 110 110
(Enter 2-4 data, if |SOTHM > 0)
2. Data: RHOB( NLAY) | nput Modul e: ULDREL (one value for each |ayer).
3. Data: SP1(NLAY) |nput Mdul e: ULDREL (one value for each |ayer).
4. Data: SP2( NLAY) | nput Mdul e: ULDREL (one value for each |ayer).
(Enter 5-6 data, | REACT > 0)
5. Data: RCL( NLAY) | nput Modul e: ULDREL (one value for each layer).
6. Data: RC2( NLAY) | nput Modul e: ULDREL (one value for each layer).

Explanation of Fields Used in Input Instructions
| SOTHM is a flag indicating whether, or if any, which sorption type is sinulated.

If 1SOTHM = 1, Linear isothermis sinulated.
If 1SOTHM = 2, Freundlich isothermis sinulated.
If 1SOTHM = 3, Langnuir isothermis sinulated.
If 1SOTHM = 0, no sorption isothermis sinulated.
| REACT is aflag indicating whether the first-order rate reaction is sinulated.
If IREACI = 1, radioactive decay or biodegradation is sinulated.
If IREACI = 0, no first-order rate reaction is sinulated.
RHOB is the bulk density of the porous nediumin the aquifer. One value is specified for
each | ayer.
SP1 is the first sorption constant. One value is specified each layer. The use of SP1
depends on the type of sorption selected (i.e., |SOTHV.
For linear sorption, SP1 is the distribution coefficient.
For Freundlich sorption, SP1 is the Freundlich sorption equilibriumconstant.
For Langnuir sorption, SPl is the Langnuir sorption equilibriumconstant.
SP2 is the second sorption constant. One value is specified for each | ayer. The use of
SP2 depends on the type of sorption selected (i.e., |SOIHM.
For linear sorption, SP2 is not used, but still nust be entered.
For Freundlich sorption, SP2 is the Freundlich exponent.
For Langmuir sorption, SP2 is the maxi mum anount of the solute that can be adsorbed
by the soil matrix.
RC1 is the first-order rate constant [1/T] for the dissolved phase.
RC2 is the first-order rate constant [1/T] for the sorbed phase. Generally, if the

reaction is radioactive decay, RC2 should be set equal to RCl. However, for certain
types of biodegradation, RC2 may be different from RCL.
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Dispersion Package

Input to the D spersion Package (MIDSP1) is read on unit 3, which is preset in the nain program
of MI3D. The input file is needed only if the Dispersion Package is used in the sinulation.

FOR EACH SIMULATION

1. Data: AL(NCOL, NROW | nput Modul e: U2DREL (one array for each layer).
2. Data: TRPT(NLAY) | nput Mdul e: ULDREL (one value for each |ayer).

3. Data: TRPV(NLAY) | nput Mdul e: ULDREL (one value for each |ayer).

4 Dat a: DMCOEF( NLAY) | nput Modul e: ULDREL (one value for each |ayer).

Explanation of Fields Used in Input Instructions
AL is the longitudinal dispersivity [L] for each cell in the grid.
TRPT is the ratio of the horizontal transverse dispersivity to the
di spersivity.
TRPV is the ratio of the vertical transverse dispersivity to the

di spersivity.

| ongi t udi nal

| ongi t udi nal

DMCOEF is the effective nolecular diffusion coefficient. Set DMCOEF = 0, if the effect of

nol ecul ar diffusion is considered uninportant.
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Sink & Source Mixing Package

Input to the Sink & Source M xing Package (MISSML) is read on unit 4, which is preset in the main
program of MI3D. The input file is needed if any sink or source option is used in the flow nodel,

including the

const ant - head or general -head- dependent boundary conditions. The classification of

the sink/source type used in MI3D is the sane as that used by MODFLOW

FOR EACH SIMULATION

1. Dat a: FWEL FDRN FRCH FEVT FRIV FGHB
For mat : L2 L2 L2 L2 L2 L2

2. Dat a: MXSS
For mat : 110

FOR EACH STRESS PERIOD
(Enter the 3. data, if FRCH =T)

3. Data: I NCRCH
For mat : 110

(Enter the 4. data, if FRCH = T and INCRCH > 0)

4, Data: CRCH( NCOL, NROW | nput Mbodul e: U2DREL

(Enter the 5. data, if FEVI = T)

5. Dat a: I NCEVT

For mat : 110

(Enter the 6. data, if FEVT = T and | NCEVT > 0)

6. Data: CEVT(NCOL, NROW | nput Modul e: U2DREL

7. Data: NSS

For mat : 110
(Enter the 8. data, if NSS > 0)
8. Data: KSS I SS JSS CsS | TYPE
For mat : 110 110 110 F10.0 110
Explanation of Fields Used in Input Instructions

FWVEL is alogical flag for the Well option.

FDRN is alogical flag for the Drain option.

FRCH is alogical flag for the Recharge option.

FEVT is alogical flag for the Evapotranspiration option.

FRI V is alogical flag for the River option.

FGHB is alogical flag for Ceneral - Head- Dependent Boundary opti on.

If any of above options is used in the flow nodel, its respective flag nust be set
to T. otherw se, set to F.

MXSS i s the maxi mum nunber of all point sinks and sources sinmulated in the flow nodel.
Poi nt sinks and sources include constant-head cells, wells, drains, rivers, and
gener al - head- dependent boundary cells. Recharge and Evapotranspiration are treated
as areal ly distributed sinks and sources; thus, they should not be counted as point
si nks and sources. MXSS should be set close to the actual nunber of total point
sinks and sources in the flow nodel in order to nminimze the conputer nenory
all ocated to store sinks and sources.

| NCRCH is a flag indicating whether an array containing the concentrati on of recharge fl ux

will be read for the current stress period.
If INCRCH > 0, an array containing the concentration of recharge flux will be read.
If INCRCH < 0, the concentration of recharge flux will be reused fromthe |ast
stress period. For the first stress period, the concentration of recharge flux is
set to zero by default.

CRCH is the concentration of recharge flux. If the recharge flux is positive, the
recharge acts as a source whose concentration can be specified as desired. If the
recharge flux is negative, the recharge acts as a sink (or discharge) whose
concentration is always set equal to the concentration of the aquifer at the cell
where di scharge occurs. Note that the location and flow rate of recharge/di scharge
are obtained fromthe flow nodel directly through the unformatted head and flow
file (MI3D. FLO) .

| NCEVT is a flag indicating whether an array containing the concentration of
evapotranspiration flux will be read for the current stress period.

If INCEVT > 0, an array containing the concentration of evapotranspiration flux
will be read.

If INCEVT < 0, the concentration of Evapotranspiration flux will be reused fromthe
| ast stress period.

CEVT is the concentration of Evapotranspiration flux. Evapotranspiration is the only

sink whose concentration can be specified externally. Note that the concentration
of a sink cannot be greater than that of the aquifer at the sink cell. Thus, if the
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NSS

KSS, 1SS,

Css
I TYPE

sink concentration is specified greater than that of the aquifer, it is
autonatically set equal to the concentration of the aquifer. Note that the |ocation
and flow rate of evapotranspiration are obtained from the flow nodel directly
through the unfornatted head and flow file (MI3D. FLO).

is the nunmber of point sources whose concentrations need to be specified.
Unspecified point sources are assuned to have a zero concentration by default.
(Note that the concentration of point sinks are always set equal to the
concentration of the aquifer).

JSS

are the cell indices (layer, row, colum) of the point source for which a
concentration is to be specified.

is the specified concentration for the point source at the cell [JSS, ISS, KSS].

is an integer nunber indicating the type of the point source as |listed below Enter
one record for each point source of specified concentration. Note that the |ocation
and flow rate of point sources/sinks are obtained from the flow nodel directly
through the unfornatted head and flow file (MI3D. FLO).

ITYPE = 1, constant-head cell;

ITYPE = 2, well;

ITYPE = 3, drain (this is defined in MI3D. A drain can, however, never be a source);
I TYPE = 4, river;

I TYPE = 5, general -head boundary cell.
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Appendix 5: Using PMWIN with your MODFLOW

You can configure PMNN to run with your own MODFLOW by nodifying the file PMANN IN. This file
is located in the hone directory of PMAN (e.g., C\PMA'N). PMA'N supports various versions of
MODFLOW by using the IUNIT assignments in a corresponding section of PMAN.IN. These IUNIT
assignments nust be the sanme as those used in the nmain program of MODFLOW The follow ng two
tabl es show an exanpl e. Table Al shows a part of the main program of MODFLOW containing the IUNIT
assignments. Table A2 shows the cooresponding settings saved in the [User's own] section of
PMAI'N. INI. For this exanple, the User's own version of MODFLOWis chosen.

F(IUNIT(1).GT.0) CALL BCF2AL(I SUM LENX, LCSCL, LCHY.

1 LCBOT, LCTOP, LCSC2, LCTRPY, | UNI T(1), | SS

2 NCOL, NROW NLAY, | OUT, | BCFCB, LOWETD, | WDFLG, LCCWWD,
3 VETECT, | VETI T, | HDWET, HDRY)

I F(IUNIT(2).GT.0) CALL WEL1AL(| SUM LENX, LOVELL, MXWELL, NVELLS
1 I UNI T(2), | OUT, | \ELCB)

I F(IUNIT(3).GT.0) CALL DRNIAL( | SUM LENX, LCDRAI , NDRAI N, MXDRN
1 I UNI T(3), | OUT, | DRNCB)

I F(IUNIT(4).GT.0) CALL RIVIAL(I SUM LENX, LCRI VR, MXRI VR, NRI VER
1 I UNI T(4), | OUT, | RI VCB)

I F(IUNIT(5).GT.0) CALL EVT1AL(I SUM LENX, LCl EVT, LCEVTR, LCEXDP
1 LCSURF, NCOL, NROW NEVTOP, | UNI T(5) , | OUT, | EVTCB)

I F(QIUNIT(7).GT.0) CALL GHBI1AL( | SUM LENX, LCBNDS, NBOUND, MXBND
1 I UNI T(7), | OUT, | GHBCB)

I F(IUNIT(8).GT.0) CALL RCH1AL( | SUM LENX, LCl RCH, LCRECH, NRCHOP
1 NCOL, NROW | UNI T(8) , | OUT, | RCHCB)

I F(IUNIT(9).GT.0) CALL SIP1AL(ISUM LENX, LCEL, LCFL, LCGL, LCV
1 LCHDCG, LCLRCH, LCW MXI TER, NPARM NCOL, NROW NLAY,

2 I UNIT(9), | QUT)

I F(IUNIT(11) .GT.0) CALL SOR1AL( | SUM LENX, LCA, LCRES, LCHDCG, LCLRCH
1 LCl EQP, MXI TER, NCOL, NLAY, NSLI CE, MBW | UNI T(11), | OUT)

I F(IUNIT(13) .GT.0) CALL PCG2AL(!|SUM LENX, LCV, LCSS, LCP, LCCD
1 LCHCHG, LCLHCH, LCRCHG, LCLRCH, MXI TER, | TERL, NCOL, NROW NLAY,
2 I UNI T(13), | OUT, NPCOND)

I F(IUNIT(14) .GT.0) CALL STR1AL(!SUM LENX, LCSTRM | CSTRM MXSTRM
1 NSTREM | UNI T(14), | OUT, | STCB1, | STCB2, NSS, NTRI B
2 NDI V, | CALC, CONST, LCTBAR, LCTRI B, LCl VAR)

I F(IUNIT(16).GT.0) CALL HFB1AL( | SUM LENX, LCHFBR, NHFB, | UNI T( 16)
I ouT

I FCIUNIT(19).GT.0) CALL IBS1AL(! SUM LENX, LCHC, LCSCE, LCSCV,
1 LCSUB, NCOL, NROW NLAY, | I BSCB, | | BSCC, | SS, | UNI T(19), | QUT)
I F(IUNIT(20).GT.0) CALL CHD1AL(| SUM LENX, LCCHDS, NCHDS, MXCHD,

1 I UNI T(20), | OQUT)

Table A1 IUNIT assignnments given in the main program of MODFLOW
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Appendix 6: Running MODPATH with PMWIN

PMN' N supports both two versions (version 1.x and 3.x) of MODPATH and MODPATH- PLOT. You nust run
MODPATH or MODPATH- PLOT wi t hin a DOS-Box (of Wndows) or in the DOS-Environnent.

If you are using MODPATH version 1.x (released prior to Septenber, 1994), type path\PATHFILE at
the pronpt ENTER NAME OF FILE CONTAINING NAMES AND UNITS OF DATA FILES. \Were path is the path
to the directory of your nodel data. PATHFILE contains the IUNIT assignnents and paths and nanes
of input data files generated by PMANN. The nanmes of the input files for MODFLOW and MODPATH are
given in Appendix 7.

If you are using MODPATH or MODPATH PLOT (version 3.x), follow the steps bel ow

TO READ INPUT FROM AN EXISTING RESPONSE FILE, ENTER FILE NAME:
( <CR> = ENTER DATA INTERACTIVELY )
[ ? = Help ]

(WHAT YOU SHOULD DGO Just press ENTER here. For the first tine you run MODPATH or MODPATH-
PLOT, you do not have a response file and you have to enter data interactively. The user-
specified data will be saved by MODPATH or MODPATH-PLOT in the response files MPATH. RSP or
MPLOT. RSP, respectively. Using a response file, you do not need to go through the input
procedures unless you want to change the data for MODPATH or MODPATH PLOT).

Only by MODPATH-PLOT:

TO REDEFINE SETTINGS, ENTER NAME OF FILE WITH SETTINGS DATA:
(<CR> = USE DEFAULT SETTINGS FOR DEVICE)

[ 2 = Help ]

(WHAT YOU SHOULD DG Just press ENTER here, unless you want to change settings.)

ENTER THE NAME FILE:
[ 2 = Help ]

(WHAT YQU SHOULD DO Type path\ MPATH30 at this pronpt. Wiere path is the path to the directory
of your nodel data. For exanple, if you have saved your nodel data in C \PMAN N\ DATA, you will
type C \PMN N DATA MPATH30 at this pronpt. After this pronpt, you enter the interactive input
procedure of MODPATH or MODPATH PLOT. Just follow the pronpts of the prograns.)
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Appendix 7: Input data files of the supported programs

The input data files created by PMAN for each packages of the supported programs are saved in
the nodel directory and |isted bel ow

MODFLOW

Basi ¢ Package BAS. DAT
Bl ock- Centered Fl ow Package (BCFl or BCF2) BCF. DAT
Ri ver Package RI V. DAT
Rechar ge Package RCH. DAT
Wel | Package WEL. DAT
Drai n Package DRN. DAT
Evapotranspirati on Package EVT. DAT
Gener al - Head Boundary Package GHB. DAT
Strongly Inplicit Procedure Package (SIP) S| P. DAT
Slice-Successive Overrel axati on Package (SSOR) SOR. DAT
Precondi ti oned Conjugate G adi ent 2 Package (PC®&) PCG2. DAT
Stream Routing Fl ow Package (STR1) STR1. DAT
I nt er bed- St or age Package (1 BS1) | BS1. DAT
Hori zont al - Fl ow Barrier Package (HFB1) HFB1. DAT
Ti me- Vari ant Speci fi ed- Head (CHD1) CHD1. DAT
Qut put Control OC. DAT

MODPATH and MODPATH-PLOT (version 1.x)
Main data file MAI N. DAT

MODPATH and MODPATH-PLOT (version 3.x)
Main data file MAI N30. DAT
(G her files required by MODPATH, such as RIV.DAT or VEL.DAT are the same as those of MODFLOW)

MT3D

Basi ¢ Transport Package MTBTNL. DAT
Advection Package MTADV1. DAT

Di spersi on Package MTDSP1. DAT
Sink & Source M xing Package MTSSML. DAT
Chemi cal Reaction Package MIRCT1. DAT
PEST

Instruction File I NSTRUCT. DAT
Control File PESTCTL. DAT
Bl ock- Centered Fl ow Package Tenplate File BCFTPL. DAT

Ri ver Package Tenplate File RI VTPL. DAT
Recharge Package Tenplate File RCHTPL. DAT
Wel | Package Tenplate File WELTPL. DAT
Drai n Package Tenplate File DRNTPL. DAT
Evapotranspirati on Package Tenplate File EVTTPL. DAT
Gener al - Head Boundary Package Tenplate File GHBTPL. DAT
Stream Routing Fl ow Package Tenplate File STRTPL. DAT

I nt er bed- St orage Package Tenplate File | BSTPL. DAT
Gid Specification File (used by MODBORE. EXE) filename. GRD*
Bore Listing File (used by MODBORE. EXE) BORELI ST. DAT
Bore Coordinates File (used by MODBORE. EXE) BORECOOR. DAT

* filename is the file name of your nodel. The grid specification file provides the grid geonetry
and | ocation details. The format of this file is given below.
File Format
1. Data: NROW NCOL
2. Data: X Y ANGLE
3. Data: DELR(NCQL)
4. Data: DELC(NROW
Explanation of Fields Used in Input Instructions

NROW is the number of nodel rows.

NCOL is the number of nodel col ums.

X is the x-coordinate of the top-left corner of the nodel grid.

Y is the y-coordinate of the top-left corner of the nodel grid.

ANGLE is the rotation angl e expressed in degrees and neasured countercol ckwi se fromthe
positive x-axis.

DELR is the cell width along rows. Read one val ue for each of the NCOL colums. This is
a single array with one value for each col um.

DELC is the cell width along colums. Read one value for each of the NRONrows. This is

a single array with one value for each row
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